# Contents

## Preface
- About This User’s Guide ........................................ ii
- Finding the Latest Information ................................. iv
- Assumptions ........................................................ iv
- Do Not Use Database Tools to Modify Oracle Applications Data ........................................ v
- Other Information Sources ........................................ vi
- About Oracle ......................................................... x
- Thank You .......................................................... x

## Chapter 1
- Introduction ....................................................... 1 – 1
- Human Resource Management ................................. 1 – 2
- Separate v. Integrated HRMS Systems ....................... 1 – 3
- Human Resources and Payroll Activity Cycles ............. 1 – 4
- Introduction to the HRMS Model .............................. 1 – 6
- Managing Change Over Time ................................... 1 – 9
- Dated Information and Hierarchy Versions .................. 1 – 10
- DateTrack ......................................................... 1 – 11
- Setting Your Effective Date ..................................... 1 – 11
- Viewing Datetracked Information and History ............. 1 – 13
- Updating and Correcting Datetracked Information ......... 1 – 14
- Deleting Datetracked Information ............................ 1 – 16
- Work Structures and Key Flexfields .......................... 1 – 17
# Chapter 2

## The Employer and Other Organizations

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site Locations</td>
<td>2–2</td>
</tr>
<tr>
<td>Setting Up Site Locations</td>
<td>2–3</td>
</tr>
<tr>
<td>Representing Employers</td>
<td>2–4</td>
</tr>
<tr>
<td>Single or Multiple Business Groups</td>
<td>2–4</td>
</tr>
<tr>
<td>Defaults for the Business Group</td>
<td>2–5</td>
</tr>
<tr>
<td>Representing Organizations</td>
<td>2–6</td>
</tr>
<tr>
<td>Levels of Internal Organizations</td>
<td>2–6</td>
</tr>
<tr>
<td>Internal Organizations and Cost Centers</td>
<td>2–7</td>
</tr>
<tr>
<td>External Organizations</td>
<td>2–7</td>
</tr>
<tr>
<td>Employer and Organization Setup</td>
<td>2–8</td>
</tr>
<tr>
<td>Accessing Business Groups</td>
<td>2–8</td>
</tr>
<tr>
<td>Creating an Organization</td>
<td>2–10</td>
</tr>
<tr>
<td>Additional Information for HR Organizations</td>
<td>2–13</td>
</tr>
<tr>
<td>Entering Business Group Information</td>
<td>2–14</td>
</tr>
<tr>
<td>Business Groups: Entering Budget Value Defaults</td>
<td>2–16</td>
</tr>
<tr>
<td>Business Groups: Entering Sickness Control Rules</td>
<td>2–17</td>
</tr>
<tr>
<td>Business Groups: Entering Tax Details</td>
<td>2–18</td>
</tr>
<tr>
<td>Business Groups and HR Organizations: Work Day Defaults</td>
<td>2–19</td>
</tr>
<tr>
<td>HR Organizations: Entering Costing Information</td>
<td>2–20</td>
</tr>
<tr>
<td>HR Organizations: Entering Parent Organizations</td>
<td>2–20</td>
</tr>
<tr>
<td>Deleting an Organization</td>
<td>2–22</td>
</tr>
<tr>
<td>Organization Hierarchies</td>
<td>2–23</td>
</tr>
<tr>
<td>Multiple Hierarchies</td>
<td>2–24</td>
</tr>
<tr>
<td>Organizational Change and Version Control</td>
<td>2–25</td>
</tr>
<tr>
<td>Creating Organization Hierarchies</td>
<td>2–26</td>
</tr>
<tr>
<td>Changing Organization Hierarchies</td>
<td>2–28</td>
</tr>
<tr>
<td>Deleting Organization Hierarchies</td>
<td>2–28</td>
</tr>
<tr>
<td>Organization Hierarchy Report</td>
<td>2–29</td>
</tr>
</tbody>
</table>

# Chapter 3

## Jobs and Positions

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Representing Jobs and Positions</td>
<td>3–2</td>
</tr>
<tr>
<td>Position Reporting Structures</td>
<td>3–3</td>
</tr>
<tr>
<td>Deciding How to Use Organizations, Jobs, and Positions</td>
<td>3–4</td>
</tr>
<tr>
<td>Job and Position Names</td>
<td>3–5</td>
</tr>
<tr>
<td>Adding Information About Jobs and Positions</td>
<td>3–6</td>
</tr>
<tr>
<td>Defining Jobs</td>
<td>3–8</td>
</tr>
<tr>
<td>Defining Positions</td>
<td>3–10</td>
</tr>
<tr>
<td>Evaluating Jobs and Positions</td>
<td>3–13</td>
</tr>
</tbody>
</table>
Setting Up an Evaluation System ......................... 3 – 13
Entering Evaluation Information .......................... 3 – 14
Valid Grades .............................................. 3 – 15
Entering Job and Position Requirements ............... 3 – 16
Entering Work Choices for a Job or Position .......... 3 – 17
Viewing Position Occupancy ............................ 3 – 20
Creating Position Hierarchies ........................... 3 – 22
Changing Position Hierarchies .......................... 3 – 24
Deleting Position Hierarchies ............................ 3 – 24
Position Hierarchy Report ............................... 3 – 25
Making Mass Updates .................................. 3 – 26
Preparing for Your Mass Move ............................ 3 – 27
Performing Mass Move Tasks ............................. 3 – 28
Describing Your Mass Move ............................. 3 – 28
Identifying Your Source Positions ....................... 3 – 29
Identifying Your Target Positions ....................... 3 – 31
Verifying Transferring Assignments for Each Source Position ................................................. 3 – 32
Verifying or Adding Valid Grades for Each Target Position ......................................................... 3 – 34
Executing the Mass Move ................................ 3 – 35
Reviewing the Mass Move ................................ 3 – 35
Resolving Problems and Reexecuting a Mass Move .... 3 – 36
Managing Your Mass Move Collection ................. 3 – 37

Chapter 4

Grades and Their Relationship to Pay .................... 4 – 1
Representing Grade Structures .......................... 4 – 2
Using Grades ........................................... 4 – 3
Defining Grades ....................................... 4 – 4
Deleting Grades ....................................... 4 – 5
Grade Relationships to Compensation and Benefits .... 4 – 6
Relating Pay to Grades Directly: Using Grade Rates ... 4 – 8
Defining Grade Rates .................................. 4 – 9
Viewing Grade Comparations ............................ 4 – 10
Relating Pay to Grades Indirectly: Using Pay Scales .... 4 – 12
Defining a Pay Scale .................................... 4 – 13
Defining Scale Rates .................................... 4 – 14
Relating Grades to Progression Points ................. 4 – 15
Placing an Employee on a Grade Step .................. 4 – 17
Incrementing Grade Step Placements .................... 4 – 18
Current and Projected Progression Point Values Report ... 4 – 19
Chapter 5

Payrolls and Other Employee Groups .......................... 5 – 1
Representing Payrolls ............................................. 5 – 2
Defining Payment Methods for the Enterprise ........... 5 – 3
Defining a Payroll .................................................. 5 – 5
Representing Other Employee Groups ................. 5 – 10
Setting Up the People Group Flexfield .................. 5 – 10

Chapter 6

Typical Models Based on Enterprise Culture .......... 6 – 1
Project Based Enterprises ................................. 6 – 2
Rule Based Enterprises ........................................ 6 – 6
Hybrid Enterprise Structures ............................. 6 – 10
Contract Staff and Other Non–standard Assignments .... 6 – 12

Chapter 7

Representing Compensation and Benefits in Oracle Human Resources .......................... 7 – 1
Representing Compensation and Benefits ..................... 7 – 2
  Introducing Elements ........................................... 7 – 3
Element Classifications ...................................... 7 – 4
Element Entries ................................................... 7 – 5
Element Input Values .......................................... 7 – 7
Element Eligibility Rules ...................................... 7 – 10
  Element Qualifying Conditions ......................... 7 – 11
Costing Compensation and Benefits ......................... 7 – 13

Chapter 8

Setting Up Compensation and Benefits ............... 8 – 1
Setting Up Compensation and Benefits for Human Resources .......... 8 – 2
Defining an Element (HR Users) .......................... 8 – 3
  Element Processing Option Examples .................. 8 – 7
Defining an Element’s Input Values ....................... 8 – 8
Defining Element Links ....................................... 8 – 10
  Adjusting Input Values for an Eligibility Group .... 8 – 12
Element Link Details Report ............................... 8 – 13
Customizing the Element Entries Window ............... 8 – 14
Tracking Compensation and Benefit Changes ........ 8 – 15
Chapter 9

Entering and Reporting on Compensation and Benefits ................................. 9 – 1
Entering Compensation and Benefits .............................................................. 9 – 2
  Automatic or Manual Element Entry .......................................................... 9 – 3
Entering Elements ......................................................................................... 9 – 4
MIX for Batch Entry .................................................................................... 9 – 7
  Creating and Updating Batches of Element Entries ..................................... 9 – 8
  Validating a BEE Batch ............................................................................. 9 – 13
  Transferring a BEE Batch .......................................................................... 9 – 13
  Purging a Batch From the BEE Tables ....................................................... 9 – 14
  Rolling Back a MIX Process ..................................................................... 9 – 14
Inquiring on Compensation and Benefit Entries ........................................... 9 – 16
  Listing Employees by Element ................................................................... 9 – 17
  Viewing Element Entry History ................................................................. 9 – 18

Chapter 10

Salary Administration and Budgeting ......................................................... 10 – 1
Salary Administration and Performance Reviews ..................................... 10 – 2
  Reviewing Current Salaries ....................................................................... 10 – 3
Setting Up Salary Administration ................................................................. 10 – 4
Defining and Linking a Salary Element ......................................................... 10 – 5
Defining Salary Bases .................................................................................. 10 – 6
Changing Salary Components ..................................................................... 10 – 8
Entering Salaries and Salary Changes .............................................................. 10 – 9
Using the Salary Administration Window ...................................................... 10 – 10
Using the Salary Management Folder ............................................................ 10 – 13
Correcting a Salary Entry ............................................................................ 10 – 15
Viewing Salary History ................................................................................ 10 – 16
Salary Review Report ................................................................................... 10 – 17
Salary Budgeting .......................................................................................... 10 – 18

Chapter 11

Controlling Costs .......................................................................................... 11 – 1
Costing in Oracle HRMS .............................................................................. 11 – 2
  Setting Up the Cost Allocation Key Flexfield ............................................ 11 – 3
Setting up Earnings and Deductions for Cost Collection .......................... 11 – 4
Setting Up Organizations for Cost Collection .............................................. 11 – 5
Setting Up Assignments for Cost Collection ............................................... 11 – 5

Chapter 12

Human Resource Budgets .......................................................................... 12 – 1
Human Resource Budgets ............................................................................ 12 – 2
  Entering Actual Values Against Budgets .................................................... 12 – 3
Setting Up Budgets ........................................ 12 – 4
Salary Review Report ................................. 12 – 5
Salary Budgeting ........................................ 12 – 6
Reviewing and Renaming Period Types ........... 12 – 7
Defining Calendars ..................................... 12 – 8
Defining Human Resource Budgets ................ 12 – 9
Viewing and Reporting Budget Variances ....... 12 – 10
List Position Budget Variance ...................... 12 – 11
List Budget Variance by Organization .......... 12 – 12
Staffing Budget Details Report ................. 12 – 13

Chapter 13

Personal Information .................................... 13 – 1
Displaying Personal Information .................. 13 – 2
Using the Find Person Window .................... 13 – 3
People Folders ....................................... 13 – 3
Entering Personal Information .................... 13 – 4
Entering New People ................................ 13 – 5
Hiring .................................................. 13 – 8
Entering Addresses .................................. 13 – 10
Adding Telephone Information .................. 13 – 11
Entering Pictures .................................... 13 – 13
Entering Next of Kin and Other Contacts ....... 13 – 13
Competence Profiles, Qualifications, School Attendances and Work Choices ...................... 13 – 15
Creating a Competence Profile .................... 13 – 16
Entering Work Choices .............................. 13 – 19
Entering Qualifications .............................. 13 – 21
Entering Schools and Colleges Attended ...... 13 – 23
Entering Special Information ....................... 13 – 24
Listing People by Special Information .......... 13 – 26
Tracking People’s Roles and Activities ......... 13 – 28
Full Personal Details Report Set .................. 13 – 29
Deleting a Person from the System ............. 13 – 30

Chapter 14

Employment Information ............................. 14 – 1
Managing Employment Information ............ 14 – 2
The Employee Assignment ....................... 14 – 4
Components of the Assignment .................... 14 – 5
Using Multiple Assignments ...................... 14 – 5
Identifying Employees and Assignments ....... 14 – 6
Entering a New Assignment ........................................... 14 – 8
Changing Assignment Information ................................. 14 – 11
Ending an Assignment .............................................. 14 – 13
Ending Employment ................................................... 14 – 14
Cancelling a Termination ............................................ 14 – 16
Terminations Report .................................................. 14 – 16
Additional Employment Information ............................... 14 – 18
Entering Payment Methods for an Employee Assignment ....... 14 – 19
Entering Secondary Assignment Statuses ......................... 14 – 21
Inquiring and Reporting on Employment Information .......... 14 – 22
Listing Assignments .................................................. 14 – 22
Listing Employees by Organization ............................... 14 – 25
Listing Employees by Position ..................................... 14 – 27
Assignment Status Report .......................................... 14 – 29
Employee Summary Report ......................................... 14 – 30
Employee Movements Report ...................................... 14 – 30
Assignment History .................................................. 14 – 32

Chapter 15
Recruitment .......................................................... 15 – 1
The Recruitment Cycle .............................................. 15 – 2
Recruitment Preparation ............................................ 15 – 4
Raising Requisitions for Vacancies ................................. 15 – 7
Defining Recruitment Activities .................................. 15 – 8
Viewing Vacancies ................................................... 15 – 9
Selection Processing .................................................. 15 – 10
Making Quick Applicant Entries ................................... 15 – 11
Entering Full Application Information ............................. 15 – 12
Tracking Applicant Progress ..................................... 15 – 15
Interviewing Applicants ............................................ 15 – 17
Mass Update of Applicants ....................................... 15 – 19
Hiring Applicants ................................................... 15 – 20
Ending Applications .................................................. 15 – 21
Requisition Summary Report ...................................... 15 – 22

Chapter 16
Introducing Career Management Activities ......................... 16 – 1
Introducing Career Management Activities ...................... 16 – 2
Advantages of the Common Competence Framework .......... 16 – 3
Career Management – A Fully Tailorable, Proactive
Management Tool .................................................. 16 – 4
Web and Workflow Access (LMDA and EDA) ................ 16 – 4
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>17</td>
<td>Designing Methods of Measurement and Creating Competencies</td>
</tr>
<tr>
<td></td>
<td>Designing Your Methods of Measurement and Creating Competencies</td>
</tr>
<tr>
<td></td>
<td>What Are Competencies?</td>
</tr>
<tr>
<td></td>
<td>Competencies, Proficiency Levels and Indicators</td>
</tr>
<tr>
<td></td>
<td>Structuring Your Competencies</td>
</tr>
<tr>
<td></td>
<td>Which Method Should You Use?</td>
</tr>
<tr>
<td></td>
<td>General Rating Scales</td>
</tr>
<tr>
<td></td>
<td>Different Rating Scales</td>
</tr>
<tr>
<td></td>
<td>Creating Rating Scales</td>
</tr>
<tr>
<td></td>
<td>Competencies</td>
</tr>
<tr>
<td></td>
<td>Creating Competencies</td>
</tr>
<tr>
<td></td>
<td>Competence Types and Groupings</td>
</tr>
<tr>
<td></td>
<td>Grouping Competencies is Useful</td>
</tr>
<tr>
<td></td>
<td>Grouping Competencies into Types</td>
</tr>
<tr>
<td>18</td>
<td>Defining Competence Requirements</td>
</tr>
<tr>
<td></td>
<td>Competence Requirements</td>
</tr>
<tr>
<td></td>
<td>Why Define Competence Requirements</td>
</tr>
<tr>
<td></td>
<td>Can You Copy Competencies?</td>
</tr>
<tr>
<td></td>
<td>Defining Competence Requirements – Core or Generic</td>
</tr>
<tr>
<td></td>
<td>Copying Existing Competencies from an Organization,</td>
</tr>
<tr>
<td></td>
<td>Job or Position</td>
</tr>
<tr>
<td>Chapter 19</td>
<td>Identifying Qualifications and Delivering Competencies</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Chapter 20</td>
<td>Assessing and Appraising People</td>
</tr>
<tr>
<td>Chapter 21</td>
<td>Planning Careers and Succession</td>
</tr>
<tr>
<td>Chapter 19</td>
<td>Defining Competence Requirements – No Core Competencies</td>
</tr>
<tr>
<td>Chapter 19</td>
<td>Viewing Competencies at Organization, Job or Position</td>
</tr>
<tr>
<td>Chapter 20</td>
<td>Assessing and Appraising People</td>
</tr>
<tr>
<td>Chapter 20</td>
<td>Competence–Based Assessments</td>
</tr>
<tr>
<td>Chapter 20</td>
<td>Why is Measurement Useful?</td>
</tr>
<tr>
<td>Chapter 20</td>
<td>Templates for Different Assessments</td>
</tr>
<tr>
<td>Chapter 20</td>
<td>What Type of Assessment do you Want to Perform?</td>
</tr>
<tr>
<td>Chapter 20</td>
<td>Identifying Proficiency Levels in the Assessment Template</td>
</tr>
<tr>
<td>Chapter 20</td>
<td>Identifying Competence Types and Competencies in the Assessment Template</td>
</tr>
<tr>
<td>Chapter 20</td>
<td>Calculating Scores in the Assessment Template</td>
</tr>
<tr>
<td>Chapter 20</td>
<td>Calculating the Total Score</td>
</tr>
<tr>
<td>Chapter 20</td>
<td>Changing or Deleting an Assessment Template</td>
</tr>
<tr>
<td>Chapter 20</td>
<td>Creating Templates for Competence–Based Assessments</td>
</tr>
<tr>
<td>Chapter 20</td>
<td>Appraisals</td>
</tr>
<tr>
<td>Chapter 20</td>
<td>Appraisal Templates and Questionnaire Pages</td>
</tr>
<tr>
<td>Chapter 20</td>
<td>Questions and Your Answer Format</td>
</tr>
<tr>
<td>Chapter 21</td>
<td>Career and Succession Planning</td>
</tr>
<tr>
<td>Chapter 21</td>
<td>Modelling Career and Succession Plans</td>
</tr>
<tr>
<td>Chapter 21</td>
<td>Career Paths</td>
</tr>
<tr>
<td>Chapter 21</td>
<td>Modelling Career and Succession Planning Based on Jobs</td>
</tr>
<tr>
<td>Chapter 21</td>
<td>Modelling Career and Succession Planning Based on Positions</td>
</tr>
</tbody>
</table>
Defining Career Paths ........................................... 21 – 8

Chapter 22

Matching People to Posts and Vacancies ................. 22 – 1
Matching People Using Web–Based Access ............... 22 – 2
Viewing the Results of Suitability Matches .......... 22 – 3

Chapter 23

Using Special Information Types for Skills Information ....... 23 – 1
The Special Information Approach to Skills Matching .... 23 – 2
Viewing and Reporting Skills Matching Information .... 23 – 5
Skills Matching Report ....................................... 23 – 5

Chapter 24

Absence Management ............................................. 24 – 1
Absence Management ........................................... 24 – 2
Absence Types .................................................... 24 – 3
Setup of Absence Types ...................................... 24 – 4
Absence Elements .............................................. 24 – 5
Absence Recording .............................................. 24 – 7
Absence Management Setup Steps ......................... 24 – 8
Defining and Linking an Absence Element ............... 24 – 9
Defining an Absence Type ................................... 24 – 11
Entering Absences .............................................. 24 – 13
Viewing and Reporting on Absence Information ....... 24 – 15
Viewing Absence History ................................... 24 – 15
Listing Employees by Absence Type ..................... 24 – 16
Absences Report ............................................... 24 – 17
Plans for Accrual of PTO ..................................... 24 – 18
Accrual Start Rules ............................................ 24 – 19
Length of Service and Accrual Amount Rules .......... 24 – 21
Accrual Plan Setup Steps .................................... 24 – 23
Defining a PTO Accrual Plan ............................... 24 – 23
Setting Up Length of Service Bands ................. 24 – 25
Reviewing or Changing Net Accrual Calculations .... 24 – 26
Linking the Accrual Plan Elements ..................... 24 – 28
Maintaining PTO Plan Records ........................... 24 – 29
Enrolling Employees in PTO Accrual Plans ............ 24 – 29
Recording Accrued Time Taken .......................... 24 – 30
Running the PTO Carry Over Process .................. 24 – 30
Reviewing Employees’ PTO Accruals .................. 24 – 32
### Chapter 25: Administering Events and Attendance
- Setting Up Events ........................................... 25–2
- Creating an Event .............................................. 25–2
- Managing Bookings and Attendance ......................... 25–3
- Employee Reviews ........................................... 25–4
- Entering an Employee Review ................................ 25–4
- Entering Performance Ratings .............................. 25–5

### Chapter 26: Using Letters to Manage Recruitment and Enrollment
- Using Letters to Manage Recruitment and Enrollment ........ 26–1
- Setting Up Standard Letters .................................. 26–3
- Concurrent Processing ........................................ 26–5
- Using a Word Processor ........................................ 26–6
  - Which Word Processor? ...................................... 26–7
- Flowchart for Setting Up Standard Letters Using MultiMate or WordPerfect ........................................... 26–7
- Planning ......................................................... 26–9
- Writing a SQL*Plus Script for MultiMate or WordPerfect ......................................................... 26–9
- Registering the SQL*Plus Script for MultiMate or WordPerfect ......................................................... 26–10
- Linking the SQL*Plus Script With a Letter for MultiMate or WordPerfect ......................................................... 26–11
- Writing a Skeleton Letter ..................................... 26–12
- Requesting Letters for MultiMate or WordPerfect ........... 26–14
- Merging the Data File With the Standard Letter MultiMate or WordPerfect ......................................................... 26–16
- Writing a SQL*Plus Script for Microsoft Word ............... 26–18
- Generating a Microsoft Word Letter ......................... 26–20
- Using Oracle Reports ......................................... 26–22
  - Planning the Content and Layout ......................... 26–23
  - Writing the Report ........................................... 26–23
  - Registering the Report ....................................... 26–23
  - Linking the Report With a Letter ......................... 26–24
  - Running the Report ......................................... 26–25

### Chapter 27: Setup for Personal and Assignment Information
- Person Types ................................................... 27–2
- Defining Person Types ........................................ 27–3
- Person Types and Information Management .................. 27–4
## Assignment Statuses

27 – 5

## Defining Assignment Statuses

27 – 7

## Setup To Allow Processing After Termination

27 – 9

## Defining Special Information Types

27 – 10

## Enabling Special Information Types

27 – 12

### Chapter 28

**System Administration**

28 – 1

- The Role of the System Administrator
- Setting User Profile Options
- Enabling Currencies

### Chapter 29

**Reports and Inquiries**

29 – 1

- Overview of Inquiry and Reporting Tools
- Inquiry Windows and Folders
- Predefined and User Defined Reports
- QuickPaint
- Defining QuickPaint Reports
- Running QuickPaint Reports
- Creating an Assignment Set
- Custom Reports

### Chapter 30

**Customizing Windows and Menus**

30 – 1

- Adding New Fields to Windows
- Restricting the Data Displayed in a Window
- Types of Data Restrictions
- Defining an Element or Distribution Set
- Defining Customized Forms
- Linking Windows in Task Flows
- Windows You Can Use in Task Flows
- Defining Task Flow Nodes
- Defining Task Flows
- Setting Up Navigation Menus
- Setting Up Query–only Access to Forms
- Calling Customized Forms and Task Flows from Menus

### Chapter 31

**QuickCodes and User Tables**

31 – 1

- QuickCodes
- Adding QuickCode Values
### Appendix C

**Database Items**
- List of Descriptive Flexfields .......................... C – 1
- Static Database Items ................................. C – 2
  - Applicant Information .......................... C – 2
  - Employee Assignment Information ................. C – 2
  - Contact Addresses .............................. C – 7
  - Contact Information ........................... C – 8
  - Employee Hire Information .................. C – 10
  - Location Details .............................. C – 10
  - Payroll Details ................................. C – 12
  - People Addresses ............................ C – 13
  - People Information ........................ C – 15
  - Recruiter Information .................... C – 17
  - Supervisor Information .................. C – 18
- Location Details .............................. C – 18
- Dynamic Database Items ............................. C – 19
  - Element Database Items .................... C – 19
  - Grade Rate Database Items ............... C – 22
  - Pay Scale Rate Database Items .......... C – 22
  - Descriptive Flexfield Database Items .... C – 23
  - Key Flexfield Database Items .......... C – 25
  - Absence Database Items ................ C – 26

### Appendix D

**Template SQL*Plus Scripts**
- Template SQL*Plus PERWPOUK ................... D – 1
- Template SQL*Plus Script PERWPWUK .......... D – 6
- OTA SQL*Plus Script to Produce Confirmation Letters .... D – 8

### Glossary

### Index
Welcome to Release 11.0 of the Oracle Human Resources UK User’s Guide.

This guide includes the information you need to set up Oracle Human Resources to meet the requirements of your enterprise. It describes how you can represent your enterprise structures, policies and people on the system and use this information to manage your human resources. It contains detailed information about the following:

- Overview and reference information
- Oracle Human Resources implementation suggestions
- Specific tasks you can accomplish using Oracle Human Resources
- How to use Oracle Human Resources forms and windows
- Oracle Human Resources programs, reports, and listings
- Oracle Human Resources functions and features

This preface explains how this user’s guide is organized and introduces other sources of information that can help you.
About This User’s Guide

The first part of this guide explains how you can set up Oracle Human Resources to represent your enterprise structures and policies, and how you relate these to the people in your system.

- Chapter 1 describes the requirements of human resource and payroll management, and the processes they involve. This provides the context for the information model you can construct in Oracle HRMS.
- Chapters 2 through 5 explain how to represent your enterprise structures, including organizations, jobs and positions, grades, and payrolls.
- Chapter 6 describes three models appropriate to three different types of enterprise It covers the set up of each of these structures. explains how to set up the system to collect costing information during a payroll run.
- Chapters 7 through 9 explain how you can represent your compensation and benefit policies in the system and enter and report on compensation and benefit information for your employees.

Once you have set up this key information in the system, you can consider how to use Oracle Human Resources to help you with the main HR management tasks.

- Chapters 10 through 12 cover setting up and using salary administration, cost control and human resource budgets.
- Chapters 13 and 14 explain how you can enter people on the system, assign them to work structures, and hold various kinds of information about them. These chapters also introduce you to the basics of hiring, redeploying, and termination of employment.
- Chapters 15 through 25 cover the key management processes and how you might use Oracle HRMS to support them. These include:
  - Absence and attendance
  - Recruitment
  - Training administration and other special information
  - Skills matching
  - Succession planning
The final chapters of the guide focus on tasks for the system administrator and setup team.

- Chapter 27 explains how to set up person types and assignment statuses, and how to define special information types.
- Chapter 28 describes the role of the System Administrator.
- Chapters 29 and 30 explain how you can customize the way information is entered and extracted from the system. This includes:
  - customizing inquiry windows and writing reports
  - customizing the user interface
  - adding your own fields to windows
- Chapter 31 explains how to set up QuickCodes and user tables to add lists and tables of valid values to the system.
- Chapters 32 through 34 look at how you can integrate Oracle Human Resources with Oracle Payroll, and use it with other software such as word processors and spreadsheets. These chapters also consider how you control security of access, set up security, and set up an audit trail.

The Appendixes provide a reference source about the default menus, and about flexfields and database items in Oracle HRMS. Appendix C provides a template SQL*Plus script for use with standard letters.

This user's guide is available online

All Oracle Applications user's guides are available online, in both HTML and Adobe Acrobat format. Most other Oracle Applications documentation is available in Adobe Acrobat format.

The paper and online versions of this manual have identical content, and you can use whichever format is more convenient.

The HTML version of this book is optimized for on-screen reading, and lets you follow hypertext links for easy access to books across our entire library. You can also search for words and phrases if your national language is supported by Oracle's Information Navigator. The HTML documentation is available from the Oracle Applications toolbar, or from a URL provided by your system administrator. Note
that the HTML documentation is translated into over twenty languages.

You can order an Oracle Applications Documentation Library CD containing Adobe Acrobat versions of each manual in the Oracle Applications documentation set. Using this CD, you can search for information, read it on-screen, and print individual pages, sections, or entire books. When you print from Adobe Acrobat, the resulting printouts look just like pages from an Oracle Applications hardcopy manual.

Finding the Latest Information

For information about any new features that were not available when this user’s guide was printed, look at the What’s New? section on the main Help menu. This information is updated for each new release of Oracle Human Resources HTML Help.

Assumptions

This guide assumes you have a working knowledge of the following:

- the principles and customary practices of your business area
- Oracle Human Resources
  
  If you have not yet used Oracle Human Resources we suggest you attend one or more of the training classes for this product available through Oracle Education.
  
- the Oracle Applications graphical user interface.
  
  To learn more about this, read the *Oracle Applications User’s Guide*.

See Other Information Sources below for further details of Oracle Applications product information.
Do Not Use Database Tools to Modify Oracle Applications Data

Oracle provides powerful tools you can use to create, store, change, retrieve and maintain information in an Oracle database. But if you use Oracle tools like SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using an Oracle Applications form can update many tables at once. But when you modify Oracle Applications data using anything other than Oracle Applications forms, you may change a row in one table without making corresponding changes in related tables. If your tables get out of synchronization with each other, you risk retrieving erroneous information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications forms to modify your data, Oracle Applications automatically checks that your changes are valid. Oracle Applications also keeps track of who changes information. But, if you enter information into database tables using database tools, you may store invalid information. You also lose the ability to track who has changed your information because SQL*Plus and other database tools do not keep a record of changes.

Consequently, we STRONGLY RECOMMEND that you never use SQL*Plus, Oracle Data Browser, database triggers, or any other tool to modify Oracle Applications tables, unless we tell you to do so in our manuals.
Other Information Sources

You can choose from many sources of information, including documentation, training, and support services, to increase your knowledge and understanding of Oracle Human Resources.

Most Oracle Applications documentation is available in Adobe Acrobat format on the *Oracle Applications Documentation Library* CD. We supply this CD with every software shipment.

If this guide refers you to other Oracle Applications documentation, use only the Release 11 versions of those books unless we specify otherwise.

**Oracle Applications User’s Guide**

This guide explains how to navigate, enter data, query, run reports, and introduces other basic features of the graphical user interface (GUI) available with this release of Oracle Applications. It also includes information on setting user profiles, as well as running and reviewing reports and concurrent requests.

You can access this guide online by choosing “Getting Started with Oracle Applications” from any Oracle Applications help file.

**Related User’s Guides**

Oracle Human Resources shares business and setup information with other Oracle Applications products. Even if you have not installed them as separate products, your Oracle Human Resources application includes some forms and functionality from other Oracle Applications. Therefore, you may want to refer to other user’s guides when you set up and use Oracle Human Resources.

If you do not have the hardcopy versions of these manuals, you can read them by choosing Library from the Help menu, or by reading from the Oracle Applications Document Library CD, or by using a web browser with a URL that your system administrator provides.

**Oracle Payroll User’s Guide**

This guide is aimed at Payroll managers and explains how to set up and use Oracle Payroll to pay your employees and meet necessary legislative requirements.
Oracle Training Administration User’s Guide

This guide explains how you can use OTA with Oracle HR to support each part of your enterprise’s training cycle.

Application Data Export User’s Guide

This guide is aimed at end-users, system administrators and consultants. It describes how you can use ADE to export data from Oracle Human Resources into either a spreadsheet or mail merge application. It also contains information on how to install ADE.

Oracle HRMS Implementation Guide

This guide includes modular implementation flowcharts and checklists to assist with your project planning. It contains a summary of the sequence of recommended steps for implementing Oracle Human Resources and Oracle Payroll. Full instructions for each implementation step are contained in the User’s Guide.

Oracle Applications Flexfields Guide

This guide provides flexfields planning, setup, and reference information for your implementation team, as well as for users responsible for the ongoing maintenance of Oracle Applications product data. This guide also provides information on creating custom reports on flexfields data.

Oracle Workflow Guide

This manual explains how to define new workflow business processes as well as customize existing Oracle Applications–embedded workflow processes. You also use this guide to complete the setup steps necessary for any Oracle Applications product that includes workflow–enabled processes.

Oracle Alert User’s Guide

Use this manual to define periodic and event alerts that monitor the status of your Oracle Applications data.

Country–Specific Manuals

Use these manuals to meet statutory requirements and common business practices in your country or region. They also describe
additional features added to Oracle Human Resources to meet those requirements. Look for a User’s Guide appropriate to your country. For example, Oracle user’s guides for Japanese users exist in the Japanese language.

**Oracle Applications Implementation Wizard User’s Guide**

If you are implementing more than one Oracle product, you can use the Oracle Applications Implementation Wizard to coordinate your setup activities. This guide describes how to use the wizard.

**Oracle Applications Developer’s Guide**

This guide contains the coding standards followed by the Oracle Applications development staff. It describes the Oracle Application Object Library components needed to implement the Oracle Applications user interface described in the *Oracle Applications User Interface Standards*. It also provides information to help you build your custom Developer/2000 forms so that they integrate with Oracle Applications.

**Oracle Applications User Interface Standards**

This manual contains the user interface (UI) standards followed by the Oracle Applications development staff. It describes the UI for the Oracle Applications products and how to apply this UI to the design of an application built by using Oracle Forms 4.5.

**Installation and System Administration**

**Oracle Applications Installation Manual**

This manual and the accompanying release notes provide information you need to successfully install Oracle Financials, Oracle Public Sector Financials, Oracle Manufacturing, or Oracle Human Resources in your specific hardware and operating system software environment.

**Oracle Applications Upgrade Manual**

This manual explains how to prepare your Oracle Applications products for an upgrade. It also contains information on finishing the upgrade procedure for each product. Refer to this manual and the *Oracle Applications Installation Manual* when you plan to upgrade your products.
Oracle Applications System Administrator's Guide

This manual provides planning and reference information for the Oracle Applications System Administrator. It contains information on how to define security, customize menus and online help, and manage processing.


This manual contains database diagrams and a description of Oracle HRMS database tables, forms, reports, and programs. This information helps you convert data from your existing applications, integrate Oracle HRMS with other non–Oracle applications, and write custom reports.

You can order a technical reference manual for any product you have licensed. Technical reference manuals are available in paper format only.

Other Information

Training

Oracle Education offers a complete set of training courses to help you and your staff master Oracle Applications. We can help you develop a training plan that provides thorough training for both your project team and your end users. We will work with you to organize courses appropriate to your job or area of responsibility.

Training professionals can show you how to plan your training throughout the implementation process so that the right amount of information is delivered to key people when they need it the most. You can attend courses at any one of our many Educational Centers, or you can arrange for our trainers to teach at your facility. In addition, we can tailor standard courses or develop custom courses to meet your needs.

Support

From on–site support to central support, our team of experienced professionals provides the help and information you need to keep Payables working for you. This team includes your Technical Representative, Account Manager, and Oracle’s large staff of consultants and support specialists with expertise in your business area, managing an Oracle server, and your hardware and software environment.
About Oracle

Oracle develops and markets an integrated line of software products for database management, applications development, decision support, and office automation, as well as a complete family of financial, manufacturing, and human resource applications.

Oracle products are available for mainframes, minicomputers, personal computers, network computers, and personal digital assistants, allowing organizations to integrate different computers, different operating systems, different networks, and even different database management systems, into a single, unified computing and information resource.

Oracle offers its products, along with related consulting, education, and support services, in over 140 countries around the world. Oracle Corporation is the world’s leading supplier of software for information management, and is the world’s second largest software company.

Thank You

Thank you for using Oracle Human Resources and this user’s guide. We value your comments and feedback. At the end of this manual is a Reader’s Comment Form you can use to explain what you like or dislike about Payables or this user’s guide. Mail your comments to the following address or call us directly at (650) 506–7000.

Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA  94065
U.S.A.

Or, send electronic mail to appsdoc@us.oracle.com.
Oracle Human Resource Management Systems is the family name for an integrated group of applications that support the management of people. This chapter reviews the business needs of human resource management and how they are met by Oracle HRMS. It provides an introduction to key components and special features of the system.
Human Resource Management

The term Human Resource Management owes much to the view that employees are an asset to be managed in the same way as other, non-human, assets.

When the emphasis is on Resource Management, then in the formal accounts of any enterprise, people appear only as costs. However, they can also be thought of as assets in the sense that they are a productive resource, requiring proper maintenance and renewal.

People Management

The management of people within any enterprise involves a complex and dynamic inter-relationship of management and personal skills. This complexity results in a unique set of structures and policies within each enterprise.

This unique identity is often referred to as the culture of the enterprise, and as the enterprise develops so does its unique culture.

Company Culture

The organizational structures of an enterprise, the ways in which its employees work, and its compensation policies all reflect its unique culture. This culture is also evident in more subtle ways, including enterprise policies on information sharing and decision making.

The cultural diversity of enterprises is reflected in their implementation and use of information systems. It is generally true that all companies need a human resource information system. However, the information they require, its structure, and the means by which they obtain it, produce a different system in every case.

Packaged systems solutions like Oracle HRMS provide a core system, which each enterprise customizes to meet its own needs. Customization involves the definition of special information requirements, structures, and processes. It also involves analysis of the working practices associated with day-to-day maintenance and use of the system.

Changing Role of Human Resource Management

Human resource management was originally an administrative and welfare role within an enterprise. This often included recruitment and record-keeping functions.

This role was primarily reactive in nature. Human Resources responded to the needs of both managers and employees, but did not anticipate them.
In the last few decades, human resource management has evolved and assumed a more proactive role. This reflects the recognition of the importance of managing people in the successful achievement of enterprise objectives.

The result now is that this function within many enterprises encompasses responsibilities that include a wide ranging spectrum of activities.

**Payroll Management**

In contrast, payroll management has traditionally been a function of the Finance Group in most enterprises. It has been responsible for the correct payment of employees in line with local and national legislation as well as company policy.

Often this has been a reactive and operational role in which payroll staff responded to the needs of both line managers and employees.

**Separate v. Integrated HRMS Systems**

Traditionally, Human Resources and Payroll groups have both been responsible for holding and managing human resource information – often in separate systems.

There is growing acknowledgement of the importance of complete, accurate, and timely information about the people within an enterprise. This has led to a greater demand for information derived from both Human Resources and Payroll sources.

Historically this was achieved by the development of *interface* products, which allowed technical specialists to transfer data between the two systems.

Many systems attempt to simplify the transfer of data between two systems. Oracle HRMS is one of the first to provide a truly *integrated* system, which both functions can genuinely share. At the same time, it is flexible enough to be implemented for use in a human resources only or a payroll only environment. In each case you have access to the full range of functionality associated with human resources or payroll.
Human Resources and Payroll Activity Cycles

We can look at the range of human resource activities as an inter-related cycle of functions, as shown in Figure 1 – 1.

The payroll user is concerned with operational and legislative aspects, which introduce a number of external factors that the information system must deal with. These include legislative requirements, auditing requirements and payroll costing. We can look at the operational factors and the effects of the external factors as an interrelated cycle of functions, as shown in Figure 1 – 2.
Figure 1 – 2
The Payroll Cycle

- Set Objectives
- Define and Maintain Organization Structures
- Define and Administer Payrolls
- Define and Administer Earnings & Deductions
- Maintain Employee Records
- Process Payrolls
- Reconcile Payrolls
- Cost Payroll Transactions and Transfer to External Systems

- Legislation: Tax and Insurance
- Statutory Reporting
- Auditing
- Ad hoc Reporting
Introduction to the HRMS Model

With Oracle HRMS you can define your own human resource model to reflect your own enterprise structures and policies. This information model lets you record the personal, work, and pay information for all the people you want to hold and process.

The model is both flexible and adaptable. It is flexible, so that you can reflect the needs of different companies, or different groups within the same company. It is adaptable, so that you can easily change the basic model as your enterprise changes.

See: Managing Change Over Time: page 1 – 9

![Diagram of Modelling Human Resource Information]

People

In Oracle HRMS, you can hold information about current and former employees, applicants, external contacts such as contractors, and employee contacts such as relatives and dependents.
In addition to standard information such as addresses, nationality, interview records, qualifications, and absence information, you can define any other special information you need to hold for people. For example, you can define what information to hold on medical history, previous employment, or outside interests.

See:
Entering Personal Information: page 13 – 4
Entering Special Information: page 13 – 24

Work Structures

Work structures represent the different ways in which employees can work within your enterprise. They provide the framework for defining the work assignments of your employees. They also enable you to manage the information about your enterprise that is independent of your employees.

The work structures include your internal organizations (such as departments or divisions), payrolls, jobs or positions, grading structures, and any special employee groupings that you use in your enterprise.

See:
Representing Employers: page 2 – 4
Representing Organizations: page 2 – 6
Representing Jobs and Positions: page 3 – 2
Representing Grade Structures: page 4 – 2
Representing Payrolls: page 5 – 2
Representing Other Employee Groups: page 5 – 10

Compensation and Benefits

In Oracle HRMS you can define your own types of compensation and benefits, and the business rules you want to apply to them. As you change policies, move people within your enterprise, and adjust their individual remuneration packages, the system maintains their compensation and benefit history.

For example, suppose you want to define a special type of payment and make this available only to employees who work at a particular location. In Oracle HRMS you use a compensation element to represent the payment. You define the business rule as a link between the
Assignments

In Oracle HRMS, the assignment describes employees’ places within the enterprise: the organization for which they work, their role, grade, location, and so on. As you change the assignment information for an employee, you automatically build up his or her work history.

Your compensation eligibility rules link compensation and benefits to work structures, such as jobs or grades. The assignment places employees within the work structures of the enterprise. In this way, an employee’s assignment determines his or her eligibility for compensation and benefits.

You can use assignments to identify major employee groups within the enterprise for management, for reporting and costing, and for compensation and benefit planning and administration.

See: The Employee Assignment: page 14 – 4

See:
Representing Compensation and Benefits: page 7 – 2
Grade Relationships to Compensation and Benefits: page 4 – 6
Salary Administration and Performance Reviews: page 10 – 2
Managing Change Over Time

A key requirement for any enterprise is the ability to manage change confidently and effectively. Typical enterprise changes include corporate restructuring, departmental reorganization, mergers and de–mergers of companies, centralization or decentralization of control and decision making, employee development and turnover.

In Oracle HRMS, you can change each of the major parts of your enterprise model without having to redefine the other parts.

Work Structures

You can attach dates to your work structures to manage different versions over time. You retain previous versions for historical information and you can create future–dated versions to prepare for reorganization in advance.

You can also set up in advance the business rules, including compensation and benefits, associated with the new structures. These become effective on the date you specify, avoiding a workload peak.

People, Assignments, and Compensation and Benefits

In contrast to work structures, which are simply dated, other key dynamic information in Oracle HRMS is datetracked. This includes information on employees, assignments, and compensation and benefits. DateTrack allows you to maintain a continuous history of the information over time.

When reviewing, entering, changing or deleting datetracked data, you can set an effective date in the past or future. The system uses only information in effect as of that date for whatever you do. When you make a change, you can choose whether it is a correction to the last update or a new update to be recorded in the history of the record. You can use DateTrack History to view a report of every update ever made to a record.

You can identify windows containing datetracked, rather than dated, information by the presence of a region labelled Effective Dates.
Dated Information and Hierarchy Versions

The information in Oracle HRMS about your locations, organizations, jobs, positions, grades, payrolls and other work structures is dated information. All dated information has From and To dates, that is, dates from and to which it is in effect in your enterprise. For example, when defining a position, you enter a date from which it starts. To close it down, you give it a date to which it remains valid.

Oracle HRMS does not permit you to assign employees to structures on dates earlier than their Date From, or later than their Date To. Similarly, the system protects you from building eligibility rules for compensation and benefits based on work structures that have not yet gone into effect, or are out of date.

**Suggestion:** Consider using a fixed date, such as 01–JAN–1901 as the start date for all your initial work structures. By choosing a date like this you can immediately identify all of your implementation definitions. You should use accurate dates for all subsequent definitions.

Dated Versions of Hierarchies

You can structure the organizations and positions you enter in Oracle HRMS into organization or position hierarchies that serve various purposes. Reporting hierarchies, for example, reflect reporting lines within your enterprise.

You maintain both dates and version numbers for these hierarchies, to keep a history of your hierarchies as they change over time.

To build a new version of a hierarchy, you can copy an existing one and make the necessary changes to it. When you save the new version the system automatically gives the previous version an end date.
DateTrack

All important dynamic information in Oracle HRMS is datetracked, including information about people, assignments, payrolls, and compensation and benefits.

You can enter datetracked information or make changes to it at any time. When you set an effective date for your work, DateTrack ensures that only information effective on that day is used for any processing, validation, and reporting you carry out. You can view a history of every change made to datetracked information.

Setting Your Effective Date

When you log on to Oracle HRMS, your effective date is always today’s date. To view information current at another date, or to make retrospective or future-dated changes, you need to change your effective date.

There is a DateTrack:Date Security user profile option, which determines whether you can change your effective date. Your system administrator sets this profile option. You can check its value on the Personal Profile Values window. There are four possible values:

- **All**: You can change to any other effective date.
- **Future**: You can change between today’s date and any future dates.
- **Past**: You can change between today’s date and any past dates.
- **Present**: You cannot change to a date other than today.

To set your effective date:

1. Save any outstanding information you have entered or changed, then choose the Alter Effective Date icon from the Toolbar.
The Alter Effective Date window opens.

2. Enter a new effective date and choose OK.

If your current window is a “top-level” window (one called directly from the Navigator), your new effective date remains in place until you reset it or exit Oracle HRMS. If your current window is not a top-level window, your new effective date only applies while you are working in the current window and any windows subsidiary to it. When you return to a top-level window, your effective date is reset to its previous value.

Note: In certain special cases, when you change your effective date on a subsidiary window, Oracle HRMS returns you to the previous window, and you may have to requery the records you want to view or update. This protects the integrity of these records.

So long as your effective date remains different from today’s date, it is displayed in the title bar of every window.

Effective Date Reminder

When you are new to DateTrack, you may find it useful to be reminded of your effective date whenever you open a window that contains datetracked information. The reminder appears in a Decision window and asks whether you want to change your effective date. If you choose Yes, the Alter Effective Date window displays.

There is a user profile option called DateTrack:Reminder that determines when the Decision window appears. There are three possible values for this profile option:

- Always
- Never
- Not Today

The Not Today value causes the reminder to appear when you navigate to a datetracked window and your effective date is not today’s date.

You can set the value of this profile option in the Personal Profile Values window.
Viewing Datetracked Information and History

Oracle HRMS maintains a continuous record of changes made to datetracked information. When you view a record in a datetracked window, it shows you a snapshot of the information on your effective date. The Effective Dates region on the datetracked window shows you the dates between which the snapshot is valid.

Suppose you are viewing an assignment with an effective start date of 01–JAN–1987 and no effective end date. This means that the assignment was created or last changed on 1 January 1987, and the snapshot information you are viewing is still valid. There have been no changes to the assignment since 1 January 1987, and there are no future dated changes.

To find out whether the assignment existed before 1 January 1987, you should use DateTrack History.

If there is an effective end date, you know that the record was either deleted or changed on the next day. To find out whether the record continues to exist, you can set your effective date to the day after this end date, or use DateTrack History.

Viewing the History of Datetracked Information

To see all the changes made to a datetracked record over time, use DateTrack History.

To view DateTrack History:

1. Choose the DateTrack History icon from the Toolbar. The DateTrack History Change Field Summary window opens. Each row shows which fields were changed on the From date.
2. Choose the Full History button if you want to open a DateTrack History folder showing the value of each field between the effective
dates. The row for the current snapshot (corresponding to your effective date) is highlighted.

You can use the Folder menu to select the fields to view in the folder.

Note: It is possible to customize the information displayed in the Folder by modifying the DateTrack History view for the underlying table. See: How To Create and Modify DateTrack History Views, (Oracle HRMS Implementation Guide)

Updating and Correcting Datetracked Information

When you update datetracked information, you are prompted to choose between Update and Correction.

If you choose Update, Oracle HRMS changes the record as from your effective date, but preserves the previous information. If you choose Correction, Oracle HRMS overrides the previous information with your new changes. The start and end dates of the snapshot you have corrected remain the same.

Example

Suppose you hire two new employees, Jack Lee and Julie Summers. A few weeks later Julie gets married. At the same time you discover an error in Jack’s record relating to his nationality.

You update Julie’s information by setting your effective date to the date of her wedding and entering her new married status, her change of name, and new next of kin information. Her previous personal information, which was valid until her wedding, remains in her record.

You correct Jack’s wrong nationality by setting your effective date to his hire date and entering the correct nationality. By choosing Correction,
you put the record right, from the beginning. You should check whether there is an end date in the Effective Dates region of Jack’s record. If there is, you have only corrected the first snapshot of the record. Set your effective date to the day after the end date, and make the correction again. Continue in this way until the To field is blank, indicating that you have reached the last snapshot of this record.

**Updating a New Record**

You cannot create a record and then update it on the same day. If you try to do this, Oracle HRMS warns you that the old record will be overridden, and then changes Update to Correction. This is because DateTrack maintains records for a minimum of a day at a time.

**Future Updates**

Using DateTrack, you can make future updates. For example, suppose you are relocating an employee, with six months notice. You decide to enter the relocation on the system straight away. So you set your effective date to the first day when the employee will be at the new location, and change the location on the assignment.

Later that month you promote the employee to a new grade. So you set your effective date to today’s date and change the grade on the assignment. Oracle HRMS checks to see whether the record has a future update scheduled. It finds that the location changes in the future and prompts you for the type of update you now want to make. You have two choices:

- **Insert:** This simply inserts the change before the next scheduled change. This is the correct choice for the example. The employee would be promoted from today. The future-dated relocation still takes place in six months time.

- **Replace:** This change replaces all future-dated changes. In the example, the employee would be promoted from today. However, the record of the relocation would be completely removed from the system.
Deleting Datetracked Information

When you delete datetracked information, Oracle HRMS prompts you with the following options:

- **End Date:** This ends the record on your effective date. When you requery the record, this end date displays in the To field.
- **Purge:** This totally removes the record from your database.

If there are any future updates to the record after your effective date, Oracle HRMS may prompt you with another two options:

- **All:** This removes all future updates to the record. The current snapshot is valid until you make another change.
- **Next:** This removes the next future update to the record. It then resets the current snapshot’s end date to the end date of the deleted update.

**Note:** You do not always see all of these options when you choose to delete. Some windows do not allow all four operations.

Removing an End Date

If you have mistakenly set an end date on a datetracked record, you can remove it.

**To remove an end date:**

1. Set your effective date to the day the record ends.
2. Choose Delete Record from the Edit menu.
3. Choose the DateTrack delete option Next. This removes the next change to the record, which is the end date. Save your work.
Work Structures and Key Flexfields

Before you begin defining your enterprise’s work structures, you set up some key flexfields.  

*Key flexfields* are a special feature of Oracle Applications. They help you customize applications, by holding particular information your enterprise needs where you need it. A key flexfield can hold as many as 30 separate segments of information. You can determine exactly what information to hold and how it must be entered.

Oracle HRMS includes six user-definable key flexfields. These are especially useful in helping you build information on work structures that suit the mission and culture of your enterprise.

Job and Position Name

Using these key flexfields, you determine the number of segments in your job and position names or codes, and the valid values for each segment.

For example, you may want names that are simple titles using one flexfield segment only, such as Account Manager or Programmer. Or, you may want multiple-segment names that convey more information, such as Senior.Account Manager or Part-time.Trainee.Programmer.

See: Representing Jobs and Positions: page 3 – 2

Personal Analysis

The Personal Analysis key flexfield is for holding information about:

- the various requirements for your jobs and positions, such as educational attainment, certification or license types and levels, or language skills
- the educational levels, qualifications, skills and other personal attributes of your employees or applicants, which match your job or position requirements
- a wide range of other types of information you need to keep on record for your workforce, for example, company car usage, workplace accidents, and immunizations for communicable diseases.

You can define up to 30 instances of the Personal Analysis flexfield structure, each holding one special information type.

See: Defining Special Information Types: page 27 – 10
Grade Name

You may want to use simple, single-segment grade names (A, B, C), or more complex grade names (Manual.A.1, Manual.A.2, Clerical.C.1, Clerical.C.2).

See: Representing Grade Structures: page 4 – 2

People Group

The People Group key flexfield is for setting up special groupings of employees. For example, you can set up a segment of this flexfield to hold all the unions present at your enterprise. When you give an employee an assignment, you can use this segment to record his or her union membership.

See: Representing Other Employee Groups: page 5 – 10

Cost Allocation

The Cost Allocation key flexfield is for maintaining data needed to transfer information on employee costs from your payrolls to the general ledger, and to labor distribution systems.

For example, you might define one segment of the Cost Allocation flexfield to hold a list of your cost centers, another to hold GL account codes, and a third to hold labor distribution codes.

You would then make choices from these lists to tell the system how to collect payroll costs. For example, when you enter a department into Oracle HRMS, you could select the cost center against which to collect the employee costs of the department.

If you are using Oracle General Ledger, you can map segments of the Cost Allocation flexfield to segments of the GL Accounting flexfield.

See: Costing in Oracle HRMS: page 11 – 2

See Also

Oracle Applications Flexfields Guide
This chapter explains how to represent your enterprise in Oracle HRMS, and how to set up default information applicable across the enterprise.

It further explains how to represent:

- the physical work locations of your employees
- organizations internal to your enterprise, such as companies, departments, divisions, or units
- external organizations of importance to human resource management, such as recruitment agencies, insurance providers and tax authorities
- reporting lines and other relationships among these organizations. You represent these relationships by building organization hierarchies.
Site Locations

In Oracle HRMS, you set up each physical site where your employees work as a separate location. Similarly, you enter the addresses of external organizations that you want to maintain in your system, such as employment agencies, tax authorities, and insurance or benefits carriers. When setting up internal or external organizations, you pick from a list of these locations.

This approach has these advantages:

- You enter information about each location only once, thereby saving data entry time.
- Central maintenance of locations ensures consistency of address standards.
- Your work sites exist as separate structures identifiable for reporting purposes, and for use in the rules that determine employee eligibility for various types of compensation and benefits.
Setting Up Site Locations

Enter site addresses in the Location window. Locations are shared across Business Groups in Oracle HRMS and with two other Oracle applications: Inventory and Purchasing. Oracle HRMS does not use some of the fields in the Location window. These fields are disabled for HRMS users.

To enter a work location and its address:
1. Enter the name of the location, and a description if required.
2. Select a national address style from the list.
   A window opens with the address format for the country you select.
3. Enter address information in this window and choose the OK button.

   Additional Information: Default address styles are predefined for many countries. You can add address styles for other countries, if required.

Removing Site Locations

You cannot delete locations, but you can make them inactive.

To remove an address from the Location list:
- Enter an inactive date from which the location is no longer in use in your enterprise.
Representing Employers

The largest organizational unit you set up in Oracle HRMS to represent your enterprise as an employer is the **Business Group**. A Business Group may correspond to a company or corporation, or in large enterprises, to a holding or parent company or corporation.

It can be an organization with a physical location where people work, or it may simply be an abstract representative of a legal entity that employs people assigned to work in organizations beneath it.

By default, all employees you enter in Oracle HRMS receive an assignment to their Business Group. When you give them assignments to internal organizations such as divisions or departments, these replace the default assignment, but their records continue to exist within the Business Group.

Single or Multiple Business Groups

A Business Group holds a complete, self-contained set of information on work structures, remuneration policies and employees.

Each Business Group can have just one particular set of segments defined for its Job, Position, Grade, Employee Group and Cost Allocation key flexfields. You set up the key flexfields for a Business Group before setting up the Business Group itself.

Many enterprises decide to use a single Business Group to hold ‘live’ information, so they can display, report and manage information from all parts of the enterprise at the same time.

**Note:** You cannot view information online for more than one Business Group at a time.

However, there are reasons for setting up multiple Business Groups in the same installation, such as the following:

- You want to have a copy of your live system with example records for training or testing purposes.

- You are a holding company or a corporation with a number of subsidiary companies. Each subsidiary has its own structures, employees, and compensation and benefit policies. If your subsidiaries are in different countries you also have to deal with local legislative requirements.

- You are acquiring a company or merging with another company, and you want to maintain separate structures and compensation and benefits during the transition process.
The Startup Business Group

Oracle HRMS comes with one Business Group supplied as startup data. You can use this Business Group and its default definitions as the starting point for your own Business Group, or you can create a new Business Group.

If you create a new Business Group, you must create a new responsibility (or edit the default responsibility) to allow access to it, before beginning to create other work structures.

See Also

Accessing Business Groups: page 2 – 8

Defaults for the Business Group

You can enter certain types of information for the Business Group to appear as defaults throughout your enterprise structures:

- You can select a default currency.
- You can enter a default for the value each assignment contributes towards each staffing budget that you define. For example, by default an assignment may count as one for a headcount budget.
- You can enter default working hours for all the employees in the Business Group. You can override these defaults at organization, position, and assignment levels.

When defining a Business Group, you choose a method of creating identifying numbers for its employees and applicants. The choices are:

- automatic number generation
- manual entry
- for employees only, automatic use of a national identifier, such as the US social security number or the UK National Insurance number.

**Note:** Once you save an automatic number generation method, you can later change only to manual entry.
Representing Organizations

In Oracle HRMS, you represent your enterprise as an employer by means of the Business Group.

Below this level, you represent the groupings in which employees work, such as branches, departments or sections, by means of internal organizations. To enable the assignment of employees to an internal organization, you classify it as an HR Organization.

You also maintain information in the system about various types of external organizations relevant to human resources and payroll management and administration. You can never assign employees to external organizations, even those classified as HR Organizations.

Organization Types

When setting up an organization you can give it an organization type. The type may, for example, identify the function an organization performs, such as Administration or Service, or the level of each organization in your enterprise, such as Division, Department or Cost Center.

You create the organization types you require by entering values for the QuickCode Type ORG_TYPE.

Levels of Internal Organizations

You decide for yourself the level of organization detail your enterprise needs in Oracle HRMS.

At one extreme, a Business Group can be the only organization defined in the system. However this will severely limit your ability to manage and report on employee assignment and payroll information, and to control access to HRMS records. At the other extreme, you can define an organization for every grouping of employees, however small. But the costs of maintaining organizations at this level will probably outweigh the benefits.

When thinking about the internal organizations to set up for your enterprise in Oracle HRMS, consider what your current managerial groupings are. Then you can adjust up or down to determine the best level or organizational detail for your enterprise to maintain.

See Also

Organization Hierarchies: page 2 – 23
Internal Organizations and Cost Centers

Depending on the structure of your enterprise and your decisions about which organizations to represent in Oracle HRMS, there may not be a one-to-one correspondence between your cost centers and the organizations you enter.

When defining an internal organization, you can identify one cost center against which the payroll costs of the employees assigned to the organization should be collected. You simply select the cost center from a list in a segment of the Cost Allocation key flexfield.

For example, suppose you are defining in Oracle HRMS the organization Product Assembly, whose employee payroll costs go to the cost center Production. When entering the organization Product Assembly, you select Production from the list of cost centers in the Cost Allocation flexfield:

**Cost Allocation Key Flexfield**

*Segment 1: Cost Center*

410–Accounting
425–Production
503–Public Relations

**Note:** If employees’ costs are charged to cost centers other than those of their organizations, or if they work in an organization only part time, you can enter other cost centers, and the percentage of time to be charged to each, on their employee assignments. Costing information entered for employee assignments overrides that entered for organizations.

See Also

Setting Up the Cost Allocation Key Flexfield: page 11 – 3

External Organizations

Oracle HRMS can hold basic information on organizations not part of your own enterprise, such as training vendors, tax offices, benefits carriers or certification bodies.

You define external organizations in the same way as internal organizations. External organizations can appear in your organization hierarchies together with internal organizations.

**Attention:** The main difference in the system between internal and external organizations is that you cannot assign people to an external organization.
Employer and Organization Setup

Use the Organization window to set up:

- Business Groups
- internal organizations
- external organizations

The information you enter depends on the nature of the organization.

You must create a Business Group and a responsibility to allow access to it, before you create other organizations.

Accessing Business Groups

You access the startup Business Group using the default ‘Oracle Human Resources’ responsibility. A responsibility is linked to a security profile, which determines which records you can see. The default Oracle HRMS responsibilities allow you to see all the records for the startup Business Group.

You can adapt the startup Business Group or create a new one for your enterprise.

If you are creating a new Business Group, your system administrator must create a new responsibility for it after you save it, but before you use it. This responsibility must give access to all the records in the Business Group. Alternatively, the system administrator can simply update the default Oracle Human Resources responsibility by changing the HR:Security Profile user profile option to the name of the view–all security profile generated for the new Business Group (see steps 8 to 10 below).

To define a “view–all” responsibility:

1. Navigate to the Responsibilities window.
2. Enter a Name for the responsibility and select the application for which you are defining it (such as Oracle Human Resources) in the Application field.
3. In the Menu field, select F4 HRMS Top Menu.
4. In the Report Group field, select one of the seeded report groups (such as US HRMS Reports and Processes).
5. Save your work.
6. Navigate to the System Profile Values window.

7. Select your new responsibility and query the HR:Security Profile option.

8. Enter the name of the view–all security profile for your new Business Group. By default this is the name of your Business Group.

9. Save your work.

See Also

Access Control Through User Responsibilities: page 33 – 2
Creating an Organization

Use the Organization window to set up:

- Business Groups
- internal organizations, such as departments, divisions, and sections
- external organizations, such as benefits carriers, tax authorities, and recruiting agencies.

Prerequisites for All Organizations

- Enter the names and addresses of your work sites in the Location window.
  See: Setting Up Site Locations: page 2 – 3
- Enter organization types you need in the QuickCodes window, for the QuickCode Type ORG_TYPE.
  See: Adding QuickCode Values: page 31 – 3

Prerequisites for Business Groups

- Enable the currencies you need. Normally your system administrator does this.
  See: Enabling Currencies: page 28 – 7
- Define the structures for the Job, Position and Grade Name key flexfields, and define the structures and at least one segment for the People Group and Cost Allocation key flexfields.
  See: Work Structures and Key Flexfields: page 1 – 17
- Make entries for the QuickCode Types FREQUENCY and BUDGET_MEASUREMENT_TYPE in the QuickCodes window.
  See: Adding QuickCode Values: page 31 – 3

Prerequisites for HR Organizations

- To enter cost codes for these organizations, check that the Cost Allocation key flexfield includes a cost code segment, with a qualifier of Organization. This qualifier must be present for the segment to appear in the Organization window.
  See: Setting Up the Cost Allocation Key Flexfield: page 11 – 3
To create a new organization:

1. Enter a name that is unique within the Business Group, and optionally select an organization type.

   **Note:** All Oracle applications you install share the information entered in the Organization window. Therefore organization names must be unique within a Business Group, and Business Group names must be unique across your applications network.

2. Enter a start date early enough for any historical information you must enter.

   You cannot assign an employee to an organization before the start date of the organization.

3. Select a location to record the site address, if one exists. You can also enter an internal address to add more details such as a floor or office number.

4. Select Internal or External. You cannot assign people to an external organization.

5. Save the organization. Then select at least one classification and enable it.

   **Note:** Your system administrator can limit the classifications you see to those relevant at your installation.

   - Select Business Group to define a Business Group.

   **Attention:** Classifying an organization as a Business Group is not reversible. Employees, organizations, and other data are
partitioned by Business Group. Each Business Group must be viewed using a separate responsibility.

- Select **HR Organization** for all organizations (including Business Groups) to which you want to assign employees.
- Select **Payee Organization** when defining an external organization that is the recipient of a third party payment from an employee, for example a court-ordered payment. You can then select this organization on the Personal Payment Method window when entering a third party payment method.

6. Save all enabled classifications for this organization.

**To enter additional information:**

1. In the Organization window, query the organization if it does not already appear there. In the Organization Classifications region, select the classification for which to enter additional information, and choose the Others button to open the Additional Organization Information window.

2. This window displays the entry options available for the selected classification. Choose the option you want. Another Additional Organization Information window opens. Click in a field of this window to open a window for information entry.

3. Enter additional information for the classification.

   **Note:** There is no additional information to enter for a Payee Organization.

---

**Additional Information for Business Groups**

- **To enter basic, required information for the Business Group:**
  See: Entering Business Group Information: page 2–14

- **To enter defaults for human resource budget values:**
  See: Business Groups: Entering Budget Value Defaults: page 2–16

- **To enter the Sickness Control Rule for the Business Group (SSP/SMP users only):**
  See: Business Groups: Entering Sickness Control Rules: page 2–17

- **To enter tax details:**
  See: Business Groups: Entering Tax Details: page 2–18
To enter defaults for work day start and end times:
See: Business Groups and HR Organizations: Work Day Defaults: page 2 – 19

To enter training default values for Oracle Training Administration:
See: Creating a Business Group for Oracle Training Administration, Oracle Training Administration User’s Guide.

Additional Information for HR Organizations

To enter cost codes for collection of costing information:
See: HR Organizations: Entering Costing Information: page 2 – 20

To place the organization in hierarchies:
See: HR Organizations: Entering Parent Organizations: page 2 – 20

To enter default work day start and end times.
See: Business Groups and HR Organizations: Work Day Defaults: page 2 – 19
Entering Business Group Information

The Business Group Information window is an example of a flexfield structure. The first window you see displays the information in a condensed format. Click the field to open the full window, which labels each segment of the flexfield.

**To enter Business Group information:**

1. In the Organization window, query the Business Group if it does not already appear there. In the Organization Classifications region, select Business Group, choose the Others button, and select Business Group Information.

2. Click in a field of the Additional Organization Information window to open the Business Group Information window.

3. You can enter a short name for the Business Group. Release 10 does not use this name. It is provided for compatibility with earlier releases, where it appeared in the header line of each form.

4. Select the method of creating identifying numbers for employees and applicants. The choices are:
• automatic number generation
• manual entry
• automatic use of the national identifier (for example, the social security number in the US, and the NI number in the UK). This option is available for employees only.

**Attention:** Once you save your method, you cannot later change to either of the automatic options. You can only change to manual entry.

5. Select the names of the key flexfield structures you want to use in this Business Group.

6. Select the appropriate Legislation Code and default currency.
   The Legislation Code determines the startup data you can access and the contents of some legislation–specific windows.

**Attention:** Selecting the correct legislation code is essential for the correct functioning of Oracle HRMS. You cannot change the legislation code after entering employees against the Business Group.

7. You can enter a Minimum and Maximum Working Age for the Business Group. When you enter or hire employees, you receive a warning if the person’s age is outside this range.

8. Save your work.

**Note:** The Fiscal Year Start field is not used in Oracle Human Resources.
You can set up budgets for non-monetary measures such as headcount or full-time equivalent. When you enter employee assignments to define the work an employee does for your enterprise, you can specify the value of the assignment towards these budgets. For example, all assignments typically count as one for headcount budgets, but may count as less than one for full-time equivalent budgets.

To remove the requirement to enter these values for every assignment, you can enter defaults for the whole Business Group. You can override the defaults for individual assignments.

Prerequisites

- Define units of measure (such as Headcount) by adding values to the QuickCode Type BUDGET_MEASUREMENT_TYPE in the QuickCodes window.

To define budget value defaults:

1. In the Organization window, query the Business Group if it does not already appear there. In the Organization Classifications region, select Business Group, choose the Others button, and select Budget Value Defaults.

2. Click in a field of the Additional Organization Information window to open the Budget Value Defaults window.

3. In the Units field, select a measurement type, such as Full Time Equivalent or Headcount.

4. Enter a default value in the Value field.

You can enter a default value for as many budgetary units as you plan to use for the Business Group.

See Also

Human Resource Budgets: page 12 – 2
Business Groups: Entering Sickness Control Rules

If you have installed Oracle SSP/SMP, specify whether employees must submit medical evidence when they report a sickness absence.

To enter sickness control rules:

1. In the Organization window, query the Business Group if it does not already appear there. In the Organization Classifications region, select Business Group, choose the Others button, and select Sickness Control Rules.

2. Click in a field of the Additional Organization Information window to open the Sickness Control Rules window.

3. Select Yes or No in the Incapacity Evidence Required field.

   If you select Yes, Oracle SSP/SMP automatically creates a stoppage for payment of SSP if an employee has not submitted medical evidence while on sickness absence.

See Also

- Entering Sickness Evidence
  Oracle SSP/SMP User’s Guide

- Viewing and Recording SSP Stoppages
  Oracle SSP/SMP User’s Guide
Business Groups: Entering Tax Details

Your Business Group must register one or more PAYE schemes with the Inland Revenue. You can enter the details of each scheme for reporting purposes.

To enter tax office information:

1. In the Organization window, query the Business Group if it does not already appear there. In the Organization Classifications region, select Business Group, choose the Others button, and select Tax Details References.

2. Click in a field of the Additional Organization Information window to open the Tax Details References window.

3. Enter tax district details and the statutory name and address of your Business Group.

4. If your enterprise runs a contracted out occupational pension scheme, enter your Employer’s Contracting Out number. This is issued by the Pension Schemes Office.
Business Groups and HR Organizations: Work Day Defaults

You can set up default working hours for all employees in the Business Group or in an HR Organization, saving data entry at lower levels. When necessary, you can override the defaults at lower levels, for example, for individual positions or employees.

The Salary Administration process uses working hours information to prorate the salary values against which it validates any salary proposals.

To define work day defaults:

1. In the Organization window, query the Business Group if it does not already appear there. In the Organization Classifications region, select Business Group, choose the Others button, and select Work Day Information.

2. Click in a field of the Additional Organization Information window to open the Work Day Information window.

3. Enter the normal start and end times in 24 hour format. For example, for 5.30 p.m., enter 17:30.

4. Enter a number in the Working Hours field, and select the corresponding period of time in the Frequency field. For example, enter 40 and select Week.

You can add to the list of available frequencies by making entries for the QuickCode Type FREQUENCY, using the QuickCodes window.
HR Organizations: Entering Costing Information

To enter costing information:

1. In the Organization window, query the HR Organization if it does not already appear there. In the Organization Classifications region, select HR Organizations, choose Others, and select Costing Information.
2. Click in the Additional Information window to display the segments of the Cost Allocation flexfield set up with the qualifier of Organization.
3. Select the appropriate cost code in each segment.
   For individual employees, you can override these organization–level codes by entering costing information on their assignments.

See: Setting Up Assignments for Cost Collection: page 11 – 5

HR Organizations: Entering Parent Organizations

After you set up organization hierarchies, use the Parent Organization window to place a subordinate organization in hierarchies by naming its immediate parent in each hierarchy.

To enter a parent organization:

1. In the Organization window, query the HR Organization if it does not already appear there. In the Organization Classifications region, select HR Organization, choose Others, and select Parent Organization to open the Parent Organization window.
2. Select the hierarchy name.
3. Select the name of the parent organization to which the HR Organization is subordinate in this hierarchy.

4. To enter the HR Organization in another hierarchy, repeat steps 2 and 3.

See Also

Organization Hierarchies: page 2 – 23
Deleting an Organization

To remove an organization from the list of organizations available for employee assignments, enter an end date (Date To) on the organization record.

To entirely delete an organization from the system, you must first:

- remove any employee assignments to the organization
- remove the organization from any hierarchies
- disable its organization classifications in the Organization window.
Organization Hierarchies

In Oracle HRMS, organization hierarchies show reporting lines and other hierarchical relationships among the organizations in your enterprise.

You set up a primary reporting hierarchy reflecting the main reporting lines in your enterprise, as established in the organization chart of your enterprise. Below is an example of an organization chart showing the reporting lines of a single-company enterprise.

Figure 2 – 1
Chart Showing Primary Reporting Lines

![Diagram of organizational hierarchy]

Global Industries

- Executive
  - Company Services
    - Facilities
    - Company HR
      - Finance
      - MIS
    - Production
    - Sales
      - Sales East
      - Sales West
    - R & D
    - HR
  - Assembly
  - Maintenance
  - Testing
  - Inventory
Multiple Hierarchies

In addition to the primary reporting hierarchy, you can set up in Oracle HRMS as many other organization hierarchies as you need.

Hierarchies for Matrix Management

Your enterprise may have a matrix management structure in which organizations have more than one reporting line. For example, looking at the organization chart in Figure 2 – 1, the HR organization under Production may have a dotted–line reporting relationship to the organization Company HR. You can set up additional hierarchies to reflect secondary reporting relationships within your enterprise.

Security Hierarchies

As well as constructing hierarchies to reflect reporting lines, in Oracle HRMS you use hierarchies to control access to information. For example, in a decentralized enterprise you might want to give each regional manager access to the records of the employees in the organizations in his or her region.

Looking again at the organization chart in Figure 2 – 1, you want managers in the Sales East office to have access to the records of all employees in the eastern region sales groups. You can do this by building a geographical hierarchy of your regions and the organizations in each.

See: Security Profiles: page 33 – 4

Hierarchies for Reporting

When you run some of the Oracle HRMS standard reports, you can specify an organization hierarchy to determine which organizations and employees the report covers. You can also use this approach in your own standard or ad hoc reports. You can create additional organization hierarchies just for analysis and inquiry purposes.
Organizational Change and Version Control

Changing your hierarchies to reflect simple changes in reporting lines is not difficult. You create a new version of your existing hierarchy and modify parts of its structure. The system retains earlier versions of hierarchies for historical information.

However when you experience a major restructuring, it is often best to create new work structures, including new organizations and reporting lines.

**Suggestion:** You can create future-dated versions of your organization structures and use these to prepare for reorganization in advance. You retain previous versions of your hierarchies for historical information.

See Also

Dated Information and Hierarchy Versions: page 1 – 10
Creating Organization Hierarchies

You can create all types of organization hierarchies in two ways:

- using the Organization Hierarchy window
- using the Organization Hierarchy Diagrammer

The Hierarchy Diagrammer, included with Oracle HRMS, enables you to create your organization hierarchies graphically and make intuitive drag-and-drop changes to them.

See: Hierarchy Diagrammers Online Help

This topic explains how to use the Organization Hierarchy window.

Always define hierarchies from the top organization down.

Prerequisites

- Define the top organization in the hierarchy, and at least one organization subordinate to it.

To set up a new organization hierarchy:

1. Enter a unique name, and check Primary if it is your main reporting hierarchy.
2. Enter the version number and start date for the hierarchy.
You can copy an existing hierarchy. See: **To copy an existing hierarchy**, below.

3. Query the top organization name into the Organization block.

4. In the Subordinates block, select the immediate subordinates for the top organization.

5. To add organizations below one of these immediate subordinates, check the Down check box for the organization.

   The Organization block now displays the organization you selected. You can add subordinates to this organization. To return to the previous level, check the Up check box.

   **Attention:** The list of organizations from which you can select in the Subordinates block includes organizations that are already in the hierarchy. If you select such an organization, you will move it and all its subordinates within the hierarchy. See: Changing Organization Hierarchies: page 2 – 28

---

**To create a new version of an existing hierarchy:**

1. Query the name of the hierarchy.

2. In the Version field, use the Down Arrow to move through existing versions of the hierarchy until you reach a version number for which no other data appears. Enter the start date for the new version.

   **Note:** Overlapping versions of a hierarchy cannot exist. Whenever you enter a new version of a hierarchy, the system automatically gives an end date to the existing version. Oracle HRMS retains the records of obsolete hierarchies so you do not lose historical information you may need.

   You can copy an existing hierarchy. See: **To copy an existing hierarchy**, below.

3. Query the top organization name into the Organization block.

4. In the Subordinates block, select the immediate subordinates for the top organization.

5. To add organizations below one of these immediate subordinates, select the Down check box for the organization.

   The Organization block now displays the organization you selected. You can add subordinates to this organization. To return to the previous level, select the Up check box.

---

**To copy an existing hierarchy:**

1. Enter or query the name and number of your new hierarchy version and choose the Copy Hierarchy button.
2. Select the name and version number of the hierarchy you want to copy.

Details of this hierarchy then appear in the Organization and Subordinates blocks. You can change these.

---

**Changing Organization Hierarchies**

To add new organizations to an existing hierarchy, query the hierarchy and version you want to change, query the parent organization for the one you are adding, and select the new organization in the Subordinates block.

To change the top organization of an existing hierarchy, query the hierarchy and version you want to change, query the new top organization, and select the previous top organization in the Subordinates block.

You can move an organization and all of its subordinates within a hierarchy. To move an organization, query the hierarchy and version you want to change, query the new parent organization for the one you want to move, and select the organization to move in the Subordinates block.

---

**Deleting Organization Hierarchies**

To delete an organization hierarchy, you must first remove the subordinate organizations from the hierarchy, starting at the lowest level. You cannot delete an organization hierarchy if other versions exist, or a security profile uses it.
Organization Hierarchy Report

Oracle HRMS includes a standard Organization Hierarchy Report to display the relationships between organizations in a hierarchy. You run reports from the Submit Requests window.

To run the Organization Hierarchy Report:

1. In the Name field, select Organization Hierarchy.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. In the Organization Structure field, select the hierarchy. If there are multiple versions, select a version.
   
   If the effective date lies between the version’s start and end dates, the report shows information for the effective date. If it lies outside these dates, the report shows information for the start date of the version.

5. In the Parent Organization field, select the highest organization in the hierarchy that you want to see on the report.
6. Enter Yes in the Managers Shown field to see managers’ names.
   
   If there are more than ten managers, you see the number of managers only.
7. Choose the Submit button.
Jobs and Positions

This chapter explains the concepts of jobs and positions in Oracle HRMS and how you can use these work structures to represent the roles of your employees.

It further explains how to:

- use the Job Name and Position Name key flexfields to identify groups of employees in your enterprise
- hold information associated with jobs and positions, such as job descriptions, and standard working hours for positions
- represent the reporting lines and other relationships among positions. You represent these relationships by building position hierarchies
- reorganize jobs, positions and assignments within your Business Group.
Representing Jobs and Positions

In many enterprises the basic management units are roles, not individuals. In theory at least, organizations are able to continue in unchanged existence, in spite of frequent changes in staff. However, the definition of a ‘role’ varies from one enterprise to another. Like organization structures, it reflects the culture of the enterprise.

You define roles to represent the ways that different groups of employees work. In Oracle HRMS you can use jobs or positions, or a combination, to define roles.

**Job**

A job is a generic role within a Business Group, which is independent of any single organization. For example, the jobs ‘Manager’ and ‘Consultant’ can occur in many organizations.

**Position**

A position is a specific occurrence of one job, fixed within one organization. For example, the position ‘Finance Manager’ would be an instance of the job of ‘Manager’ in the ‘Finance’ organization. The position belongs to the organization. There may be one, many, or no holders of a position at any time.

**Example**

In a large structured organization, you may have a permanent establishment of positions for most of your employees. However, you may also have groups of employees hired to perform specific tasks. This can be on a temporary or a permanent basis. Staff in this category can include agency workers, consultants and contractors. For these staff, you can define the role more flexibly as a job.
Position Reporting Structures

If you use positions to define roles, you can define position hierarchies to show the detailed line management reporting in each organization or throughout the enterprise.

Position hierarchies are very like organization hierarchies. You can set up a primary hierarchy and multiple secondary hierarchies to show reporting lines, including 'dotted line' reporting, and to control access to information.

Position hierarchies are dated, so you can create future-dated versions to prepare for reorganization in advance, and can retain previous versions for historical information.
Deciding How to Use Organizations, Jobs, and Positions

When you plan how to model your organizations and roles, consider the following points:

- Positions are normally used in role–based enterprise structures where clearly defined rules largely determine the ways employees work, and the compensation and benefits they receive.
- To manage fixed establishments of posts that exist independently of the employee assignment, it is best to use positions.

If you decide to use positions to represent your enterprise structures you need to consider carefully how to use organizations.

Positions provide you with a finer degree of structural definition and control than organizations on their own. You can use both organizations and positions to represent your reporting structures. However, if you define both, you must also maintain both over time. This may lead you into duplication of effort and information.

**Suggestion:** If you decide to use positions to represent how people work in your enterprise, it is best to define most of the detail at the level of the position. Do not duplicate this detail in organization structures.

Use organizations to show your highest level of departments or divisions. Use positions and position hierarchies to show the reporting groups existing in your enterprise.

See Also

Rule Based Enterprises: page 6 – 6
Before you define your jobs and positions, decide whether you want to use simple names and codes, or multi-segment job and position names to hold more information.

The name can be a title only, as for example:

- Director
- Analyst
- Training Manager

You can add another segment to categorize the jobs or positions. In this way, you can use segments to identify subgroups of employees within your enterprise. For example, a job name can comprise a title and a job type, such as:

- Director of Finance.Director
- Assistant Director of Finance.Director
- Finance Officer.Professional

Similarly, a position name can comprise a title, a position number, and an indicator showing whether the position is part-time. For example:

- Training Manager.020001.F/T
- Secretary to the Training Manager.020013.P/T

You define the segments of the job and position names and their valid values by setting up the Job Name key flexfield and the Position Name key flexfield. Normally your system administrator does this.

See Also

User Definable Key Flexfields: page B – 2
Adding Information About Jobs and Positions

As you define roles in your enterprise, you can describe their responsibilities, requirements, and working conditions. There are a number of ways to add information about a role:

• For positions, you can enter in standard fields, the location, probation period, and working hours. Entering location and working hours for an organization provides a default for all positions within that organization.

• You can attach documents (such as word processed documents, spreadsheets, or simple text comments) to each job or position record. For example, you might attach text describing the objectives and tasks of the job or position.

  See: Using Attachments: page 32 – 6

• You can add up to twenty additional fields to each window to hold extra information you require. These fields can be global (they always appear), or context–sensitive (they appear only when triggered by another piece of information).

  For example, these fields can record the health and safety requirements of a position, or its suitability for job share. The additional fields appear in a *descriptive flexfield*.

  See: Adding New Fields to Windows: page 30 – 2

• You may need to add other information, such as required qualifications or valid experience, to help match people to roles. You define the sorts of Special Information Types you want to hold and set them up using a special field called the *Personal Analysis key flexfield*. For each job or position, you select the requirements from your Special Information Types relevant to that role.

  See: Matching People to Vacancies: page 23 – 2

Comparing and Relating Roles

You may also want to relate roles to each other and define the relative grading of the roles. You can relate roles in the following ways:

• By forming multiple hierarchies of positions to show reporting relationships or career paths.

  See: Creating Position Hierarchies: page 3 – 22

• By linking jobs into multiple career paths to show suggested progression paths.
• By recording successor positions and relief positions (to cover in the case of absence) against each position.

See: Defining Positions: page 3 – 10

• By recording the grades that are valid for each job and position.

See: Valid Grades: page 3 – 15

• If you use an evaluation system (such as the Hay Evaluation System) to compare roles, you can set up fields to hold evaluation information and an overall score for each job and position.

Defining Jobs

You use the Job window to define jobs, the skills that jobholders require, and the grades to which they can be assigned. You can also enter job evaluation scores, if you have set up a job evaluation system.

Prerequisites

- Define all the segments of the Job Name key flexfield that you want to use for the job name.
- If there are one or more valid grades to enter for this job, check that these grades are defined.

To define a job:

1. Enter a start date early enough to handle any historical information you want to enter.
2. Enter a unique name for the job. If there is more than one segment in the Job Name flexfield, a window opens when you enter the Name field. You must enter a unique combination of segments in this window.
3. Save the job.
4. Choose the Evaluation button to enter evaluation information and an overall evaluation score for the job.
5. Choose the Requirements button to enter job requirements, such as required qualifications or valid experience, to help you match people to roles.

Note: Check with your HR manager or system administrator whether this is the right window for entering job requirements.
You use this window if requirements were defined using Special Information Types. You use the Competency Requirements window if you have implemented Career Management.

6. Choose the Valid Grades button to enter the grades to which jobholders can be assigned.

See Also

- Entering Evaluation Information: page 3 – 14
- Entering Job and Position Skill Requirements: page 3 – 16
- Valid Grades: page 3 – 15
- Entering Work Choices for a Job or Position: page 3 – 17
Defining Positions

You use the Position window to define positions within your organizations and to add them to position hierarchies. You can also enter the skills that position holders require and the grades to which they can be assigned. You can enter position evaluation scores, if you have set up a position evaluation system.

Prerequisites

- Define all the segments of the Position Name key flexfield that you want to use for the position name.
- Define the organizations for the Business Group.
- Define the jobs for the Business Group.
- If you want to hold probation periods for positions, enter the units in which you measure probation periods as values for the QuickCode Type QUALIFYING_UNITS.
- If you want to add the position to a position hierarchy, define the hierarchy in the Position Hierarchy window.

To define a position:

1. Enter a start date early enough to handle any historical information you want to enter.
2. Enter a unique name for the position.
   If there is more than one segment in the Position Name flexfield, a window opens when you enter the Name field. You must enter a unique combination of segments in this window.
3. Select the organization and job for this position. They must have a start date on or before the start date of this position.

**Attention:** You cannot change the organization or job once you have saved the definition.

You can set up several positions that have the same job in the same organization. Each position name must be unique.

4. Optionally, select a status for the position. If the status is Valid or blank, employees can be assigned to the position. If the status is Invalid or any other status defined at your site, employees cannot be assigned to the position.

5. Location and Standard Conditions default from the organization, but you can override the defaults.

6. If there is a probation period for this position, you can enter its length in the Probation Period alternative region.

7. In the Absence alternative region, select Yes in the Replacement Required field if you want users to be warned that they should enter the name of a replacement when they enter an absence for a holder of this position. You might want to do this for positions where it is essential that a person is ‘in charge’ at all times.

You can select the position that should be held by the person to cover as relief in case of absence.

8. In the Planned Successor alternative region, you can select the position from which a successor will move to fill this position.

9. Save your position.

10. If you want to add the position to one or more position hierarchies, choose the Reporting To button. Select a hierarchy and the name of the position to which this position reports.

11. Choose the Evaluation button to enter evaluation information and an overall evaluation score for the position.

12. Choose the Requirements button to enter position requirements, such as required qualifications or valid experience, to help you match people to roles.

**Note:** Check with your HR manager or system administrator whether this is the right window for entering position requirements. You use this window if requirements were defined using Special Information Types. You use the Competency Requirements window if you have implemented Career Management.

13. Choose the Valid Grades button to enter the grades to which position holders can be assigned.
See Also

Entering Evaluation Information: page 3 – 14
Valid Grades: page 3 – 15
Entering Work Choices for a Job or Position: page 3 – 17
Evaluating Jobs and Positions

Evaluation systems are common in large enterprises, which compare the responsibilities of roles to help in the definition of grades. Directly or indirectly, the evaluation can also contribute to setting compensation levels. The UK’s Local Government Scheme and the Hay Evaluation System, used internationally, are examples of evaluation systems.

Evaluation systems normally use a set of formal and systematic procedures to perform a comparison of roles. As such, evaluation is primarily concerned with the definition of the relative status of a role, and not with a set of absolutes. The objective of all evaluation systems is to place a role in a grading or salary structure.

There are two main types of evaluation system:

<table>
<thead>
<tr>
<th>Factor</th>
<th>Points Rating</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key roles are examined factor by factor and a rank comparison order produced for each factor. A complex comparison of weighted factors then follows.</td>
<td>A wider range of factors is used. Each factor is weighted and has a numerical scoring system. The total points scored determines the placement of the role in a grade or salary structure.</td>
</tr>
</tbody>
</table>

These systems might incorporate benchmarking, where a few key roles determine the rank of all the others. Grades and compensation levels are determined after the evaluation and ranking of the jobs.

Setting Up an Evaluation System

1. Decide whether to hold the evaluation information for jobs or for positions, depending on your own definitions of employees’ roles within the enterprise model.

2. Define values for the QuickCodes Types EVAL_SYSTEM (evaluation system name) and EVAL_SYSTEM_MEAS (the units in which to measure the evaluation). If you use more than one system, you can define multiple values to provide a list of values in the Job Evaluation and Position Evaluation windows.

   See: Adding QuickCode Values: page 31 – 3

3. Define the structure and segments of the Additional Evaluation Details descriptive flexfield, which holds the evaluation
information. This descriptive flexfield displays on the Job Evaluation and Position Evaluation windows.

For example, you could define the following segments:

- Responsibility
- Problem Solving
- Know How
- Related Grade

If you are using more than one evaluation system in your enterprise, you should make the flexfield segments context sensitive to the evaluation system. Context sensitive segments ensure that each system has its own distinct set of evaluation information.

Your system administrator usually carries out this task as it requires access to parts of the system that control how Oracle Human Resources works.

**Entering Evaluation Information**

Enter evaluation scores and details in the Job Evaluation or Position Evaluation window.

**Prerequisites**

- An evaluation system must be implemented.

![Job Evaluation Window](image)

**To enter a job or position evaluation:**

1. Select the evaluation system used to evaluate this job or position.
2. Enter the overall score and select the units of measurement.
3. Enter the date of the evaluation.
4. Open the descriptive flexfield window, and enter the information it prompts you for.

Valid Grades

When you have evaluated the relative status of your roles (using an evaluation system or some other approach), you can associate valid grades with each role. You may choose to define valid grades for a few key roles and then use these as benchmarks for all other roles.

When you assign an employee to a grade, the list of grades you select from indicates which grades are valid for the employee’s job or position.

You enter valid grades in the Valid Grades window for a job or position.

To enter valid grades:

- Select as many valid grades as you require.

  The Date From defaults to the date the job or position becomes active, or the date the grade becomes active, if this is later. You can change this date.
Entering Job and Position Requirements

Using the Job Requirements window and Position Requirements window, you can store any personal attributes or experience required by a job or position. You can then use this information to list employees or applicants who might be suitable to hold the job or position.

**Note:** If you are using Career Management for suitability matching, enter competence requirements for jobs and positions in the Competence Requirements window.

The implementation team at your site must set up one or more special information types to hold the requirements information.

See: Defining Special Information Types: page 27 – 10

![Job Requirements Window](image)

**To enter job or position requirements:**

1. Select the name of a special information type.
2. Enter the Requirements field to open the window corresponding to this special information type.
3. In this window, enter the precise requirement of the job or position and choose OK.
4. If the requirement is essential to the job or position, check the Essential check box. This information is used in the Skills Matching Report.
5. Save the requirements.
See Also

Viewing and Reporting Skills Matching Information:  *(Oracle Human Resources UK User’s Guide)*

---

**Entering Work Choices for a Job or Position**

You can enter work choices that can affect an employee’s, applicant’s, contractor’s, or ex–employee’s capacity to be deployed within your enterprise (or a customer’s). Work Choices include willingness to travel, willingness to relocate, and preferred working hours and work schedule. You can enter work choices for a job or position, and compare these with the personal work choices entered for people.

You enter this information in the Work Choices window, accessed from the Job or Position window.

---

**Prerequisites**

You need to enter the following QuickCodes for work factors:

- Define time scales as values for the QuickCode Type PER.TIME.SCALES.
- Define work schedules as values for the QuickCode Type PER.WORK.SCHEDULE.
- Define working hours as values for the QuickCode Type PER.WORK.HOURS.
- Define the full time equivalents as values for the QuickCode Type PER.FTE_CAPACITY.
- Define relocation preferences as values for the QuickCode Type PER.RELOCATION.PREFERREDENTS.
- Define lengths of service as values for the QuickCode Type PER.LENGTHS_OF_SERVICE.
To enter work choices for a job or position:

1. Check the relevant work requirements boxes if the job or position requires the holder to:
   - work in all locations
   - relocate
   - be willing to relocate
   - travel
   - hold a passport

2. Enter the length of time the jobholder must perform the job or position, for example, indefinite or two years.

3. Enter the normal working hours (for example, 9.00 to 5.30), the work schedule (the working days in the week or pattern of shifts), the proportion of full time hours required, and the minimum length of service required.

4. Check the relevant international deployment boxes if the job or position requires the jobholder to:
   - work in all countries
   - be willing to relocate

5. Select the countries to which the jobholder might be relocated.

6. Select the locations to which the jobholder might be relocated.
7. Enter any further job or position requirements, if required.

See Also

Entering Work Choices (Person): page 13 – 19
Viewing Position Occupancy

The Position Occupancy folder lists all those people who have held a selected position or who are applying for it, and the dates of their occupancy. This information could be relevant for selecting people with the necessary skills for similar positions.

**Note:** As supplied, this folder displays employees who have held the selected position or who are scheduled to hold it. Your system administrator can create a customized version of the form to display applicants who are currently applying for the position.

The supplied folder also contains a button to open the People window to see further details of an occupant. Your system administrator can change the buttons displayed on this window.

To view occupants of a position:

- In the Position window, query a position and choose the Occupancy button.

Occupants are listed in reverse date order. Where a person has occupied the same position at different times, a separate record is created for each occupancy.
To see further details of occupants or applicants:

- Select the person’s record in the Position Occupancy folder and choose the Person button.

**Note:** There is no restriction on the assignments you can view in the Position Occupancy folder. However, you cannot view further details if you do not have clearance to view that person’s records.
Creating Position Hierarchies

You can create and maintain your reporting structures in two ways:

- using the Position Hierarchy window
- using the Position Hierarchy Diagrammer

The Hierarchy Diagrammer, included with Oracle HRMS, enables you to create your position hierarchies graphically, and make intuitive drag-and-drop changes to them.

See: Hierarchy Diagrammers Online Help

This topic explains how to use the Position Hierarchy window. Always define hierarchies from the top position down.

**Prerequisites**

- Define the top position in the hierarchy, and at least one position subordinate to it.

**To create a new position hierarchy:**

1. Enter a unique name, and check Primary if it is your main reporting hierarchy.
2. Enter the version number and start date for the hierarchy.

You can copy an existing hierarchy. See: **To copy an existing hierarchy**, below.
3. Query the top position name into the Position block.

The Holder field displays the name of the employee who holds this position. If there is more than one holder, this field displays the number of holders. You can choose the List icon from the toolbar to display the list of holders.

4. In the Subordinates block, select the immediate subordinates for the top position.

5. To add organizations below one of these immediate subordinates, check the Down check box for the position.

The Position block now displays the position you selected. You can add subordinates to this position. To return to the previous level, check the Up check box.

**Attention:** The list of positions from which you can select in the Subordinates block includes positions that are already in the hierarchy. If you select such a position, you will move it and all its subordinates within the hierarchy.

See: Changing Position Hierarchies: page 3 – 24

-----

**To create a new version of an existing hierarchy:**

1. Query the name of the hierarchy.

2. In the Version field, use the Down Arrow to move through existing versions of the hierarchy until you reach a version number for which no other data appears. Enter the start date for the new version.

   **Note:** Overlapping versions of a hierarchy cannot exist. Whenever you enter a new version of a hierarchy, the system automatically gives an end date to the existing version. Oracle HRMS retains the records of obsolete hierarchies so you do not lose historical information you may need.

   You can copy an existing hierarchy. See: **To copy an existing hierarchy**, below.

3. Query the top position name into the Position block.

4. In the Subordinates block, select the immediate subordinates for the top position.

5. To add positions below one of these immediate subordinates, check the Down check box for the position.

The Position block now displays the position you selected. You can add subordinates to this position. To return to the previous level, check the Up check box.
To copy an existing hierarchy:

1. Enter or query the name and number of your new hierarchy version and choose the Copy Hierarchy button.

2. Select the name and version number of the hierarchy you want to copy.

Details of this hierarchy then appear in the Position and Subordinates blocks. You can change these.

See Also

Dated Information and Hierarchy Versions: page 1 – 10

Changing Position Hierarchies

To add new positions to an existing hierarchy, query the hierarchy and version you want to change, query the parent position for the one you want to add, and select the new position in the Subordinates block.

To change the top position in an existing hierarchy, query the hierarchy and version you want to change, query the new top position, and select the previous top position in the Subordinates block.

You can move a position and all of its subordinates within a hierarchy. To move a position, query the hierarchy and version you want to change, query the new parent position for the one you want to move, and select the position to move in the Subordinates block.

Deleting Position Hierarchies

To delete a position hierarchy, you must first remove the subordinate positions from the hierarchy, starting at the lowest level. You cannot delete a position hierarchy if other versions exist, or if a security profile uses it.
Position Hierarchy Report

Oracle HRMS includes a standard Position Hierarchy Report to display the relationship between the positions in a hierarchy. The report also lists the current holders of each position in the hierarchy.

You run reports in the Submit Requests window.

To run the Position Hierarchy Report:

1. In the Name field, select Position Hierarchy.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. In the Position Structure field, select the hierarchy. If there are multiple versions, select a version.
   - If the effective date lies between the version’s start and end dates, the report shows information for the effective date. If it lies outside these dates, the report shows information for the start date of the version.
5. In the Parent Position field, select the highest position in the hierarchy that you want to see on the report.
6. Enter Yes in the Holders Shown field to see holders’ names.
   - If there are more than ten holders, you see the number of holders only.
7. Choose the Submit button.
Making Mass Updates

You can use the Mass Move feature to reorganize your Business Group, either within an organization or between organizations.

You can move assignments between existing positions, create new positions in which to move assignments, and change the grade, location, and standard conditions of an assignment.

Business Group reorganizations often entail changing many employee records in the same way. Because Mass Move allows you to modify multiple employee records at once, you can make such changes conveniently.

These topics are covered:

- Preparing for your mass move: page 3 – 27
- Performing tasks to complete your mass move: page 3 – 28
- Managing your collection of mass moves: page 3 – 37
Preparing for Your Mass Move

To prepare for your mass move, you must make certain decisions and ensure that certain prerequisites are in place.

Making Decisions for Your Mass Move

- What is my source organization? (The mass move transfers assignments from the source organization.)
- What is my target organization? (The mass move transfers assignments to the target organization. The target organization can differ from or be the same as the source organization.)
- What is the effective date for the mass move?
- What are the source position(s)? (The mass move transfers assignments from the source position(s) within the source organization).
- Do you want to deactivate the source position?
- What are my target position(s)?
- If my target position(s) are new, will their location and standard conditions be copied from the source position, target organization, or Business Group?
- What grades are valid for the target position(s)?
- Which assignment(s) will transfer from my source position(s) to my target position(s).
- Will the grade of any transferring assignment change during the mass move?
- Will the location and standard conditions of any transferring assignment change during the mass move?

Prerequisites for Your Mass Move

To prepare for your mass move:

- Make sure you have access to a responsibility linked to the Business Group within which the mass move will take place.
  See: Accessing Business Groups: page 2 – 8
- Check that the source and target organizations for your mass move already exist in the HRMS database.
  See: Creating an Organization: page 2 – 10

See Also

Performing Mass Move Tasks: page 3 – 28
Performing Mass Move Tasks

Executing a mass move includes the following tasks:

1. Describe your mass move: page 3 – 28
2. Identify your source position(s): page 3 – 29
3. Identify your target position(s): page 3 – 31
4. For each source position, verify the transferring assignments: page 3 – 32
5. For each target position, verify or add valid grades: page 3 – 34
6. Execute the mass move: page 3 – 35
7. Review the mass move: page 3 – 35
8. If necessary, resolve any problems and then reexecute the mass move: page 3 – 36

Describing Your Mass Move

To define your mass move, the first task involves entering a description, determining the source and target organizations for the mass move, and specifying the date on which the mass move will take effect.

To describe your mass move:

1. Navigate to the Mass Move window.
2. Enter a description of the mass move you want to perform.
   You can change this description at any time before the mass move is processed.
3. Select the source and target organizations for the mass move.
   The source and target organizations can differ or be the same. The lists includes organizations that have been defined for the Business Group.
3 – 29

**Note:** You cannot create a target organization “on the fly.”

You can change the source and target organizations for this mass move at any time until you choose the Find button on the Find Positions window. These definitions then become part of the permanent definition of the mass move and cannot be changed.

Status is a display field that indicates whether the mass move has not yet been executed (Unprocessed), successfully executed without errors or warnings (Complete), successfully executed without errors but with warnings (Complete with Warnings), or unsuccessfully executed with no changes made (In Error).

4. If necessary, adjust the effective date of the mass move.
   
   You can adjust the effective date at any time before the mass move is processed.

5. Save your work.

---

**Identifying Your Source Positions**

After describing your mass move, you must identify source position(s) to be moved.

To identify your source positions:

1. In the Mass Move window, choose the Positions button.

![Image of Mass Move window with Positions button highlighted]
2. In the resulting Find Positions window, select source job(s) and the source position(s) associated with those job(s).

You can select from a list of existing job(s) and position(s) in the source organization, or you can use generic search criteria (wildcards) to identify a pool of source jobs and source positions from which you will select your source positions in Step 3.

3. Choose the Find button.

When the Mass Move – Positions window is populated with information, the source and target organizations you defined in the Mass Move window appear in display fields.

4. If you used search criteria to identify a pool of source jobs and positions, make sure that the list includes all of the source jobs and positions you want to include in this mass move.

Attention: If you want to add source jobs or positions to this list, you must delete this mass move and define a new mass move; source job(s) and position(s) cannot be added to this list.

5. In the move check boxes, check each of the source positions you want to move.

Assignments associated with unchecked source positions will not be affected by the mass move in any way.

6. If you want to deactivate any source position on the effective date for the mass move, check the Deactivate Old Position check box when that position is selected.

Selected: Deactivating a source position does not delete it from the HRMS database, but enters the mass move effective date as the end date for the position.

Unselected: Leaving this check box unchecked allows assignments to be assigned to this source position after the effective date of the mass move, even though the source position may have no assignments immediately following the mass move.

Attention: Unchecking the Move check box for a record restores the original values for that record.

See Also

Defining Positions: page 3 – 10
Managing Your Mass Move Collection: page 3 – 37
Identifying Your Target Positions

Now that you have identified the source position(s) for your mass move, you are ready to identify its target position(s). For each of the target positions you will define, perform the following steps:

To identify your target positions:

1. On the Mass Move – Positions window, select one source position for your mass move.

2. Select a target job to correspond with that source position.
   The list includes existing jobs within the Business Group.
   **Note:** You cannot create a target job “on the fly.”

3. Choose Edit Field to enter a new target position, or select a target position.
   The list includes existing positions in the target organization.
   **Note:** Each source position can only have one target position. However you can use the same target position for multiple source positions.

4. Select the location and standard conditions for this target position.
   If this target position is a new position, you can enter location and standard conditions as follows:
   **Source Position:** Indicates that the location and standard conditions of the source position will be applied to the new target position when the mass move takes effect.
   **Target Organization:** Indicates that the location and standard conditions of the target organization will be applied to the new target position when the mass move takes effect.
   **Business Group:** Indicates that the location and standard conditions of the Business Group will be applied to the new target position when the mass move takes effect.
   **Attention:** Unchecking the Move check box for a record restores the original values for that record.

5. When you have identified each of your source and target positions, choose the Assignments button.

See Also

- Verifying Transferring Assignments for Each Source Position: page 3 – 32
- Defining Positions: page 3 – 10
Verifying Transferring Assignments for Each Source Position

The content of the Mass Move – Assignments window depends on the source position you last selected in the Mass Move – Positions window. The Mass Move – Assignments window displays that selected source position, and its corresponding source organization and source job. It also displays the target position you have entered for this selected source position, and the target organization and job associated with this target position.

All of the (applicant as well as employee) assignments associated with the source position you selected in the Mass Move – Positions window are also displayed.

As the Move check boxes show, by default all assignments associated with this source position are selected to move to the target position. The Mass Move – Assignments window allows you to verify these assignments, indicate which ones, if any, will not be moving to the target position, and change the grade, location and standard conditions for any of the assignments to be moved.

To verify transferring assignments for each source position:

1. If you want to prevent any of these assignments from moving to the target position, uncheck the appropriate Move check boxes.
2. If you want to change the grade for any transferring assignment, select the assignment, and then select another grade for that assignment.
3. If you want to copy location and standard conditions for a transferring assignment from an entity other than the current assignment (default), select the assignment, and then select the new location and standard conditions for that assignment. The options follow:

**Current Assignment**: Indicates that the transferring assignment will maintain its current location and standard conditions when the mass move takes effect.

**Source Position**: Indicates that the location and standard conditions of the source position will be applied to the transferring assignment when the mass move takes effect.

**Target Organization**: Indicates that the location and standard conditions of the target organization will be applied to the transferring assignment when the mass move takes effect.

**Business Group**: Indicates that the location and standard conditions of the Business Group will be applied to the transferring assignment when the mass move takes effect.

**Attention**: Unchecking the Move check box for a record restores the original values for that record.

4. To save your work and then return to the Mass Move – Positions window, close the Mass Move – Assignment window.

When the Mass Move – Positions window reappears, you can repeat the above steps for any other source positions whose transferring assignments you choose to verify. Otherwise, you are ready to verify or add valid grades for any target(s) jobs/positions.

**See Also**

- Entering a New Assignment: page 14 – 8
- Site Locations: page 2 – 2
Verifying or Adding Valid Grades for Each Target Position

Because it is possible for the grade of a transferring assignment to be outside the bounds of the valid grades for the target job or target position, you can use Mass Move to add valid grades to the target position.

1. On the Mass Move – Positions window, choose the Valid Grades button.
   
The resulting Mass Move – Valid Grades window displays information for the source position you last selected in the Mass Moves – Positions window. It displays the valid grades for the target position:
   
   • A newly-created target position has the same valid grades as the source position.
   
   • An existing target position retains its existing valid grades and Mass Move adds any other grades that are valid for the source position.

   Thus Mass Move accommodates the grade(s) of the transferring assignment(s). You cannot delete any of the valid grades.

2. Optionally, select additional valid grades for the target position.

3. To save your work and then return to the Mass Move – Positions window, close the Mass Move – Valid Grade window.

   When the Mass Move – Positions window reappears, you can select any other records, to verify or add valid grades for that target position.
See Also

Valid Grades: page 3 – 15

Executing the Mass Move

2. Save your work when prompted to do so.
3. On the Mass Move window, choose the Execute button.
   If the number of changes being made is large, executing the mass move may take some time.

Reviewing the Mass Move

After you have chosen the Execute button on the Mass Move window, you are ready to review the results.

To review the mass move:

1. On the Mass Move window, review the contents of the Status field.
   - **Unprocessed**: Indicates that you have not yet executed the mass move.
   - **Complete**: Indicates that the mass move completed successfully without errors. For historical purposes, completed mass moves are automatically archived and cannot be modified.
   - **Complete with Warnings**: Indicates that the mass move completed successfully, nevertheless, you should still review any warning messages the mass move generates. It is possible for a mass move to execute with Status=Complete with Warnings, yet without all assignments moving as you intended.
   - **In Error**: Indicates that the mass move did not complete successfully and that no changes took effect. You must first resolve the offending conditions before you can successfully reexecute the mass move.

   **Attention**: If the Status field shows In Error or Complete with Warnings, the Message button appears next to the Positions button.

2. If the Message button is displayed, review the messages.
   The Message window that appears includes the following fields:
   - **Type**: Type of message; Warning or Error.
Row Information: If this field displays a position name, the message applies to a source position. If this field displays the name of a person, this field applies to the assignment associated with that person.

Message: Text of the message.

Note: The Explain button on the Message window is disabled if no additional information is available.

3. If the Status field shows Complete or Complete with Warnings, navigate to the Mass Move – Assignments window and verify that the mass move changes you wanted to make did in fact take effect. Then navigate back to the Mass Move window.

Resolving Problems and Reexecuting a Mass Move

If the Status field on the Mass Move window shows In Error, you need to resolve the problems and reexecute the mass move until the Status field shows Complete or Complete with Warnings. If the Status field shows Complete with Warnings, you will want to investigate those Warnings, and then determine whether you want to resolve the warning conditions and reexecute the mass move to eliminate the warnings. (However, it is important to remember that a mass move complete with warnings has in fact executed successfully.)

Resolving problems may require that you exit Mass Move. For example, an applicant assignment associated with a vacancy will not move during a mass move. To move that assignment to the target position, you would need to use the Assignment window to disassociate this applicant assignment from the source position, and then assign this applicant to a target position.

To reexecute a mass move:

1. Navigate to the Mass Move window.
2. Query the mass move that you previously saved and want to reexecute.
3. After the Mass Move window is populated with data, make whatever changes you need to make to correct the mass move definition.

Attention: Since assignments are datetracked, you may only update a given assignment once a day. To bypass this rule, you can alter the mass move effective date.
If you query a previously saved mass move and then choose the Positions button, the Find Positions window is not displayed. Instead, the Mass Move – Assignments window immediately appears and is populated with data.

4. Choose the Re-execute button.

5. Review your mass move in the standard manner.

Managing Your Mass Move Collection

As you reorganize your Business Group over time, you will develop an historical archive of mass moves. This archive consists of:

- All executed mass moves for which Status=Complete
- Any executed mass moves for which Status=Complete with Warnings
- Any saved but unexecuted mass moves (Status=Unprocessed or Status=In Error) that you have not deleted

Because it is important to maintain an historical record of Business Group reorganizations, you cannot delete a mass move when its status is Complete or Complete with Warnings. However, you can delete any unexecuted mass moves you chose to save but which have a status of Unprocessed or In Error.

Reexecuting a mass move overwrites its original contents. Thus, only the latest reexecution of that mass move would appear in the historical archive.
This chapter explains how to represent the grade structures used in your enterprise and how to relate compensation to grades. You can relate compensation to grades directly, using grade rates, or indirectly, using grade scales.
Representing Grade Structures

Grades can have different levels of complexity, which need to be represented in the overall structure of the grade.

In its simplest form, a grade can be a single character, or number, in a logical sequence. For example:

- grade A
- grade B
- grade C

By adding a second segment to the grade name, you can identify sub-grades, such as:

- grades A.1, A.2, A.3, and A.4
- grades B.1 and B.2
- grades C.1, C.2, and C.3

A more complex structure could be used to distinguish grades for different staff groups, such as:

- Clerical.C.1 and Clerical.C.2

In this example, there are three segments in the grade name. A grade is the combination of segments you define. You set up the segments and their valid values using the Grade Name Key Flexfield. Normally this is done by the system administrator.
Using Grades

Grades are normally used to record the relative status of employee assignments and to determine compensation and benefits, such as salary, overtime rates, and company car.

Using Grades to Compare Roles

You can define one or more valid grades for each job or position. You enter this information in the Valid Grades window, which opens from the Job window or the Position window.

When you enter a grade assignment, the list of grades shows which ones are valid for the job or position you select.

See: Valid Grades: page 3 – 15

Associating Grades with Compensation and Benefits

You can associate compensation and benefits with your grades. For example, you can record a minimum or maximum salary for a grade. There are two approaches:

- Using grade rates, you can either enter a fixed value for each grade, or you can enter a minimum, maximum, and mid-point values for each grade.

- Using grade scales, you can associate each grade with several points on a pay scale, and enter compensation values for these points.

Attention: The compensation information can change independently of the grade. Therefore, you should not define it as part of the grade name. Instead you should relate it to the grade, either directly or indirectly.
Defining Grades

Prerequisites

- Define all the segments of the Grade Name key flexfield that you want to use for the grade name.

To define a grade:

1. Enter your grades in sequence number order.
   
   The sequence number can be any number from 1 upwards. The number indicates the rank order of the grade; 1 indicates the highest grade.
   
   This is the sequence in which the grades appear to users in lists of values.
   
   Consider sequencing each grade at intervals of 10 or more, to accommodate any future changes to grades.

2. Enter a unique name for the grade. If there is more than one segment in the grade name structure, a window opens when you enter the Name field. You must enter a unique combination of segments.

3. Enter a start date early enough to handle any historical information you want to enter.

4. Save your work.
Deleting Grades

To remove a grade from the list of grades to which employees can be assigned, enter an end date against the grade.

To delete a grade entirely from the system, you must first reassign anyone assigned to the grade. If you have historical records using the grade, you cannot delete it. Instead, enter an end date.
Grade Relationships to Compensation and Benefits

In many enterprises there are rule based reward structures based on grade. These rules can relate grades and pay *directly or indirectly*.

**Direct Relationship**

You may have a salary administration system in which the actual level of pay normally falls between a minimum and a maximum value for a grade. Regular performance reviews and ratings can involve comparison with the mid-point value of pay for your grade. In Oracle HRMS, this is a *grade rate*.

**Figure 4 – 2**

Relating Grades and Pay Directly and Indirectly

<table>
<thead>
<tr>
<th>Grade</th>
<th>Fixed</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>A.1</td>
<td>10000</td>
<td>10000 – 12500</td>
</tr>
<tr>
<td>A.2</td>
<td>10500</td>
<td>10500 – 13250</td>
</tr>
<tr>
<td>B.1</td>
<td>12000</td>
<td>12000 – 14500</td>
</tr>
<tr>
<td>B.2</td>
<td>13000</td>
<td>13000 – 16000</td>
</tr>
</tbody>
</table>

**INDIRECT – GRADE SCALES**

<table>
<thead>
<tr>
<th>Name</th>
<th>Range</th>
<th>Points</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>A.1</td>
<td>28 – 32</td>
<td>28</td>
<td>10000</td>
</tr>
<tr>
<td>A.2</td>
<td>30 – 34</td>
<td>29</td>
<td>10250</td>
</tr>
<tr>
<td>B.1</td>
<td>31 – 36</td>
<td>30</td>
<td>10625</td>
</tr>
<tr>
<td>B.2</td>
<td>33 – 38</td>
<td>31</td>
<td>10900</td>
</tr>
<tr>
<td></td>
<td></td>
<td>32</td>
<td>11250</td>
</tr>
</tbody>
</table>

**Indirect Relationship**

You may be using a step based system of progression points within grades, in which each point has a fixed value in a pay schedule or table. In Oracle HRMS this is a *pay scale*. 
Relating pay to grades indirectly is common in government, education and health enterprises. It is also common in large commercial enterprises that negotiate pay levels with staff or union representatives.
Relating Pay to Grades Directly: Using Grade Rates

In Oracle HRMS, you can set up a table of values related to each grade. These are called grade rates. You can enter a fixed value or a range of valid values for each grade.

For example, you might define a salary rate and an overtime rate of pay for every grade, with minimum, maximum, and midpoint values. Both rates would be in monetary units. However, you can also define rates with non–monetary units, such as days, hours, or numbers.

![Figure 4 – 3 Grade Rates](image)

Grade rates are datetracked and this means that you can keep the history of the actual values you use. You can also set up rate values at a future date and be sure that this information will automatically take effect on the date you set, and not before.

You can use your grade rate values:

- as part of a QuickPaint report or inquiry
- to validate salary proposals
- to validate other compensation entries you make for employees
The salary administration process validates salary proposals automatically against the appropriate grade rate. You can use formula validation to check other compensation entries.

See Also

Salary Administration and Performance Reviews: page 10 – 2
Using Oracle FastFormula for Validation: (Oracle FastFormula User’s Guide)

Defining Grade Rates

You define grade rates in the Grade Rate window. When you save your definition, an automatic process creates corresponding database items that formulas can access.


To define grade rates:

1. Set your effective date to a date early enough for any historical information you want to enter.
2. Enter a name for the grade rate and select the units for measuring it. Save your new rate.
3. In the Grade Rate Values block, select the grades for which you want to define rates. For each grade, enter a fixed value and/or a minimum, maximum and mid value.
To use this grade rate to validate salary proposals entered in the Salary Administration window, you must enter a minimum and maximum value.

To view compariso values using this grade rate, you must enter a mid value.

See Also

Setting Up Salary Administration: page 10 – 4

Viewing Grade Comparisons

The View Employee Grade Compariso window compares the compensation values you enter for employees with the minimum, maximum, and mid values you define for their grades.

Prerequisites

- Define a grade rate and enter minimum, maximum, and mid values for each grade.
- Enter salary or other compensation values for your employees.

To view employee grade compariso values:

1. Select an element, an input value, and a grade.

The inquiry finds assignments that are on this grade and that have an entry for this input value.
2. Select a grade rate for which you have defined a range of valid values.

The inquiry compares the minimum, maximum, and mid values for your chosen grade with the element entries of the list of assignments.

3. Choose the Find button to run the inquiry.

The folder in the lower part of the window lists the assignments that match your selection criteria:

- The *value* is the element entry value for each assignment.
- The *comparatio* shows the assignment’s element entry as a percentage of the mid–value defined for the grade rate.
- The *percent of range* shows the position of the assignment’s element entry between the minimum value for the grade rate (0%) and the maximum value (100%).

**Part Time Employees**

Employee are part time if the hours on their assignment’s standard conditions are less than the work day hours entered for their organization. For part time employees, the system prorates the minimum, maximum, and mid grade rate values before calculating the comparatio and percent of range.
Relating Pay to Grades Indirectly: Using Pay Scales

If you are involved in negotiating pay levels with staff or union groups, you may be using a system of grade steps or points with specific values of pay for each step, or point. For example, you may have negotiated different pay scales with different union groups. Or, you may have negotiated a single set of pay points for all of your employees.

Typically, employees are placed on a step within their grade. They move up the steps for the grade by a periodic incrementing process. This process might run automatically at a fixed time each year or it might be based on a review process specific to the employee.

In Oracle HRMS you set up a pay scale to show the separate points and the value negotiated for each point. You can set up any number of pay scales, for example for negotiated pay scales with different unions.

Setting Up Pay Scales

To set up a pay scale:

1. Create the pay scale itself, which is a set of progression points.
2. Define one or more rates associated with the pay scale, entering a value for each progression point.
3. Define your grade scales, which are the points of the pay scale that are valid for each grade.

You can define the rates before or after you define the grade scales.

Using Pay Scales

You manually place an employee on the appropriate grade step. You can use a process to automate the periodic incrementing of the grade step placements for some or all employees.

See Also

Incrementing Grade Step Placements: page 4 – 18
Placing an Employee on a Grade Step: page 4 – 17
Defining a Pay Scale

You define a pay scale, which is a set of progression points for compensation, in the Pay Scale window.

To define a pay scale:

1. Enter a unique name for the pay scale.
2. Enter the Increment Frequency for this pay scale. For example, if you want to increment the placement of assignments on the pay scale once each year, enter 1 in the Number field and select Year in the Per Period field.

   **Note:** These values provide information only. You can use the Submit Requests window to set up automatic regular incrementing of grade step placements by the Increment Progression Points process.

   See: Incrementing Grade Step Placements: page 4 – 18

   The Automatic Increment field shows the date of the last automatic increment.
3. Save the pay scale.
4. Enter the names of the points (or steps) of the scale. The Point names can be numeric or alphanumeric. Enter them in ascending order.
5. Enter a sequence number, in ascending order, for each point. The sequence determines the progression order for the incrementing process. Then save the scale again.

**Suggestion:** Enter sequence numbers in multiples of 5 or 10, for example 5, 10, 15, 20. This makes it easier to enter new points between existing points in the sequence if you need to in the future.

## Defining Scale Rates

In the Scale Rate window, you can create a rate and enter a fixed value for each progression point on a pay scale. You can create as many rates as you require, such as one for a shift allowance, and another for overtime. Notice that, unlike grade rates, you can only enter a fixed value for each point; you cannot enter a range of valid values.

The values are datetracked so that you can keep the history of the actual values you use. You can also set up rate values at a future date and be sure that this information will automatically take effect on the date you set, and not before.

The rates can be defined in monetary units, or as integers, numbers, days, or hours, in various formats. For example, you could define a rate in hours to specify the maximum number of overtime hours that can be worked per week.

When you define rates, an automatic process creates corresponding database items that formulas can access.

See: Dynamic Database Items: page C – 19
To create a scale rate:

1. Set your effective date early enough to handle any historical information you want to enter.
2. Enter a unique Name for the rate.
3. Select the Units for measuring the rate, such as hours, money, or integer.
4. Select the Pay Scale for which you are defining the rate.
5. Save the rate.
6. In the Progression Point Values block, select the points for which you want to define rates. For each point, enter a fixed value. Save the rate again.

Relating Grades to Progression Points

A pay scale defines a complete set of progression points. You can associate a subset of these points with each grade.

The group of points valid for a grade is called a grade scale. Each point in the grade scale is called a step because it represents the steps for incrementing an employee’s pay. The steps must follow the sequence of points on the pay scale but they can jump several points, if appropriate to the specific grade.

![Figure 4 – 4 Grade Scales](image)

<table>
<thead>
<tr>
<th>Pay Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Point</strong></td>
</tr>
<tr>
<td>10</td>
</tr>
<tr>
<td>20</td>
</tr>
<tr>
<td>30</td>
</tr>
<tr>
<td>40</td>
</tr>
<tr>
<td>50</td>
</tr>
<tr>
<td>60</td>
</tr>
<tr>
<td>70</td>
</tr>
<tr>
<td>80</td>
</tr>
</tbody>
</table>
To create a grade scale:

1. Set your effective date early enough to handle any historical information you want to enter.

2. Select a grade, and select the pay scale from which you want to choose progression points.

3. Select the highest point (or ceiling) to which employees on this grade can be automatically incremented by the Increment Progression Points process. Save the grade scale.
   
   You can override this ceiling for individual employee assignments.

4. In the Grade Steps block, select the points you want to include on this grade scale.

   When you save, the system sorts the points into ascending order by their sequence numbers (defined in the Pay Scale window).
Placing an Employee on a Grade Step

If you include a grade as part of an employee’s assignment, you can place the employee on a step on the associated grade scale.

You place an employee using the Grade Step Placement window. When you open this window, information about the grade and scale appears automatically. By default, the ceiling point is the one you defined for the grade. However, you can enter a special ceiling point for individual employees in the Assignment window.

To place an employee on a grade step:

1. Set your effective date to the date when the placement should come into effect.
2. Select the point or step on which to place the employee assignment.
3. If you want the employee’s placement to increment automatically when you run the Increment Progression Points Process, check Auto-Increment.
4. You can select a reason for manually entering a placement. You can add values to the list of valid reasons by defining values for the QuickCode Type PLACEMENT_REASON.
5. Save your work.
The Progression Point Values block displays the rates you have defined for the pay scale, and the values corresponding to the selected progression point.

### Incrementing Grade Step Placements

You can increment grade step placements manually, using the Grade Step Placement window, or automatically, by running the Increment Progression Points process.

**To run the Increment Progression Points process:**

1. Navigate to the Submit Requests window.
2. In the Name field, select Increment Progression Points.
3. Enter the Parameters field to open the Parameters window.
4. Enter the name of the pay scale.
5. Enter the date on which the increment becomes effective.
6. You can also enter values for some or all of the segments of your People Group Flexfield. This restricts the assignments incremented by the process to those in the group matching the values you enter.

**Attention:** An assignment’s grade step placement is incremented automatically only if:

- it is still below the ceiling point, and
- the automatic increment check box on the Grade Step Placement window is checked for the assignment, and
- there are no future changes or deletions to the assignment’s grade step placement, or to the assignment itself, or to the grade scale for the assignment’s grade, or to the new grade step for the assignment.

Oracle HRMS supplies two predefined reports to help you predict and check the results of the Increment Progression Points process.
Current and Projected Progression Point Values Report

Run this report before running the Increment Progression Points process, to assess its effects. The report shows what changes would be made by the process and how much it would cost for a particular scale rate, such as salary, or for all rates.

You run reports in the Submit Requests window.

To run the Points Values Report:

1. In the Name field, select Current and Projected Progression Points Values Report.
2. Enter the Parameters field to open the Parameters window.
3. Select a Pay Scale and enter the date on which the increment would become effective.
4. You can also select an organization, a group, and a rate, to reduce the scope of the report.
5. Choose the Submit button.

Employee Increment Results Report

Run this report after running the Increment Progression Points process. This report shows the results of the process.

You run reports in the Submit Requests window.

To run the Employee Increment Results Report:

1. In the Name field, select Employee Increment Results Report.
2. Enter the Parameters field to open the Parameters window.
3. Select a Pay Scale and the increment process run for which you want to see the results.
4. You can also select an organization, a group, and a rate, to reduce the scope of the report.
5. Choose the Submit button.
This chapter explains how to set up payrolls to pay your employees and to define groups of employees who are eligible to receive particular compensation and benefit elements. It also explains how to define payment methods for paying employees and making third party payments.

Using all the work structures you set up, you can identify groups of employees by organization, job, position, grade, employment category, salary basis, or payroll. Additionally, you may need to set up your own groups, for example to identify employees within a trade union, or a pension group. This chapter explains how you can set up your own groups using the People Group Key Flexfield.
Representing Payrolls

In Oracle Payroll you set up payrolls to pay your employees. An employee must have an assignment to a payroll in order to receive pay. Both human resources and payroll users can also use payrolls for other purposes:

- to identify specific groups of employees for inquiry or reporting purposes
- to define eligibility for certain compensation elements
- as part of security definitions, to restrict access to the records of certain groups of employees on the system.

**Note:** You must define payrolls in order to use nonrecurring elements. You can use these elements to represent types of compensation and benefits, and to maintain absence balances for your employees.

See: Element Entries: page 7 – 5

You can define as many payrolls as you require to represent groups within your workforce. You might need to define multiple payrolls for the following reasons:

- You require different payment frequencies (weekly or monthly) for different groups of employees.
- Your enterprise has registered more than one PAYE scheme.
- You need to restrict access to certain payroll information for reasons of confidentiality.

![Figure 5 – 1
Multiple Payrolls in a Business Group](image-url)
Each payroll has its own processing calendar, key dates, costing information, tax details and available payment methods.

## Defining Payment Methods for the Enterprise

Oracle HRMS provides three possible payment method types. These are BACS, cheque and cash.

Within these payment method types, you can define as many payment methods as you require for your enterprise. When you create a payroll you can select which of these methods are valid for employees assigned to that payroll. You select one of these methods as the default method for the payroll.

Employees can be paid by one or more of the valid methods for their payroll. You select the appropriate methods and enter bank account information, if required, in the Personal Payment Method window. If you do not enter any personal payment methods, the employee is paid using the default method for his or her payroll.

You can also define payment methods for third party payments, such as court-ordered wage attachments. Third party payments are always made by check, so methods for these payments must have the type Check.

Define payment methods for the enterprise in the Organizational Payment Method window.

---

To define a payment method:

1. Set your effective date to the date you want to begin using the payment method.
2. Enter a name for the payment method, and select its type. You can create as many payment methods for each type as you require. For example, if you have different source bank accounts for different payrolls, you must create separate payment methods.

3. The base currency for the Business Group appears. For some payment methods, you can select another currency.

4. Select the Third Party Payment check box if this method is for making payments to third parties, for example for employee benefits or court-ordered deductions.

5. Enter the Bank Details field to open the Bank Details window. Enter information about the account from which payments are coming.

6. Enter further details for BACS Tape in the Further Information descriptive flexfield. BACS User Number is required.
   Enter bureau details only if your enterprise uses a payments bureau.
   In the two Limit fields, set maximum values for the total payment and for each individual transaction. These are BACS security procedures.
   The Contra narrative is text you enter to further identify the file of transactions being sent to BACS. It appears on the Contra record and on the Acceptance Advice received from BACS as confirmation that the data has been accepted.

7. Save your work.

See Also

Entering Payment Methods for an Employee Assignment: page 14 – 19
Defining a Payroll

A payroll is a set of employees whose pay you process with a single frequency, for example, weekly or monthly. You can define as many payrolls as you require to meet the pay policies of your enterprise. You put an employee on a payroll by assigning him or her to the payroll.

Use the Payroll window to define a payroll, including its calendar and valid payment methods.

Period Types and Calendars

Since a payroll has only one pay frequency, you must define at least one payroll for each pay frequency you use. Table 5–1 shows the valid period types for pay frequency.

<table>
<thead>
<tr>
<th>Payroll Period Types</th>
<th>Periods per Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year</td>
<td>1</td>
</tr>
<tr>
<td>Semi-Year</td>
<td>2</td>
</tr>
<tr>
<td>Quarter</td>
<td>4</td>
</tr>
<tr>
<td>Bi-Month</td>
<td>6</td>
</tr>
<tr>
<td>Calendar Month</td>
<td>12</td>
</tr>
<tr>
<td>Lunar Month</td>
<td>13</td>
</tr>
<tr>
<td>Semi-Month</td>
<td>24</td>
</tr>
<tr>
<td>Bi-Week</td>
<td>26</td>
</tr>
<tr>
<td>Week</td>
<td>52</td>
</tr>
</tbody>
</table>

Table 5–1 Payroll Period Types

Prerequisites

- Define the payment methods available for your employees.
To create a new payroll:

1. Set your effective date to a date early enough to handle any historical information you want to enter. Your effective date must be on or before the first period start date of the payroll calendar.

2. Enter the payroll’s name and select its period type from the list.

3. Enter the end date of the payroll’s first period, and the number of years for which the system should initially generate the payroll’s calendar. You can increase this number later to generate additional years.

   When you enter the First Period End Date, make sure that the corresponding start date of the first period is after the start date of the payroll.

4. Enter any date offsets you require for the payroll. Offsets are calculated from the last day of the payroll period. As UK legislation requires all offset dates to be within the payroll period, your choice is between a negative integer, such as –2, and zero, which is the default. You can specify offsets for:

   • the normal payment date: this is the effective taxpoint date for the period which determines statutory processing
   • the BACS processing date: the date you specify appears on the BACS header and is the effective date of the BACS process
   • the date you issue pay advices: this date appears on your pay advices
   • the cut off date for entries to the current payroll period: this is informational
These offsets are the defaults for the calendar. You can manually make date changes in the calendar, for example when an offset date falls on a weekend or holiday, by choosing the Period Dates button.

5. Select a default payment method for employees who have no valid personal payment method. You cannot select a method using magnetic tape because this requires information about employees’ bank accounts.

6. Select a default consolidation set for this payroll. One consolidation set is created automatically when you define your Business Group. Oracle Payroll users can create other consolidation sets for payroll processing.

7. In the Costing region, you can enter information about the set of books and suspense account holding costing information for this payroll. The information you enter here depends on the setup of your Cost Allocation key flexfield.

   See: Setting Up the Cost Allocation Key Flexfield: page 11 – 3

8. Check the Arrears Payroll checkbox if you want to use Advance Pay for an arrears payroll. You do not need to check the box just to run an arrears payroll.

   See: Advance Pay Process (Oracle Payroll UK User’s Guide)

9. Check the Negative Payment Allowed checkbox if you want the pre-payments process to include negative payments. If you leave the box unchecked, pre-payments ignores negative payments.

10. If you are an Oracle Payroll user, enter the Statutory Information field to open the Statutory Information window.

    **Note:** The Statutory Information field is not visible if your HR:User Type profile option is set to HR User.

    - **Tax Reference:** Each payroll has a separate tax reference number that is recorded on statutory reports.
    - **Permit Number:** This is the DSS permit number for sending end of year returns on magnetic tape.
    - The payment of holiday pay in advance and the method of calculating National Insurance within your enterprise are determined by your business rules.
    - **HM Forces:** HM Forces establishments should enter Yes to enable Oracle Payroll formulas to process NI at the appropriate Forces rate. Other enterprises enter No.
    - **BACS Payment Rule:** Select either Next banking day or Previous banking day. This becomes the alternative payment day when BACS payments fall due on a weekend or public holiday.
• **SMP Recovered**: At the end of each year you enter the amount of SMP to be recovered for the year.

• **SMP Compensation**: At the end of each year you enter the additional amount you can claim under small employer’s relief for SMP, if applicable.

• **SSP Recovered**: At the end of each year you enter the amount of SSP to be recovered for the year.

**Note**: The information you enter in these last three fields appears in the End of Year report. Enter the amounts as figures only in the form you want them to appear in the report, for example, 1000.00.

11. Save your work.

12. Choose the Period Dates button to view the calendar generated for your payroll. In the Period Dates window:

   • You can view the default offset dates for every period, and you can manually override any of these dates in any record.

   • You can change the payroll’s default Open status in any period to Closed to prevent further element entries. You can also reopen the period if necessary.

**Attention**: Use this feature with caution. When you perform certain important tasks in Oracle HRMS, the system may automatically create or delete element entries. These tasks include hiring and terminating people, and updating assignments. You cannot change any element entries that span a closed payroll period, and so you may be prevented from performing these tasks.

13. Choose the Valid Payment Methods button to add valid payment methods for this payroll.

   In the Valid Payment Methods window, the default payment method for the payroll appears automatically. You can add other methods. First set your effective date to the date you want the method to become valid.

   **Note**: An employee assigned to this payroll can have any number of personal payment methods chosen from those you enter here for the payroll.

   See: Entering Payment Methods for an Employee Assignment: page 14 – 19
Deleting Payrolls

You can delete a payroll if there are no active employee assignments or element links to it. However, if you have run processing for a payroll it is not advisable to delete it. If necessary, define a new payroll and simply discontinue use of the old payroll.
Representing Other Employee Groups

All the work structures provide ways of defining groups of employees at your enterprise, such as groups working at a particular location, or on a certain grade, or in a department. You create the groups by assigning employees to the work structures in the Assignment window.

You can also assign people to:

- an employment category: full-time – regular, full-time – temporary, part time – regular, or part time – temporary
- a salary basis, such as weekly or annual, which defines the duration for which the employee’s salary is quoted

Oracle HRMS provides a special structure you can use to define any other special groupings of employees your enterprise requires. This structure is called the People Group. Just as with payrolls and other work structures, you can assign employees to these groups, and use them to define employee eligibility for compensation and benefits elements.

Examples of group definitions might be:

- members of a union
- members of a pension plan.

Setting Up the People Group Flexfield

The People Group is a key flexfield, like Job Name, Position Name, and Grade Name. As with these other key flexfields, you can define up to 30 segments to hold information you use to identify employee groups in your enterprise.

Using the People Group key flexfield to define your groups is a powerful mechanism because you can:

- link elements to Group flexfield segments so that only employees within the group are eligible for the elements
- inquire and report on individual segments in Inquiry windows and in reports
- use DateTrack to build up a history of the group information

If your enterprise uses pay scales to relate compensation levels to grades indirectly, you can use a People Group segment to specify which employees are processed by the Increment Progression Points process.
Once you decide how to define the Group key flexfield structure and segments, it is the responsibility of the System Administrator to set up this and the other key flexfields. At least one segment of this flexfield must be set up before you can begin entering employee assignments.

Attention: If you make any of the People Group segments required, they are required in the Element Link window, as well as the Assignment window. This means that you may have to create multiple element links if you want to use a People Group segment in the eligibility criteria for a link.

For example, suppose you have defined two segments: a Yes/No segment called Fast Track, which is required, and a segment called Pension Plan, which is not required. You want to make an element available only to members of a certain pension plan. However, you must create two element links: one for members of the pension plan who are on the Fast Track, and another for members who are not on the Fast Track.

If there are many possible values for the required segment, the maintenance of multiple links can become a burden so be cautious in making segments of this flexfield required.

See Also

Oracle Applications Flexfield Guide
Each enterprise has its own unique ‘culture’, which is reflected in the organization of work and in the management of people within the enterprise. Culture also affects the reward systems in operation and the control systems that are required. Although each enterprise is unique, it is possible to identify some common types of enterprise.

This chapter describes three typical enterprise models and suggests how you might implement Oracle HRMS for each of these. These suggestions are not intended to provide a blueprint for your own implementation, but they should help you to see how you can implement and use different combinations of organizations and jobs, or positions in your own situation.
Project Based Enterprises

Project based enterprises are typically service based industries in which flexibility and organizational change is a key feature. Examples of this type of enterprise are consultancy or construction companies, or small manufacturing or software companies.

At its simplest level, an employee is assigned to work on a single project for a given period of time. For example, an engineer working on a large scale construction project might be assigned to the project for a period of six months. All of his or her work, and costs, are associated with this one project. When this is complete the employee moves on to perform a similar role in another project. In this example you would expect the employee to have a single assignment, with 100% of the assignment costs allocated to a single project. The employee assignment might also contain project specific information, such as location or group information.

In a different situation, an employee might be assigned to a number of projects at the same time. For example, consider an Applications Consultant working for Oracle Corporation. This person is employed as a consultant by a specific organization within Oracle but the project work is undertaken outside Oracle. The consultant performs similar tasks in different implementation projects, and costs are allocated on the basis of actual time spent working on each project. In this example you would expect the consultant to have a single assignment in Oracle HRMS and the project allocation and costs to be entered as timecard information.

In both of these examples, employees perform specific roles, but they work on different tasks or projects at different times. Project based enterprises normally have a fluid organization structure with regularly changing reporting and management lines. This fluidity provides the flexibility required to compete in rapidly changing markets.

Organizations can be formed or transformed at short notice as different projects or management groups are formed. Employees can be assigned and reassigned to these organizations, also at short notice, although they normally retain their basic role, or job.

Representing Organizations and Jobs

In both of the examples given, you need the ability to define and change organization structures easily and quickly. You also must be able to move employees between organizations while keeping the same job. For both of these reasons, you would probably use organizations and jobs to show how people are assigned and managed.
Jobs are independent of organizations. In the Assignment window, you can change the assignment organization or job independently.

Typically, you would not define Positions to show this type of working. Positions require additional definition and maintenance, and do not reflect the sort of flexible working environment found in this type of enterprise.

Working with organizations and jobs as the basis of the employee assignment, you can also consider how you would reflect the assignment of the employee to individual projects. There are a number of possible options to consider.

- Use organizations to show actual projects, and assign employees to projects.
  - Useful for single projects. For multiple project assignments you would need to use multiple assignments.

- Use a People Group flexfield segment to hold the project code.
  - An alternative for single projects, where you want to use the organization to show internal management structures. However, for multiple project assignments you would still need to use multiple assignments.

- Use a Cost Allocation Flexfield segment to hold the project code.
  - Useful for both single and multiple project assignments. You can collect project cost information at the work assignment or the timecard entry level.

### Organization Structures

You should define organizations down to the level of individual managers, and use the manager flag on the Assignment window to identify the manager of each organization. Also, define your primary organization hierarchy to show the detailed management reporting lines among organizations and managers. In this way you can show that employees assigned to an organization are managed by the organization’s manager.
Attention:  It is best not to use the Supervisor field of the assignment window to identify managers for individual employees. This field is used to identify a personal supervisor for an employee and is not updated if the supervisor moves to another job or organization.

Job Structures

In this type of environment, jobs show the specific roles employees perform. Therefore, you are likely to have multi-segment job names to distinguish different types and different levels of jobs in the enterprise. For example, you might define a three segment job name with Job Group, Title, and Job Level. An actual job combination might then be 'Applications.Consultant.Senior'.

Project Allocation and Costing

With this type of implementation, you would probably use the assignment to identify management type reporting. You would identify project-working using a segment of the Cost Allocation flexfield to show Project Code for each assignment.

If you set the qualifier Assignment to Yes for this segment, you could enter percentage costs for the assignment to different project codes. If you set the qualifier Element Entry to Yes for this segment, you could use a timecard element to record and cost the actual hours worked on each project.

See: Setting Up Assignments for Cost Collection: page 11 – 5

Other Management Issues

When you consider this environment there are other areas your decisions may affect:

<table>
<thead>
<tr>
<th>Remuneration Policies</th>
<th>Individual compensation and benefits are often based on personal negotiation, or performance reviews. Therefore you will probably have fewer rules to determine policy and more consideration of the actual values entered for an employee.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grades and Jobs</td>
<td>Typically grades and jobs are very closely linked. For example, the name Senior Consultant may identify both the role of an employee and his or her relative status and eligibility for compensation and benefits.</td>
</tr>
</tbody>
</table>
You may decide to set up the same structures for both the job and the grade. This will be true if you want to set up rates of pay with minimum and maximum values associated with your grades.

**Budgets**

Headcount budgets are usually allocated at the level of the organization, or to the combination of organization and job.

You can calculate your salary budgets from the definition of organization and job headcount budgets, combined with valid grades and grade rate information.

Actual salary costs in an HR environment can be calculated from the actual salaries of assigned employees.

Actual salary costs in an environment including Oracle Payroll can be calculated directly from payroll results.

See: Salary Budgeting: page 10 – 18

**Vacancies and Recruitment**

Vacancies are not created by default whenever an employee leaves. Managers often have the freedom to decide if they want to replace an employee, or to recruit to a different role.

The recruitment process is often informal and allows for recruitment by resume, or cv. Individual managers are usually responsible for interviewing and selecting candidates. This may be on a one-to-one basis.

**Career Planning and Development**

The need for individual career planning and development is matched by the need to identify skilled employees for specific projects.

Using *Special Information Types* you can easily define experience, education, qualifications or skills requirements for different jobs. Using these sane information types you can enter information under these headings for individual employees. Oracle HRMS includes a skills matching report.
Rule Based Enterprises

The rule–based enterprise is typically a highly structured environment in which all aspects of work and remuneration are well organized and regulated. Common examples of this type of enterprise are found in government, education, health and other public sector industries. A key feature of this type of enterprise is the concern with managing positions, or posts. Positions exist, and are managed independently of people in post.

You can picture the role type organization as a ‘Greek temple’, which rests its strength in its pillars. These pillars are the specialist functions or departments that exist within the enterprise. They are strong and almost independent organizations. For example, the Finance department would have very little involvement in the working of the HR department.

Coordination between the groups takes place at the top of the structure by a narrow band of senior management – the pediment. In this environment it is assumed that this should be the only personal coordination needed. “If the separate pillars do their job, as laid down by the rules and procedures, the ultimate result will be predictable.”

Roles are usually more important than individuals. People are selected for satisfactory performance of a role, which is described so that a range of individuals could fill it. Reward systems are likely to be role or rule-based.

Often, clearly defined procedures exist for every task and process within the enterprise. For example, job descriptions and job evaluation procedures define individual roles and positions of authority. Also, it is common to find that procedures exist to govern communications, such as colored and numbered forms, committee reports, and so forth.

Representing Positions

‘Positions’ are most appropriate for this type of enterprise and provide the finer detail on work structure and line management that is needed in a fixed establishment. Employees are assigned to a position, and by definition to the organization and job for that position.
Because you are focussing on the use of positions and position hierarchies you define organizations to show only the major divisions in your enterprise. You can model the details of these departments and sections using your position hierarchies. (If you also define detailed organizations and hierarchies, you are defining the same structural information twice.)

In this situation, jobs provide an additional level of information for positions, which is independent of any specific organization. For example, you might want to define job types of 'Managerial', 'Executive' or 'Clerical' so that you can identify skill requirements and levels of benefits for each job.

Position Name

In this environment you should consider using the segments of the position name to hold other key information about the position. For example you might want to consider using the following as segment values:

- **Cost Code**
  You might want to show the cost center, or a cost code for each position in your establishment. Using the segment of the key flexfield you could use the same list of cost codes as your general ledger.

- **Funding Organization.**
  You might have funding for a position from an external source. For example, government funding.

- **Multiple assignments allowed – Y/N?**
  In Oracle HRMS a position can have any number of holders. You can set headcount budget values to track any variance on budget, or you could use this type of segment to prompt users.
• Current status.

As part of your position control procedures you may need to mark the status of a position for reporting or management purposes. For example, you can label a position as ‘Frozen’, ‘Vacant’ or ‘Active’.

**Note:** You can use the Additional Position Details descriptive flexfield to hold this type of information about positions if you do not want the information to be visible to all users.

**Management Reporting Lines**

You can define a primary position hierarchy to show the management reporting lines for all of your positions. You should find that most of your security and reporting needs are based on this primary hierarchy. Groups are identified by selecting a manager and all the positions that report to it in this hierarchy.

**Other Management Issues**

When you consider this environment there are other areas your decisions may affect:

<table>
<thead>
<tr>
<th>Remuneration Policies</th>
<th>Individual compensation and benefits are often regulated, or based on union negotiated agreements. Reward systems are usually based on the role performed rather than on personal or performance assessment. This may mean that you have to define detailed eligibility rules for compensation and benefits.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comparative Grades and Positions</td>
<td>Valid grades are defined for positions and it is common to use grade steps and progression points. National or union pay scales establish actual rates of pay for a grade and this is independent of performance. An employee is paid the rate for his or her grade and step. Incrementing rules, which determine progression to the next step, are usually part of the plan and are often time-based. Job evaluation methods exist to compare roles across the industry with agreed grading structures and rates of pay.</td>
</tr>
<tr>
<td>Budgeting</td>
<td>Headcount or full-time equivalent budgets are usually set for each position.</td>
</tr>
</tbody>
</table>
You can calculate your Salary budgets from the position budgets, combined with valid grades and progression point information.

In an HR environment you would calculate actual salary costs, at any time, from the current salaries of assigned employees.

In an environment including Oracle Payroll, you would calculate actual salary costs directly from payroll run results.

See: Salary Budgeting; page 10 – 18

Vacancies and Recruitment

There is an automatic vacancy when an employee terminates employment. The position exists even when there are no holders.

The stages of the recruitment process and the procedures surrounding these are probably well defined and regulated.

Standard letters for each stage of the process are also likely to be well established.

In this environment people are recruited for their ability to perform a role. You would hold job descriptions and skill requirements for each position using attachments for text and the Special Information Type for structured data.

Typical Reports

Typically there is a well defined set of standard reports needed in this environment. Often these are required by government.
Hybrid Enterprise Structures

Many enterprises combine different types of structure for different groups of employees. Typical of these hybrid types are large manufacturing or corporate enterprises where management and administrative roles are fixed into specific organizations, but other roles are managed in a more flexible manner.

In Oracle HRMS you would set up this type of hybrid enterprise using positions for some groups of employees, and organization and jobs for others. For example, in one factory organization you might define a position for the Production Manager, and one job for all production line workers.

Employee Assignments

In this type of enterprise most of your workers would be assigned to an organization and a job. However you would define management positions because they have the characteristics of fixed roles within specific organizations, including the idea of automatic vacancy on termination of the assignment. In each organization you would have only one position. This would be the manager, and by default, any other employee who works in the organization would report to the manager.

Other Management Issues

Other issues for managing groups of employees by position, or by organization and job are the same as for the previous examples.
<table>
<thead>
<tr>
<th>Remuneration Policy</th>
<th>Employees working in unionized jobs participate in negotiated rates of pay and conditions. You would define grade rates or progression points to deal with negotiated pay rates for workers in jobs.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Salary Administration</td>
<td>Employees in management positions are more likely to have their salary administered personally and be reviewed on their performance. You define grade rates and salary bases to deal with salary administration for employees in positions.</td>
</tr>
</tbody>
</table>
Contract Staff and Other Non-standard Assignments

It is common to find individuals working within an enterprise who do not fit into the general definition of work structures. For example, you may have agency or contract staff working temporarily to cover a vacancy, or you may have external contract staff working as part of a project team.

The way in which you record information for these individuals depends on how you manage them:

- You can treat the assignment for this type of employee in exactly the same way as any regular employee.
- Alternatively, you could set up a different person type to distinguish this type of employee.
- You could define your own types of employment category to distinguish different ways of working at the assignment level.
- You could define and use your own assignment statuses to identify different ways of working in a particular job or position.

However, you might decide that the person does not work in a predefined role, but is simply working in a particular organization for a set period of time. To do this you would assign the employee to an organization only, and focus on the other assignment information for further information.

**Attention:** A basic rule in Oracle HRMS is that an employee must have an assignment. The minimum work structure required for an assignment is the Business Group.
CHAPTER 7

Representing Compensation and Benefits in Oracle Human Resources

Compensation and benefits information forms the basis of the individual remuneration package for each employee. Human resource departments maintain this information and typically also track the costs associated with compensation and benefits. Over time you can use this information to track the compensation history for each employee and to plan and implement policy changes.

This chapter deals with the issues of compensation and benefit management from a human resource perspective. This means that it is primarily focussed on the management issues associated with modelling compensation and benefits in Oracle Human Resources.

Attention: If you are interested in processing this information using Oracle Payroll you should also read the chapter on Earnings, Deductions, and Benefits in your Oracle Payroll User’s Guide.
Representing Compensation and Benefits

With Oracle HRMS you define a working model of your own types of compensation and benefits, and the policies, or business rules that govern the allocation of these to your employees.

The first step in the process is to define the separate types of compensation and benefit you want to track. In Oracle HRMS, you define these as elements.
Introducing Elements

Elements represent the compensation and benefit types that you give to your employees. In a payroll environment these are also the earnings and deductions that contribute to the overall pay of an employee and appear on a pay advice. Typical examples include regular salary and wages, bonus payments, health insurance enrolment, tax and insurance payments, stock purchase plans and pension contributions.

You can also define elements to represent direct payments to employees that are not part of their pay (such as expense reimbursements) or employer payments on behalf of employees (such as pension contributions).

A further use of elements is to hold information that is a non-payment type. For example, you might use elements to track which employees have received non-payment benefits or equipment such as mobile telephones, company cars, or uniforms.

There is no limit to the number of elements you can define and all your definitions are datetracked.
Element Classifications

In Oracle HRMS, elements are grouped into primary classifications such as Earnings and Voluntary Deductions. In a human resources department, you can use the classifications to identify groups of elements for information and analysis purposes. In a payroll department, you use the classifications to control processing, including the order in which elements are processed, and the balances they feed.

These primary element classifications are supplied. You cannot change them as they are designed to meet the legislative requirements of your country.
Element Entries

To enter details of any compensation or benefit type for an employee you make an *element entry* for that employee.

**Effective Duration of an Entry**

Some entries are relevant to one pay period only, while others represent payments to be made every pay period.

For example, when you enter salary for an employee you probably expect to continue payment of this until you change or end the entry. In contrast, you would probably expect an entry of overtime hours to be dealt with as a single payment in the period in which it is entered.

![Figure 7-2](image)

**Recurring**

This means that, once the element is entered for an employee, the values apply in every subsequent pay period. For example, your salaried employees expect to receive their salary once every pay period regardless of any other variable factor.

**Nonrecurring**

This means that any entry for this element applies only in the pay period in which it is given to the employee. For example, you might define an overtime element to record the number of overtime hours worked in any pay period. You would use this information to pay the employee once only.
Attention: For each employee, the pay periods are derived from the definition of the payroll to which the employee is assigned.

See Also

Entering Compensation and Benefits: page 9 – 2
Element Input Values

When you define an element, you must consider what information you want to record each time you make an entry of the element for an employee.

Typically, you would expect to record more than just the name of the element. For example, if you defined an element to record employee expenses, you might want to record the Type, as a code value, and the Claim Amount as a monetary value.

In Oracle HRMS you define these values as input values for the element. When you define an element, you can define up to 15 input values for it. You decide which values you want to record and what limits, or validation, to apply to those values.

Input values can be numbers, text, dates, times, hours, or monetary values. You also decide whether each input is required or optional when an entry of the element is made for an employee.

Processing Input Values

Input values are so called because they are the inputs to calculations performed by Oracle Payroll. In a payroll run, formulas process the input values and other database information to produce run results.

For example, if your enterprise makes overtime payments, you might write a formula to calculate the payment amounts for each assignment from inputs of the overtime rate and the hours worked for the period. The payroll run then processes each assignment and produces the overtime payment amounts as run results.

Run results are used for other purposes besides summing the amount of employee pay. In the overtime example, the run result information can also be used for costing purposes and to track the actual hours of overtime worked.

Table 7–1 shows the input values, with some representative entries, for the element NI Car Primary. This is a recurring Information element, predefined in Oracle Payroll, which you enter for employees with company cars. The run results of the processed element feed a balance that accumulates the employer’s Class 1A contributions to company car benefit.
<table>
<thead>
<tr>
<th>Input Value Name</th>
<th>Type</th>
<th>Entry</th>
<th>Validation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pay Value</td>
<td>Money</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Price</td>
<td>Money</td>
<td>12000.00</td>
<td>Min. – Max.</td>
</tr>
<tr>
<td>Registration Date</td>
<td>Date</td>
<td>24–JUN–1994</td>
<td></td>
</tr>
<tr>
<td>Registration Number</td>
<td>Character</td>
<td>L 123 ZYX</td>
<td></td>
</tr>
<tr>
<td>Mileage Band</td>
<td>Character</td>
<td>2501–17999</td>
<td>Lookup (GB_MILEAGE)</td>
</tr>
<tr>
<td>Fuel Scale</td>
<td>Money</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Payment</td>
<td>Money</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 7 – 1 Input Values for NI Car Primary Element

### The Pay Value

Oracle Payroll makes special use of the *pay value* to represent the result of processing an element for employee pay. The pay value is the amount paid to the employee from that element after payroll processing. You must define a pay value as one of the inputs for the element if you want Oracle Payroll to process an element for pay. You can have only one pay value for each element and it must have the name ‘Pay Value’.

You can enter a pay value directly as an input to the element. When you do so, no formula will fire during the payroll run to calculate any direct result for the element. Instead, the pay value you enter becomes the run result.

### Validating Input Values

When you define inputs for an element, you also define the validation for each input value. The validation you define controls the values a user can enter. The options are to:

- provide a default value
- provide a minimum and maximum value range
- provide a fixed value
- provide a lookup list of valid values
- validate the input value using a formula

Using the formula option you can model complex business rules for validating entries. For example, for a bonus payment you might want
to set a maximum bonus value that depends on length of service and current salary.

With Oracle’s formula writing tool, Oracle FastFormula, you can include conditional logic to validate input values using different criteria for different employees.

See Also

Defining an Element’s Input Values: page 8 – 8

Using Oracle FastFormula for Payroll Calculations: (Oracle FastFormula User’s Guide

Using Oracle FastFormula for Validation: (Oracle FastFormula User’s Guide
Element Eligibility Rules

Employees can be eligible for compensation elements in a number of different ways. For example:

- You may have a union group, with negotiated rates of pay. All members of the union are entitled to a fixed rate of pay dependent on their assigned grade and step.
- You might also have groups of salaried employees where you negotiate the level of salary with each employee personally. The salary value might be based on a combination of performance, personal, or market factors that are regularly reviewed with the employee.

In both cases you are dealing with a similar type of compensation, but the rules that govern actual values, as well as eligibility and review, are different. You define these rules in Oracle HRMS using *element links*.

Element Links

An eligibility rule for an element is defined as a link between the element and the components of the employee assignment. Each link defines a group of employees who are eligible to receive the element.

For example, you might want to give a production bonus only to those employees who work full time in Production and are on the weekly payroll. To do this you would define a link between the element ‘Production Bonus’ and the combination of the ‘Production’ organization, the ‘Full–Time’ employment category and the ‘Weekly’ payroll.

While this link is effective, you cannot pay the bonus to anyone who is not eligible. Similarly, element linking on deductions ensures that you do not take deductions from employees not liable for them.

An employee is eligible for an element when his or her assignment exactly matches the link definition. You can link an element to the following components of an employee assignment:

- Organization
- Job
- Position
- Grade
- Location
- Payroll
- Group Segments
- Employment Category
- Salary Basis

**Adjusting Element Values for Different Groups**

For each eligibility group, you can also define different default values. For example, you might want to pay a bonus to most employees, with a default value of 2 percent. However, you might want to exclude the Sales department from the bonus, because they are paid on a commission basis, while for everyone in the HR department you might want to default 3 percent.

To do this you would define the bonus element with a default input value of 2 percent. You would then link this to each department in turn, except the Sales department. Employees in Sales would not be eligible for the bonus. When you link the bonus to the HR department, you would change the default to 3 percent.

**Multiple Rules of Eligibility**

You can define more than one link for each element but there must be no overlap between the eligibility criteria for the links. For example, you could create one link to the combination of grade ‘A’ and the job ‘Accountant’. However, you could not create one link to grade ‘A’ and a second link to the job ‘Accountant’. This would imply that an accountant on grade A is eligible for the same element twice.

Oracle HRMS does not permit you to define links that would make an employee eligible for an element more than once.

**Element Qualifying Conditions**

An employee is eligible for an element if his or her assignment matches the eligibility criteria on the link. However, an employee might be eligible for an element and yet not receive it because he or she does not meet other qualifying conditions.

Two common qualifying conditions are a minimum age or a minimum period of service in the current assignment. You can define these conditions when you define the element. You can enter or adjust these conditions when you define the element links so that you have different qualifying conditions for different groups of assignments.
These qualifying conditions are checked automatically when you try to enter an element for an employee.

Using Standard Links for Automatic Element Entry

If you want all employees who meet the eligibility criteria and qualifying conditions to receive a recurring element automatically, you can define Standard links to the element. You can create a standard link if:

- the element is recurring, and
- multiple entries are not allowed for the element

If there are no qualifying conditions, the start date of the automatic entry is the date the assignment becomes eligible for the element. For example, this might be the employee’s hire date, or the date of a promotion or transfer.

If you entered qualifying conditions for the element, the start date of the automatic entry reflects the date on which the employee meets the qualifying conditions. For example, if a new hire is entitled to a company car after six months, an element entry is automatically created when the employee is entered on the system, and the start date of the entry is six months after the hire date.

If the employee’s date of birth is altered on the system, this may change the date on which he or she qualifies for the element. In this case, the start date of the element entry changes automatically.

Manual Element Entries

You may have other qualifying criteria that are performance or assessment based. Perhaps employees must pass a certain test or achieve a certain volume of sales before they qualify for the receipt of the element. For this type of element (and for all nonrecurring elements), you cannot define a Standard link. You must manually enter the element for those employees who should receive it. You can make entries individually or in a batch.
Costing Compensation and Benefits

Using Oracle HRMS, you can record cost information at a number of different levels. These cover the definitions of your organizations, compensations and benefits, individual employee assignments and the specific elements that make up their remuneration package.

When you define the element link you can define how the element values are costed for the group of assignments defined by the link criteria. For example, you may want to cost the same element to different codes for different payrolls.

You can enter Costing information at the element link level if you have set up a segment of the Cost Allocation flexfield with the qualifier Element set to Yes. If you set the qualifier Balancing to Yes, you can do double entry accounting.

The values you enter at the level of the element link apply, by default, to all entries of the element for all assignments matching the link. However, you can set up cost allocation so that users can override the account codes for one assignment, or for a single entry, if required. For example, with timecard entries you may want to record different cost centers for different hours worked. In this case you would want to enter the cost center information when you enter the timecard element.

You enable this by setting up a Cost Center segment with the qualifier Element Entry set to Yes.

See Also

Setting Up the Cost Allocation Key Flexfield: page 11 – 3
Compensation and benefits are represented by elements in Oracle HRMS. This chapter explains how to:

- define elements to record the allocation of compensation and benefits
- define element input values to record details such as the type and level of compensation or benefit awarded to an employee
- define element links to control which employees are eligible to receive each element
- customize the Element Entries window to control the elements a user can see and enter for employees
- track and model changes in your compensation and benefit packages and rules
Setting Up Compensation and Benefits for Human Resources

To set up compensation and benefits for human resources:

1. Define elements to represent your compensation and benefit types. For each element, define the input values a user enters when giving the element to an employee.

2. Link each element to your enterprise work structures to define one or more groups of employees who are eligible to receive it. Employees are eligible for an element only if they are assigned to the work structures that are linked to the element.

3. Specify how the element should be costed for each eligibility group.

4. Make an entry of the element for each employee who should receive it. Depending on how you define and link the element, the entry may be done automatically or manually.

See Also

Defining an Element (HR Users): page 8 – 3
Defining Element Links: page 8 – 10
Costing Compensation and Benefits: page 7 – 13
Entering Compensation and Benefits: page 9 – 2
Defining an Element (HR Users)

Use the Element window to create compensation and benefit types.

Attention: This topic explains how to define elements using an HR responsibility. If you want to define elements to be processed in a payroll run by Oracle Payroll, you must use a Payroll Responsibility. That is, your HR User Type profile option must be Payroll User or HR with Payroll User. This enables you to see additional fields in the Element window in which you can enter information about how the element is to be processed.

See: Defining an Element (Payroll Users), Oracle Payroll User’s Guide

Prerequisites

- Decide how you want to validate the values users enter when they give an element to an employee.

If you want to restrict their entries to a list of valid values, use the QuickCode Types window to define a new lookup. Then enter your valid values for this lookup in the QuickCodes window.

See: Adding QuickCode Values: page 31 – 3

If you want to validate values using a formula, write your formula first using the Formulas window.

To enter dates, names and a classification for the element:

1. Set your effective date early enough to handle any historical element entries you want to make.
2. Enter a unique Name, Reporting Name, and Description for the element. The reporting name is a short identifier for reports and pay advices.
3. Select a Primary Classification.
   In Oracle Payroll, the element’s classification controls its processing priority range, and ensures that it feeds the correct balances.
   If you are defining a salary element for Salary Administration, you must select the classification Earnings.

Processing Information

To enter processing information for the element:

1. Select the Processing Type.
   - *Recurring* means that an entry of this element applies in every period until the entry is ended or until a change of assignment means that the employee is no longer eligible.
   - *Nonrecurring* means that an entry of this element applies in one pay period only. The dates of the pay period are determined by the payroll to which the employee is assigned.
If you are defining a salary element for Salary Administration, you must select the type Recurring. If you are defining an absence element for Absence Management, you must select the type Nonrecurring.

2. Select a Termination Rule. This determines how entries of the element are processed after termination of the employee.

   • Select Actual Termination if you want recurring entries to close down on the date the employee leaves. For a nonrecurring element, select Actual Termination if you want the entries to close down at the end of the pay period in which the employee leaves, or on the date the assignment ends (the final process date) if this is earlier.

   • Select Final Close if you want the entries to stay open beyond the employee’s leaving date so that you can continue to pay the employee.

Only Payroll users can select Last Standard Process.

3. If you want to be able to give an employee more than one entry of the element at the same time, check the Multiple Entries Allowed check box.

4. If you want to be able to make occasional one–off entries of a recurring element, check the Additional Entries Allowed check box.

   See: Element Processing Option Examples: page 8 – 7

5. If you want to prevent any new entries being made for the element, either temporarily or permanently, check the Closed for Entry check box. This does not affect any existing entries of the element.

   **Attention:** Use this feature with caution. When you perform certain important tasks in Oracle HRMS, the system may automatically create or delete element entries. These tasks include hiring and terminating people, and updating assignments. Therefore, if you check Closed for Entry on an element, this might prevent users terminating employees and updating assignments. If there are standard links for the element, it will also prevent users hiring people who are eligible for the element.

---

**Currency**

- **To define currencies for element entry values:**
  - If you want to enter values of element entries in a currency other than the base currency of the Business Group, select the currency in the Currency, Input field.
The Output field displays the currency appropriate for your legislation.

**Qualifying Conditions**

To define qualifying conditions for receiving the element:

1. If there is a minimum age for employees to receive the element, enter it in the Age field.
2. If there is a minimum length of service employees must work before receiving the element, enter a number in the Length of Service field and select a unit of measure (such as months or years) in the Units field.
3. If you want the element to be entered automatically for all employees who are eligible, check the Standard check box.
   
   **Note:** The qualifying conditions and Standard check box provide defaults for the element. You can override them for particular groups of assignments when you define the element’s links.

   See: Defining Element Links: page 8 – 10

4. Save the element definition.

**Further Information**

You can enter the Further Information field if you use Oracle SSP/SMP.

To define input values for the element, choose the Input Values button.

**See Also**

- Defining an Element’s Input Values: page 8 – 8
- Defining and Linking an Absence Element: page 24 – 9
- Defining and Linking a Salary Element: page 10 – 5
Element Processing Option Examples

The options you choose in the Processing Region of the Element window determine the type of entries that can be made for the element and when they can be made.

Multiple Entries

Suppose you define a nonrecurring element for entering the overtime hours worked by monthly–paid employees. If you enter the hours on a weekly basis, you might need to give an employee five entries of the overtime element in each pay period. You need to enable more than one entry of the element in each pay period by checking the Multiple Entries Allowed check box.

Additional Entries

Suppose you define a recurring bus allowance element to be paid every week to employees working at a particular location. You give these employees a normal recurring entry of the element so that they receive the allowance automatically each week.

However, you also want to give the allowance to other employees temporarily working at the same location. You need to check the Additional Entries Allowed check box so that you can give these employees a one–off (nonrecurring) entry of the element.

Notice that for an element defined in this way, an assignment could have:

- a normal recurring entry only
- an additional entry for one pay period only
- a normal recurring entry and an additional entry

The assignment could have several normal recurring entries of the element (if you also checked the Multiple Entries Allowed check box). However, it can only have one additional entry in a pay period.
Defining an Element’s Input Values

To define input values:

1. Set your effective date early enough to handle any historical element entries you want to make.
2. Enter or query the element in the Element window and choose the Input Values button.
3. Enter the name of the first input value. Remember that if you want to define a pay value, you must name it Pay Value.
4. Select the unit type of your input value (money, hours, character, date, number, or time). A Pay Value must have the unit type Money if the element is in a payments type classification.
5. You can use the Sequence field to change the order in which the input values appear in the Element Entries window.
6. Check the Required check box if all entries of the element must have a value for this input.
7. Check the User Enterable check box if users can enter a value for this input. Uncheck it if you want to ensure that the default value is entered for all employees.
8. Check the Database Item check box if the value can be used as a Database Item in formulas or QuickPaint inquiries. Database Items are simple identifiers that the system uses to find specific items of information in the human resources database.

Default Values

To enter a default for an input value:

1. Enter the value in the Default field.
2. If you want existing entries to be updated whenever the default is changed, check the Hot Default check box. The input value must be required if you want to use this option.

A hot default appears in the Element Entries window in quotation marks. If the user overrides the default, subsequent changes to the default will not affect the entry.

Validation

1. To enter validation for an input value:

   • Enter maximum and minimum values for the input.
   
   • Select a QuickCode Type to act as a lookup supplying a list of valid values.
   
   • Select a formula to validate entries for this input value. Formulas can return messages to users about the success or failure of the validation.

2. Select Warning or Error to determine whether the system warns users that an entry is invalid or prevents them from saving an invalid entry. You cannot select a value if you chose a Lookup because a user cannot enter an invalid value for an input value validated by lookup.
Defining Element Links

Use the Element Link window to define groups of assignments that are eligible for an element.

Prerequisites

- In Oracle Payroll, you can distribute direct costs (such as an employer’s contribution to a pension plan) over other elements (such as employee’s pensionable earning elements). If you want costs to be distributed, define a distribution set in the Element and Distribution Set window. This set contains the elements over which you plan to allocate the costs.

See: Defining an Element or Distribution Set: page 30 – 6

To define an element link:

1. Set your effective date to the date you want the eligibility criteria to come into effect.
2. In the Element Name field, select the Element for which you are defining a link.
3. Check the Standard check box if you want all employees who are made eligible by the link to receive the element automatically. You can only create a standard link if:
   - the element is recurring, and
   - multiple entries are not allowed by the element definition
4. In the Eligibility Criteria region, select the assignment components that form the basis of your eligibility rule. If you want to link to all employees, do not enter any eligibility criteria.

You can link to all payrolls or to a specific payroll. Do one of the following:

- Enter the name of a specific payroll if you want only employees on that payroll to be eligible for the element. Do not check the Link to all Payrolls check box.
- Leave the Payroll field blank and check the Link to all Payrolls check box if you want employees assigned to any payroll to be eligible. This rule excludes employees who are not assigned to a payroll.
- Leave both fields blank if assignment to a payroll is irrelevant to eligibility for the element.

Costing

To enter costing information for the link:

1. In the Costing alternative region, select the Costable Type. Notice that some element classifications are predefined as Not Costed and you cannot override this.

   - If you do not want to allocate costs for the element, select Not Costed.
   - If you want all entries of the element to be allocated to the same account, select Fixed Costed. This prevents users overriding the account code at the assignment and element entry levels.
   - If you want users to have the flexibility to override the account code at these lower levels, select Costed.
   - If you want to distribute overhead costs over other elements, select Distributed. Then select a Distribution Set.

2. For deductions elements:

   - Enter the account code you want to credit in the Costing field.
   - Enter the account code you want to debit in the Balancing field.

   For elements in all other classifications:

   - Enter the account code you want to debit in the Costing field.
   - Enter the account code you want to credit in the Balancing field.

Depending on your set up of the Cost Allocation flexfield, the Balancing field may not be enabled.
3. Check the Transfer to GL check box if you want Oracle HRMS to transfer cost totals to the general ledger on completion of each payroll run.

**Qualifying Conditions**

- **To enter qualifying conditions for the link:**
  - In the Qualifying Conditions alternative region, you can add or change age or length of service conditions for this particular eligibility group.
  
  The system checks these conditions when you make an entry of the element. If the employee does not meet the qualifying conditions, you receive a warning.

**Input Values**

- **To adjust input values for this eligibility group:**
  - Save your link definition and choose the Input Values button.

---

**Adjusting Input Values for an Eligibility Group**

In the Link Input Values window, you can adjust the Default, Maximum, and Minimum for each input value. Logically, the new values should be within the range you defined for the element itself. However, this is not enforced.

You can also choose which input values are costed by checking the Costed check box.
Element Link Details Report

This report allows you to check the eligibility criteria that have been defined for an element. You can restrict the information in the report by certain assignment components, by element or element classification, by element processing type, and by link type and status.

You run reports from the Submit Requests window.

To run the Element Link Details report:

1. In the Name field, select Element Link Details Report.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. Select the classification of elements you want to report on. Optionally select an element processing type (recurring or nonrecurring) or an element to further restrict the report.
5. If you want to restrict the links listed in the report to standard links only, select Yes in the Standard Link field. Select No to restrict the report to non–standard links. Leave blank to report on both types of link.
6. You can select a link status to restrict the report to links that are either Active or Inactive at your effective date.
7. Do one of the following:
   - Select No in the All Payrolls field and select a payroll in the Payroll field to report on links to this payroll only.
   - Select Yes in the All Payrolls field and leave the Payroll field blank to report on links to all payrolls.
   - Select No in the All Payrolls field and leave the Payroll field blank, to report on all links irrespective of their payroll criteria.
8. You can also select a job or organization to report on links to these assignment components only.
9. Choose the Submit button.
Customizing the Element Entries Window

As part of the setup of compensation and benefits, you need to plan how users will make element entries. For example, you will want to consider how you will use the MIX facility and which users have access to the Element Entries window.

You can create customized versions of the Element Entries window. A customized version might restrict the elements a user can enter. This enhances speed, usability, and security for specific data entry scenarios.

For example, one version could be restricted to the element name ‘Timesheet’ and accessed from a menu entry labelled ‘Timesheet Entries’.

Element entry can be restricted by:

- Element Set (that is, a group of elements that you define)
- Element Type (that is, recurring or nonrecurring)
- Element Classification (such as, Earnings, or Direct Payment)

See Also

Restricting the Data Displayed in a Window: page 30 – 3
Tracking Compensation and Benefit Changes

It is inevitable that your business rules for compensation and benefits will change over time. Element definitions, link definitions, and element entries are all dated tracked. This lets you track the changes to your compensation and benefit policies without losing any of your historical employee information. The history of your definitions remains in place for validation and reporting, and for future calculations of back pay.

Maintaining Elements

After you have defined and used an element, you can make the following changes:

- Change a required input value to be not required
- Alter the sequence in which input values appear in the Element Entries window
- Change the input value validation rules for minimum, maximum, lookup, or formula
- Change your specification of which input values create Database Items. Note, however, you cannot remove Database Items if they are used in any formulas or QuickPaint reports.

You cannot remove existing input values nor add new ones if you have created any entries for the element.

Maintaining Links

Link rules always control the entry of element values at the time of entry. Changes to link rules affect existing entries in different ways, depending on your use of Standard links and Hot Defaults. After you have used an element you can make the following changes to the link rules:

- Change the input value defaults and validation.
  - These changes affect all new entries. Changes to hot defaults affect existing entries. Changes to validation also affect existing entries when you update the entry.
- Date—effectively end all of the rules that apply to an element and define a new set of rules, which are effective from a later date. For example, suppose you have defined eligibility for a company car based on grade. Following a change of policy you must now define eligibility based on job.
– You will not be allowed to end the link if any nonrecurring entries exist at the date you want to end the rule. You must delete existing entries before you end the link.

– You can end the link if recurring entries exist. Any existing entries will be ended, automatically, when you end the link.

• Change the qualifying conditions of age and length of service that employees must meet to be eligible for the element.

**Policy Development**

With DateTrack you can also make future-dated changes to your information safe in the knowledge that these changes will not become effective in the system until the correct date.

In this way you can use your compensation and benefit information to plan changes ahead of time; analyze the impact of these changes; adjust these changes and generally smooth out the workload that is often associated with major changes in compensation and benefits policy.

**See Also**

Managing Change Over Time: page 1 – 9
This chapter explains how to make compensation and benefit entries for employees by:

- Batch Element Entry using MIX
- Individual element entry using the Element Entries window
- Automatic entry, controlled by the element definition

It also explains the windows you can use to report on which employees receive a particular element of compensation, or to see the history of an employee’s compensation package over time.
Entering Compensation and Benefits

An employee must have an entry for an element to receive that element as a component of his or her compensation and benefits package. You can start, update and stop element entries for individual employees in a number of different ways:

- You can define standard element links so that eligible employees receive an entry automatically.
- You can use MIX (Mass Information Exchange) to enter a batch of element entries, using defaults for fast entry.
- You can make manual entries of most elements for an individual assignment in the Element Entries window. However, there are two exceptions. You enter salaries in the Salary Administration window, and you enter absences in the Absence Detail window.

Processing Element Entries

If you also implement Oracle Payroll, you can process these entries in a payroll run. The payroll process is the means by which you calculate actual earnings and deductions for each employee in each pay period.

Oracle Human Resources and Oracle Payroll fully share the information you set up for compensation and benefits. You use the same elements, the same rules to determine eligibility, and the same entries to show personal levels of compensation and benefits.

If you decide not to implement Oracle Payroll you can still use your HR compensation and benefit information for transfer to your own payroll system.

See Also

Entering Absences: page 24 – 13
Entering Salaries and Salary Changes: page 10 – 9
MIX For Batch Entry: page 9 – 7
Automatic or Manual Element Entry

If an element is defined as recurring with standard links, the system makes an entry automatically for all eligible assignments.

**Suggestion:** If you are defining elements for information only, aim to define recurring elements with standard links and default values. This reduces your manual data input requirements to a minimum.

If an element is nonrecurring, or if you have enabled multiple entries for a recurring element, you cannot define standard links. This means you must make a manual entry of the element. You can make entries individually or in a batch, for fast data entry.

Manual Entries for Recurring Elements

You can start entries for a recurring element at any point in time. Use DateTrack to set the Effective Start Date of an entry, to update values, and to maintain history for the entry.

Values you enter for a recurring element remain effective for all subsequent processing periods until you change the element entry. A recurring element entry ends if the employee ceases to be eligible for the element, for example after a change of work assignment.

Manual Entries for Nonrecurring Elements

When you define an element as nonrecurring you are saying that an entry made for this element is effective for only the current pay period. To make the entry, you set your effective date to *any* date in the appropriate pay period.

Any changes you make to individual entries are always corrections. There can be no history of element entries within a payroll period. However, the entries for each period (if any) are stored as history for an employee.

**Note:** Effective Start and End Dates for a nonrecurring entry are the dates of the pay period. As a result, employees must be assigned to a payroll before they can have nonrecurring element entries.
Entering Elements

You enter compensation and benefits for employee assignments in the Element Entries window. If the employee is assigned to a salary basis, you enter his or her salary in the Salary Administration window.

You can use the Element Entries window to make entries or to inquire on existing entries. Use the Period field, Classification field, and Processing Types option buttons to restrict the entries you see when making inquiries.

The Processed check box displays whether Oracle Payroll has processed the entry in the current pay period.

To enter an element for an employee assignment:

1. Change your effective date if necessary to:
   • the correct start date for a recurring element entry
   • any date in the correct pay period for a nonrecurring element entry

   If the pay period is closed at your effective date, you cannot enter any nonrecurring elements that process in a payroll run. If a current or future pay period is closed, you cannot enter any recurring elements that process in a payroll run.

2. If you want to reduce the list of elements to choose from, select a Classification or a Processing Type, or both, in the first region.

3. In the Element Name field, select an element.
The system checks whether the employee meets the element’s qualifying conditions. If the employee is either not old enough or has not served for the required qualifying period, it displays a warning message.

**Note:** Entries for elements defined with a standard link appear automatically.

4. If the Costing field is enterable, you can enter a cost code, for example to indicate to which cost center the assignment’s time should be charged.

5. You can enter a reason for the element entry you have made or updated. To add new reasons to the list, enter values for the QuickCode Type ELE_ENTRY_REASON.

6. You can check the Override check box to create an entry that overrides all other entries of this element in the current period. You cannot create an override entry if one already exists, or if any of the entries of this element have been adjusted.

7. If you want to create a one–off entry of a recurring element, check the Additional check box.

   An Additional entry is valid only for the current pay period, shown in the Effective Dates fields.

   You can only check Additional if:
   - the element definition allows additional entries, and
   - an additional entry does not already exist for the assignment in this period, and
   - the employee is assigned to a payroll
   - there is a payroll period defined at your effective date

8. Choose the Entry Values button to open the Entry Values window.

9. Enter values in the Entry Values fields. Notice that:
   - Entry to some fields may not be permitted.
   - Some fields may be required.
   - Some fields may have a list of values; others may be validated as you leave the field. You will receive a message if your entry is not a valid value.
   - Some fields may contain default values. If the default value is in quotation marks, it is a “hot default”.

**Attention:** You should consider carefully before overriding a hot default. If you override it, then any subsequent changes to the
default value on the element or element link definition will not affect the element entry. However, you can clear your entry if you want the default value to come back into effect.

10. Save your work.

**Adjusting a Pay Value**

Oracle Payroll users can adjust the Pay Value of any normal recurring payroll element entry. When you open the Entry Values window for an entry of this kind, you will see a Show Adjustment check box in the lower left corner of the window.

You cannot adjust an entry that has been overridden.

**Note:** You do not see this check box until you have saved the entry.

To adjust a Pay Value:

1. Check the Show Adjustment check box.
2. In the Adjustment pop list, select Add, Subtract, or Replace. You can only select Add or Subtract if the Pay Value is numeric.
3. Enter the value to add to, subtract from, or replace the existing Pay Value entry.
MIX for Batch Entry

Use the Batch Header and Batch Lines windows of MIX’s BEE (Batch Element Entry) facility for rapid entry of batches of information held as element entries. This information might include timecard data, compensation information, and vacation entitlements, for example.

You can enter information in a batch for as many elements and assignments as you require. You can enter defaults for any value to speed up data entry, and you can change the defaults as you work through a batch. You choose which element input values to display in the Batch Lines window.

Validation of Batch Entries

To validate a batch after saving it, you run the BEE validation process from the Batch Header window. This process checks the header and each line of the batch. For example, it checks that each assignment number exists in the database, and that you have specified values for all required input values.

You can add your own validation procedures to the standard process. For example, you can set up control types, such as record counts, and write a validation procedure to check that the batch matches the control totals you enter for each type. You can also add any business validation you require, for example to check that amounts entered for a bonus do not exceed a maximum, or that an assignment’s paid time off entitlement is sufficient to cover time taken.

When the batch is ready for transfer to the database, you run the BEE transfer process from the Batch Header window. This process first performs the same checks as the validation process. If it finds no errors, it transfers the element entries from the temporary tables to the Entries table in Oracle HRMS.

You can choose whether the transfer process automatically purges the entries from the temporary tables after transfer. You can also run a separate purge process.

Batch Statuses

The Batch Status depends on the status of the batch header, all the batch lines, and any control totals specified for the batch. On the Batch Header window, you can see the following status values:

Valid All of the lines, control totals, and header are valid.
All of the lines, control totals, and header have been transferred.

At least one line, control total, or the header is unprocessed.

At least one line, control total, or the header is in error.

The combination of statuses in the header, lines, and batch is not consistent. For example, it is inconsistent for some, but not all, of the lines to have the status Transferred.

Note: A status mismatch is not possible if you always use the Batch Header and Batch Lines windows to enter and maintain a batch.

Creating and Updating Batches of Element Entries

You can enter batches of element entries in the Batch Header and Batch Lines windows.

Prerequisites

- You can create additional validation procedures for checking the batch header and lines, and for validating the batch against control totals.
- If you want to use control totals to validate the batch, enter values for the QuickCode Type CONTROL_TYPE.

Entering a Batch Header

The header identifies the batch and determines what happens if any of the batch lines duplicate existing element entries.
To enter a batch header and control totals:

1. Set your effective date to the date when you want the entries to take effect.

2. Enter a name for the batch, and enter a reference number and the source of the batch, if you require these for your own reference.

3. Select what action the process should take if one of the batch lines matches an existing element entry for an assignment at the effective date.
   - Create New Entry – The process creates a new entry if multiple entries of the element are allowed by the element definition. If multiple entries are not allowed, the process sets the status of the batch line to Error.
   - Reject Entry – The process sets the status of the batch line to Error.
   - Change Existing Entry – The process corrects or updates the existing entry. If there is more than one existing entry, the process sets the status of the batch line to Error.
   
   The Undefined option is display-only (for batches created using SQL*Plus or a similar tool).

4. If you selected Change Existing Entry, select the type of date effective change to be made to recurring entries:
   - Update – The process changes the existing entry from the effective date, but preserves the previous information. If there are future-dated changes to the existing entry, the process inserts the change before the next scheduled change.
• Correct – The process corrects the existing entry from its start date through to its end date. Any future-dated changes are unaffected.

• Override – The process changes the existing entry from the effective date, but preserves the previous information. If there are future-dated changes to the existing entry, the process replaces all future-dated changes with the batch line.

Notice that if you select this option, you cannot check the Reject if Future Changes check box.

The Undefined option is display-only (for batches created using SQL*Plus or a similar tool).

5. If you want to reject batch lines that match entries that start in the future or for which future changes are scheduled, check the Reject if Future Changes check box.

Notice that if you check this box, you cannot select the Override option.

6. If you want the batch to be purged from the temporary tables after successful transfer to Oracle HRMS, check the Purge After Transfer check box.

7. If you have set up control types to validate the batch before transfer, choose the Totals button. Select a batch control type and enter the total for the batch. You can enter as many types and totals as you require.

Entering Batch Lines

A batch line is one element entry for an assignment.

Use the Create Batch Lines window to create identical lines for all assignments identified by an assignment set. This is a quick way to create many lines for an element. If the input values need to vary between assignments, you can leave these blank and add them later using the Batch Lines window.

In the Batch Lines window, you can enter new lines for individual assignments, and you can view and edit lines created automatically for an assignment set. You can speed up entry of new lines by entering default input values.

Note: A batch can contain lines for as many elements as you require. Lines within a batch can have different effective dates.

To navigate to these windows, first create and save a batch header in the Batch Header window. Then choose the Create Lines button (for
the Create Batch Lines window) or the Lines button (for the Batch Lines window).

To enter batch lines for an assignment set:

1. Select the assignment set and payroll which identify the employees you want to create lines for.
2. Select the element for the batch lines and enter input values as appropriate.
3. Change the effective date if required.
4. Choose the Process button to submit a concurrent process called Create Batches. Confirm that you want the system to create the lines.

The Batch Lines window now closes, taking you back to the Batch Header window.
5. Choose the Create Lines button again if you want to add lines for another element. Requery your batch and choose the Lines button if you want to view and edit the lines created by the process.

To enter batch lines manually:

1. Choose the Lines button.
2. Select the element for which you want to make entries.
3. To enter default values to speed up the data entry, choose the Defaults button. The Defaults window displays the input values for the selected element.

4. Enter default values in any of the fields in the Defaults window. These defaults apply to all new entries in the batch, but not to any entries you have already made. You can change the defaults at any time during your data entry.

5. Uncheck the Display check box for any field that you do not want to display in the Lines window. You might want to hide any fields for which the default is correct for every entry.

6. In the Lines window, enter the data required for the batch. Lists of values are available on some fields, but no validation is enforced during data entry. You can override the Effective Date for any line. This is the effective start date for a new entry or the effective date of an update.

7. Save your entries. If you want to make entries for another element, select the element, enter new defaults, enter the lines, then save again.

Retrieving Existing Batch Lines

Use the Batch Lines window to view existing batch lines.

To retrieve existing batch lines:

1. Do one of the following:
   • Select the element in the Element field.
   • Check the Unknown Elements check box if you are querying batch lines entered for an invalid element (or no element) by SQL*Plus or another tool.

2. Choose the Find button.

Updating a Batch

You can update a batch at any time before you transfer it. If you make any changes to a batch with the status Validated or Error, the batch status changes to Unprocessed.
Validating a BEE Batch

You can validate a batch with the status Unprocessed, Error, or Valid. The validation process tests each batch line against certain predefined rules about element entries, and also against your own rules if you have created additional validation procedures.

To validate a batch:

1. Query the batch in the Batch Header window, and choose the Process button.

2. Select Validate, and choose Start. The system displays the concurrent request ID so that you can query it on the Requests window.

3. When the concurrent request is completed, query the batch in the Batch Header window.
   If the Batch Status is Valid, the validation was successful. If the Batch Status is Error, at least one line, control total, or the header is in error.

4. To view the status of individual lines in the batch, choose the Lines button. In the Batch Lines window, select an element and choose Find.

5. If you entered control totals for the batch, choose the Totals button on the Batch Header window to view the status for each control type.

6. To view messages for the whole batch, or all lines, or control totals, choose the Messages button. Use the option group at the top of the Messages window to control which messages are displayed.

Transferring a BEE Batch

A batch exists in the temporary BEE tables only until you run the transfer process to create element entries in the Oracle HRMS Entries table.

To transfer a batch:

1. Query the batch in the Batch Header window, and choose the Process button.

2. Select Transfer, and choose Start. The system displays the concurrent request ID so that you can query it on the Requests window.
3. When the concurrent request is completed, query the batch in the Batch Header window.

If the Batch Status is Transferred, there were no errors in the batch and the process has created the element entries. The process may have issued messages associated with the batch header, lines, or control totals.

If the Batch Status is Error, the process has set the status of at least one line, or control total to Error. Check the status fields in the Batch Lines window and the Control Totals window, and review the messages issued by the process.

---

**Purging a Batch From the BEE Tables**

If the Purge After Transfer check box on the Batch Header window is checked when you run the transfer process, the batch is deleted from the MIX tables automatically after the transfer. If the box is not checked, you can purge the batch by running a separate process.

You can purge a batch with any status.

**To purge a batch:**

1. Query the batch in the Batch Header window, and choose the Process button.
2. Select Purge, and choose Start. The system displays the concurrent request ID so that you can query it on the Requests window.

When the concurrent request is completed, the batch is purged.

---

**Rolling Back a MIX Process**

You can roll back a MIX process if you want to completely remove it after it successfully completes. You have a choice of deleting the batch header as well or of keeping the header after the rollback.

The process interlock rule (which prevents you rolling back a payroll process if any further processing has taken place) does not apply to MIX Rollback. You can still perform the rollback even if run results from payroll processing exist for any of the lines.

You run the MIX Rollback process from the Submit Requests window.

**To roll back a MIX process:**

1. Select the batch header name of the process you want to roll back.
2. Enter Yes to cancel the rollback process if the system detects run results for any of the batch lines. Enter No if you want the system to complete the rollback even though run results exist.

3. Enter Yes to keep the batch after the rollback. Enter No to delete the batch after the rollback.
Inquiring on Compensation and Benefit Entries

Three windows are provided for making inquiries:

- In the Element Entries window, you can view the entries for one employee assignment in any one pay period.

- In the List Employees By Element window, you can view a list of the employee assignments receiving a compensation element in any period of time you choose. You can also see the last entry value for each assignment.

- In the View Element Entry History for Employee window, you can view the history of entries for one or more elements for an employee.

If your system administrator has customized these windows, you may be restricted to viewing elements of a certain processing type or classification.
Listing Employees by Element

In the List Employees By Element window you can view a list of the employee assignments receiving a compensation element in any period of time you choose.

To view a list of employees receiving an element:

1. Select an element.
2. Select Current Employees, Ex–employees, or both.
3. You can also enter a date range. Both date fields default to your effective date.
4. You can enter additional query criteria in the second region.
5. Run the query.

The window displays all entries of the element for employees of the type you selected in the chosen time period.

Note: This window does not display datetracked updates to recurring element entries. You only see the latest value (within your chosen time period) of each element entry. The date of the last datetracked update may vary from employee to employee.
Viewing Element Entry History

In the View Element Entry History for Employee window you can view, for a single employee assignment, a history of entries for:

- all recurring elements, all nonrecurring elements, or both
- elements from a selected classification

To view element entry history for an employee:

1. Enter your selection criteria. You can:
   - Select a classification.
   - Select a processing type.
   - Enter a date range. The end date defaults to your effective date.

2. Place your cursor in the Element Name field and run the query.
   The window displays all entries of the types of element you selected within the time period, including datetracked updates to entries. New entries are shown in bold to contrast with datetracked updates, which are listed under the initial entry.

3. Select an entry and choose the Entry Values button to view the entry values.
This chapter explains how to set up your system for salary administration and budgeting. It also explains how to enter and approve salary proposals for individual employees, and how to review salaries for groups of employees.
Salary Administration and Performance Reviews

In Oracle HRMS you use salary administration to:

• enter salary amounts or wage rates for newly hired employees.
• enter and approve proposals for salary or wage increases (or decreases) for current employees. You can associate a salary change with the result of a performance review.

To administer salaries for employees, you first assign them to a salary basis. This determines the duration for which their salaries are quoted, such as hourly or monthly. Then for new employees, you enter starting salary amounts, which receive approval automatically.

For current employees, you enter proposed salary changes, expressed either as a new amount or a change amount or percentage. If necessary, you can break down a salary change into two or more components, to reflect different reasons for the change. For example, you might define components for Cost of Living and Merit. You can approve each component of the proposal separately. When all components are approved, you can approve the proposal as a whole. Proposals do not take effect until they receive approval.

Optionaly, you can select a performance review to associate with a salary change. When you set up salary administration, you can enter grade rate ranges against which the system validates salary proposals.

Salaries Determined by Grade

If your employees’ salaries are entirely determined by their grade, you may not need to use Salary Administration. For these employees you define a grade rate or pay scale rate and enter values for each grade. Then you can assign employees to grades, and place them on the appropriate point of their grade scale. If you use Oracle Payroll, you can write a salary formula that uses the grade rate or pay scale rate to calculate each employee’s salary pay value.

See Also

Grade Relationships to Compensation and Benefits: page 4 – 6
Reviewing Current Salaries

Before entering salary proposals, you can review the current salaries of comparable groups of employees. There are a number of ways to do this:

- Query a list of assignments in the Salary Management folder to view their current salaries and any existing salary proposals. You can view up to ten salary components (such as Cost of Living, Location Adjustment, or Promotion) for each proposal.
  
  See: Using the Salary Management Folder: page 10 – 13

- Query lists of assignments receiving a particular salary element on the List Employees by Element window. This shows the latest approved salary for each assignment in the date range you select.
  

- Run the Salary Review Report to view current and previous salaries for all employees, or for employees assigned to a selected organization, job, position, and/or grade.
  
  See: Viewing Salary History: page 10 – 16

- If you use grade rates, you can view the salaries of all employees on a certain grade receiving a particular salary element, using the View Employee Grade Comparison window. This window also displays each employee’s salary as a percentage of the midpoint defined for the grade.
  
  See: Viewing Grade Comparisons: page 4 – 10

- If you use pay scale rates for salaries, you can report on the salaries of all employees or a group of employees using the Employee Increment Results report.
  
  See: Employee Increment Results Report: page 4 – 19
Setting Up Salary Administration

Before entering salaries for new hires and salary proposals for current employees using salary administration, complete the following setup steps.

**To set up salary administration:**

1. Create a salary element for each group of employees whose salaries are quoted on the same basis (such as annually or hourly).

2. Link the salary elements to components of employee assignments, using the Element Link window.

3. Define a salary basis for each salary element.

   **Note:** If you want your new components to be displayed in the Salary Management folder, you must also change a view.

   See: Changing Salary Components: page 10 – 8

4. Review the seeded salary components, which are defined as values for the QuickCode Type PROPOSAL_REASON. If necessary, create your own salary components.

5. If you want to record performance ratings such as Outstanding, Superior and Average, enter them in the QuickCodes window for the QuickCode Type PERFORMANCE_RATING.

6. Add the function Salary Administration: Approve to the menu of responsibilities that should be able to approve salary proposals. Without this function, users can enter salary proposals but they cannot approve them.

7. Assign employees to a salary basis using the Salary Information region of the Assignment window. Also assign employees to a grade, if you have associated a grade rate with the salary basis.

Validating Salary Entries

There are two ways to validate salary entries:

- You can *warn* users when they enter a salary proposal that is outside a valid range defined for an employee’s grade. This approach uses grade rate ranges.

- You can *prevent* users from approving a salary that is outside a valid range, or that fails validation performed by a formula. Notice that this validation is not performed until you try to approve a salary proposal. This approach uses element input value validation.
To validate salaries against grade rate ranges:
1. Create a salary grade rate and enter minimum, maximum, and midpoint values for each grade.
2. When you define the salary basis, select your salary grade rate.
3. Assign your employees to grades.

To validate salaries using input value validation:
1. If you want to validate salaries using a formula, create your formula in the Write Formulas window.
2. When you define an input value for the salary element, you can select a formula to perform validation, or you can enter minimum and maximum valid values.
3. If you want to vary the validation for different groups of employees, you can enter validation criteria in the Link Input Values window.

See Also
- Entering a New Assignment: page 14 – 8
- Using Oracle FastFormula for Validation: (Oracle FastFormula User’s Guide)

Defining and Linking a Salary Element
You define a salary element in the Element window.

To define a salary element:
1. Set your effective date to a day on or before the start of the first payroll period for which you want to enter salaries.
2. Enter a name for the element, and select the classification Earnings.
3. Select the Type Recurring.
4. Do *not* check the Standard check box.
5. Save the element, then choose the Input Values button.
6. In the Input Values window, create one input value to hold the salary value. This is normally the Pay Value. If you want to associate this element with more than one salary basis, create one input value for each salary basis.
Suggestion: If the salary basis is different from the payroll periods of the employees who will receive this element, make this clear in the input value name. For example, if the salary basis is Annual, you could name the input value Annual Salary.

You can enter validation criteria for the input value, such as a Minimum and Maximum value, or a formula to perform the validation. Select Error in the Warning or Error field.

Note: If you select Warning, users do not see the warning in the Salary Administration window

8. Save your work.

To link the salary element:

1. Set your effective date to a day on or before the start of the first payroll period for which you want to enter salaries.
2. In the Element Link window, select your new salary element.
3. Do not check the Standard check box.
4. Select eligibility criteria for this element. If you want to make the element available to all employees, do not select any criteria.
5. Save the link.
6. If you want to enter different validation criteria for different eligibility groups, you can change the Min and Max valid values in the Link Input Values window.

See Also

Defining an Element (HR Users): page 8 – 3
Defining Element Links: page 8 – 10

Defining Salary Bases

The salary basis establishes the duration for which a salary is quoted, for example, hourly, monthly or annually. Notice that an employee’s salary basis is not necessarily the same as the pay periods of his or her payroll. For example, an employee with an hourly pay rate has the salary basis Hourly Salary, but can have an assignment to a weekly payroll.

You can associate an element with one salary basis. When you associate an element with a salary basis, you cannot create or maintain entries for the element on the Element Entries window. You must use the Salary Administration window to enter and maintain employee salaries.
You define a salary basis in the Salary Basis window.

To define a salary basis:

1. Enter a name and select a basis.

2. Select the name of the salary element and input value associated with this salary basis.

3. Optionally, select a grade rate to associate with the salary basis.
   Oracle HRMS uses the grade rate to validate your salary proposals. You receive a warning if the salary you enter for an employee is not within the grade rate range defined for the employee’s grade.

   In doing this check, the system takes account of the hours in the employee’s standard work week. It compares the hours on the employee’s assignment with those entered for his or her organization.

   If the employee works fewer than the standard hours per week for the organization, the system prorates the permissible minimum and maximum grade rate values before validating the salary.

4. If you selected a grade rate, select the Basis (Hourly, Monthly, Annual, or Period) for the rate. For example, if your grade rate specifies the valid monthly salary ranges for each grade, select Monthly Salary in the Grade Rate Basis field.

5. If either the Basis or the Grade Rate Basis is Hourly Salary (but not both), you must enter a value in the Annualized Hours field. This records the number of working hours in a year (and hence in a month). The system uses this figure to convert salary entries and grade rate values to the same basis when it validates a new salary entry.
Changing Salary Components

Salary changes can be broken down into two or more components, to reflect different reasons for the change. You can approve each component of the proposal separately.

Ten salary components are predefined, as shown in Table 10 – 1. You can create as many additional components as you require. However, only ten components can be displayed in the Salary Management folder. If you want your new components to be displayed in the folder instead of the default components, you must update a view.

This task is for system administrators.

<table>
<thead>
<tr>
<th>Predefined Salary Component</th>
<th>QuickCode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost of Living</td>
<td>COL</td>
</tr>
<tr>
<td>Job Evaluation</td>
<td>JOEV</td>
</tr>
<tr>
<td>Location Adjustment</td>
<td>LOAD</td>
</tr>
<tr>
<td>Market Adjustment</td>
<td>MKAD</td>
</tr>
<tr>
<td>New Hire</td>
<td>NEWH</td>
</tr>
<tr>
<td>Performance</td>
<td>PERF</td>
</tr>
<tr>
<td>Periodic Review</td>
<td>PERE</td>
</tr>
<tr>
<td>Progression</td>
<td>PROG</td>
</tr>
<tr>
<td>Promotion</td>
<td>PROM</td>
</tr>
<tr>
<td>Transfer Adjustment</td>
<td>TRAD</td>
</tr>
</tbody>
</table>

Table 10 – 1  Predefined Salary Components

**To create new salary components to display in the folder:**

1. Query the QuickCode Type PROPOSAL_REASON in the QuickCodes window and add a new code for each new component.

2. In a text editor, open the View file peupl01v.sql.

3. Go to the component reason list and replace the default QuickCodes with the new codes you have created.

**Note:** There are two places in the file where you need to change these codes.
4. Go into SQL*Plus as hr user and run the edited script.

5. Change the column names in the Salary Management folder by choosing Change Prompts from the Folder menu.

**Entering Salaries and Salary Changes**

Use the Salary Administration window to enter a salary amount for a new employee, to propose a salary change for a current employee, or to approve a salary proposal.

Use the Salary Management folder to approve multiple salary proposals or to download salary information to a spreadsheet. In the spreadsheet you can enter new proposals, edit existing proposals, and approve salary components. Then you can upload your changes to the database.

If you want to hold multiple reasons for a salary change, you can break down a proposal into two or more components. Each component represents a different reason for changing the salary. You can define as many reasons as you require using the QuickCode Type PROPOSAL_REASON. Examples might be Merit Award and Cost of Living.

From the Salary Administration window, you can open the Performance window. You can associate a salary proposal with a performance review in two ways:

- You can simply enter the date of the review and a performance rating in the Performance window.
- If you use the Employee Review window to schedule and record performance reviews, you can select a review by type in the Performance window.

To review the history of an employee’s salary and performance reviews, use the Salary History window.
Using the Salary Administration Window

Use the Salary Administration window to enter a salary amount for a new employee, to propose a salary change for a current employee, or to approve a salary proposal.

Entering an Approved New Salary

Use the procedure below to enter:

- a starting salary amount for a newly hired employee, or
- a salary amount for a current employee assigned to a new salary basis. This could be, for example, an employee moving from an hourly wage to a monthly salary.

Notice that you cannot enter multiple components of a starting salary for a newly hired employee or one assigned to a new salary basis.

To enter a salary for a new employee, or one assigned to a new salary basis:

1. Enter the start date for the salary. For a new hire, this is usually the hire date.
2. Enter the amount of the salary in the New Amount field.
3. You can select a reason.
4. Save the new salary. Its approval is automatic.

**Entering a Salary Proposal**

You can propose a salary change for someone at any time. If you entered intervals for regular salary reviews in the Salary Information region of the Assignment window, Oracle HRMS uses this information to display the date of the next scheduled salary review. However, you can override this date, provided that the date you enter is after the date of the last approved salary.

If there is an unapproved salary proposal recorded for the assignment, you must approve or delete this proposal before you can enter a new proposal.

You can enter a salary proposal as a new amount, a single change amount or percentage, or multiple change amounts or percentages (reflecting different reasons, such as a merit award and a cost of living component).

► **To propose a salary change:**

1. In the Salary region, enter the date when the new salary should come into effect.

2. If you want to hold multiple reasons for a salary change, check the Use Multiple Components check box.

3. Do one of the following:
   - If you did not check the Use Multiple Components box, enter the salary change in the Salary region. You can enter a new salary amount, or the amount or percentage of the proposed change.
   - If you did check the Use Multiple Components box, use the Components region. Select the reason for each component of the proposal and the amount or percentage of each proposed change.

   Notice that each percentage is applied to the last approved salary. For example, if the last approved salary is 3000 and there are two components of 10% and 5%, the new amount is 3000 + 300 + 150.

   To effect a salary decrease, enter a negative number in the Change Amount or Change Percent field.

4. You can select a reason for the overall salary change.

5. If you entered a time period for regular salary reviews in the Salary Information region of the Assignment window, the date of the next review appears automatically. You can change this date.
6. To associate the salary change with a performance review, choose the Performance button. Enter the date of the review and select a performance rating. In the Interview region, you can select a review that was recorded in the Employee Review window.

7. If you entered a time period for regular performance reviews in the Salary Information region of the Assignment window, the date of the next review appears automatically. You can change this date.

8. Save your proposal.

Approving a Salary Change

A salary proposal does not go into effect until it receives approval. If you have recorded multiple components of a salary proposal, you can approve each component independently. However, none of them goes into effect until you approve the overall proposal.

When you approve a salary, Oracle HRMS creates or updates a salary element entry for the assignment. You can view this entry in the Element Entries window, but you cannot change it there.

Note: You may not be able to approve salaries. This is controlled by a menu function set up by your system administrator.

To approve a salary change:

- Query the proposal, check the Approved box, and save. If some individual components were not already approved, you are warned and they are automatically approved if you continue.
Using the Salary Management Folder

Using the Salary Management Folder, you can select sets of assignments for which you want to enter or approve salary proposals. For each assignment, the folder can display the current approved salary and proposed new salary, including up to ten salary components.

Using Application Data Export (ADE), you can download this information from the folder to a spreadsheet. Here you can manipulate the data to create new salary proposals or to modify existing proposals. You can then upload your revised salary information to the database. If your responsibility permits, you can approve all or selected proposals in the folder.

Manipulating Salary Information in a Spreadsheet

You can use a spreadsheet application to enter or update salary proposals for groups of employees. The changes you make in the spreadsheet are checked when you upload them to the database. To minimize errors, follow these rules:

- Do not enter components for a first salary (for example, for a new hire). Enter a proposed amount and change date only.
- Enter changes for the full salary or for components but not for both.
- If you enter components, make sure you enter a value (Y or N) in the Approved field for each component.
Do not alter a Change Date that was downloaded from the database.

Do not enter information in the grey fields (except for Change Date).

Note that the Change Amount is given precedence over the Change Percentage. If you enter inconsistent values, the upload process records the new change amount and adjusts the percentage to match. If you want to record a percentage change, clear the amount field.

If you want to delete a component, clear both the change amount and percentage fields for that component.

**To manipulate salary proposals in a spreadsheet:**

1. In the Salary Management folder, query the assignments you want to process.
2. Click on the ADE icon on the Oracle HRMS tool bar.
3. In the ADE Fetch Data window, select the style Salary Proposals and select the action Spreadsheet. Choose Start.
   This launches your spreadsheet application and iconizes ADE.
4. Edit the data in the spreadsheet, following the rules outlined above. Save the spreadsheet with a new name (to prevent it being overwritten the next time ADE is run).
5. Exit your spreadsheet application.
6. In ADE, choose the Upload button.
   **Note:** If the Upload button is not available, ask your system administrator to create the function HR_HRIO_ENABLE_UPLOAD and add it to your menu.
7. Choose Load and select the spreadsheet that you saved.
   You can review your changes in the built-in ADE spreadsheet. The Status column shows which rows have been updated.
8. Choose Upload.
   The updated information is uploaded to the database. The Status column records any errors encountered during the upload.
9. To view your new proposals in the Salary Management folder, requery the data.

**Approving Multiple Salary Proposals**

If the Approve button is displayed in the Salary Management folder, you can select multiple assignments in the folder and approve them.
Note: If the Approve button is not displayed, you cannot approve salaries. This is controlled by a menu function set up by your system administrator.

When you approve a salary, Oracle HRMS creates or updates a salary element entry for the assignment. You can view this entry in the Element Entries window, but you cannot change it there.

To approve multiple salary proposals:
1. In the Salary Management folder, query the assignments you want to process.
2. Select the assignments you want to approve and choose the Approve button. To select multiple assignments, hold down the CTRL key and click on the assignment records you want to select.

Correcting a Salary Entry

You enter and approve salary proposals in the Salary Administration window. You can also correct salary entries in this window.

To correct a salary proposal:
- Enter the correct value in the New Amount field.

To correct an approved salary:
1. Delete the salary record and enter a new one.
2. If you discover an error in a proposal approved in the past, after which more recent approved proposals are on record, you must delete and reenter every proposal from the one last approved back through the incorrect one.
3. When you delete an approved proposal that the payroll run has processed, you receive a warning message. You can continue to delete the record, but you must of course correct the processing.
Viewing Salary History

Oracle HRMS maintains a complete history of approved salary changes for an employee, along with associated performance reviews. In the Salary History window, you can view the dates, reasons, and amounts of each approved salary change, and of any new salary proposal.

The Salary History window contains a folder. You can enter a query in the folder to reduce the list of salary changes displayed. You can remove, rearrange, add, or resize fields in the folder if you have access to the folder menu.

The **Change** field shows the amount of the salary change, and the **Actual** field shows the new salary effective from the **Change Date**. The **Hourly**, **Monthly**, **Annual**, and **Payroll** fields show the salary prorated to these periods. The **Mid**, **Minimum**, and **Maximum** fields show values from the grade rate for the employee’s grade. The **Comparatio** field shows the salary as a percentage of the midpoint defined for the grade rate.

Salary Review Report

Use this report to see current and past salaries, and salary proposals, for some or all of your employees. You can restrict the employees to those assigned to a selected organization, job, position, or grade. You can also restrict the report to showing only employees receiving the maximum salary for their grade (defined by the grade rate). You can use the report to show all salaries (approved and proposed) or to show unapproved salary proposals only.

You run reports from the Submit Requests window.

To run the Salary Review Report:

1. In the Name field, select Salary Review Report.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. Optionally select an organization, job, position, and/or grade to restrict the scope of the report to employees assigned to these components.
5. If you want to restrict the report to showing salary proposals, select Yes in the Unapproved Proposals Only field.
6. If you want to restrict the report to showing employees receiving the maximum salary for their grade (defined by the grade rate), or a higher salary, select Yes in the Grade Rate Maximum Only field.
7. Choose the Submit button.
Salary Budgeting

Using Oracle Human Resources, you can set up human resource budgets for headcounts and full time equivalents at various levels of the organization.

See: Human Resource Budgets: page 12 – 2

Most enterprises need to add salary estimates to these headcount budgets to provide salary budgets. Oracle Human Resources provides you with the key information you require to define your salary budgets:

- headcount or FTE budget for a defined period of time
- valid grades for jobs and positions
- grade rates or pay scale rates to show salary values

However, the detailed process of salary budgeting varies from one enterprise to another according to the enterprise size, type, and culture. This topic looks at three types of enterprise to suggest different ways in which you could use the information held in Oracle Human Resources to derive your salary budgets.

Note: The calculation of actual salary values happens during the payroll run. To help you compare planned versus actual spending, Oracle Payroll provides the following information:

- actual pay values for each assignment in the payroll run
- balances to show to date totals
- costs accumulated to the cost centers and project codes you set up in the Cost Allocation Flexfield

Budgeting Approach in a Government Agency

A typical government agency has a rule–based structure based on organizations, positions, and grading structures. In this type of enterprise, salary budgets are usually set for each position, then rolled up to the organization level.

Starting from the position definition, you can extract the list of valid grades and the grade rate values for each of these grades. If you use grade scales, you can use the midpoint value from the range defined for each grade.

To calculate the salary budget for each position, you multiply the position headcount by one of the values for the grade. Typically you would use the value for the middle grade. However, you might choose the lowest grade if you are making entry–level assignments to new positions.
When you have established the relationship between these various items in the database, you can automate the budgeting through the creation of a standard reporting view, using SQL*Plus.

**Budgeting Approach in a Centralized Management Company**

The company with a centralized management structure has a more flexible approach to roles, frequently using jobs rather than positions. There is more emphasis on recruiting the ‘right people’ and on individual responsibility and initiative. Reward systems are usually performance related.

Salary budgets are typically set for each organization, based on a headcount budget for jobs and organizations. The budget for each organization is calculated from the midpoint grade rate value for the valid grades for each job multiplied by the planned headcount for each organization and job combination.

**Budgeting Approach in a Devolved Management Company**

In this type of enterprise, local managers are expected to decide on the composition of their own workforce in response to market requirements, and to set their staff’s compensation levels, within an overall budget. Control is exercised through the allocation of a budget, but administration of the budget is left to the discretion of the local manager.

Current expenditure in each organization is used as the starting point for budgeting. This cost is projected on the basis of plans for expansion or reduction, with some inflationary factor added.

One approach to budgeting in this environment is to download current salary values from Oracle Human Resources to a spreadsheet. You can use Oracle Glue to create an interface from Oracle Human Resources to your spreadsheet system. The spreadsheet facilities are well suited to the application of various percentages to try out salary and headcount change proposals.

**See Also**

Using Oracle HRMS with Spreadsheets: page 32 – 5
In any human resource environment you must be able to enter the labor costs associated with your employees. This chapter explains how you can use the Cost Allocation key flexfield to set up the account and cost centers against which you want to collect costs, and the levels at which the costs should be recorded. If you use Oracle Payroll, you can automatically accumulate these costs after a payroll run.
Costing in Oracle HRMS

In Oracle Human Resources, you can:

- estimate current labor costs from the compensation definitions you have entered on the system
- project future labor costs by modelling organizational change and salary reviews
- allocate costs to cost centers and project codes at any level, from the organization to individual element entries for assignments
- allocate costs to account codes for transfer to the General Ledger

However, the accurate accumulation of labor costs can only be done following a payroll run. Using Oracle Payroll, you can run the supplied Costing process to accumulate actual payroll costs under the headings you set up in the Cost Allocation flexfield. You can run another supplied process to transfer the costs to accounts in Oracle General Ledger.

If you do not use Oracle Payroll or Oracle General Ledger, you need to consider how the salary information and cost codes you enter in Oracle Human Resources relate to your payroll and financial systems where real costs are recorded.

In a human resource system, there are typically three types of heading under which you want to collect labor costs:

- account codes, to transfer earnings and deductions to the appropriate General Ledger accounts
- cost centers, to show the costs of particular departments
- project (or product) codes, to transfer costs to a project management or labor distribution system

You set up each of these types, and any others required by your enterprise, as segments of the Cost Allocation key flexfield.

See Also

Costing Process,
Oracle Payroll User’s Guide
Setting Up the Cost Allocation Key Flexfield

You must define at least one segment of the Cost Allocation key flexfield; you can define up to thirty. You can define a list of valid codes or values for each segment. If you plan to transfer costing information to Oracle General Ledger, you should set up at least one segment of the Cost Allocation key flexfield that maps onto segments of the Oracle General Ledger Accounting key flexfield.

Users can enter values in the flexfield segments in the following windows:

- Costing Information (for an organization)
- Payroll
- Element Link
- Costing (for an assignment)
- Element Entries

You decide which segments of your flexfield appear in which window. For example, suppose you define a Cost Center segment. You may want it to appear in the Costing Information window for the organization, so that users can associate one cost center with each organization. You may also want it to appear in the Costing window for the assignment so that users can override the organization’s cost center code for employees who do not spend all their time working for one organization.

Notice that you can override a code entered at a higher level by a code entered at a lower level. For example, if an employee normally works on Project 501, you enter this code at the assignment level. If the employee works temporarily on Project 602, you can allocate some of the assignment’s costs to that code at the element entry level for one or more pay periods.

You define which flexfields segments appear in which windows by qualifying each segment with the levels at which it should be displayed. Table 11 – 1 lists the six levels and the types of segment that are typically displayed for user entry at each level.

<table>
<thead>
<tr>
<th>Level</th>
<th>Qualifiers for this Level</th>
<th>Typical Segments Displayed at this Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization</td>
<td>Organization</td>
<td>cost centers</td>
</tr>
<tr>
<td>Payroll</td>
<td>Payroll</td>
<td>company code, set of books</td>
</tr>
<tr>
<td>Element Link</td>
<td>Element, Balancing</td>
<td>GL account codes for costing and balancing</td>
</tr>
</tbody>
</table>

Table 11 – 1 Choosing Where To Display Segments
## Setting up Earnings and Deductions for Cost Collection

If you want to collect earnings and deductions costs for transfer to General Ledger accounts, you must set up a segment of the Cost Allocation key flexfield with a name such as GL Account, and with the qualifier Element set to Yes. If you want to be able to override the account codes for elements at the assignment or element entry level, set these qualifiers to Yes also.

Define your account codes as valid values for this segment. If you use Oracle General Ledger, you should use the same set of values when you define the GL flexfield called Accounting.

**Suggestion:** If you are not using Oracle General Ledger you could set up your own table of financial codes and values and use Table Validation for your cost headings. You can set up a table in the Table Structure window.

You could also consider populating this table from your existing financial systems.

See: User–defined Tables: page 31 – 9

If you want to do double entry accounting, you should also set the qualifier Balancing to Yes. This allows you to enter two account codes for each element link: one to credit and one to debit. You enter these codes in the Costing and Balancing fields in the Element Link window.
Setting Up Organizations for Cost Collection

If you want to collect organization costs for allocation to a cost center, you must set up a segment of the Cost Allocation key flexfield with a name such as Cost Center, and with the qualifier Organization set to Yes. If you want to be able to override the cost center codes at the assignment or element entry level, set these qualifiers to Yes also. Define your cost centers as valid values for this segment.

Then, when setting up an organization, you can specify the cost center to which the earnings and deductions of all employees in that organization should be allocated.

Setting Up Assignments for Cost Collection

When you choose a cost center for an organization in Oracle Human Resources you are saying that the payroll costs of employees in the organization default to that cost center. This works well if each organization equates to one cost center. However, there may not be a one-to-one relationship between your organizations and your cost centers.

Some employees may regularly work for fixed amounts of time in two or more cost centers. To handle these employee assignments, you need to set the Assignment qualifier to Yes for the Cost Center segment of the Cost Allocation key flexfield. This allows you to enter multiple Cost Centers in the Costing window for the Assignment. You can also enter the proportion of time worked in each center.

For example, if someone works half time in PR and half time in Sales, you can enter 50% for each. This indicates that you should collect half of the employee’s payroll costs against each cost center.
Notice that costing entries for assignments are datetracked so you can enter changes ahead of time.

**Note:** Information you enter in the Costing window for the assignment should override any information entered for an organization. If you use Oracle Payroll this happens automatically.
Chapter 12

Human Resource Budgets

In Oracle Human Resources, you can define non-monetary budgets, such as headcount or full-time equivalents, that are based on your work structures. This chapter explains how to set up budgets and to report on budget variances.
Human Resource Budgets

In Oracle Human Resources, you can define non–monetary budgets, such as headcount or full–time equivalents, that are based on your work structures.

You can define budgets against an organization, job, grade, position, or any combination of these. You can monitor the budgets by comparing the budget values with actual values derived from employee assignments.

For example, you might define a headcount budget of two for the position Marketing Manager. The variance of the actual value from the budget value depends on the number of employees assigned to that position at any time. A negative variance indicates a vacancy.
Entering Actual Values Against Budgets

You can monitor human resource budgets by comparing the budget values with actual values derived from employee assignments.

In the calculation of actual values, an assignment does not always count as one. For example, if an assignment is part-time, it should count as less than one for a Full Time Equivalent type of budget. At the Business Group level, you can enter the default value of an assignment for each budget type. Then you can override the default for particular assignments in the Assignment Budget Values window.

To override the default for an assignment:

- Select a budget type in the Units field and enter the value of the assignment for this budget in the Value field.

Attention: If you do not enter a default value at the Business Group level, you must be careful to enter a value for every assignment. If there is no value entered in the Assignment Budget Values window, that assignment is not counted when calculating actual values for the budget.
Setting Up Budgets

To set up a human resource budget:

1. Define values for the QuickCode Type BUDGET_MEASUREMENT_TYPE in the QuickCodes window.
2. Review the period types defined on the system. You can rename them to match the names you use in your enterprise.
3. Define calendars to determine the start date and period type of your budgets.
4. Define your budgets.
Salary Review Report

Use this report to see current and past salaries, and salary proposals, for some or all of your employees. You can restrict the employees to those assigned to a selected organization, job, position, or grade. You can also restrict the report to showing only employees receiving the maximum salary for their grade (defined by the grade rate). You can use the report to show all salaries (approved and proposed) or to show unapproved salary proposals only.

You run reports from the Submit Requests window.

To run the Salary Review Report:

1. In the Name field, select Salary Review Report.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. Optionally select an organization, job, position, and/or grade to restrict the scope of the report to employees assigned to these components.
5. If you want to restrict the report to showing salary proposals, select Yes in the Unapproved Proposals Only field.
6. If you want to restrict the report to showing employees receiving the maximum salary for their grade (defined by the grade rate), or a higher salary, select Yes in the Grade Rate Maximum Only field.
7. Choose the Submit button.
Salary Budgeting

Using Oracle Human Resources, you can set up human resource budgets for headcounts and full time equivalents at various levels of the organization.

See: Human Resource Budgets: page 12 – 2

Most enterprises need to add salary estimates to these headcount budgets to provide salary budgets. Oracle Human Resources provides you with the key information you require to define your salary budgets:

- headcount or FTE budget for a defined period of time
- valid grades for jobs and positions
- grade rates or pay scale rates to show salary values

However, the detailed process of salary budgeting varies from one enterprise to another according to the enterprise size, type, and culture. This topic looks at three types of enterprise to suggest different ways in which you could use the information held in Oracle Human Resources to derive your salary budgets.

Note: The calculation of actual salary values happens during the payroll run. To help you compare planned versus actual spending, Oracle Payroll provides the following information:

- actual pay values for each assignment in the payroll run
- balances to show to date totals
- costs accumulated to the cost centers and project codes you set up in the Cost Allocation Flexfield

Budgeting Approach in a Government Agency

A typical government agency has a rule–based structure based on organizations, positions, and grading structures. In this type of enterprise, salary budgets are usually set for each position, then rolled up to the organization level.

Starting from the position definition, you can extract the list of valid grades and the grade rate values for each of these grades. If you use grade scales, you can use the midpoint value from the range defined for each grade.

To calculate the salary budget for each position, you multiply the position headcount by one of the values for the grade. Typically you would use the value for the middle grade. However, you might choose
the lowest grade if you are making entry-level assignments to new positions.

---

**Reviewing and Renaming Period Types**

Budgetary calendars and payroll calendars are based on a period, such as a Quarter or a Year. Standard period types are seeded with the system. If you want to use a different name for a period type, enter the name in the Period Types window.

You cannot remove the names that are already defined, but you can insert a new record and select the appropriate Number Per Year.
Defining Calendars

You can define calendars for human resource budgets in the Budgetary Calendar window.

To define a budgetary calendar:

1. Enter the name, and start date for your calendar.
   Check that the start date year is early enough to cope with your historic data. Once you define the calendar, you cannot change the start date.

2. Select a period type. If you select Semi-monthly, enter a value between 1 and 28 in the Midpoint Offset field to determine the start date of the second time period each month. For example, if you enter the value 15, the second time period each month begins on the 16th.

3. Save the calendar.
   The system automatically creates the time period details. You can alter the default names for each time period.

4. If you want to add years to, or delete years from, the end of the calendar, choose the Change Calendar button.

5. When you have defined your calendars, you are ready to define your budgets.
Defining Human Resource Budgets

You define human resource budgets in the Budget window.

During the time period of the budget, it may be necessary to adjust the budget values as a result of organizational or financial change. You can create multiple versions of a single budget for comparison purposes.

To define a budget:

1. Enter the name of the budget, and select a measurement type and calendar. Save the budget.

2. Enter a version number and start date for this budget version. Save the new version.

3. Select the components for which you want to produce budget element information, and save your work.

   You can enter any combination of organization, job, position, and grade. You must select a value for at least one of the fields.

4. In the Budget Values block, select a specific time period from your calendar. Enter a numeric budget value for your selected budget element for that period.

   The system automatically gets the actual values and calculates the Variance as an absolute value and a percentage value.
5. Select other time periods for this budget element, as you require, and enter your budget values. Save your values.

6. Repeat steps 3 and 4 as necessary for other budget elements. Save your work.

**Viewing and Reporting Budget Variances**

You can view the variance for any budgets in the Budget window. If you are using positions, you can view the variance between your budget and the actual values for positions using two other windows:

- List Position Budget Variance
- List Budget Variance by Organization.

You can report on variances using the Staffing Budget Details report.
List Position Budget Variance

To view position variances within a hierarchy:

1. In the List Position Budget Variance window, select a position hierarchy and a position from the hierarchy. The inquiry will return the budget variance for this position and its subordinates in the hierarchy.

2. Select a budget and the budget period for which you want to view variances. Choose the Find button.

The folder displays the actual number of holders at the start and end of the period, the number of new starters and leavers during the period, and the variance between the budget value and the actual value at the period end.
To view position variances within an organization:

1. In the List Budget Variance by Organization window, do one of the following:
   - Select an organization hierarchy and an organization from the hierarchy. The inquiry returns the budget variance for all positions within this organization and its subordinates in the hierarchy.
   - Select an organization. The inquiry returns the budget variance for all positions within this organization.

2. Select a budget and the budget period for which you want to view variances. Choose the Find button.

The folder displays the actual number of holders at the start and end of the period, the number of new starters and leavers during the period, and the variance between the budget value and the actual value at the period end.
Staffing Budget Details Report

You can use the standard Staffing Budget Details report to compare your actual staffing levels with budgeted levels for a specified range of periods.

You run reports in the Submit Requests window.

To run the Staffing Budget Details report:

1. In the Name field, select Staffing Budget Details report.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. Select the budget and version.
5. Select the start and end periods to include in the report.
6. Choose the Submit button.
This chapter focuses on how to enter people and personal information on the system. You can choose to hold a wide range of personal information, such as medical details, work schedule, and preferred language for correspondence, as well as the basics such as date of birth, employee number, and addresses.

It also explains how to hire people, how to enter personal contacts, including dependents and beneficiaries, and how to inquire and report on the people held in the system.

For people who are your employees, there is assignment information and other information to hold. Chapter 14 Employment Information looks at information to record specifically for employees.
Displaying Personal Information

There are lots of ways to view information about people held in Oracle HRMS. For example, you can:

- use Employee Direct Access to view and update your own personal details using a web browser
- use Line Manager Direct Access to view information about people in your organization
- use the Find Person window or a People folder to display the people who interest you, then ‘drill down’. by clicking on buttons, to the information you need
- use an inquiry window to view specific information about a person, such as employment or absence history
- use QuickPaint to design a report incorporating personal, assignment, application, or compensation information

See Also

Web and Workflow Access: page 16 – 4
Inquiry Windows and Folders: page 29 – 3
QuickPaint: page 29 – 9
Using the Find Person Window

When you navigate to the People window, the Find Person window automatically displays in front of it.

To query a person using the Find Person window:

1. Do one or both of the following:
   - Enter a full or partial query on the person’s name. Where a prefix has been defined for the person, a full name query should be in the format ‘Maddox, Miss Julie’.
   - If relevant, enter a query on employee number, applicant number or NI number.

2. Choose the Find button.
   The person or people found by the query are displayed in the People window. If the query found more than one person, you can use the [Down Arrow] key or choose Next Record from the Go menu to display the next person.

People Folders

Using the People Folder window, you can enter inquiries about the people held on Oracle HRMS. You select the fields of personal information you want to see, and position them in the order you prefer. For example, you can produce an alphabetical listing of all applicants and their gender, nationality, and disability registration.

The system saves your inquiry and field formatting as a folder so you can rerun the inquiry at any time. You can make this folder available to all users, or save it as a private folder.

Note: The system administrator can create customized versions of the People Folder window so that you use each version for one person type only.
Entering Personal Information

Every enterprise must be able to record personal information for its employees, applicants, and contacts. Some of this information is standard, including basic information such as name, address, birth date, hire date, and nationality.

Oracle HRMS enables you to enter and update this information for all person types on one form – the People window. You can also use this window to update people’s statuses, for example, from applicant to employee.

Note: The system administrator can create customized versions of the People window so that you use each version for certain person types only or for certain functions only (entering employees, entering applicants, or hiring applicants).
Entering New People

Use the People window to enter and maintain basic personal information for all person types, including employees.

The minimum information to enter for all categories of people is name and type. In addition, for employees you must enter gender, employee number and date of birth (for assignment to a payroll). All other personal information is optional.

To enter a new person:

1. If the Find Person window opens, choose New.

2. Set your effective date to the appropriate date for adding the person to the system. If you are entering an employee, this should be his or her hire date.

3. Enter the person’s name and other details in the Name region. Only the last name is required.
   - You can use the Title field to enter a title such as Mrs. or Doctor for the person.
   - You can use the Prefix field to enter the first part of the person’s name, such as Van or De. This field allows you to sort by the main part of the last name, Zee instead of van der Zee, if you choose to do so.
   - You can use the Suffix field to hold part of the last name, such as Junior or II. This enables the suffix to be reported on separately, as required in some government-mandated reports.

4. Select a type. If you select Employee, the Hire Date field displays your effective date. You can change the hire date, and this changes the employee’s effective start date.

5. Enter the person’s identification information in the Identification region.
   - If your enterprise uses manual number entry, use the Employee or Applicant fields to enter an employee or applicant number as appropriate. If your enterprise uses automatic number generation, the employee or applicant number automatically displays when you save your entries in this window.

6. Enter details for the person as required in the Personal Information region:
   - To assign an employee to a payroll, you must enter his or her date of birth.
• In the Mail To field, select Home or Office to indicate the person’s preferred mail destination
• In the Date Last Verified field, you can enter the date the person last checked this personal information for accuracy.
• In the Status field, select the person’s marital status
• In the Email field, enter the person’s email ID

Optionally, you can enter additional information for people in the alternative regions described in the following steps.

**Note:** The Background Information, Medical Information and Rehire Information alternative regions appear only if your system administrator has enabled them for you.

---

**To enter employment information for employees and applicants:**

1. Choose the Employment Information alternative region.
2. Select the person’s ethnic origin.
3. Enter the work permit number for a non–EEA person.
4. Check the boxes to indicate that the person is a director, a pensioner, or has multiple assignments that you want to aggregate for processing.
5. For reporting purposes, enter any period of service that is not recorded on the system but that should count for pension calculations.

---

**To enter office location information for a new hire or an existing employee:**

1. Choose the Office Location Information alternative region.
2. Enter the office number for this office.
3. Enter the internal location of this office.
4. Enter the office identifier for internal mail.

---

**To enter information for an applicant:**

1. Choose the Applicant Information alternative region.
2. If the applicant’s resume is on file, check the Exists check box.
3. If the applicant’s resume is on file, select the date indicating when the resume was last updated.
4. Select the date up to which a file is to be maintained for this applicant.
To enter information concerning the background check for an employee:
1. Choose the Background Information alternative region.
2. Check whether the employee’s background check has been performed.
3. Select the date on which the background check was performed.

To enter rehire recommendation information for an applicant who was a former employee:
1. Choose the Rehire Information alternative region.
2. Check whether the former manager has recommended the applicant for rehire.
3. Select the reason for this recommendation.

To enter further name information:
1. Choose the Further Name Information alternative region.
2. Enter one or more honors/degrees (BA, MBA, or JD, for example) which the employee has earned.
3. Enter the name (perhaps a nickname) by which the employee prefers to be known.
4. If the employee previously was known by a different last name, enter the previous last name.

To enter medical information for an employee:
1. Choose the Medical Information alternative region.
2. Select the employee’s blood type. You cannot change this value once you enter it.
3. Select the date of this employee’s last medical test.
4. Enter the name of the physician who performed this test.

To enter other information for a person:
1. Choose the Other Information alternative region.
2. Select the type of schedule the employee will work.
3. Select the current status of the student.
4. Enter the person’s current full time/part time availability to work with your company.
5. Select the language the person prefers for correspondence. This language can differ from the person’s native language, depending on the nature of the correspondence.

6. Check the Military Service check box if the person is employed in a military service in some capacity. The value of this field can impact benefits calculations.

7. Check the Second Passport Exists check box if the person possesses multiple passports.

Hiring

When you enter a new person as an employee, he or she is automatically hired as of your effective date.

► To hire an applicant:

1. Update the applicant assignment status to Accepted in the Application window.

2. Set your effective date to the applicant’s hire date and query the applicant in the People window.

3. In the Type field, select Employee. The Hire Date field displays your effective date.

4. Save your work.

Note: You cannot update the applicant assignment status to Accepted and change the Person Type to Employee on the same date, since these are both datetracked changes.

► To rehire an ex–employee:

1. Set your effective date to the new hire date and query the ex–employee in the People window.

2. In the Type field, select Employee. The Hire Date field displays your effective date.

3. Save your work.

► To cancel a hire:

- Query the employee in the People window and clear the Hire Date field. Then save.
The system warns you that any changes made to the person’s records after their hire date will be lost. You can choose whether to continue or cancel.

You cannot cancel a hire if:

- Oracle Payroll has processed the employee in a payroll run.
- The person’s type has changed since the hire date.
- New assignments have been created for the person after the hire date.
- The person was initially entered on the system as an employee and therefore has no previous history as an applicant or contact. In this case you must delete the person’s records from the system using the Delete Person window.

See: Deleting a Person from the System: page 13 – 30
Entering Addresses

You can enter as many addresses as necessary for each person, using the Address window.

Prerequisites

- Set up any address types you want to use (such as home or business) as QuickCodes for the QuickCode Type ADDRESS_TYPE.

  See: Adding QuickCode Values: page 31 – 3

To enter an address for a person:

1. Select a national address style and click in the Address field. A window opens with the address format for the country you select.

2. Enter your address information in this window. You can enter up to three telephone numbers to associate with the address. Choose the OK button. This returns you to the Address window.

   **Note:** Telephone numbers you enter here are held separately from the numbers you enter in the Phone Numbers window. You have to enter and maintain them separately.

3. Select an address type, such as home, or weekend, or business. You can only have one address of each type at any time.

4. You can check Primary for the address you are creating, to identify the person’s main address. By default, the first address you enter is the Primary address. Only one address at any time can be a person’s Primary address.

5. Save your work.

**Additional Information:** Default address styles are predefined for many countries. You can change these defaults and you can create address styles for other countries.
To change the primary address:

- End the existing primary address, and create the new primary address starting the next day.

#### Adding Telephone Information

You can enter multiple telephone numbers for people in the HRMS database. To enter telephone information for a person, use the Phone Numbers window.

To enter a telephone number:

1. In the Type field, select the type of the telephone device.
2. In the Phone Number field, enter the telephone number. Any format is allowed.
3. In the From field, select the start date for the telephone number.
4. In the To field, optionally select the date when the telephone number is no longer valid.
5. Save your work.

**Note:** If you want to maintain a history of telephone numbers for this person, be sure to add a new entry for the new telephone number and enter an end date for the existing
existing telephone number. If you do not want to maintain such a history, simply update the record for the existing telephone number.
Entering Pictures

You can store a picture associated with each person on your system, perhaps holding a photograph or digitized image of the person’s signature. These may be useful for approval or identification purposes. You must digitize the image and save it in one of the following file formats:

• BMP
• JFIF
• JPEG
• PCX
• PICT
• TIFF

You enter pictures in Oracle HRMS in the Picture window.

To enter a person’s picture in Oracle HRMS:
1. In the Picture window, choose the Load Picture button.
2. Enter the file path to locate the directory in which you saved the graphic file.
3. Highlight the filename and choose the OK button. The graphic is loaded in the format indicated by the filename. For example, a file called image.bmp would be loaded as a BMP file.

Entering Next of Kin and Other Contacts

Use the Contact window to hold information about an employee’s contacts, for example:

• people to contact in an emergency
• dependents
• beneficiaries of benefits such as insurance policies or stock purchase plans
• people receiving a third party payment withheld from the employee’s salary

A person entered as a contact can be one, some, or all of the above.

Prerequisite

☐ Set up any relationship types (such as spouse, child, or friend) you want to use as values for the QuickCode Type CONTACT.
To enter a contact:

1. Do one of the following:
   - Enter the name of a new person.
   - Select from a list of people already entered on the system.
2. If you enter a new person, you can select their gender and enter their birth date.
3. Optionally, select a relationship type for the contact.
4. If this contact is the recipient of a third party payment (for example, from a court-ordered deduction), check the Payments Recipient check box.
   This allows you to select this person on the Personal Payment Method window when entering a third party payment method for the employee.
5. Save your work.
6. To enter addresses for the contact, choose the Address button.
Competence Profiles, Qualifications, School Attendances and Work Choices

As you recruit new people and develop existing employees, you need to track their competencies and work preferences. This enables you to match them to projects and vacancies, develop succession plans, and organize further training and certification. In Oracle HRMS, you can record the following information:

- A competence profile – this is a list of the competencies held by a person and their level of proficiency in each competence.
- Qualifications, including details of individual subjects, grades, licenses, status of ongoing training and tuition fees.
- Attendances at educational establishments, such as schools and colleges.
- Work choices, including willingness to travel and relocate; preferred working hours, work schedule, and duration within post and preferred countries for international relocation.

You can enter this information when an employee first joins the enterprise, taking the details from their resume or from tests or interviews. You might update it after the employee successfully completes a training course, and after periodic assessments or appraisals.

You can either enter this information using standard Oracle HRMS windows or using the web–based Line Manager Direct Access.

Copying Core or Primary Assignment Competencies

Some competencies are important for all employees throughout your enterprise; others are required for particular jobs, positions, or organizations. If competencies have been entered as core competencies for your enterprise or as requirements against a person’s job, position, or organization, you can copy them to the person’s competence profile. Copying competencies not only saves you time from having to enter the details yourself, but it also ensures that you do not miss entering relevant competencies.

To assist you in entering applicants and evaluating employees against vacancies, you can also copy competencies from a vacancy. The system checks all the competence requirements of the organization, job and/or position for which the vacancy is defined. It enters these against the person so that you can record the person’s proficiency in each competence and then compare applicants against the vacancy’s requirements.
Managing Competencies Over Time

You can make changes to the competencies and proficiency levels your employees possess over time, enabling you to see both the latest and historical information. When you view a competence profile, you can choose whether to see just the current profile or all historical information, if you want to see changes in proficiency levels over time.

Use Oracle Alert’s automatic mail notification to keep you informed when an employee’s competencies need certification and renewal. This frees your time for more essential tasks. For example, use the competence Renewal Period to drive Oracle Alert—it compares the renewal period date with the date on the person’s Competence Profile, or the last training class delivering the skill.


Creating a Competence Profile

Use the Competence Profile window to create and update a personal competence profile.

When you open this window, you will see all competencies, past and present, held by the person. If you want to see only current
To create a competence profile:

1. Select the first competence this person possesses.
   You can also automatically enter all competencies required for the person’s primary assignment or a vacancy, or the enterprise’s core competencies. See: To copy competencies from requirements: page 13 – 17.

2. Select the proficiency level at which the person performs the competence.

3. Enter the date from which the person possesses the competence at this level. For example, if the person gained the competence through a qualification, enter the date the qualification was gained. You can enter a date when the competence expires, if required.

4. In the Source of Proficiency Rating field, you can select the method by which the person gained the competence, such as training course or previous experience.

5. Select the method of certifying that the person attained the competence at the recorded level, such as by examination.

6. Enter the date when the person’s proficiency in this competence should be reviewed.

7. Continue to enter the competencies the person possesses, then save your changes.

To copy competencies from requirements:

1. Choose the Copy Competencies button. A Copy Competencies window appears.

2. Do one of the following:
   - Check the Core Competencies box to copy all the competencies required throughout your enterprise.
   - Check the Primary Assignment Competencies box to copy all the competencies required in the organization, job and position to which the person is assigned.
   - Select a vacancy to copy all the competencies required in the organization, job and position for which the vacancy is defined.

3. Enter the dates between which the competencies are valid (you must have a From date, but you can leave the To date blank).
4. Choose the Copy button. 

You can now enter proficiency levels, certification methods, and so on for each of these competencies held by the person.

▶ To update a competence profile:

1. Check the current check box if you want to see only the current competencies the person possesses, otherwise leave this box blank.

2. Enter new competencies for this person, or update proficiency levels and other details for existing competencies.

   **Note:** If you update a proficiency level, enter the date when the new level was attained. Then, when you save your changes, you will see that the system keeps a record of the old proficiency level, ending the day before the start date of the new level.

3. Save your changes.
Entering Work Choices

You can a person’s work choices, such as their willingness to travel or relocate, their preferred working hours and work schedule, and the length of time they would like to stay in their next post. You can then compare these choices with the work requirements of jobs or positions when you are planning redeployment.

You enter personal deployment choices in the Work Choices window, accessed from the People window.

To enter work choices for a person:

1. Check the relevant work capabilities boxes if the person is:
   - willing to work in all locations
   - willing to relocate
   - willing to travel
   - prepared to work in their current location only
   - willing to visit internationally

2. Select the length of time the person wants to stay in a role, for example, indefinite or two years.

3. Select the person’s preferred working hours (for example, 9.00 to 5.30), work schedule (the working days in the week or pattern of shifts), the proportion of full time hours available and any relocation preferences (for example, with family).
4. Check the relevant international deployment boxes if the person is willing to:
   • work in all countries
   • relocate
5. Select the countries in which the person prefers to work, and any countries in which they are not prepared to work.
6. Save your work.
Entering Qualifications

You can enter an employee’s qualifications when they first join the enterprise, and then update them after periodic assessments or appraisals or after completion of a training course.

Use the Qualifications window, accessed from the People window, to enter and update qualifications.

To enter qualifications:

1. Select the type of qualification this person possesses and the title of the qualification.
2. Select the status of the qualification, for example, whether training is ongoing or completed.
3. Enter the grade at which the person holds the qualification, if appropriate.
4. Select the establishment at which the person gained the qualification.
5. Enter the awarding body which bestowed the qualification, if you want.
6. Enter the dates between which the qualification is gained. You must enter a Start date but you can leave the End date blank (if the qualification is still incomplete).
7. Enter the date the qualification was awarded, if you want.

8. Enter the projected completion date the qualification is awarded, if relevant.

9. Enter the ranked position within the class, if relevant.

10. Enter any comments, for example, what percentage of the award was course work or examination, if you want.

11. Save your work.

**To enter tuition fees for reimbursement:**

1. In the Tuition Details alternative region, enter the amount and select the currency to reimburse the person.

2. Select the method of tuition, for example, day release.

3. Enter the method of reimbursement, for example, bank transfer to be paid when qualification is awarded.

4. Save your changes.

**To enter training details:**

1. Choose the Training Details alternative region.

2. Enter the amount of training completed. For example, enter 30 days completed of a training program that lasts 60 days.

3. Enter the total amount of training required to deliver the qualification.

4. Enter the units in which the training is measured, for example, days.

**To enter license details:**

1. Choose the License Details alternative region.

2. Enter the licence number, for example, a driving licence number.

3. Enter any restrictions, for example, licence not valid in certain states.

4. Enter the licence expiry date.

**To enter subjects:**

1. Enter the first subject the qualification comprises.

2. Select the status at which the subject is awarded, for example, whether training in the subject is ongoing.
3. Enter the dates between which the subject is studied. You must enter a Start date but you can leave the End date blank (if the subject is still incomplete).

4. If the subject forms a major part of the qualification, check the Major box.

5. Enter the grade at which the subject is studied, if you want.

6. Continue to enter further subjects until you have entered them all for the qualification, then save your changes.

---

**Entering Schools and Colleges Attended**

You can enter the school or college at which the person gained a qualification.

Use the School and College Attendances window, accessed from the People window, to enter attendance at an establishment.

---

**To enter schools and colleges attended:**

1. Select the name of the school or college that the person attended.

2. Enter the dates of the attendance. You must enter a Start date but you can leave the End date blank (if the attendance is ongoing).

3. If attendance is full time at the school or college, check the Full Time box.

4. Continue to enter schools or colleges, if required, then save your changes.
Entering Special Information

Basic personnel information is handled in a fairly standard way from enterprise to enterprise. However, other types of information are recorded and used in quite different ways. Examples include training records, disciplinary records, competence, and medical records. Oracle HRMS does not restrict you to any predefined format for holding this information. You can set up your own user-defined fields for recording, analyzing, and reporting on whatever special information you require.

You set up each area of information that you want to handle separately as a Special Information Type. For example, you might define special information types for medical details and disciplinary records. You can enter a person’s information under these sorts of headings in the Special Information window.

Note: Your system administrator can create customized versions of the Special Information window, for entry of information for only one or a selected set of information types.
To enter special information for a person:

1. In the Name field, select the type of information you want to enter for the person.
2. In the Details block, click in the Detail field to open a window for entering information of this type.
3. Choose the OK button when you have completed your entries, then save your work.

See Also

- Listing People by Special Information: page 13 – 26
- Skills Matching Report: page 23 – 5
- Defining Special Information Types: page 27 – 10
Listing People by Special Information

To view a list of people who match a particular profile for one Special Information Type, use the List People By Special Information window.

**Note:** The system administrator can create customized versions of the List People By Special Information window so that you use each version for one information type only. For example, one version could be called List People By Technical Skills.

To list people by special information:

1. Select a Special Information Type.
2. Click in the Details field. A window opens prompting you for the details you have defined for this information type.
3. Enter values in the fields against which you want to match people, then choose OK. If you leave a field blank, it is not used in the matching process.
4. Choose the Find button.
Employees and applicants who match your selection criteria are listed in the folder in the lower part of the window. You can enter a query here to further restrict the list of people. If you have access to the Folder menu you can remove, rearrange, or resize the fields displayed.
Tracking People’s Roles and Activities

Table 13 – 1 lists the windows you can use to track the roles and activities of employees and applicants. These windows are described in context in other topics, as listed in the table.

You can also use the web–based Line Manager Direct Access to enter some information, such as assessments and appraisals, and to view a wide range of employee data, including employment history, roles (who they manage, supervise etc.) and absence history.

See: Web and Workflow Access: page 16 – 4

<table>
<thead>
<tr>
<th>Window</th>
<th>Used For</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment</td>
<td>describing the work role of an employee</td>
<td>The Employee Assignment: page 14 – 4</td>
</tr>
<tr>
<td>Application</td>
<td>describing the vacancy for which an applicant has applied</td>
<td>Entering Full Application Information: page 15 – 12</td>
</tr>
<tr>
<td>Absence Detail</td>
<td>recording an employee’s absence from work</td>
<td>Entering Absences: page 24 – 13</td>
</tr>
<tr>
<td>Book Events</td>
<td>recording that an employee or applicant will attend an event. The event must be already defined in the Event Bookings window.</td>
<td>Managing Bookings and Attendance: page 25 – 3</td>
</tr>
<tr>
<td>Employee Review</td>
<td>scheduling and recording details of an employee’s review or other interview type</td>
<td>Employee Reviews: page 25 – 4</td>
</tr>
<tr>
<td>Applicant Interview</td>
<td>scheduling and recording details of an applicant’s interviews</td>
<td>Interviewing Applicants: page 15 – 17</td>
</tr>
</tbody>
</table>

Table 13 – 1 Other Windows for Personal Information

You can enter other work–related information for employees, such as salary and payment methods, after entering the employee’s assignment.

See Also

Managing Employment Information: page 14 – 2
Full Personal Details Report Set

To create printed reports of the personal information held for one person, you can run the Full Personal Details report set. It comprises four reports that meet employees’ rights to view their own personal details under data protection legislation:

- Full Person Details 1 reports on addresses and information entered in the People window, such as name, date of birth, nationality, and work telephone number.
- Full Person Details 2 reports on applications and applicant interviews.
- Full Person Details 3 reports on assignment information including periods of service, payment methods, and element entries.
- Full Person Details 4 reports on miscellaneous work information, including special information, absences, recruitment activities, and contacts.

If you do not need to see all this information for the employee, you can run individual reports rather than the report set. The Full Person Details report, Full Assignment Details report, and Full Work Details report are equivalent to reports 1, 3, and 4 in the report set, respectively. The Full Applicant Details report is equivalent to report 2 in the report set, but you can only run this as a separate report for an applicant, not an employee.

You run report sets from the Submit Request Set window.

To run the Full Personal Details report set:

1. In the Request Set field, select Full Personal Details.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the reports.
4. Enter the name of the person for whom you want to print the reports.
5. Choose the Submit Request button.

See Also

Employee Summary Report: page 14 – 30
Deleting a Person from the System

If you mistakenly save information in the People window, you can remove the person by selecting Delete Record from the Edit menu. Notice that you are prevented from performing this action if you have entered information about that person in other windows.

If you want to remove all records of a person, use the Delete Person window. Notice, however, that you cannot use this window to remove the records of an employee or ex–employee whom Oracle Payroll processed in any payroll runs.

To delete all records of a person:

- Query the person in the Delete Person window and choose the Delete Person button.

  If there is a contact for the person you are deleting, there are two possibilities:

  - If the only information held about the contact is the basic person details entered in the Contacts window, then the record of the contact is deleted.
  - If there is other information held about the contact (for example, assignment or applicant information), the contact is not deleted. However, the record of their relationship to the person you are removing from the system is deleted.
The previous chapter focussed on the personal information you hold for all types of people. Employees require additional information on where they fit into your enterprise, and on their compensation and benefits.

This information is the substance of a contract an enterprise has with each of its employees. It associates the employee to the enterprise’s work structures and compensation and benefit policies.

This chapter describes the key types of employment information, how you hold them in Oracle HRMS, how you track changes in employment for employees, and how you can report and inquire about employment information.
Managing Employment Information

Table 14 – 1 below summarizes the information typically held for an employee, and how you can hold this information in Oracle HRMS.

<table>
<thead>
<tr>
<th>Information</th>
<th>How to set it up</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Title or Position</td>
<td>Assign the employee to work structures in the Assignment window.</td>
</tr>
<tr>
<td>Department</td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td></td>
</tr>
<tr>
<td>Grade</td>
<td></td>
</tr>
<tr>
<td>Grade Step Placement</td>
<td>Enter in the Grade Step Placement window; enter any special ceiling in the Assignment window.</td>
</tr>
<tr>
<td>Name of manager or position to report to</td>
<td>Use a position hierarchy or enter supervisor name in the Assignment window.</td>
</tr>
<tr>
<td>Salary</td>
<td>Assign to a salary basis in the Assignment window; enter amount in the Salary Administration window.</td>
</tr>
<tr>
<td>Benefits</td>
<td>Define and link elements; enter values in the Element Entries window.</td>
</tr>
<tr>
<td>Pay Frequency</td>
<td>Assign to a payroll in the Assignment window.</td>
</tr>
<tr>
<td>Pay Method</td>
<td>Accept the default from the Payroll to which the employee is assigned or select a method in the Personal Payment Method window.</td>
</tr>
<tr>
<td>Full time/part time status</td>
<td>Assign to an employment category.</td>
</tr>
<tr>
<td>Standard Work Day</td>
<td>Enter in the Assignment window or accept the default from the organization or position to which the employee is assigned.</td>
</tr>
<tr>
<td>Overtime rules</td>
<td>Define an element, using links to define eligibility rules, and element entry defaults or validation to control the values given.</td>
</tr>
<tr>
<td>Vacation Entitlement</td>
<td>Define Absence Types and set up increasing or decreasing balances for the employee; enroll employee in appropriate accrual plans.</td>
</tr>
<tr>
<td>Sickness Entitlement</td>
<td></td>
</tr>
<tr>
<td>Maternity Entitlement</td>
<td></td>
</tr>
<tr>
<td>Notice Period</td>
<td>You should hold full text procedures and regulations outside the system, perhaps using Oracle Book to hold the information online. You can associate groups of people with different rules or procedures using the People Group key flexfield.</td>
</tr>
<tr>
<td>Disciplinary procedure</td>
<td></td>
</tr>
</tbody>
</table>

Table 14 – 1 Employment Information
Table 14–1 Employment Information

<table>
<thead>
<tr>
<th>Information</th>
<th>How to set it up</th>
</tr>
</thead>
<tbody>
<tr>
<td>Costing</td>
<td>Enter cost codes for the assignment in the Costing window, or accept the default from the organization to which the employee is assigned.</td>
</tr>
<tr>
<td>Probation Period</td>
<td>Enter in the Assignment window.</td>
</tr>
</tbody>
</table>

Every enterprise needs to track the changes in employment information for each employee over the lifetime of their employment:

- Where a change affects a group, the human resource system must be able to effect that change for every individual in the group according to a set of rules.
- Where a change affects only a few individuals, the system must allow entry of changes for those individuals.

In Oracle HRMS, you manage these changes through the *employee assignment*:

- The assignment connects employees to your enterprise’s work structures and policies, so that changes to the structures and policies are reflected in the employee’s records.
- You can query groups of employees with similar assignments (such as all assignments on grade C2) and make changes for each employee in these groups.
- The assignment is datetracked to maintain a work history as the employee moves through your enterprise.
The Employee Assignment

The assignment is the central concept that relates employees to the structures in which they work, and the compensation and benefits for which they are eligible.

In Oracle HRMS, many of the activities you undertake in human resource management, such as vacancy management and budget planning, are based around assignments and not people. In particular, you enter all earnings, deductions, and other pay–related elements for the employee assignment, rather than the employee. This makes it possible to give an employee two or more assignments when this is necessary.

For example, if an employee has two or more open contracts of employment with your enterprise, he or she can have a separate assignment for each contract.

An employee must have a current assignment at all times. You record relocations, promotions, transfers and so on as changes to the existing
assignment. These changes are datetracked so that you can view the history of changes to an assignment, and can make future-dated changes in advance.

Components of the Assignment

At a minimum, an assignment defines the Business Group for which an employee works, the date the assignment began, and its current status, such as active or suspended.

You can use the assignment to define more precisely the place of the employee in the enterprise, including his or her job, position, organization, location, grade, and supervisor. You can also assign the employee to any of the employee groups you set up using the People Group key flexfield, such as pension groups or unions.

You can assign employees to an employment category, such as Part Time – Regular or Full Time – Temporary. Your startup data includes four categories, and you can add others for the QuickCode Type EMP_CAT.

You can assign employees to a salary basis and maintain their salaries or wages using the Salary Administration procedure.

See Also

Salary Administration and Performance Reviews: page 10 – 2
Contract Staff and Other Non-Standard Assignments: page 6 – 12

Using Multiple Assignments

Relocations, transfers, promotions and so on go on record as datetracked changes to employees’ existing assignments; you do not enter new assignments for changes like these.

However if your enterprise permits employees to work in two or more different capacities at once and thereby become eligible for different benefits, you can enter additional assignments for them.

You can maintain multiple assignments for any employee, but must designate one as the primary assignment. Oracle HRMS separately manages each assignment, and its associated compensation and benefits.
To show that an assignment is part time, you use the employment categories Part Time – Regular or Part Time – Temporary. You could also set up a Full Time Equivalent budget, and weight each assignment as a fraction of a full time equivalent for the calculation of actual values.

Notice that when employees split their time between two departments performing the same job, or fulfill two different roles in one organization, you do not need to define two separate assignments to maintain accurate costing records. You can set up cost allocation to distribute proportions of one assignment’s payroll costs to different cost centers.

See Also

Human Resource Budgets: page 12 – 2
Setting Up Assignments for Cost Collection: page 11 – 5

Identifying Employees and Assignments

Oracle HRMS uses two unique identifiers for employees:

- Employee Number
- Employee Assignment Number

Employee Number

The Employee Number uniquely identifies every employee in your Business Group.

An employee can have only one Employee Number. You decide how this number is to be generated when you define your Business Group:

- Automatic
- Manual
- National Identifier (for example, the US Social Security Number or the UK National Insurance Number)

If you choose automatic or national identifier number generation, the employee number, by default, remains the same for an employee who has multiple periods of service. If you choose manual number entry, you can update the number at any time.

The employee name and number appear together in people information windows, such as the People window and View Absence History.
window. In these windows you can select an employee by name or by employee number.

**Employee Assignment Number**

The employee assignment number uniquely identifies every assignment that exists within your Business Group. An employee can have one or more than one assignment, and therefore more than one assignment number.

The system automatically generates the assignment number, which is the same as the employee number by default. You can manually override the default assignment numbers the system generates. For example, you might want to use this number to store a payroll code.

If an employee has a second current assignment, the system also generates the second Assignment Number by default from the Employee Number, as in the following example:

<table>
<thead>
<tr>
<th>Employee Name</th>
<th>Samantha Green</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Number</td>
<td>1012</td>
</tr>
<tr>
<td>1st Assignment Number</td>
<td>1012</td>
</tr>
<tr>
<td>2nd Assignment Number</td>
<td>1012-02</td>
</tr>
</tbody>
</table>
Entering a New Assignment

Enter new assignments in the Assignment window. You must hire applicants before you can create an employee assignment for them. The details of the employee assignment default from their accepted application.

To enter a new assignment:

1. Set your effective date to the start date of the new assignment.
2. Select the organization to which you want to assign the employee. By default, the employee has an assignment either to the Business Group organization, or to the organization to which he or she was an applicant. If a location is defined for the Business Group or other organization, it also appears as a default. If you overwrite these defaults, a window appears asking if the change is an update or a correction. Select Correction.
3. Select a payroll if you are paying the employee using Oracle Payroll, or if you intend to record for the employee certain types of compensation and benefits (represented on the system by nonrecurring elements).
   
   **Note:** If Oracle Payroll is installed and you are an HR User, you cannot assign employees to payrolls. Ask your system administrator to change your HR:User Type profile option if you need to assign employees to payrolls.
4. Select a grade if you use grade rates or grade scales to determine the appropriate compensation levels for employees.
5. Select any other components which you want to include in the assignment. These are optional.

6. Select a Status for the assignment. By default a new assignment has the status Active Assignment (or an equivalent user status defined on your system).

   See: Assignment Statuses: page 27 – 5

7. Enter an Assignment Number to uniquely identify the assignment. By default, this number is the same as the Employee Number, for the employee’s first assignment.

8. Enter the information you want to hold in the alternative regions.

**Supervisor Region**

Enter the name and employee number of the employee’s personal supervisor.

**Note:** This information shows the personal supervisor for an employee and is not updated by the system. Use organization and position hierarchies to show management reporting lines.

**Note:** The Auto WGI uses this information.

**Probation Period and Standard Conditions Regions**

The probation period and standard work day information default from the employee’s position. If standard conditions are not defined for the position, they may default from the employee’s organization or Business Group.

**Miscellaneous Region**

The Internal Address adds address details (such as the floor or office number) to the location address.

You can select a reason for adding or changing the assignment. You define valid reasons as values for the QuickCode Type EMP_ASSIGN_REASON.

Check the Manager check box if the assignment is at the level of manager.

Check the Primary check box if it is the employee’s only assignment or main assignment.

**Special Ceiling Region**

A special ceiling progression point is the highest point to which the Increment Progression Points process can automatically progress the employee.
You can enter a special ceiling if the employee is assigned to a grade, and a grade scale is defined for this grade. This special ceiling overrides the ceiling defined for the grade scale.

**Salary Information Region**

Using the Salary Administration window, you can enter a proposed salary change for an employee, associate this change with a performance review, and accept or revise the change later. To administer an employee's salary in this way, you first assign the employee to a salary basis in the Salary Information region.

You can also enter the frequency of salary and performance reviews.

**Attention:** If you change an employee’s salary basis to a basis that uses a different salary element, the employee’s existing salary element entry will be ended. Using the Salary Administration window, you should make a new salary entry for the employee, effective from the date of the salary basis change.

**See Also**

Salary Administration and Performance Reviews: page 10 – 2
Additional Employment Information: page 14 – 18
Changing Assignment Information

When an employee experiences changes such as a promotion, transfer, or move from full time to part time, you change a component of the assignment. A change to any of the assignment components produces the DateTrack prompt.

- If you choose Correction, Oracle HRMS overwrites the existing assignment information.
- If you choose Update, Oracle HRMS records the date and change, and retains the original information.

By changing your effective date on the system, you can see the employee’s assignment at any point in time. You can also view the changes made to the assignment over time using DateTrack History.

DateTrack History shows the changes made to one assignment. Use the Assignment History window to view the history of all the employee’s assignments, both currently and in any previous periods of service.

Effects of Changing an Assignment

Changing any assignment component can have the following effects:

- The employee may lose eligibility for some compensation types, benefits or deductions, and gain eligibility for others. You receive a warning that the system automatically ends any unprocessed element entries for which the employee is no longer eligible.
- The employee may have a different level of access to Oracle HRMS, since the system’s security is based on assignment to work structures.
- If you change the employee’s grade when a grade step placement exists for the assignment, you receive a warning message that the placement will be date effectively ended and any future placements will be deleted. Also, the special ceiling point field is cleared.

Note: If an assignment change causes the system to change element entries, you may not be able to save the change if a current or future pay period is closed. You must reopen the period or change your effective date to make the change.

Changing Primary Assignments

Over time, a secondary assignment may need to be elevated to a primary assignment. Most companies have requirements to show the history of changes in an employee’s record.
This process will create two historical records: one showing a secondary assignment that lasted from x day to y date, and the other showing that the primary assignment started as one set of components and then changed to another set of components (which are the same as the secondary assignment) as of a particular date.

**To change a primary assignment:**

1. Create a new assignment “B” as a secondary assignment.
   See Entering a New Assignment: page 14 – 8
2. Set an effective date for the assignment to become the employee’s primary assignment.
3. Change Assignment “B” to be the primary assignment by selecting the Primary checkbox in the Miscellaneous alternative region.

**See Also**

Assignment History: page 14 – 32
Viewing Datetracked Information and History: page 1 – 13
Updating and Correcting Datetracked Information: page 1 – 14
Ending an Assignment

Oracle HRMS does not permit an employee to exist in the system without an active assignment. That is, an employee must always have at least one active assignment at any point in time. This means that for an employee with just one active assignment, the only way to end the assignment is to terminate the employee, using the Terminate window.

See: Ending Employment: page 14 – 14

For employees with more than one active assignment, you can end all but one of their assignments by selecting an assignment status of End or Terminate in the Assignment window. Sites not using Oracle Payroll can use these two statuses to provide information. For example, End may mean that further pay processing cannot occur for the assignment, while Terminate may mean that further processing can occur. Alternatively, these sites can simply use the status End.

At sites using Oracle Payroll, the choice of End or Terminate controls the ability to include the assignment in a payroll run after the date the assignment ends, as explained in the procedure below.

To end one of many assignments:

1. Set your effective date to the actual termination date for the assignment.

2. Update the assignment status to End or Terminate Process Assignment (or the equivalent user status on your system):

   - Use *Terminate Process Assignment* (with a Payroll system status of *Process*) if further pay processing of the assignment is required after the date the assignment ends. This leaves the assignment’s final processing date open so that further processing can occur.

   - Use *End* (with a Payroll system status of *Do Not Process*) if all pay processing for the assignment is finished. This makes your effective date the assignment’s final processing date, after which no further processing for the assignment can occur.

   **Note:** The End status is not recorded on the assignment; it causes the assignment to end as of the effective date of entry of this status.

   - To temporarily prevent pay processing for this assignment, use the status *Terminate Assignment* (with a Payroll system status of *Do Not Process*). When no further processing is required and you are ready to set a final processing date, update the status to *End*. 
Ending Employment

If an employee is leaving your enterprise, you terminate him or her. This changes the person type to ex-employee and ends all assignments.

If an employee is leaving your agency, you terminate him or her. This changes the person type to ex-employee and ends all assignments.

The ex-employee’s records remain in the database. You can reinstate, or rehire, the person to create a new period of service.

Since terminating ends all assignments, the system does not permit you to terminate an employee who has future-dated assignments.

**Note:** If you have mistakenly added someone to the database or you want to remove all records for an ex-employee, you can delete the person in the Delete Person window. You cannot delete an employee whom Oracle Payroll has processed in a payroll run.

See: Deleting a Person from the System: page 13 – 30

If you mistakenly hired an applicant, you can cancel the hire in the Person window.

See: Hiring: page 13 – 8

Terminating an Employee

You end employment in the Terminate window.

**To terminate an employee:**

1. Optionally, enter the reason for the termination. You can define valid reasons as values for the QuickCode Type LEAV_REAS.
If you use Oracle Payroll and the employee is deceased, you must select the reason Deceased so that this is recorded on the P45.

2. Enter the termination dates. Only the Actual date is required. This is the date when the employee’s person type changes to Ex-employee. The Notified and Projected dates are for information only. The Final Process date is a date after which no further pay processing for the employee can occur, if you are using Oracle Payroll.

For the Final Process date:

- If you may need to process pay for the employee after termination, set the Final Process date later than the Actual date, or leave it blank.

  This means that the employee’s assignments are given the default user status for the HR System Status Terminate Assignment. If there is more than one user status defined for this system status, when you choose the Terminate button the system prompts you to select which status to enter on the employee’s assignments.

- If you do not need to continue processing, set the Final Process date to the Actual date.

**Note:** If you are an Oracle Payroll user, you must also enter a Last Standard Process Date. This is the last date for normal processing, while the Final Process date is the last date for late payments. Element entries are closed down on the Last Standard Process, the Actual date, or Final Process date, depending on how you have defined the elements.

3. When the information is complete, choose the Terminate button to complete the termination.

**Setup To Allow Processing After Termination**
Cancelling a Termination

If the employee decides not to leave, or the date of leaving changes, you can cancel a termination. You can cancel a termination at any time provided that you have not rehired the employee. (You rehire an employee by changing his or her person type to Employee in the Person window.)

Oracle HRMS reopens the assignments previously closed down and gives each assignment the status it had before termination. It also restores other information to its state before termination. For example, it removes the end date put on recurring element entries for the assignment.

Notice, however, that any nonrecurring element entries that were deleted for processing periods after the termination date cannot be automatically restored. You must act to reenter these entries.

- **To cancel a termination:**
  - Choose the Reverse Termination button in the Terminate window.

- **To change the termination date:**

  1. Cancel the termination by choosing the Reverse Termination button.

  2. Enter a new Actual date and choose the Terminate button.

Terminations Report

Oracle HRMS includes a standard report showing the reasons why employees left your organization within a specified period.

You run reports from the Submit Requests window.

- **To run the Terminations Report:**

  1. In the Name field, select Terminations.

  2. Enter the Parameters field to open the Parameters window.

  3. Enter the effective date for which you want to see the report.

  4. In the Organization Structure field, select an organization hierarchy name, if you want to see terminations in a number of subordinate organizations. If there are multiple versions, select a version.

  5. In the Parent Organization field, select the parent organization within the hierarchy whose subordinate organizations you want to see in the report.
6. Enter the start and end dates defining the period in which you are interested.

7. Select at least one termination reason to include in the report.

8. Choose the Submit button.

See Also

Employee Movements Report: page 14 – 30
Additional Employment Information

Just as you can record additional information about people, such as their addresses, contacts, and skills, you can also record additional information associated with each employee assignment. The main items of information are as follows:

- You can propose or approve a salary change in the Salary Administration window.
  See: Entering Salaries and Salary Changes: page 10 – 9
- You can make entries to the earnings, deductions, benefits and other elements the employee is eligible for, using the Element Entries window.
  See: Entering Elements: page 9 – 4
- If you use a pay scale and progression point system, you can place the assignment on a pay scale using the Grade Step Placement window.
  See: Placing an Employee on a Grade Step: page 4 – 17
- You can select the cost centers or accounts to which the costs of the assignment should be allocated, using the Costing window.
  See: Setting Up Assignments for Cost Collection: page 11 – 5
- You can use the Assignment Budget Values window to specify the value of the assignment in terms of headcount, full time equivalent (FTE), or any other budgets you have defined.
  See: Human Resource Budgets: page 12 – 2
- For employees who have assignments to payrolls, you can select the methods by which the employee wants to receive pay for this assignment in the Personal Payment Method window.
  See: Entering Payment Methods for an Employee Assignment: page 14 – 19
- You can enter secondary assignment statuses for analysis and reporting, if these have been defined on your system.
  See: Entering Secondary Assignment Statuses: page 14 – 21
Entering Payment Methods for an Employee Assignment

For each employee assignment, you can enter one or more payment methods, selecting from the list of valid methods for the employee’s payroll.

If you enter multiple methods (for example because the employee is paid from more than one source account), you can enter the proportion of pay for each method and its processing priority. An assignment can have two instances of the same payment method, for example if salary is divided between two bank accounts.

Employees with no personal payment method on record receive pay by the default payment method of their payrolls.

You enter payment methods for employee assignments in the Personal Payment Method window. You can also use this window to enter the payee for third party payments.

Prerequisites

- Define all the payment methods available in your Business Group using the Organizational Payment Method window.
  
  See: Defining Payment Methods for the Enterprise: page 5 – 3

- Select at least one valid payment method for each payroll you define in the Payroll window.

  See: Defining a Payroll: page 5 – 5

- Assign the employee to a payroll.

- For third party payment methods, define the payee in the Organization window (using the classification Payee Organization) or the Contact window (using the relationship Payments Recipient).
To enter a personal payment method for remuneration:

1. Set your effective date to the date on which to begin paying the employee by this method.

2. In the Name field, select a payment method.

3. Enter a number in the Priority field to determine the order for Oracle Payroll to use each payment method. It uses the method with the lowest number first.

4. Enter either the amount or percentage of the assignment’s pay to be paid by this method.
   If the total of the amounts you allocate to payment methods is less than the amount to be paid, Oracle Payroll uses the payment method with the highest priority number to pay the excess.

5. If the payment method type is BACS, open the Bank Details window for entry of information about the employee’s bank account.

To enter a third party payment method:

1. Set your effective date to the date on which to begin making payments using this method.

2. In the Name field, select a third party payment method.
   Third party payment methods automatically receive priority 1 (the highest priority) and you cannot change this. You cannot split a third party payment between different payment methods; the Percentage field always displays 100%.
3. In the Payee region, select an organization or a person.
4. Save your work.
You can select this third party payment method in the Payee Details entry value when you enter a deduction to be paid as a third party payment.

**Entering Secondary Assignment Statuses**

Your implementation team may have created secondary assignment statuses for analysis and reporting of employee or applicant assignments.

For example, suppose your primary status Maternity Leave applies to employees both when a child is born and when one is adopted, and you want to study its use in these two cases. To accomplish this you can set up the secondary statuses Maternity Birth and Maternity Adopt, and enter them for employees taking maternity leave.

You enter secondary statuses for an employee assignment or an applicant assignment in the Secondary Statuses window.

![Secondary Statuses Window](image.png)

► **To give a secondary status to an assignment:**
1. Select the status and enter a start date.
2. You can also select a reason for giving the new status.
   When a status no longer applies, simply enter an end date.

**See Also**

Assignment Statuses: page 27 – 5
Inquiring and Reporting on Employment Information

Oracle HRMS provides a number of predefined inquiry windows and reports for employment information. You can also create your own inquiries and reports using QuickPaint or other reporting tools.

Listing Assignments

There are three predefined inquiry windows for producing lists of assignments that match criteria you enter:

- Assignments Folder
- List Assignments
- List People by Assignment

Assignments Folder

Using the Assignments Folder window, you can query lists of current assignments, past assignments, or both. You select the fields of assignment information you want to see, and position them in the order you prefer. For example, you can produce a listing of all current employees ordered by organization, and by grade within organization.

The system saves your inquiry and field formatting as a folder so you can rerun the inquiry at any time. You can make this folder available to all users, or save it as a private folder.
**Note:** The system administrator can create customized versions of the Assignments Folder window so that you use each version for one person type only.

The system administrator can also link this window in a task flow so that you use it to access other windows of employment information. Notice that if you select a past assignment in the folder, you cannot open other windows of employment information.

**List Assignments Window**

In this window, you can view current employees and applicants. If you enter the Job, Position, Grade, or Group fields, a window opens prompting you for individual segments of the flexfield. You can enter selection criteria in one or more segments. This means that you can search on parts of the job name, for example.
List People by Assignment Window

In this window you can choose whether to view current or former employees/applicants, or both. However, you must search on a whole Job, Position, or Grade name, not on segments of these flexfields.

To produce lists of assignments:

1. Select values in one or more fields in the top part of the window, and choose the Find button.

   The folder in the lower part of the window lists the assignments that match the selection criteria you entered.

2. You can enter a query in the folder to reduce further the list of assignments displayed. For example, you could run the query “C%” in the Full Name field to view the assignments of people whose names begin with C.

3. You can remove, rearrange, add, or resize fields in the folder if you have access to the Folder menu.
Listing Employees by Organization

In the List Employees by Organization window, you can view lists of employees within one organization or within all organizations below a specified level in a hierarchy you select.

To list employees in several organizations:
- Select an organization hierarchy and select the highest organization in this hierarchy for which you want to list employees. Choose the Find button.

To list employees in one organization only:
- Leave the Organization Hierarchy field blank and select an organization. Choose the Find button.

You can enter a query in the Employees block to further restrict the list of employees to be displayed.

Manager Field
The Manager field identifies any employee for whom the Manager check box is checked in the Miscellaneous region of the Assignment window.

If there is more than one manager in the organization you select, the Manager field displays the number of managers. You can view the names of these managers by choosing the List icon from the Toolbar.
Organization Field

If an employee belongs to more than one organization within the hierarchy you selected, the number of organizations appears in the Organization field. You can view the names of these organizations by choosing the List icon from the Toolbar.
Listing Employees by Position

There are two windows for viewing lists of employees by position:

- List Employees by Position
- List Employees by Position Hierarchy

List Employees by Position Window

To view employees in a single position, or in all positions corresponding to a job or organization, use the List Employees by Position window.

1. Select any combination of an organization, job, or position.
2. Choose the Find button.

The folder displays the positions that match your selection criteria, together with the holder’s name and employee number. If there is more than one holder for a position, the number of holders is displayed in the Holder Name field. You can view the names of these holders by choosing the List icon from the Toolbar.

Note: You can enter a query in the folder to reduce further the list of positions displayed. You can remove, rearrange, add, or resize fields in the folder if you have access to the Folder menu.
List Employees by Position Hierarchy Window

To view lists of employees in a number of positions within a hierarchy, use the List Employees by Position Hierarchy window.

To view lists of positions within a position hierarchy:

1. Select a position hierarchy and the highest position in the hierarchy for which you want to list employees.

2. Choose the Find button.

   The folder displays all positions below the one you selected in the hierarchy. It also lists the employees who hold these positions.

   If there is more than one holder for a position, the number of holders appears in the Holder Name field. You can view the names of these holders by choosing the List icon from the Toolbar.

Note: You can enter a query in the folder to reduce further the list of positions displayed. You can remove, rearrange, add, or resize fields in the folder if you have access to the Folder menu.
Assignment Status Report

Use this report to see a list of people assigned to particular organizations, jobs, positions and grades, with specific assignment statuses. If you select both applicants and employees as person types, the report prints out in two sections. Otherwise it prints for the type you select.

Run reports from the Submit Requests window.

To run the Assignment Status Report:

1. In the Name field, select Assignment Status Report.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. Leave the Organization Structure field blank to see information about all organizations. Select an organization hierarchy name to see assignment statuses in a number of subordinate organizations.
5. If there are multiple versions, select a version.
   If the effective date lies between the version’s start and end dates, the report is effective as of this date. If it lies outside these dates, the report is effective as of the start date of the version you select.
6. Leave the Parent Organization field blank to see information about all organizations. Select a name in this field to see information on all subordinate organizations in the hierarchy.
   \textbf{Note:} You must enter a value in this field if you have entered a value in the Organization Structure field, and you must leave this field blank if you left that field blank.
7. Make entries in the Group, Job, Position, Grade and Payroll fields as required.
   If you leave all segments of the Group flexfield blank, you see information about employees in any groups. If you leave one segment blank you see employees with any value for that segment.
8. Enter Yes in the Primary field if you want to report on primary assignments only. Leave blank to include all assignments.
9. Select Employee, Applicant or Both in the Person Type field. This determines which sections of the report are printed.
10. Select up to four assignment statuses, or leave blank to list employees and/or applicants with any assignment status.
11. Choose the Submit button.
**Employee Summary Report**

This report is a current summary of information for an employee, covering addresses, contacts, period of service, assignments, special information, personal payment methods, and element entries.

Run reports from the Submit Requests window.

- **To run the Employee Summary Report:**
  1. In the Name field, select Employee Summary.
  2. Enter the Parameters field to open the Parameters window.
  3. Enter the effective date for which you want to see the report.
  4. Enter the name of the employee whose summary you want to see.
  5. Choose the Submit button.

---

**Employee Movements Report**

There are two versions of the Employee Movements Report:

- Employee Organization Movements Report shows employee movements into and out of a particular organization or hierarchy.
- Employee Payroll Movements Report shows employee assignment changes to and from a particular payroll.

Both versions list the following movements: New Hires, Terminations, Transfers In, and Transfers Out. You can use this information to monitor employee assignment changes for turnover analysis.

Run reports from the Submit Requests window.

- **To run the Employee Organization Movements Report:**
  1. In the Name field, select Employee Organization Movements Report.
  2. Enter the Parameters field to open the Parameters window.
  3. Do one of the following:
• If you want to see information for a whole organization hierarchy, select the Organization Hierarchy name and version number, and leave Parent Organization blank.

• If you want to see information for one organization, select the organization name in the Parent Organization field, and leave Organization Hierarchy name and version number blank.

• If you want to see information for an organization and its subordinates in a particular hierarchy, select the name of the organization and the name and version of the organization hierarchy to which it belongs.

4. Select the period for which you want to see the information.

5. In the Employee Detail field, do one of the following:
   • Select Summary Only to see total numbers for each category of change.
   • Select Order by Assignment Number or Order by Employee Name to see a full listing of employee assignments for New Hires, Terminations, Transfers In, and Transfers Out. This information will be listed in the order you select.

6. Choose the Submit button.

**To run the Employee Payroll Movements Report:**

1. In the Name field, select Employee Payroll Movements Report.

2. Enter the Parameters field to open the Parameters window.

3. Select the payroll and payroll period for which you want to see the information.

4. In the Employee Detail field, do one of the following:
   • Select Summary Only to see total numbers for each category of change.
   • Select Order by Assignment Number or Order by Employee Name to see a full listing of employee assignments for New Hires, Terminations, Transfers In, and Transfers Out. This information will be listed in the order you select.

5. Choose the Submit button.
Assignment History

Use the Assignment History window to view the history of all an employee’s assignments, both current and in previous periods of service.

To view an employee’s assignment history:

1. In the Current field, select Yes, No or All.
   
   Yes selects the list of current employees. No selects the list of ex-employees. All selects the list of both current and ex-employees.

2. In the Name or Number field, select an employee or ex-employee and choose the Find button.

   The Service History region displays the employee’s final period of service. It shows three periods of time:

   • **This Period** shows the number of complete years and months worked in this period of service to date.
   
   • **All Periods** shows the number of complete years and months worked in all periods of service to date.
   
   • **Including Breaks** shows the total elapsed time (in complete years and months) from the employee’s initial hire date to date.

You can view previous periods of service by choosing Next Record from the Go menu.
Oracle Human Resources provides a comprehensive recruitment module enabling you to integrate all your recruitment processes, from identifying vacancies to hiring new employees. Using Oracle Human Resources, you can set up your recruitment procedures exactly as your enterprise requires. In particular, you have flexible control over the following key areas:

- recruitment and selection procedures
- security of applicant information
- handling of bulk applications
- generation of standard letters to applicants at different stages of the recruitment process
Within any recruitment function, there is a common cycle of tasks, illustrated in Figure 15–1. There are three main areas: preparation, selection, and appointment, supported throughout by the production of standard letters and reports.

- **Preparation** is concerned with the identification of a vacancy, the authorization to take some action, and running one or more recruitment activities.

- **Selection** begins with the receipt of applications and ends with the issuing of offer or rejection letters. You define your own stages of the selection process and track applicants through the stages.

- **Appointment** takes the applicant from the recruitment process to employee administration where the initial tasks include entering terms and conditions and payroll information. Oracle HRMS makes this simple since recruitment, human resource administration, and payroll management can all be handled from the same personal records.

- Each task in the cycle is supported by automation of the standard paperwork that accompanies any recruitment process.

An analysis of your own detailed working practices will help you to decide whether to use Oracle Human Resources at a basic or an
advanced level within each area. At the same time, you should identify the sequence of tasks performed by your users, from which you can derive one or more Recruitment task flows.

See Also

- Recruitment Preparation: page 15 – 4
- Selection Processing: page 15 – 10
- Using Letters to Manage Recruitment and Enrollment: page 26 – 2
Selecting applicants for recruitment is an extended process. You have to plan and coordinate a series of steps from identifying vacancies to organizing recruitment events.

Figure 15 – 2  
Recruitment Preparation

Identifying Staffing Requirements

Using Oracle Human Resources, you can define budgets to reveal the headcount requirements within your enterprise, and then raise requisitions for the vacancies you require. You might have prior authorization to maintain your headcount or you might need to get authorization when you identify the vacancy.
Oracle Human Resources lets you record and use the information you need to raise a requisition at the time you need it. This can be particularly useful where an applicant takes the initiative by making a speculative approach. Your authorized vacancy list is clear and up to date at all times.

You can view lists of vacancies of a particular status, or a selected organization, location, job, position, grade, group, recruiter, or recruitment activity.

**Skill Requirements and Specifications**

If you want to match applicants with skill requirements in the selection process, you can enter competency requirements for jobs, positions and organizations. You can then use the web–based suitability search to compare the competency profiles of your applicants against the requirements of the vacancy. You can also enter deployment factors (such as relocation and willingness to travel) against jobs and positions. In the same way, you can record the deployment choices of your applicants.

You can hold a person specification or a job description on the system as attachments or using user–defined fields (called *descriptive flexfield segments*). As with requirements, these can be held at both job and position level.

**Running Recruitment Activities**

The authorization to recruit normally results in a specific recruitment activity, such as an advertisement. This might be part of some shared recruitment activity, such as an advertisement for more than one vacancy. The shared activity, in turn, might be part of another recruitment activity, such as a Graduate Recruitment Campaign.
Figure 15-3
Recruitment Activities

<table>
<thead>
<tr>
<th>Recruiting for Organization</th>
<th>Job Position</th>
<th>Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advertising</td>
<td>Newspaper</td>
<td></td>
</tr>
<tr>
<td>Dates</td>
<td>Planned Cost</td>
<td>Actual Cost</td>
</tr>
<tr>
<td>Contacts</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Graduate Intake</td>
<td>College Event</td>
<td></td>
</tr>
<tr>
<td>Dates</td>
<td>Planned Cost</td>
<td>Actual Cost</td>
</tr>
<tr>
<td>Contacts</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Raising Requisitions for Vacancies

Use the Requisition and Vacancy window to record requisitions, vacancies, and openings within your enterprise. Notice that a requisition can be for one or more vacancies, and a vacancy can have one or more openings.

Prerequisites

- Use the QuickCode Type VACANCY_STATUS to define the stages through which vacancies pass from being first raised to being filled. Examples might be Authorized, Advertised, and Shortlisted.

To create a requisition and vacancy:

1. Enter the requisition and save it before beginning to define the vacancy.
2. Enter a name and number of openings for the vacancy.
3. Optionally enter a description and select a status.
4. You can select one or more assignment components to define the vacancy.
Defining Recruitment Activities

Use the Recruitment Activity window to define either single recruitment activities or groups of activities.

You can associate a recruitment activity with an organization and with one or more vacancies. You can record and monitor the cost effectiveness of any activity, or group of activities.

Prerequisites

- You can define types of recruitment activity as values for the QuickCode Type REC_TYPE.

To define recruitment activities:

1. Enter the details of the recruitment activity.
   - You can enter the name of a ‘parent’ recruitment activity in the Within Recruitment Activity region, if the activity you are defining is part of a campaign.

2. Choose the Recruiting For button to select one or more vacancies to associate with the activity.
Viewing Vacancies

Use the View Vacancies window to see lists of vacancies for an organization, location, job, position, grade, group, recruiter, or recruitment activity. You can also see all vacancies of a particular status.

To view vacancies:

1. Enter selection criteria in any of the fields in the top half of the window. Leave all these fields blank to see all vacancies in your Business Group.

2. Choose the Find button to see the vacancies that correspond to the criteria you have entered. In the folder you can enter a query to further restrict the vacancies displayed. If you have access to the Folder menu, you can also rename, resize, and reorder the fields displayed.

See Also

Requisition Summary Report: page 15 – 22
Selection Processing

The selection process begins with the receipt of applications and ends either with the hiring of applicants into the vacancies to which they have applied, or the terminating of their applicant assignments. During the process applicants move through a number of stages, each of which is monitored, controlled, and documented as required.

Entering Applicants

Oracle Human Resources lets you record addresses, personal details, application information, competencies, qualifications, school and college attendances, and work choices for all applicants. Notice that you track an application as one or more assignments for the applicant, similar to employee assignments. This has several advantages:

- It speeds up hiring the successful applicant since most of the important information is already on the system.
- It makes it easy to track several applications from one applicant as separate assignments.
- It enables you to enter an application from an existing employee: you update the Person Type to Employee and Applicant (or your user name equivalent) and enter the application as an applicant assignment.

Reporting on Application Information

To get a comprehensive report about an applicant, you can run the Full Applicant Details report from the Submit Requests window.

To see the applicants who have applied for a particular vacancy, or group of vacancies, run the Requisition Summary Report.

See Also

Requisition Summary Report: page 15 – 22
Making Quick Applicant Entries

Use the Applicant Entry window to enter basic person information and a single assignment for an applicant. To make this window quick and easy to use, you can only enter one address and one assignment for the applicant. If you need to update this information or add further information, use the Person and Application windows.

To record an application quickly:

1. Enter the applicant’s name and an identifying number recognized by the system.
   
   **Note:** If your Business Group uses automatic number generation, the applicant number automatically displays when you save your entries in this window.

2. Select a status for the application. By default a new application has the status Active Application (or an equivalent user status defined on your system). All other fields are optional.

3. In the Further Information field, you can select Ethnic Origin, and enter a work permit number, if appropriate.

4. To enter an address, select a national address Style.
   
   A window opens with the address format for the country you select. Enter the address lines and choose OK.

5. The Date Received defaults to your effective date, but you can change it. This is the date the applicant’s record will begin.
6. You can enter the name of the applicant’s current employer.

7. You can select a recruitment activity. If there is only one vacancy for the activity, the vacancy details appear automatically.

8. If you select a vacancy, applicant assignment information is displayed from the vacancy record. You can add to this information or change it. However, if you change it, the vacancy field clears.

9. If you do not select a vacancy, you can enter assignment information in the Vacancy Applied For region. If you do not enter an Organization, it defaults to the Business Group.

**Entering Full Application Information**

Use the People window and the Application window to enter an application if you need to do any of the following:

- record multiple assignments for an applicant
- enter Government Extra Information
- record more than one address for an applicant
- update applicant information

For other applications, you can use the Applicant Entry window.

**Prerequisites**

- If you want to use your own status names to record the stages of your selection process, enter user statuses for the predefined applicant assignment statuses.
  
  See: Tracking Applicant Progress: page 15 – 15

- If you want to hold reasons for giving a status to an applicant assignment, enter the valid reasons as values for the QuickCode Type APL.Assign_Reason.
  
  See: Adding QuickCode Values: page 31 – 3
To enter an application:

1. Set your effective date to the date you want the applicant assignment to begin, such as the closing date for applications.

2. Enter personal information for the applicant in the People window. See: Entering a New Person: page 13 – 5

3. Open the Application window. If you change the Date Received, this changes the effective start date for the applicant. You can enter the date you expect to hire the new recruit.

You cannot enter a Termination date in this window. You must use the Terminate Applicant window.

4. You can enter the name of the applicant’s current employer.

5. If the application is for a specific vacancy, select the recruitment activity and vacancy. Assignment information from the vacancy is displayed. You can add more assignment details.

6. Select an applicant assignment status and the reason for giving this status. The applicant assignment status is the key to processing the application.

7. Optionally you can enter information, in the alternative regions, about:
   - the recruiter who is responsible for handling the application
• the supervisor of the assignment
• the standard conditions and probation period for the assignment
• the source of the application, such as the type of recruitment activity, or the organization that recommended the applicant, or the employee who referred the application

Additional Application Information

If you want to hold further details of the applicant’s skills, experience, or current situation, you can choose how to do this when you implement Oracle Human Resources. For example:

• Enter qualifications, deployment choices, and a personal competence profile for applicants. You can then perform suitability matches on these people using the web–based Suitability Match option (part of Line Manager Direct Access).

  See: Competence Profiles, Qualifications, Schools Attendances and Work Choices: page 13 – 15

• Use attachments to hold free text information.
• Set up segments of the Additional Application Details descriptive flexfield to hold the information you require.

  See: Adding New Fields to Windows: page 30 – 2
Tracking Applicant Progress

The progress of all applicants through the selection process is controlled by applicant assignment statuses. Each stage of the selection process is identified by a single assignment status. It is by changing the status that you can record the progress of any applicant assignment.

![Diagram of Applicant Assignment and its Status]

Applicant Assignment Statuses

As with employee assignment statuses, there is a set of system statuses that are used in various internal processes:

- **Active Application**: This is the normal status of an application as it progresses through the selection stages.
- **Offer**: Use this status for your preferred candidate when an offer has been made.
- **Accepted**: Update the preferred candidate’s assignment to Accepted status when you are ready to hire him or her in the Person window.
- **Terminate Application.** Use this status to end an applicant assignment. If there is only one assignment for the applicant, you cannot change the status to Terminate Application. You must make the applicant an ex-applicant in the Terminate Applicant window.

  **Note:** The Terminate Application status is not recorded on the applicant assignment; it causes the assignment to end.

On your system, you can give these statuses different names (called User Statuses), appropriate to your enterprise.

See: Defining Assignment Statuses: page 27 – 7

### Using Primary Applicant Assignment Statuses

These statuses are *Primary* because they determine how the assignment is processed and handled by the system. An assignment must have one, and only one, primary status.

You can update an applicant assignment status in the following windows:

- Application
- Applicant Interview
- Terminate Applicant

When you change the status, you can enter a reason for the change. Define valid reasons as values for the QuickCode Type APL_ASSIGN_REASON.

You can also change the status of a group of applicants in the Mass Update of Applicants window. For example, if you want to call 20 applicants to a selection test and to reject all other applicants for the vacancy, you can do this in the Mass Update of Applicants window.

Changing a primary applicant assignment status can trigger the generation of a standard letter.

### Using Secondary Applicant Assignment Statuses

There may also be *Secondary* statuses set up on your system. You can use secondary statuses for analysis and reporting, but they are not used for processing.

See: Defining Secondary Statuses: page 27 – 8

You can give an assignment multiple secondary statuses. You enter secondary statuses in the Secondary Statuses window.

See: Secondary Statuses: page 27 – 6
Interviewing Applicants

Typically, you track applicant progress through a series of interviews and update the status of the application after each interview. You can define different types of interview (such as First Interview, or Selection Test) as values for the QuickCode Type APL_INTERVIEW_TYPE.

You can schedule these interviews and update the applicant assignment status using the Applicant Interview window.

You can report on applicants and their interview schedules using the Requisition Summary Report.

To schedule applicant interviews:

1. Select an interview type, and enter the date of the interview in the Start Date field. You can also select a location and enter times and an end date.

2. If you want to associate an applicant assignment status change with the interview, enter it in the New Status field. This creates a datetracked update to the applicant assignment.

You cannot enter a status when:

• there are future changes to the assignment
• the interview date is the date when the active application status began
• you are updating an existing interview record

Other Events Windows

You can also manage events attended by multiple applicants, such as tests or presentations. Define types of applicant event as values for the QuickCode Type APL_EVENT_TYPE. Create the events and book applicants onto them using the Event Bookings window.

See: Setting Up Events: page 25 – 2

You can view all the events an applicant has attended or is scheduled to attend by querying the applicant in the Person window and opening the Book Events window. You can also enter new bookings here.

See: Managing Bookings and Attendance: page 25 – 3
Mass Update of Applicants

The Mass Update of Applicants window contains a folder in which you can view all applicants and their assignment components and status. You can query groups of applicant assignments and update them as a group. There are two types of mass update you can perform:

- You can refer a group of applicants from one recruiter to another. The recruiter is the person responsible for handling the application.

- You can change the status of the applicant assignments.

**Note:** If you use the RPA to process an appointment for an applicant, you must change the applicant’s status to Accepted. The effective date of an applicant must be least one day prior to the RPA Appointment Effective Date.

To update a group of applicant assignments:

1. Select Find from the Query menu to open the Find Applications window. Enter selection criteria for the group of applicants you want to update and choose the Find button.

2. Do one of the following:
   - If you want to update all or most of these applicant assignments, choose the Select All button. Then uncheck the Mark check box for any assignments that you do not want to update.
   - If you want to update less than half of this group of assignments, check the Mark check box for each assignment you want to update.

3. Choose the Update button.
4. In the Update window:
   • If you want to update the status of the selected assignments, select the new status.
   • If you want to refer these applicants to a new recruiter, select the name of the Recruiter.

5. Choose OK to effect the update.

Hiring Applicants

When you have made a job offer to an applicant and they have accepted, you update the applicant assignment status to Accepted. You can change your effective date to the date you plan to hire the applicant, and change their person type to Employee. You change person type in the People window.

See Also

Hiring: page 13 – 8
Ending Applications

If you have rejected an applicant assignment, you can update its status to Terminate Application. However, an applicant must be left with one active assignment. To reject an applicant’s last assignment, you must terminate the applicant. This updates their person type to Ex-applicant.

You terminate an applicant in the Terminate Applicant window.

**Prerequisites**

- If you want to hold reasons for rejecting applicants, enter the valid reasons as values for the QuickCode Type TERM_APL_REASON.

### To terminate an applicant:

1. Enter the termination date.

2. Enter the status Terminate Application, or your User Status equivalent.

   This is not required, but you might use it to trigger generation of a rejection letter.

   See: Using Standard Letters to Manage Recruitment and Enrollment: page 26 – 2

   **Note:** This status is not recorded on the applicant assignment, so it is not displayed if you requery the termination.

3. If you want to record the reasons for rejecting applicants, select a reason.

4. Choose the Terminate button.
Cancelling a Termination

If you have terminated an applicant in error, you can cancel the termination in the Terminate Applicant window. Simply choose the Reverse Termination button.

Note: You cannot cancel a termination if there are any future changes to the applicant's personal record.

Requisition Summary Report

Use this report to see lists of applicants and their interview schedules for:

- all vacancies in a requisition, or
- all vacancies associated with a recruitment activity, or
- vacancies in a particular organization, location, job, position, grade, and/or group, and vacancies of a selected status

You can further restrict the applicants listed in the report by specifying start and end dates for the applicant assignments, and by selecting an applicant assignment status.

Each page of the report lists the applicants for one vacancy. This is defined as a unique combination of assignment components (organization, location, job, position, grade, and group). The vacancy has a name if you have set up vacancies on the system using the Requisition and Vacancy window, but this is not essential for running the report.

You run reports from the Submit Requests window.

To run the Requisition Summary Report:

1. In the Name field, select Requisition Summary Report.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. Optionally enter start and end dates to restrict the applicant assignments shown in the report.
5. To further restrict the scope of the report, you can select values in any of the other fields defining the vacancies to report on. Notice that you can select values for individual segments of the People Group key flexfield.
6. Choose the Submit button.
This chapter describes how you can use the Career Management modules provided by Oracle Human Resources to develop the competence approach within your enterprise.
Introducing Career Management Activities

Oracle Human Resources is a radically different human resource application. Using conventional applications, performance management activities are often carried inconsistently across the enterprise. For example, the recruitment function may perform psychometric tests that define personal skills and behavior in one way, while the appraisal scheme uses an internally agreed but different definition of skills, and training classes record licenses and qualifications in another. Not only is this costly to your enterprise, but it also means that your human resource activities are carried out inconsistently.

What distinguishes Oracle Human Resources is that it’s built upon the emerging disciplines of performance management and the competence approach. This gives a single, unified model and language for traditionally different activities (such as appraisals, assessment, recording accomplishments, and such). By using this one approach, you can:

- operate more effectively at work
- perform key human resource management processes consistently across the enterprise
- achieve clearly defined business goals within a common framework

In this section, you’ll learn about the competence approach, and other key concepts and terms. Once you have an understanding of the concepts, you’ll be able to take full advantage of Oracle Human Resources easy-to-use tools to improve the capacity of your human resources to meet enterprise goals and objectives.
Advantages of the Common Competence Framework

A common framework for describing and assessing competencies speeds the deployment process within your enterprise. This is both cost–effective and desirable. Imagine how quickly your managers can respond to new challenges when they can identify and select employees and applicants on a common basis—they can also match employees and applicants with opportunities that arise across the whole enterprise. This ability to perform global deployment effectively, through a ‘virtual job market’, provides your enterprise with the competitive edge with deployment. Consider being able to create opportunities in the US and recruit globally using common terminology to build up teams with complementary skills.

Improving employee development and motivating employees are other important aspects of cost–effective human resource management. By surfacing enterprise goals and commonly valued skills and behaviors, you can ensure that employees develop not only technical and job–specific skills, but also broader skills that ensure they continue to be marketable within the enterprise.

Assessing the applicant or contractor pool is another key area where a common framework helps your enterprise to cut costs. With Oracle Human Resources, you can assess on an enterprise–wide basis, ensuring that an able candidate is not rejected because of a mismatch for one vacancy when other suitable vacancies exist, reducing recruitment overheads.

If your enterprise is ‘knowledge–based’ rather than skills–based (such as financial services or a software provider), a common approach also enables you to assess and use the competencies your employees possess to gain a competitive edge.

Attention: This software should not be used as the sole method of assessment for making judgements about hiring, performance or deployment. Your company may be held liable if you rely on incorrect computer data or computerized rules to make such judgements.

It is the customer’s responsibility to take all appropriate measures to comply with the Data Protection and Privacy laws of the countries in which they operate.

All personal information that you store or use with this software must be up to date, accurate and relevant. You should confirm the details of the restrictions that apply to the computerized storage and use of personal information with your own legal department or representative.
Career Management – A Fully Tailorable, Proactive Management Tool

Now that you have chosen Oracle Human Resources, you can take advantage of a fully tailorable, sophisticated and proactive management tool to handle your human resources activities. From assessments to appraisals, employee profiling and career development, you can find powerful and easy-to-use features that let you take control of your employee processes using the web, and intuitive graphical tools.

Information Infrastructure

Oracle Human Resources provides you with the advantages of an information infrastructure for common systems of performance management across the enterprise. By providing a repository for all your employee and applicant competence and performance information, everyone within your enterprise can enter, review and integrate the information with that of other computerised applications, quickly and easily. Using the integrated Oracle Applications suite, you are able to answer such questions as “Did the introduction of the new incentive programme coincide with positive changes in manufacturing output?”, “Has the gap between required skills and accomplishments changed in salespeople, and has the change affected revenue?” and “How much did we spend per head on training, and how does this relate to improved performance?”.

Web and Workflow Access (LMDA and EDA)

Oracle Human Resources provides you with web and workflow-based access for many line manager and employee end-user activities through an intuitive, easy-to-use interface. Alternatively, you can perform many activities using standard Oracle HRMS windows.

We’ve looked hard at the administrative aspects of collecting, approving and acting on assessment and appraisal information and sought to automate these processes using Oracle Workflow. Our graphical Workflow designer enables you to change these processes to match your own requirements, and to change them at will to ensure that your administration is streamlined.

For a full description of all web and workflow-based access, and how to configure the application for the web, see: *Oracle HRMS Applications for the Web Configuration Guide*.

Line Manager Direct Access (LMDA)

Line Manager Direct Access (LMDA) enables line managers to perform sophisticated searches to identify people by skills, personal
characteristics, applicant or employee information. The ‘person list’
generated from the search is used for processes such as graphical
comparisons, group ranking, appraisals and assessments. Managers can
save the list and use it many times, enabling them to easily access the
people they deal with frequently.

Managers can perform a number of view and update activities on the
group of people for whom they have secure access. This security
mechanism is shared with the client server HRMS Application, and
includes organization, position and payroll–based security.

Providing Views

Line managers can view information that can include a number of drill
down stages. This enables line managers to view:

- graphical matches of competencies for a person compared with
  the requirements of an organization, job, position or other ad hoc
  choice
- graphical matches of a group of people for a given competence
- appraisal and assessment reviews
- ranked candidate lists matched against the requirements of an
  organization, job or position
- candidate application histories
- employment histories with drill down views to assignment
details
- vacation balances
- contact and dependent details
- salary history information
- roles performed by a person: who they manage, supervise etc.
- absence histories
- employee movements by organization
- absences by organization.

Employee Direct Access (EDA)

Employee Direct Access (EDA) enables employees to access their own
information and the relevant details for their contacts or dependents.
For example, it enables employees to change their address or change
their competence profile.
Which Activities are Available Using Windows, LMDA and EDA?

The following tables illustrate which setup and ongoing activities you can perform using standard Oracle HRMS windows, and which activities you can perform using Line Manager and Employee Direct Access. For some activities, you can use windows, LMDA and EDA.

### Setup Activities

<table>
<thead>
<tr>
<th>Activity</th>
<th>Windows</th>
<th>LMDA</th>
<th>EDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Rating Scales</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Competencies</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Group Competencies</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Define Competence Requirements</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use Competencies (with Oracle Training Administration installed)</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Qualification Types</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Schools and Colleges</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Assessment Template</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Appraisal Questionnaire</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Create or Modify Appraisal Template</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Ongoing Activities

<table>
<thead>
<tr>
<th>Activity</th>
<th>Windows</th>
<th>LMDA</th>
<th>EDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a Person List (perform sophisticated searches to identify people by skills, personal characteristics, applicant or employee information)</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create and review appraisals and competence–based assessments, and transfer them to other participants using Oracle Workflow. Employees can perform self assessment and appraisal</td>
<td>✓ ✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enter succession plan options for a person</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Complete suitability matching (skills profiling)</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manage deployment constraints and requests expressed by employees, such as requests to relocate, or travel internationally. Employees can update their own work choices</td>
<td>✓ ✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manage and update work choices for a job and position</td>
<td>✓ ✓</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Create and update competence profile. Employees can update their own competence profile

Enter, review and update qualifications, education, licenses and awards

Enter, review and update schools and colleges attended

View summary personal and employee data

---

**Configurable Web Interface**

Our highly configurable web interface enables you to create templates for your appraisal and assessments to meet your unique needs. You can include your own questions, the competencies that are assessed and the method your users make ratings and weightings of competencies or objectives. So, although you are using a common language, you can tailor appraisals and assessments for different parts of your enterprise to ensure that competencies that apply to small populations are assessed as well as ‘core’ competencies.

Most web pages supplied can be configured to change help text, page titles, corporate logos and navigation buttons, and so on. You can change pages to fit your corporate style and include your own pages alongside the supplied pages to provide a complete HR information repository for your employees.

Where it is essential to be able to define the fields included on a web page to customize it for your organization, such as defining an offer template for hiring candidates that includes questions about terms and conditions, Oracle Web Employees provides facilities to configure pages to your exact needs.

For more information, see: *Oracle HRMS Applications for the Web Configuration Guide*. 

---

Introducing Career Management Activities
Defining Your Competence–Based Operation

The main reason Oracle Human Resources provides you with so much flexibility is that it has a highly configurable framework. This enables you to define all the components of a performance management system to meet the needs of your enterprise, and to change them at will. You can define competencies, behavioral descriptions, performance ratings, appraisal and assessment forms, multiple types of assessment, and organization, job and position requirements.

Because of this, you can set up the application to mirror exactly how your enterprise handles its human resource activities now, or in the future to meet new market opportunities, go through mergers or expand into new countries. To enable you to take full advantage of this flexibility, it is worth spending some time before you start to use Oracle Human Resources in identifying how you want drive your human resource operation.
Introducing Career Management Activities

Figure 16–1
Controlling Your Operation

- Identify Business Goals
- Define and Group Enterprise Competencies
- Define Competence Requirements
- Create Competence Profiles
- Design Methods of Measurement
- Assess and Appraise
- Match by Suitability
- Analyse Competence Gap
- Identify Qualifications and Deliver Competencies
- Perform Succession and Career Planning
Identifying Your Business Goals Before Implementing the Competence Approach

We suggest that the first thing you do before you set up the application is to produce an action plan. This helps you identify your enterprise’s strategic business goals and objectives you want the competence approach to address. It also helps you identify the processes required to meet and achieve those goals.

Business goals or objectives take many forms, but they usually define what has to be done within the enterprise. For example, ‘to build an oil rig’, ‘to improve the quality of the product’ or to ‘gain greater penetration in the applications market’.

Once you have identified your business goals and objectives, Oracle Human Resources enables you to develop a competence approach that best supports your enterprise’s goals.

You enter your business goals quickly and easily using Special Information Types that are shared throughout the application.

Defining Your Enterprises Competencies

We, at Oracle, recognise that you will want to develop competencies that best meet the needs of your own enterprise. So, rather than providing you with pre-defined competencies that may be too prescriptive or too general, we enable you to develop your own. You might want to ‘pilot’ a small number of easily definable and measurable competencies first (for example, anything that requires physical effort such as digging a ditch or typing a letter), ensuring that the definitions are meaningful and relevant before rolling them out widely within the enterprise. Once you have developed these first competencies, you can go on to define competencies that are much more complex and difficult to observe and measure (for example, anything that includes cooperation with other people). You can, of course, have a mixture of both.

Because you might want to group related competencies together (for example, all your core competencies), Oracle Human Resources enables you to create competence types. These groups of related competencies are useful, for instance, if you want to include all competencies in a job advertisement (because they are ‘hireable’), or which can be ‘delivered’ by formal training.
Defining Your Competence Requirements

To ensure your enterprise meets its current and future goals, you’ll need to identify your competence requirements. For example, if your enterprise’s goal is ‘to gain greater penetration in the applications market’, Oracle Human Resources enables you to quickly and easily identify the competencies that people within your enterprise need to possess and exhibit to meet that goal.

Defining your core (or management or leadership) competencies might be the first stage in developing a competence approach. These core competencies are identified as being required by every person to enable your enterprise to meet its goals. In our example, the core competencies required to meet the goal greater penetration in the applications market, might include strategic thinking, quality orientation and customer awareness. With Oracle Human Resources flexibility, you can define these core competencies at the business group or organization level.

Then, once you have identified your enterprise’s core competencies, you might want to define individual job and position competencies later, for example, C++ programming, SQL*Plus, and such. The position automatically inherits the core competencies defined for the organization, saving you from having to enter them yourself!

The competence requirements held at business group, organization, job and position level are dated. With all this information at your fingertips, you can set them up for future requirements to perform analysis or resource projections for your enterprise. You can also project the impact of changes, such as reorganising and restructuring, and change them over time.

Using Competence Profiles

Using Oracle Human Resources to develop your core, job and position competence requirements enables you to compare what competencies the people within your enterprise possess, against those that are required. You need to do this as comparison is the main driver for most HR activities, whether deployment, reward, incentives, succession planning, and so on.

By having a profile of competence requirements, you can devise an appropriate assessment procedure, and assess individuals against the competencies for selection, qualification or training and development purposes.

See: Competence Requirements: page 18 – 2
Designing Your Methods of Measurement

Because of the flexibility of Oracle Human Resources, you are able to structure your competencies to design your methods of measurement to meet the needs of your enterprise. If most of the competencies within your enterprise are comprised of proficiency levels unique to individual competencies, you might want to create competencies with their unique proficiency levels. You would therefore have a number of equivalent systems for measuring performance. Alternatively, you can use the general method of measurement. Here, you do not hold the proficiency level at the competence level, but you use a general rating scale and text to describe the competence in a general way. You can, of course, use a mixture of both.

Imagine the flexibility of being able to use a general method to measure your core competencies, for example, and an individual method to measure specific job and position competencies throughout your global enterprise.

Not only do we provide you with the flexibility to use different methods of measurement, but we also provide you with the flexibility to calculate the assessment scores in a variety of ways. For example, you might want to calculate the scores just by taking performance against the competencies into consideration. Alternatively, you might want to calculate the scores by taking performance, proficiency and weighting into consideration, and to apply the weighting to proficiency. With Oracle Human Resources, the choice is yours.

See: Creating Your Methods of Measurement and Creating Competencies: page 17 – 2

Assessments and Appraisals

Assessing and appraising your enterprise’s employees are key areas of human resources management. To ensure you have the right people in place at the right time, you’ll want to find out what competencies your employees possess, and at what level they demonstrate them.

You’ll also want to find out their aspirations, and set their short- and long-term objectives, for example, what an employee is expected to achieve in the next six months. These objectives not only prepare employees for their next position within a career plan, but they also translate enterprise objectives into individual performance and improvement goals and measures.

The reason you describe and assess measurable behavior is that much of it is amenable to change by outside intervention. You can affect certain
Introducing Career Management Activities

competencies by recruiting them, others by practical or theoretical training. You can remove practical obstacles to competence by improving processes, resources or equipment. You can affect motivation by various types of incentive, whether monetary or opportunity based.

Assessment scores in Oracle Human Resources enable you to analyse visually which competencies a person (or group of people) possess, and which competencies are required by jobs or positions now, or in the near future. You can use the results of the Competence Gap processes to identify areas where you need to recruit or train employees, remove practical obstacles to competence by improving processes, resources or equipment. You can also affect motivation by various types of incentive, whether monetary- or opportunity-based.

See: Assessing and Appraising Employees: page 20 – 2

Describing and Assessing Measureable Behavior

One of the major features of Oracle Human Resources is the ability to hold the accomplishments of your people, enabling you to compare them against the competence profile for job and position requirements. It also enables you to match them to projects, develop succession plans, and organize further training and certification.

See: Creating a Competence Profile: page 13 – 16

You measure and record a score of how the person has performed against each competence during assessment. This provides clear and accessible performance measures (Is the person demonstrating the specified behavior at the level defined? Does the person have the knowledge or skills required to operate effectively?). You hold applicant and employee accomplishments in a person’s Competence Profile. You can then use the assessment results to analyse what is required to get the people with the right competencies in place. You can do this by hiring people, developing or training them.

By measuring competencies grouped into an assessment (for example, a Managerial or Engineering assessment), you focus attention on the behaviors and proficiency or performance of individuals and their ability to get things done. (Do not worry about proficiency or performance here, we describe both in What Type of Assessment do you Want to Perform?: page 20 – 5).

See: Assessing and Appraising Employees: page 20 – 2

Suitability Matching

You might use assessment scores during a suitability search to fill a job or position. You can use powerful Suitability Search tools to search for
and match the most suitable person to a job or position. This might be performed during recruitment, succession planning, and so on. You can search by:

- people
- jobs or positions

See: Suitability Matching: page 22 – 2

Perform Competence Gap Analysis

In future releases, assessments scores will be used by the Competence Gap processes. This will enable you to analyse visually which competencies a person (or group of people) possess, and which competencies are required by jobs or positions. You can analyse which competencies are required now, or in the near future.

The Competence Gap module graphically represents (by line or bar chart) the gap between a person’s, or group of people’s, competencies and what the enterprise requires.

Identifying Qualifications and Delivering Competencies

Competencies can have identified evaluation methods, such as a license, test or qualification. You can set up the qualifications that your enterprise recognises to include only the ones that you want in a person’s Competence Profile. You need to identify establishments that deliver the qualifications your enterprise recognises. These are then used to record where a person gained the qualification. Again, by keeping up-to-date and complete information, you are able to better forecast present and future requirements.

See: Creating Qualification Types: page 19 – 3
See: Creating Schools and Colleges: page 19 – 5

You can deliver competencies at a specific proficiency level through training activities your enterprise (or an outside supplier) provides. A training activity is an abstract term for any planned undertaking that improves a student’s competencies (qualifications, experience, and so on).

You can enter the competencies and proficiency levels that your training activities are expected to deliver using the Delivered Competencies window. You can then update a person’s Competence Profile after they have successfully gained the competence.
Introducing Career Management Activities

Note: You must purchase Oracle Training Administration (OTA) separately to use this functionality.


Career and Succession Planning

Once you have found out your employees aspirations, and set their short- and long-term objectives, you’ll want to prepare them for their next position within a career plan. After all, now you have motivated your employees through your performance management system, you’ll want to keep them motivated by linking their own career aspirations to enterprise aspirations. By planning succession, you enable employees to see their future role within the enterprise, keeping them motivated, and you from lengthy and costly recruitment.

Not only does succession planning enable you to keep and retain your high-flyers, it also enables you to highlight, for example, roles requiring scarce technical or commercial skills. By being able to identify these early, you can develop these scarce skills within your enterprise and replace current employees in these positions, as required.

See: Career and Succession Planning: page 21 – 2

Work Choices

Using work factors, you can track an employee’s, applicant’s, contractor’s or ex-employee’s capacity to be deployed within the enterprise.

You can a person’s work choices, such as their willingness to travel or relocate, their preferred working hours and work schedule, and the length of time they would like to stay in their next post. You can then compare these choices with the work requirements of jobs or positions when you are planning redeployment.

See: Entering Work Choices for a Job or Position: page 3 – 17
See: Entering Work Choices: page 13 – 19
Career Management Extensible and User–Defined QuickCodes

You can add, disable, or change the meaning of QuickCode for use in career management activities.

See: User and Extensible QuickCodes: page 31 – 6

The QuickCodes specific to career management activities include:

**Competence Types**

Define the competence types as values for the QuickCode Type COMPETENCE_TYPE.

**Qualification Types**

Define the types of qualifications as values for the QuickCode Type PER_CATEGORIES.

**Appraisal Web Page**

- Define appraisal statuses as values for the QuickCode Type APPRAISAL_ASSESSMENT_STATUS.
- Define appraisal types as values for the QuickCode Type APPRAISAL_TYPE.

**Competencies**

Define the competence evaluation methods as values for the QuickCode Type COMPETENCE_EVAL_TYPE.

**Work Choices**

- Define time scales as values for the QuickCode Type PER_TIME_SCALES.
- Define work schedules as values for the QuickCode Type PER_WORK_SCHEDULE.
- Define working hours as values for the QuickCode Type PER_WORK_HOURS.
- Define the full time equivalents as values for the QuickCode Type PER_FTE_CAPACITY.
- Define relocation preferences as values for the QuickCode Type PER_RELOCATION_PREFERENCES.
- Define lengths of service as values for the QuickCode Type PER_LENGTHS_OF_SERVICE.
Qualifications

- Define subject statuses as values for the QuickCode Type PER_SUBJECT_STATUSES.
- Define subjects as values for the QuickCode Type PER_SUBJECTS.
- Define tuition methods as values for the QuickCode Type PER_TUITION_METHODS.
- Define certification methods as values for the QuickCode Type CERTIFICATION_METHOD.
- Define proficiency sources as values for the QuickCode Type PROFICIENCY_SOURCE.

Competence Profile
Understanding The Business Cycle

The HR activities that use the competence approach within an enterprise can be depicted as a cycle such as the one shown in Figure 16 – 2. The main stages in the cycle are as follows:

1. Define business goals.
2. Define competencies needed to meet those goals.
3. Decide where you want to hold competencies in the enterprise structure (organization, job or position).
4. Assess person’s current level of competencies (perform multiple proficiency assessments) and update competence profile.
5. Perform skills gap analysis against current or future org, job or position requirements for:
   - filling existing jobs
   - succession planning
   - effective deployment
6. Propose action to close skills gap (training, qualifications, licenses, awards) – see which training delivers competencies.
7. Agree actions with employee (during appraisal):
   - set goals and objectives
   - sets expectations about proficiency levels and behavior
   - confirms steps to close skills gap – training, qualifications, licenses, awards

8. Evaluate – review appraisal.
   Sets performance – whether has met expected standard, goals, and objectives – overall performance.

   **Next Steps:**
   - rewards
   - incentives
   - career options

   Prepare employees for next position within a career plan.
Designing Methods of Measurement and Creating Competencies

This chapter explains how you design your methods of measurement and develop competencies as part of your performance management system.
Developing competencies as part of your performance management system enables you to evolve definitions that match the culture and needs of your enterprise, without different parts of the enterprise expending time and effort in evolving similar definitions.

A common framework for describing and assessing competencies speeds up markedly the deployment process within your enterprise. This is both cost–effective and desirable. Look at how quickly your managers can respond to new challenges when they can identify and select employees and applicants on a common basis. They can also match employees and applicants with opportunities that arise across the whole enterprise. The ability to perform global deployment effectively through a ’virtual job market’ provides your enterprise with the competitive edge with deployment.

What Are Competencies?

Oracle Human Resources defines the term ‘competence’ as measurable behavior, specifically "any measurable behavior required by an organization, job or position that a person may demonstrate in the work context". So, a competence can be:

- a piece of knowledge (such as the names of all the rivers in China)
- a skill (such as an interpersonal skill, widget turning, soldering a joint)
- an attitude (such as a proactive approach to work)
- an attribute (such as absence of color blindness or perfect pitch)

By defining measurable behavior, you can indicate what a person (for example, an employee, contractor, applicant) within an enterprise can do. Identifying how a competence is exhibited in the work context ensures your approach is objective rather than subjective, adding to employee understanding of what is expected of them. It also ensures fairness and equality of employment. Competencies clarify what is needed from both teams and individuals, especially when a major change within the enterprise is going on.
Competencies, Proficiency Levels and Indicators

Examples of competencies exhibited in the work context might be ‘communication skills’, ‘erecting and dismantling scaffolding’ or ‘typing’. On their own though, these competencies do not give you the full picture. For example, a person may be able to demonstrate the competence erecting and dismantling scaffolding, but that does not tell you how proficient a person is in that competence. For example, do they erect and dismantle scaffolding as a beginner, or as an expert? Other areas of ambiguity might include exactly what behavior is being measured. For example, the competence communication skills might mean that a person has technical, oral and written skills, or that they have the ability to communicate well.

Because of the flexibility of Oracle Human Resources, you are able to structure your competencies to design your methods of measurement to meet the needs of your enterprise. If most of the competencies within your enterprise are comprised of proficiency levels unique to individual competencies, you might want to create competencies with their unique proficiency levels. You would therefore have a number of equivalent systems for measuring performance. Alternatively, you can use the general method of measurement. Here, you do not hold the proficiency level at the competence level, but you use a general rating scale and text to describe the competence in a general way. You can, of course, use a mixture of both.

Proficiency

To enable you to fully express how a competence is exhibited in the work context, Oracle Human Resources enables you to identify the proficiency at which a competence is performed, and the associated behavioral characteristics displayed (known as behavioral indicators). You can use behavioral indicators for any description that tells you or other managers what to look for in the work context. The text description can include what tests to use, what behaviors to detect, what questions to ask (for example, in a critical incident interview), when to review, and so on.

Figure 17 – 1 illustrates the descriptions, proficiency level and behavioral indicators for the competence Communication Skills.
Figure 17–1
Competencies, levels and indicators

Figure 17–1
Competencies, levels and indicators

Communication Skills: the ability to communicate well

**Proficiency Level**

- **Expert** – Can write complex requirement specifications and liaise with developers.
- **Advanced** – Technical oral and written skills.
- **Intermediate** – Can..........
- **Proficiency Level**

- **Behavioral Indicators**

Expert – Can write complex requirement specifications and liaise with developers.

- Writes technical reports understood by peers
- Can present results of technical testing
- **Behavioral Indicators**

Structuring Your Competencies

Oracle Human Resources enables you to structure your competencies in two ways:

- **individual method**
  You can attach the individual proficiency levels to each competence

- **general method**
  You can use a general proficiency scale, and enter text to describe the competence in a general way

**Individual Method**

Figure 17–2 illustrates the competence Erecting and Dismantling Scaffolding using the individual method to structure your competencies. Notice the unique proficiency levels and behavioral indicators.
**Individual Method with its Proficiency Levels (and Behavioral Indicators)**

- 1 – Novice: Can provide assistance, as a member of a team, in the general fetching and carrying of scaffolding components
- 2 – Beginner: Can, as a member of a team, erect and dismantle basic scaffolds constructed from preformed aluminum components
- 3 – Intermediate: Can, as a member of a team, erect and dismantle scaffolds constructed from preformed steel components
- 4 – Advanced: Can, as a member of a team, erect and dismantle basic tube and clip scaffolds
- 5 Expert: Can, as a member of a team, erect and dismantle advanced tube and clip scaffolds

**General Method**

Alternatively, you can use the general method of measurement to structure your competencies. For example, you might decide to use a general method of measuring 'expertise', such as Expert, Intermediate and Novice. To do this, you could create a general rating scale, called Expertise, and hold the generic proficiency levels here. Figure 17 – 3 illustrates a general rating scale with generic proficiency levels defined.
Which Method Should You Use?

We suggest you employ the following strategy. Use the individual method if most of the competencies within your enterprise comprise of proficiency levels unique to individual competencies. Then, you can create competencies with their unique proficiency levels, providing your enterprise with a number of equivalent systems for measuring performance. Alternatively, use a general rating scale if a number of competencies within your enterprise have a common set of proficiency levels. You can then ensure consistency between measurements.

You can, of course, use a mixture of both, but whatever method you use, ensure that you give high numbers to high ratings (and low numbers to low ratings). You need to do this, for example, to ensure any bar charts you produce while performing competence gap analysis are useful.

Imagine the flexibility of being able to use a general method to measure your core competencies, for example, and an individual method to measure specific job and position competencies throughout your global enterprise.
General Rating Scales

Create general rating scales if you want to describe your enterprise’s competencies in a general way. With a general method, you do not hold the proficiency level at the competence level. Instead, you use a rating scale and text to describe the competence in a general way. Look at the benefits provided by this level of consistency of measurement during assessment and appraisal across your whole enterprise!

The Relationship Between a Common System of Measurement

Figure 17 – 4 illustrates the relationship between competencies, and a general proficiency rating scale in a common system of measurement.

![Common System of Measurement Diagram]

We suggest that you use the same rating scale measurements throughout, if you decide to use the common system of measurement in your enterprise. For example, if you use rating levels of 1 to 3 for one rating scale, stick to this scale if you set up many scales with different proficiency levels.
Different Rating Scales

You can create general rating scales for:

- proficiency
- performance
- weighting (level of importance)

A proficiency identifies the level at which a person exhibits a competence. For example, a scaffolder might be proficient at using a drill, or that a person is proficient at drilling a hole. A performance identifies whether the person has achieved the proficiency, for example, can they drill well or not.

Creating Default Rating Scales

You can make a specific general rating scale the default if you are going to link this rating scale to many competencies.

Using Attachments

You can add attachments to the rating scales, if required, for example, you can attach a competence description or a video of the skill.
Creating Rating Scales

Use the Rating Scales window to create general rating scales.

To create rating scales:

1. Enter a name and description for the rating scale, for example, Expertise.
2. Select the type of rating scale to create, for example, performance, proficiency or weighting.
3. Click the Default Rating Scale box if you want to make this rating scale the default, otherwise leave this box blank.
4. Enter the first level and description for the rating scale. For example, enter 1 in the Level field and **Novice** in the Name field.
5. Enter the behavioral indicator for that level. For example, Meets expectations.
   You can enter up to 2000 characters for each behavioral indicator.
6. You can add attachments to the rating scales, if required, for example, you can attach a competence description or a video of the skill.
7. Continue to enter levels and description for the rating scale then save your changes.
Competencies

We recognise that you’ll want to develop competencies that best meet the needs of your own enterprise. So, rather than providing you with predefined competencies that may be too prescriptive or too general, we enable you to develop your own. You might want to ‘pilot’ a small number of easily definable and measurable competencies first (for example, anything that requires physical effort such as digging a ditch or typing a letter), ensuring that the definitions are meaningful and relevant before rolling them out widely within the enterprise. Once you have developed these first competencies, you can go on to define competencies that are much more complex and difficult to observe and measure (for example, anything that includes cooperation with other people). You can, of course, have a mixture of both.

All competencies are held at the person level, in the Competence Profile. Some enterprises also group competencies by the methods used to improve them, such as hireable or trainable competencies, and still others by their use in the enterprise, for example, core or technical.

You will have previously identified how you want to structure your competencies; if you are using the individual method, you need to set up the proficiency levels for each competence you create.

Retrieving the Right Proficiency Levels

Once you set up proficiency levels for a competence, Oracle Human Resources retrieves the right proficiency levels for you when you (or other users) perform any of the following tasks:

- set up competence requirements
- create or update a Competence Profile
- perform an assessment

This not only saves you time, but also ensures that you always select the right proficiency level for the task you are performing.

Driving Alerts

Use Oracle Alert’s automatic mail notification to keep you informed when an employee’s competencies need certification and renewal. This frees your time for more essential tasks. For example, use the competence Renewal Period to drive Oracle Alert—it compares the renewal period date with the date on the person’s Competence Profile, or the last training class delivering the skill.
Creating Competencies

Use the Competencies window to create competencies

To create competencies:

1. Select the New button in the Find window.
2. Enter a name and description for the competence.
3. Enter the dates between which the competence is valid. You must enter a From date but you can leave the To date blank. If you enter a To date, ensure that it is wide enough to cover any competence elements you may need to create.
4. If you want to use a general rating scale to measure the competence against, go to Entering a Rating Scale: page 17 – 11. If you want to measure the competence against specific proficiency levels, go to Entering Proficiency Levels: page 17 – 12.

Entering a Rating Scale

5. Click the Scale radio button to use a rating scale to measure the competence against.
6. If you set up a default rating scale, it displays automatically for this competence, otherwise select one from the list. You can delete the defaulted rating scale and select another one, if required.
7. Select the Levels box if you want to check the proficiency levels for that rating scale, otherwise go straight to Entering Competence Details: page 17 – 12.

8. Click the Levels radio button to enter proficiency levels and behavioral indicators for the competence.

9. Select the Levels button and enter the first proficiency level and description. For example, enter 0 in the Level field and **No Skill** in the Name field.

10. Enter the behavioral indicator for that level, for example, **'No knowledge/expertise of scaffolding'**. You can enter up to 2000 characters for each behavioral indicator.

11. Continue to enter proficiency levels and behavioral indicators, then go to Entering Competence Details: page 17 – 12.

**Entering Competence Details**

12. Select the main method of evaluating the competence, for example, written examination or observation.

13. Enter how often you need to evaluate the competence. For example, enter 5 if you have to evaluate the competence every 5 years.

14. Select the measure to identify how often you need to evaluate the competence. For example, select Year if you evaluate the competence every 5 years.
15. Click the Certification Required box if you need a certificate to confirm possession of the competence, for example, if you need proof of a driving license.

If you click this box, when you or another user later indicates that a person possesses this competence (using the Competence Profile), you must enter the certification method and date.

16. Save your changes.

Querying a Competence Using the Find Competencies Window

When you navigate to the Competencies window, the Find Competencies window automatically displays in front of it.

To query a competence using the Find Competence window:

1. Do one or both of the following:
   - Enter a full or partial query on the competence name.
   - If relevant, enter a query on the organization, job or position.

2. Choose the Find button.

Oracle Human Resources displays the competence for you to check.
Competence Types and Groupings

Because you might want to group related competencies together, Oracle Human Resources enables you to create competence types. This flexibility enables you to create competencies displaying complex behaviors, for example, management skills, or you can split management skills into several competencies, such as communication skills, presentation skills and oral skills. The degree to which competencies are grouped in this way is up to you!

Note: If you do not group competencies into types, Oracle Human Resources groups them under the type of Others for you.

Once you have grouped your competencies into types (or Oracle Human Resources groups them under the type of Others), you use them on the assessment template, by indicating which competence types and related competencies you want to include in specific assessments.

Grouping Competencies is Useful

Grouping competencies is also useful, for:

- advertising a vacancy and you want to include all ‘hireable’ competencies on a job advertisement
- competencies for a team
- reporting purposes
- enabling easier access to particular competencies

You measure and evaluate behavior that a person demonstrates at the competence level, and not at the competence type level.

Figure 17 – 5 illustrates related competencies grouped by type Management Skills.
You can also group a competence into more than one competence type. For example, the competence Oral Skills can be grouped into both the Management Skills and the Interpersonal Relationships competence type.
Where Do You Create Competence Types?

You create the competence types using the QuickCode COMPETENCE_TYPE, then you group competencies into types using the Competence Type window.

Deleting or Adding Competencies into Types

Once you have used a competence type in HRMS (in an assessment, for example), you can query back and view it, but you cannot delete or add competencies to that type. This ensures that you cannot accidentally delete or add competencies to groups in use.
### Grouping Competencies into Types

Use the Competence Types window to group competencies

<table>
<thead>
<tr>
<th>Competence Type</th>
<th>MANUAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Competence</td>
<td>Erecting and Dismantling Scaffolding</td>
</tr>
</tbody>
</table>

#### Before You Start

Ensure that you have created the competence types you require using the QuickCode COMPETENCE_TYPE.

#### To group competencies into types:

1. Query back the competence type under which you want to group competencies.
2. Select the first competence to group within the competence type.
3. Continue to enter competencies to group within the competence type, then save your changes.
This chapter describes how you can define your competence requirements to enable your enterprise to meet its current and future goals.
Competence Requirements

To ensure your enterprise meets its current and future goals, you’ll need to identify your competence requirements. For example, if your goal is 'to gain greater penetration in the applications market', Oracle Human Resources enables you to quickly and easily identify the competencies that people within your enterprise need to possess and exhibit to meet that goal.

Defining your core (or management or leadership) competencies might be the first stage in developing a competence approach. These core competencies are identified as being required by every person to enable your enterprise to meet its goals. In our example, the core competencies required to meet the goal greater penetration in the applications market, might include strategic thinking, quality orientation and customer awareness. With Oracle Human Resources flexibility, you can define these core competencies at the business group or organization level.

Once you have identified your enterprise’s core competencies, you might want to define individual job and position competencies later, for example, C++ programming, SQL*Plus, and such. You can then copy the core competencies (with or without proficiency levels) to your organizations, jobs and positions. You can also copy required competencies to and from organizations, jobs and positions, saving you from having to enter them yourself!

The competence requirements held at business group, organization, job and position level are dated. With all this information at your fingertips, you can set them up for future requirements to perform analysis or resource projections for your enterprise. You can also project the impact of changes, such as reorganisation and restructuring, and change them over time.

One–Time Profiles for Suitability Matching

Not only can you create profiles for organizations, jobs and positions, but you can also create one–time profiles for many purposes. For example, you can create one–time profiles for a variety of activities such as for team building using the Suitability Matching Web page. You can search for and rank candidates using this functionality.
Defining Competence Requirements

Why Define Competence Requirements?

You can define your enterprise’s competence requirements at the following levels:

- business group
- organization
- job
- position
- one-time profiles (for suitability matching)

You define your core and job and position competence requirements to enable you to compare what competencies the people within your enterprise possess, with those that are required. You need to do this as comparison is the main driver for most HR activities, whether deployment, reward, incentives, succession planning, and so on.

By having a profile of competence requirements, you can devise an appropriate assessment procedure, and assess individuals against the competencies for selection, qualification or training and development purposes.

By having a template of required competencies, you are able to match and assess people against these requirements. As the required competencies are only the default, you use these as a starting point in the search, and can change them to widen or narrow down the search.

Retrieving Relevant Competencies

If you group all competencies required at business group or organization level, then each time you select a specific organization or job, the relevant competencies automatically display, saving you from having to select them each time.

You can hold competencies at position level, within the context of an organization and job. Then, when you later select a position, the relevant competencies for the organization, job and position are inherited and displayed. Alternatively, you can hold competencies at position level only, not within the context of an organization or job.

This is one of the important implementation decisions – whether to hold competencies at organization or job level, or to repeat them at position level.

If you need more information about identifying competence requirements, see Competence Types and Groupings: page 17 – 14.
Can You Copy Competencies?

You can copy the core competencies and proficiency levels to the organization, job or position, saving you time. You can then make changes to the competencies, if required, for example, change the proficiency levels, enter a grade, or change the dates between which the competence is valid.

You can also copy competencies and proficiency levels from organizations, jobs or positions to other organizations, jobs or positions. This enables you to quickly and easily to define your enterprise’s competence requirements.

Retrieving the Correct Proficiency Levels

When you are setting up your competence requirements for an organization, job or position, Oracle Human Resources retrieves the correct proficiency levels (defined when you created the competence). This ensures that you always select the right proficiency level for the competence.

Defining Essential Competencies and Different Grades

You can identify whether a competence is essential by an organization, job or position, or whether is optional. If you indicate that a competence is essential, when you later perform suitability matching, only the people who possess the competence at the specified proficiency level are retrieved in the search.

You can also identify different competencies for different grades, each with their accompanying proficiency levels. This enables you to keep a history of the competencies for an organization, job, position or grade over time.
Defining Competence Requirements – Core or Generic Competencies

Use the Competence Requirements window to define your competence requirements with core or generic competencies.

To define competence requirements (with core or generic competencies)

1. Select the business group for which you want to create competence requirements.
2. Select the Find button. Oracle Human Resources retrieves competencies if you have previously defined them as required for the business group, otherwise it retrieves nothing.
3. Press Clear Record after you have looked at the existing competencies.
4. You can now do the following:
   - Create Competence Requirements for the Business Group: page 18 – 5
   - Copy Existing Core Competencies to an Organization, Job or Position: page 18 – 6

Create Competence Requirements for the Business Group

1. Select the first competence.
2. Select the highest and lowest proficiency levels at which the competence is acceptable, if required.
If you are going to copy these requirements to an organization, job or position, you can choose not to copy these proficiency levels over.

3. Check the Essential check box if the competence is essential for this business group, otherwise, leave the box unchecked.

   **Note:** Only enter a grade if you are creating competence requirements for a job or position.

4. Enter the dates between which the competence is valid for this business group. You must enter a From date but you can leave the To date blank.

5. Continue to enter competencies for the business group, then save your changes.

**Copy Existing Core Competencies to an Organization, Job or Position**

1. Clear the details from the Business group before you copy the competencies.

2. Select the organization, job or position to which you want to copy the core competencies and press the Find button.

3. Select the Copy Competencies button. A Copy Competencies window appears.

4. Leave the Core Competencies box checked.

5. If you want to copy the proficiency levels, leave the Copy Levels box checked, and enter the dates between which the competence is valid (you must enter a From date but you can leave the To date blank). If you do not want to copy the proficiency levels, uncheck the box.

6. Select the Copy button, and Oracle Human Resources copies the competencies to the organization, job or position.

7. You can make changes to the competencies copied over, if needed, such as:
   - deleting any of the core competencies that are not required by the organization, job or position
   - changing the proficiency levels
   - checking or unchecking the Required check box
   - entering a grade (for a job or position only)
   - changing the dates between which the competence is valid

8. Save your changes.

9. You can now add further competencies for the organization, job or position, see Create Competence Requirements for the Business Group: page 18 – 5.
Copying Existing Competencies from an Organization, Job or Position

Use the Competence Requirements window to copy competencies from an organization, job or position.

1. Select the organization or job to which you want to copy the competencies. If you are copying competencies to a position, you must also select the organization and job to which the position belongs.

2. Select the Find button. Oracle Human Resources retrieves any competence requirements previously created.

3. Select the Copy Competencies button. A Copy Competencies window appears.

4. Uncheck the Core Competencies box. The organization, job and position fields are now active.

5. Select the organization, job or position from which you want to copy the competencies.

6. If you want to copy the proficiency levels, leave the Copy Levels box checked, and enter the dates between which the competencies are valid (you must enter a From date but you can leave the To date blank). If you do not want to copy the proficiency levels, uncheck the box.

7. Select the Copy button, and Oracle Human Resources copies the competencies.

8. You can make changes to the competencies copied over, if needed, such as:
   - deleting any of the core competencies that are not required by the organization, job or position
   - changing the proficiency levels
   - checking or unchecking the Required check box
   - entering a grade (for a job or position only)
   - changing the dates between which the competence is valid

9. Save your changes.

10. You can now add further competencies for the organization, see Create Competence Requirements for the Business Group: page 18 – 5.
Defining Competence Requirements – No Core Competencies

Use the Competence Requirements window to define your competence requirements with no core or generic competencies.

To define competence requirements (no core competencies)

1. Select the organization or job for which you want to create competence requirements. If you are creating competence requirements for a position, you must also select the organization and job to which the position belongs.

2. Select the Find button.

Oracle Human Resources retrieves competencies if you have previously identified them as required, otherwise it retrieves nothing.

3. Select the first competence.

4. Select the highest and lowest proficiency levels at which the competence is acceptable, if required.

If you are going to copy these requirements to other organizations, jobs or positions, you can choose not to copy these proficiency levels over.

5. Check the Essential check box if the competence is essential, otherwise, leave the box unchecked.

6. Select the grade (for a job or position only), if required.
7. Enter the dates between which the competence is valid. You must enter a From date but you can leave the To date blank.

8. Continue to add further competencies for the organization, job or position, if required.
Viewing Competencies at Organization, Job or Position

Use the Competence Requirements window to view competencies held at organization, job or position level.

To view competencies held at organization, job or position level:

1. Select the business group, organization, job or position for which you want to view competencies,
2. Click the Find button.
Identifying Qualifications and Delivering Competencies

This chapter explains how you can deliver competencies at a specific proficiency level through training activities your enterprise (or an outside supplier) provides. It also describes how you can record qualification methods, such as a license or a test, and enter the qualifications that your enterprise recognises.
Identifying Qualifications and Delivering Competencies

Competencies can have identified qualification methods, such as a license or a test. You can enter the qualifications that your enterprise recognises to include only the ones that you want in a person’s Competence Profile.

Delivering Competences Through Training Activities (Oracle Training Administration)

You can deliver competencies at a specific proficiency level through training activities your enterprise (or an outside supplier) provides. A training activity is an abstract term for any planned undertaking that improves a student’s competencies (qualifications, experience, and so on).

You can enter the competencies and proficiency levels that your training activities are expected to deliver using the Delivered Competencies window. You can then update a person’s Competence Profile after they have successfully gained the competence.

Note: You must purchase Oracle Training Administration (OTA) separately to use this functionality.

Creating Qualification Types

Competencies can have identified qualification methods, such as a license or a test, for example, a life-saving qualification or a degree. You can enter all the ones your enterprise recognises, this includes:

- all educational qualifications
- licenses
- awards
- honors

Not only can you enter different types of qualifications, but you can also rank them, if required. For example, you could rank a masters degree as 1, a degree as 2, ‘A’ levels as 3, and so on. You can also rank equivalent qualifications at the same level. For example, you can rank a degree and a BTEC Higher as level 2. This is useful, for example, if you later want to do an ad hoc query and find all people within the category of Education, with a qualification of 2 or above.

Prerequisites

You’ll need to enter the following QuickCode:

- Define the types of qualifications as values for the QuickCode Type PER_CATEGORIES.

Use the Qualification Types window to create your qualifications.

To create qualification types:

1. Enter the name of the qualification, for example, a Masters degree.
2. Select the type of qualification, for example, educational, honorary.
3. Rank the qualification, for example, 1 for a Masters degree, if required.

4. Continue to enter and rank qualifications, then save your changes.
Creating Schools and Colleges

You need to identify schools and colleges that deliver the qualifications your enterprise recognises. These are then used to record where a person gained the qualification. If you have not automatically loaded these schools and colleges into Oracle Human Resources, you can enter them manually.

You can also record the different sites or locations that comprise an establishment. This is useful, for example, where an establishment has several sites, colleges, campuses or locations.

Note: Schools and colleges you enter are available to all Business Groups you create, therefore only load or enter them once.

Use the Schools and Colleges window to enter your establishments.

To create establishments:

1. Enter the name of the establishment.
2. Enter the name of the location.
3. Continue to enter establishments, then save your changes.
This chapter explains how you set up Oracle Human Resources to enable you to assess and appraise your enterprise’s employees.
Assessing and Appraising People

An assessment is an information gathering exercise, from one or many sources, to evaluate a person’s ability to do a job. An appraisal is a ‘superset’ of recording opinions and setting and achieving objectives, plans, and so on.

Assessing and appraising your enterprise’s employees are key areas of human resources management. To ensure you have the right people in place at the right time, you’ll want to find out what competencies your employees (applicants, and so on) possess, and at what level they demonstrate them. This provides a snapshot that allows study, analysis, and evaluation,

By tightly integrating assessment and appraisal with the performance management process, both individual and enterprise performance are strengthened. You’ll find that your employees are more willing to change their behaviors as they feel committed to, and understand how their efforts make an impact on the big picture. So, using Oracle Human Resources, assessment and performance appraisal produces informed, motivated employees, committed to improving the effectiveness of their performance—in short, improving their productivity.
Assessing and Appraising People

Competence-Based Assessments

An assessment is an information gathering exercise, from one or many sources, to evaluate a person’s ability to do a job. Through the web and workflow-based access, managers and employees can measure and record a score of how the person has performed against each competence. This provides clear and accessible measures, for example, ‘Is the person demonstrating the specified behavior at the level defined?’ or ‘Does the person have the knowledge or skills required to operate effectively?’

Some assessments will simply ask one or more people to rate a person according to some agreed scale, in other cases, questionnaires may be devised that ask about different aspects of the of the person’s work.

Proficiency- and Performance-Based Assessments

In Oracle Human Resources, we use the term proficiency-based assessment to express the perceived level of expertise of a person, in the opinion of the assessor, over a given period. For example, a person may demonstrate communication skills at Expert level. We use the term performance-based assessment, however, to measure an expectation of “normal” performance of a competence over a given period. For example, a person may exceed performance expectation in the communication competence.
Why is Measurement Useful?

Once you have measured how people have performed against each competence, and at what level, you are ready to record applicant and employee accomplishments in the Competence Profile. You can keep the profile up-to-date by entering results when an employee first joins the enterprise, and then after each assessment or appraisal. Through the web and workflow-based access, employees are involved in the process of planning, managing and reviewing their own progress.

Once your employee competencies and proficiency levels are held in Competence Profiles (and job requirements in their own profile), you can use the information to analyse visually which competencies a person (or group of people) possess, and which competencies are required by jobs or positions now, or in the near future. You can use the results of the Competence Gap processes to identify areas where you need to recruit or train employees, and so on. You can also affect motivation by various types of incentive, whether monetary- or opportunity-based.

Once you have assessed measurable behavior, you can change it!

Templates for Different Assessments

To enable you and other users to perform assessments using the web, Oracle Human Resources enables you to create assessment templates for all the different assessments your enterprise performs. Examples of the types of assessment you might want to perform include:

- 360 Degree (where a manager, direct or indirect reports, peers and customers provide feedback on aspects of a person’s performance)
- self-assessment (by employee or applicant)
- peer or team assessment
- job skills assessments (for example, Engineer Grade 1, Junior Typist, and so on)

Once you have created assessment templates, assessors can work online through Line Manager Direct Access to identify employee performance or proficiency. They can enter or update assessments, without your intervention or involvement being required.

Tailoring the Layout

Not only can you create templates for the different assessments, but you can also tailor the actual layout of the assessment page to meet the needs of your enterprise. For example, you can identify:
• the type of assessment you are performing, for example, performance or proficiency
• the competence types and competencies against which to assess, and the sequence in which you want them to appear.
• the instructions to be displayed to the assessor(s) or approver(s)
• how you want to calculate the total scores

What Type of Assessment do you Want to Perform?

You can set up assessment templates for each type of assessment you want to perform, for example, job skill assessments for Scaffolders, Engineers at Grade 1, Junior Typist, and so on. By measuring competencies grouped into an assessment (for example, a Managerial or Engineering assessment), you focus attention on behaviors and the ability of an individual to get things done.

Another decision that you need to take is whether you want to perform proficiency or performance assessments. A proficiency assessment measures the expectation of the level to which a person exhibits a competence. For example, in an Engineering Grade 1 assessment you might assess that a person is proficient at using a drill, or that a person is proficient at drilling a hole. You also set future expectations, for example, that within the next 6 months, they will have achieved proficiency in milling. A performance assessment measures whether the person has achieved the proficiency, for example, can they drill well or not. You can also rank performance, for example, on a scale of 1–5.

You can create assessment templates for:
• Proficiency
• Proficiency and Performance
• Proficiency and Performance, with Weighting applied to Performance
• Proficiency and Performance, with Weighting applied to proficiency
• Proficiency with Weighting applied to proficiency
• Performance
• Performance with Weighting applied to performance

Because some enterprises will want to carry out performance assessments only (just rating that a person has achieved a specific competence), while other enterprises will want to carry out two step
processes (proficiency assessments to set expectations first before assessing performance), Oracle Human Resources enables you to assess proficiency and performance, in a two stage process.

What Do You See?

By identifying the type of assessment you are performing in the template, users of the Web assessment pages only get the headings and fields to complete appropriate to that type of assessment. For example, if you want to create an assessment template for a Scaffolder, of the type Proficiency, they might get the following headings and fields to complete on the assessment Web page:

![Figure 20 – 1 Example of Assessment Web Page for Proficiency with Weighting](image)

<table>
<thead>
<tr>
<th></th>
<th>Proficiency</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Erecting and Dismantling Scaffolding</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Slinging and Lifting</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Use of Climbing Harness</td>
<td>☐</td>
<td>☐</td>
</tr>
</tbody>
</table>

If you want to create an assessment template for a Scaffolder, of the type Proficiency and Performance, with Weighting applied to Performance, users might get the following headings and fields to complete:

![Figure 20 – 2 Example of Assessment Web Page for Proficiency and Performance with Weighting](image)

<table>
<thead>
<tr>
<th></th>
<th>Proficiency</th>
<th>Performance</th>
<th>Weighting</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Erecting and Dismantling Scaffolding</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Slinging and Lifting</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Use of Climbing Harness</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
</tbody>
</table>
Identifying Proficiency Levels in the Assessment Template

When you are setting up templates for any type of proficiency–based assessment, you have previously identified the proficiency levels or a rating scale with which to measure competencies. So you do not need to identify the performance scale, Oracle Human Resources already knows it. If you are setting up templates for any type of performance–based assessment, you need to indicate the performance scale to use in the assessment.

Entering Instructions

You can also enter the instructions to be displayed to the assessor(s) or approver(s) completing the assessment on the web page.

You can format the text to appear exactly as you want it. You can enter up to 2000 characters for each assessment type.

Identifying Competence Types and Competencies in the Assessment Template

Once you identify the type of assessment you are performing, you’ll want to identify the competence types and competencies against which to assess. When you are first setting up your assessment templates, all the competence types and competencies you previously created within your enterprise are available for you to select from.

Not only can you identify which competence types and related competencies to include in the assessment, but you can also indicate the sequence in which you want them to appear on the assessment page. This gives you complete control over the layout. (If you do not sequence the competencies or types, they appear on the assessment Web page in the order they appear in the template).
Calculating Scores in the Assessment Template

When you perform an assessment for a person, you record a score against each competence (within the framework of a job or position). Oracle Human Resources gives you the freedom to calculate the scores in a variety of ways to fully meet the needs of your enterprise. For example, you might want to calculate the scores just by taking performance against the competencies into consideration, or you might want to calculate the scores by taking performance, proficiency and weighting into consideration, and to apply the weighting to proficiency. (You can of course, only apply weighting to performance or proficiency, not to both.)

To make it easier for you, we provide several assessment types for you to choose from. These are:

<table>
<thead>
<tr>
<th>Assessment Type</th>
<th>Calculates Score By</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance</td>
<td>Performance</td>
</tr>
<tr>
<td>Proficiency</td>
<td>Proficiency</td>
</tr>
<tr>
<td>Proficiency and Performance</td>
<td>Proficiency x Performance</td>
</tr>
<tr>
<td>Proficiency and Performance, with Weighting</td>
<td>Performance x Weighting</td>
</tr>
<tr>
<td>Proficiency and Performance, with Weighting</td>
<td>Performance x Weighting</td>
</tr>
<tr>
<td>Performance with Weighting applied to</td>
<td>Performance x Weighting</td>
</tr>
<tr>
<td>proficiency</td>
<td></td>
</tr>
<tr>
<td>Proficiency with Weighting applied to</td>
<td>Performance x Weighting</td>
</tr>
<tr>
<td>proficiency, with Weighting applied to</td>
<td></td>
</tr>
<tr>
<td>proficiency, with Weighting applied to</td>
<td></td>
</tr>
<tr>
<td>proficiency, with Weighting applied to</td>
<td></td>
</tr>
<tr>
<td>proficiency</td>
<td></td>
</tr>
</tbody>
</table>

We provide you with a couple of examples to illustrate how the scores vary, depending upon how you calculate them.

**Example 1: Proficiency with Weighting Applied to Proficiency**

Figure 20 – 3 illustrates the scores where an assessment based on proficiency, with weighting applied to proficiency.

<table>
<thead>
<tr>
<th></th>
<th>Proficiency</th>
<th>Weighting</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Skills</td>
<td>5</td>
<td>5</td>
<td>25</td>
</tr>
<tr>
<td>Presentation Skills</td>
<td>5</td>
<td>2</td>
<td>10</td>
</tr>
<tr>
<td>Oral Skills</td>
<td>3</td>
<td>1</td>
<td>3</td>
</tr>
</tbody>
</table>
Example 2: Proficiency and Performance with Weighting Applied to Performance

Figure 20 – 4 illustrates an assessment based on proficiency and performance, with weighting applied to performance.

<table>
<thead>
<tr>
<th></th>
<th>Proficiency</th>
<th>Performance</th>
<th>Weighting</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Skills</td>
<td>5</td>
<td>2</td>
<td>5</td>
<td>10</td>
</tr>
<tr>
<td>Presentation Skills</td>
<td>5</td>
<td>3</td>
<td>2</td>
<td>6</td>
</tr>
<tr>
<td>Oral Skills</td>
<td>3</td>
<td>3</td>
<td>1</td>
<td>3</td>
</tr>
</tbody>
</table>

Calculating the Total Score

You can choose one of two methods to calculate the total score for the assessment. You can also use these total scores to rank groups of candidates, for use in compensation.

You can choose to calculate the total score by:

- sum total
- average total

Figure 20 – 5 illustrates an assessment based on proficiency, with weighting applied to proficiency. The total score is calculated as a sum total.

If you calculated the total score as an average total instead (25 + 10 + 3, divided by 3), the total score would be 16 rather than 38.
Changing or Deleting an Assessment Template

If a template is not yet in use, you can delete it, or you can make any changes to it that you require. For example, you might want to change the dates, or to include more competence types and competencies. Oracle Human Resources prevents you from deleting template that are in use, or from making changes to important information. This provides a safeguard against accidental deletion or change. However, you can enter an end date to terminate an assessment template, if needed, or you can change non–important details, such as:

- the name of the template and description
- any instructions

You can tell if the template is in use, because once it is, the system automatically checks the Used by Assessment check box for you.

Creating Templates for Competence–Based Assessments

Use the Assessment Template window window to create templates for competence–based assessments.

To create an assessment template:

1. Enter a name and description for the assessment you are setting up. You can enter up to 85 characters for the name.
2. Enter the instructions to be displayed to the assessor(s) or approver(s). For example, “Complete all parts of the assessment before passing it on to the next person in the chain”.

You can format the text to appear exactly as you want it. (Do you write in HTML?) You can enter up to 2000 characters for each assessment type.

3. Enter the dates between which the assessment template is valid. You must enter a From date but you can leave the Until date blank.

4. Select the type of assessment template you are creating, for example, proficiency with weighting applied.

When you are setting up templates for proficiency–based assessments, as you have previously identified the proficiency levels or a rating scale with which to measure competencies, Oracle Human Resources already knows it, so it greys out the Performance Scale fields. If you are setting up templates for any type of performance–based assessment, however, you need to indicate the performance scale to use in the assessment.

5. For any type of performance–based assessment, select the performance scale for use in the assessment.

You can click the Performance Scale button to see the proficiency levels for that scale, if required.

6. Enter any comments in the Comments field, if required.

7. For all type of assessment, select the weighting scale for use in the assessment, if required.

You can click the Weighting Scale button to see the level of importance, if required.

8. Enter any comments in the Comments field, if required.

9. Select the method for calculating the total score, by sum or average total.

10. Save your changes.

11. You can now select your competence types and competencies.
Selecting Your Competence Types and Competencies

1. Click the Competencies button to select the competency types and competencies to include in the assessment. Query back all competency types and competencies for you to select from.

2. With the first competence type displayed in the Competence Type field, scroll through them until the first competence type you want to include appears, then click the Used box.

3. You can also indicate the sequence in which you want the competence type to appear on the assessment in the Sequence field. (If you do not sequence the competence types, they appear on the assessment Web page in the order they appear here).

4. Continue to scroll through the competence types, indicating the sequence in which you want the competence type to appear until you have selected all the ones you want to include.

    **Suggestion:** We suggest that you select all the competence types you want to include first, before you select the competencies.

5. Click the Saved Competence Types Only box to retrieve in future only the competence types you are using. We suggest that you do
this, otherwise, you will have to scroll through all the competence
types from which to select the competencies.

6. Save your changes, and requery the competence types you have
selected. Only the competence types you have selected are now
displayed.

7. With the first competence type and competencies for that type
displayed, click the Used box for each competence you want to
include in the assessment.

8. You can also indicate the sequence in which you want the
competencies to appear on the assessment in the Sequence field. (If
you do not sequence the competencies, they appear on the
assessment Web page in the order they appear here).

9. Save your changes.

10. Continue to scroll through the competence types, selecting and
saving competencies, and indicating the sequence, until you have
selected them all.

11. You can click the Saved Competencies Only box to display only the
competencies you have selected in future, otherwise leave this box
unchecked.

12. You can leave the Saved Competence Types Only box checked to
display only the competence types you have included in the
assessment the next time you use this window, or you can uncheck
the box to display all competence types.
Appraisals

In Oracle Human Resources, an appraisal is the part of the performance management process where the enterprise translates its corporate objectives into individual performance and improvement goals and measures. An appraisal is the whole process where a manager and person jointly evaluate the person’s performance, in terms of competencies, against the work they have been doing, as well as setting objectives and actions.

An appraisal links:

- into precise job definitions and enterprise objective setting
- training recommendations
- individual development plans for competence improvements and deployment preferences
- the pay system, in terms of making performance ratings which can be used as the basis for pay

An appraisal enables you to hold any additional data, such as a person’s strengths and weaknesses or any comments, to meet your enterprise’s needs.

Appraisals set the following:

- goals in terms of new work to be performed and new goals for existing work
- new performance criteria against which to appraise during the next review period
- action plans to improve the competencies required to carry out work (where the work has both required and desirable competencies to meet the performance criteria)

An appraisal can be linked to an assessment, or to many assessments, as part of the appraisal exercise.
Oracle provides you with a Web-based interface for performing appraisals, and with a number of example appraisal templates that you can modify. We also provide you with an easy to use method of designing and formatting your own questionnaire pages for the appraisal. You can identify the questions to use in the appraisal, and the number, size and type of boxes in which to record the answers. You can create as many different appraisal questionnaire pages as your enterprise requires.

You can create new pages directly or by copying questions from existing pages. For example, if you created an appraisal questionnaire page for junior grades within your group, you can copy these to a questionnaire for more senior grades, and just add the extra questions. This saves you time, and ensures that you don’t make mistakes.

**Appraisal Template**

You’ll also want to create your enterprise’s appraisal templates. You use the template to:

- provide instructions to appraisers about completing the appraisal, for example, what the reviewers should do
- identify which questionnaire (and questions) belong to which appraisal
- identify which performance rating scale to use

You can use one of the example appraisal templates we provide and modify them to suit your own needs, or you can create your own.
Creating Appraisal Web Pages

1. To create your questionnaire pages, see: Create Your Appraisal Questionnaire Pages: page 20 – 17
   - Creating the Questionnaire: page 20 – 23.
   - Creating Categories: page 20 – 23.
   - Assembling the Categories Within the Questionnaire: page 20 – 24.

2. To enter your appraisal quickcodes, see: User and Extensible QuickCodes: page 31 – 6

3. To create or modify your appraisal template, see: Creating or Modifying an Appraisal Template: page 20 – 30

4. To perform an appraisal, see the online help on the Appraisal Web page.
Create Your Appraisal Questionnaire Pages

We suggest that you first identify the text headings and questions that you want to appear on the questionnaire. You can sketch them out on some paper, playing around with the positions and formats before you enter them into the application. You can also identify how you want to record the answers. For example, do you want to record the answers as text or as ticks in checkboxes?

Example Appraisal Questionnaire Page

Figure 20 – 7 provides an example appraisal questionnaire showing text headings, questions and areas in which you might want to record answers.
Once you identify how you want the text, questions and answer areas specified, you are ready to create your appraisal questionnaire page.

For example, if you want the heading text *Overall Assessment, Areas for Development and Improvement, Strengths and Improvement Areas and*
Notice that the text *Strengths and Improvement Areas* and *Development Actions Resulting From Performance Review* are minor headings under *Areas for Development and Improvement*. Although the four pieces of text are all headings (categories), you can treat these smaller, minor headings as sub–categories in Oracle Human Resources. Any category can act as a parent for child categories, which means that you can create headings with several levels.

The example below shows how categories and sub–categories (minor headings) are entered in the application to create the questions page illustrated in Figure 20 – 7.

Example

<table>
<thead>
<tr>
<th>Questionnaire</th>
<th>General Appraisal</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Category</td>
<td>Overall Assessment</td>
</tr>
<tr>
<td>Second Category</td>
<td>Areas for Development and Improvement</td>
</tr>
</tbody>
</table>

| First Sub–Category:    | Strengths and Improvement Areas    |
| Second Sub–Category:   | Development Actions Resulting from Performance Review |

You can also enter helpful text alongside the category or sub–category, if you want. For example, you might want the text *(Within next six months)* to appear alongside the category *Areas for Development and Improvement*. This type of text is known as a sub–heading.
Questions and Your Answer Format

You’ll need to create the questions to use in appraisals. You can create default questions that you can use in lots of different questionnaires, for example, ‘Please summarise your views of the appraisee’s performance against objectives’, or you can create unique questions to use in a specific questionnaire, for example, ‘Does the person relate well to customers?’ You can, of course, have a mixture of both types of questions.

If you are creating default questions, you specify default text that you can make more specific for particular questionnaire you are using.

You’ll also want to define your answer format. By defining your format, you indicate how you want the answers to be recorded on the questionnaire. You have four choices:

- text
- text area
- checkbox
- options (a list of values)

Figure 20 – 8 illustrates the four different layouts you can choose, to record your answers. You can mix layouts, and you can size and position your answers to suit your enterprise’s needs.

You can also include a help button next to the answer—then, when the appraiser clicks the help button, help text you define displays.

Note: If you want to use lists to record answers, you can use a lookup table to display the list of values, or your system administrator must enter a SQL Select statement to retrieve the list.
The Questionnaire

The categories, sub-categories, sub-headings, questions and answers are all held in a container called the questionnaire. It is this questionnaire that you link to the appraisal template.

Figure 20 – 9 shows an example questionnaire using text (categories and sub-categories), sub-headings, questions and answers.
Figure 20 – 9
Questionnaire

Overall Assessment
Please summarise your views of the appraisee's performance against objectives

Areas for Development and Improvement
(Within next 6 months)

Overall Enterprise Objectives

Business Unit Objectives

Strengths and Improvement Areas
Development Actions Resulting from Performance Review

Category Questions

Text Area

Text Area

Text Area
Creating the Questionnaire

Use the Define Questionnaire page to create the questionnaire which contains the categories, sub-categories, sub-headings, questions and answer layouts.

For an overview of creating appraisal questionnaires, see: Create Your Questionnaire Pages: page 20 – 17.

To create the questionnaire:

1. In the main menu, choose Define Questionnaire.
2. Click the New button to create the questionnaire. Entry fields display for up to three questionnaires.
3. Enter the questionnaire name and description.
   In our example, enter General Appraisal, and General appraisal for all employees.
4. If you previously created a questionnaire containing similar categories and questions, you can copy the categories and questions to the new questionnaire. Select the questionnaire from the Copy From field and click the Save button.
5. When you’re done, click the Save button.

Creating Categories

Use the Manage Categories and Questions page to create and maintain the heading text you want to appear on your appraisal questionnaire.

For an overview of creating appraisal questionnaires, see: Create Your Questionnaire Pages: page 20 – 17.

To create categories:

1. In the main menu, choose Manage Categories and Questions.
2. Click the New button to create the categories (heading text and sub-headings).
   
   **Suggestion:** You can only create up to three categories at a time. Once you have entered the third category, click the Save button and click the New button again to enter further categories.
3. Enter the categories to include on the questionnaire.
In our example, this is Areas for Development and Improvement, Overall Assessment, Strengths and Improvement Areas, and Development Actions Resulting From Performance Review.

4. Enter any special details or conditions in the Heading Text field alongside the category where you want it to appear.
   In our example, ‘within 6 months’ appears alongside the category Areas for Development and Improvement.

5. When you’ve done, click the Save button.

Assembling the Categories Within the Questionnaire

Use the Assemble Questionnaire page to assemble the categories within the questionnaire. You can update the questionnaire, if required.

For an overview of creating appraisal questionnaires, see: Create Your Questionnaire Pages: page 20 – 17.

To assemble categories within the questionnaire:

1. Select Assemble Questionnaire from the main menu.
2. Select the questionnaire you created within which you want to assemble the categories.
3. Click the New button to assemble the new categories.
4. Select the first category you want to display on the questionnaire in the Category Name field.
   In our example, this is Overall Assessment.

   Note: Do not enter a category in the Parent Category field unless you are entering minor headings (sub-categories). If you want to enter minor headings, see Entering Minor Headings: page 20 – 25.

5. Enter 1 in the Parent Display Order field if you want this category to be the first one displayed on the questionnaire.
6. Enter 1 in the Category Display Order field if you want this category to be the first one displayed on the questionnaire.
7. Leave the Display Category Header set to Yes if you want the category to be displayed on the questionnaire.
8. When you have assembled up to three categories, click the Save button.
To enter further categories:

1. Click the New button again after assembling the previous three categories.

2. Enter details of further categories in the same way as before.

3. Increment the number in the Parent Display Order field by one to indicate the order in which you want the category to display on the questionnaire.

   For example, enter 2 in the Parent Display Order field if you want the category to display second, enter 3 if you want it to display third, and so on. Enter 1 in the Category Display Order field as you want this category to be the first displayed for the second category.

   In our example, select Areas for Development and Improvement (in the Category Name field), enter 2 (in the Parent Display Order field), enter 1 (in the Category Display Order field) and Leave the Display Category Header set to Yes.

4. Click the Save button when you have entered all the categories you want.

5. Click the Layout button to see all the categories for this questionnaire.

To enter sub-categories:

1. To enter minor headings (sub-categories), move to the next blank line and select the parent category under which you want to display the heading in the Parent Category Name field.

   In our example, select Areas for Development and Improvement (because this is the category under which you want to display Strengths and Improvement Areas and Development Actions Resulting from Performance Review).

2. Select the sub-category you want to display beneath the parent category in the Category Name field

   In our example, select Strengths and Improvement Areas.

3. Leave the Parent Display Order field blank.

4. Enter the order in which this sub-category displays under the parent category.

   In our example, enter 2 in the Category Display Order field. This is because the parent category (Areas for Development and Improvement) is the main heading and Strengths and Improvement Areas is second.
5. Leave the Display Category Header set to Yes.

If you have other sub-categories to include in the questionnaire, continue to enter them as described above, but continue to leave the Parent Display Order field blank, and increment the Category Display Order field by one.

In our example, select Areas for Development and Improvement in the Parent Category Name field then select Development Actions Resulting from Performance Review in the Category Name field. Leave the Parent Display Order field blank and enter 3 in the Category Display Order field. Leave the Display Category Header set to Yes.

6. Click the Save button when you have entered all the categories you want.

7. Click the Layout button to see all the categories for this questionnaire.

---

### Defining Answer Layout and Creating Questions

Use the Define Answer Layout page to name your questions and to define how you want the answers to questions to be recorded. For example, you can create text answer boxes, checkboxes, and such. Once you have named your questions and defined your answer layout, you can create your questions.

For an overview of creating appraisal questionnaires, see: Create Your Questionnaire Pages: page 20 – 17.

**To define an answer layout:**

1. In the main menu, choose Define Answer Layout.
2. Click the New button to name your questions and to define the answer layout.
3. Enter the name of a question in the Question Name field. You can name them anything you like, but we suggest that you make them something meaningful.

In our example, we named the questions:

- HR1PLEASSUM (for ‘Please summarise your views of .......”
- HR2OVERENTOBJ (for ‘Overall Enterprise Objectives”
- HR3BUSUNTOBJ (for ‘Business Unit Objectives”
4. Enter the question in the Text field only if you are creating a default question, otherwise enter your questions later (described in Creating Questions: page 20 – 29).

5. Specify how you want answers to be recorded by creating any or all of the following:
   - Text Areas: see page 20 – 27
   - Text: see page 20 – 27
   - Checkboxes: see page 20 – 28
   - Options: see page 20 – 28

6. When you have finished defining your answer layout, see: To create questions: page 20 – 29

▶ **To create text areas:**

   If you want text areas for recording answers:
   1. Select Text Area as the HTML Type.
   2. Enter the width and height of the text area. These are columns (in our example, we used a width of 60 and height of 5).
   3. Select whether you the answer box to align to the left or right hand side of the questionnaire (select right for our example).
   4. Optionally, you can enter any heading text that you want to display above the question in the Heading Text field.
   5. Enter any field level help you want made available for the user.
   6. Continue to enter any further text area boxes and click the Save button.
   7. Continue defining your answer layout at Step 4: page 20 – 27 When you have finished defining your answer layout, create questions for your questionnaire.

   See: To create questions: page 20 – 29

▶ **To create text:**

   If you want text for recording answers:
   1. Select Text as the HTML Type.
   2. Enter the width and height of the text box (a width of 15 and height of 1 is a good default)
   3. Select whether you want the text box to align to the left or right hand side of the questionnaire.
4. Optionally, you can enter any heading text that you want to display above the question in the Heading Text field.

5. Continue to enter any further text boxes and click the Save button.

6. Enter any field level help you want made available for the user.

7. Continue defining your answer layout at Step 4: page 20 – 27 When you have finished defining your answer layout, create questions for your questionnaire.

   See: To create questions: page 20 – 29

▶ To create checkboxes:

   If you want checkboxes for recording answers:

   1. Select Checkbox as the HTML Type.
   2. Leave the width and height fields blank.
   3. Select whether you the answer box to align to the left or right hand side of the questionnaire.
   4. Enter any field level help you want made available for the user.
   5. Continue to enter any further checkboxes and click the Save button.
   6. Continue defining your answer layout at Step 4: page 20 – 27 When you have finished defining your answer layout, create questions for your questionnaire.

   See: To create questions: page 20 – 29

▶ To create options with lists:

   If you want to use lists to record answers, you can either use a lookup table to display the list of values, or you must enter a SQL Select statement to retrieve the list. You can also use the list of values to link a person’s career path into the appraisal process. You do this by creating a list that contains the alternative career paths that can be selected for the person during their appraisal.

   Using a lookup table

   1. Select Option as the HTML Type.
   2. Leave the width and height fields blank.
   3. Select whether you the answer to align to the left or right hand side of the questionnaire.
   4. If the question has a default value that is not defaulted from the list of values, enter a value.
5. If the question has a default value, select either the type of Value to use the value entered in the Default Value field. Alternatively, select SQL to use the value defaulted from a list of values and enter a Select statement to select the value in the Find field..

6. Enter any field level help you want made available for the user, in the Field Level Help field.

7. Continue defining your answer layout at Step 4: page 20 – 27 When you have finished defining your answer layout, create questions for your questionnaire.

   See: To create questions: page 20 – 29

Using a SQL select statement

1. Enter the Select statement in the SQL Text field to retrieve the list of values. Enter the SQL

2. If you are using a lookup table to display the list of values, enter it in the Lookup Type field.

3. If you are using SQL to use the value defaulted from a list of values, enter a Select statement to select the value in the Find field..

4. Continue to enter any further options and click the Save button.

5. Continue defining your answer layout at Step 4: page 20 – 27 When you have finished defining your answer layout, create questions for your questionnaire.

   See: To create questions: page 20 – 29

Creating Questions

1. Select Assemble Questionnaire from the menu and and select the questionnaire you previously created.

2. Click the Show Categories button to see the categories you assembled for that questionnaire.

   Note: You can click the Show Layout button to see the questionnaire layout at any time.

3. Click the Questions hypertext link alongside the category to add the first question. In our example, the question is HR1PLEASSUM.

4. You get a message to say that there are no questions associated with this category, so click the New button.

5. Select the first question.
6. If you are creating a unique question or overwriting the default question, enter the question text in the Text field.

In our example, select HR1PLEASSUM, and enter the question text “Please summarise your views of the appraisee’s performance against objectives”

7. Select whether you want the question to align to the left or right hand side of the questions page.

In our example, the answer box is aligned to the right, so align the question left.

   **Note:** Any text you enter in the Text field appears to the left of the answer box, whereas any text you enter in the Heading Text field appears above the answer area.

8. Return to the Update Profile Categories page and click the Questions hypertext link alongside the next category to create the question.

9. Click the New button.

10. Continue to enter questions as described, then press the Save button when you have finished.

11. Click the Show Layout button to check that you are happy with the questionnaire layout before you associate the questionnaire with the template.

---

**Creating or Changing an Appraisal Template**

Use the Appraisal Template window to create or modify an appraisal template.

You’ll need to enter enter the following QuickCodes for appraisals:

- Define appraisal statuses as values for the QuickCode Type APPRAISAL_ASSESSMENT_STATUS.
- Define appraisal types as values for the QuickCode Type APPRAISAL_TYPE.

If you do not want to use appraisal statuses or types in the appraisal, do not enter values for these QuickCodes. Users can ignore these fields on the appraisal web page.
To create an appraisal template:

1. Enter a name and description for the appraisal you are setting up. You can enter up to 85 characters for the name.

2. Enter the dates between which the appraisal template is valid. You must enter a From date but you can leave the To date blank.

3. Enter the instructions to be displayed to the appraiser(s) or reviewers(s). For example, “Complete all parts”. You can format the text to appear exactly as you want it. You can enter up to 2000 characters for each appraisal type.

4. Select the questionnaire you previously created to use in the appraisal.

5. Select the performance rating scale to be used in the appraisal.

6. Save your changes.
Planning Careers and Succession

This chapter explains the different methods of handling your enterprise’s career and succession plans. It also explains how you can create and use career paths in career and succession plans.
Career and Succession Planning

Once you have found out your employees aspirations, and set their short- and long-term objectives, you’ll want to prepare them for their next position within a career plan. After all, now you have motivated your employees through your performance management system, you’ll want to keep them motivated by linking their own career aspirations to enterprise aspirations. By planning careers and identifying succession, you enable employees to see their future role within the enterprise, keeping them motivated, and you from lengthy and costly recruitment.

Not only does career and succession planning enable you to keep and retain your high-fliers, it also enables you to highlight, for example, roles requiring scarce technical or commercial skills. By being able to identify these early, you can develop these scarce skills within your enterprise and replace current employees in these positions, as required.
Modelling Career and Succession Plans

The flexibility provided by Oracle Human Resources means that you can handle your enterprise’s career and succession plans using one of two basic models. You can either base career progression on jobs or positions. If you are using the Web-based Line Manager Direct Access, you have additional features for holding succession plan information.

Figure 21 – 1 illustrates the different models you can select from.
Career Paths

A career path shows a possible progression to one job or position from any number of other jobs or positions (see Figure 21 – 2). Career paths must be based on either job progression or position progression. You cannot mix the two.

You can define as many career paths as you require, perhaps reflecting an individual’s career priorities (such as a Management Path and a Technical Path). You build career paths from the top down. You can only enter a job or position once in any career path.

Career paths based on job progression are built using the Map Career Path window. See: Defining Career Paths: page 21 – 8

Career paths based on position progression are built using position hierarchies. See: Creating Position Hierarchies: page 3 – 22
Modelling Career and Succession Planning Based on Jobs

If your enterprise’s career and succession planning is based upon jobs, you can use career paths to show possible progressions to one job from any number of other jobs.

Career paths are based on the structures of your enterprise rather than the people you employ. You may also want to record personal aspirations and progression paths for individual employees. There are several ways to do this.

Work Choices

You can use work choices to help identify a person’s career plan. Work choices indicate a person’s preference and capacity for work within the enterprise. The information you enter indicates availability for transfer, for working in other locations, and acceptable work day patterns. You can hold similar deployment information as requirements against jobs.

Appraisals on the Web

If you are using the Web–based Line Manager Direct Access, you can select a career path for a person as part of the appraisal process. When you create the appraisal questionnaire, you create a list of values that contains the alternative career paths that can be selected for a person during an appraisal.

Special Information or Attachments

If you are not using Line Manager Direct Access, there are other ways to hold information about successor jobs against a person. For example:

- You can define a special information type to hold time intervals (such as immediate, three years, five years) and job names. You can also use the Job Requirements window to record people’s names against each job for each time interval.
- An alternative approach is simply to record this information as text in comments or a word processed document attached to each employee’s record.

To model career and succession planning based on jobs:

1. Create the career paths and map career paths.

See: Defining Career Paths: page 21 – 8
Modelling Career and Succession Planning Based on Positions

If your enterprise’s career and succession planning is based upon positions, you can create additional position hierarchies to show any type of progression. These might represent existing line management structures, or even cut across departmental or job–type boundaries.

Career paths are based on the structures of your enterprise rather than the people you employ. You may also want to record personal aspirations and progression paths for individual employees. There are several ways to do this.

Work Choices

You can use work choices to help identify a person’s career plan. Work choices indicate a person’s preference and capacity for work within the enterprise. The information you enter indicates availability for transfer, for working in other locations, and acceptable work day patterns. You can hold similar deployment information as requirements against positions.

Succession Planning on the Web

If you are using Line Manager Direct Access, you can use the Succession Planning option on the Web. You can select a person’s next
position(s), or view their current position and see who is to succeed to that position. See the online help for Line Manager Direct Access for further details.

Special Information or Attachments

If you are not using Line Manager Direct Access, there are other ways to hold information about successor positions against a person. For example:

- You can define a special information type to hold time intervals (such as immediate, three years, five years) and position names against an employee. You can also use the Position Requirements window to record people’s names against each position for each time interval.

- An alternative approach is simply to record this information as text in comments or a word processed document attached to each employee’s record.

To model career and succession planning based on positions:

1. Optionally, create position hierarchies to show career paths, if you want to show typical career progression.

   See: Creating Position Hierarchies: page 3 – 22

   Once you have created the hierarchies, you can derive personal progression from the person’s assignment to a position, and the position’s place within the hierarchies.

2. Optionally, enter work choices against positions and enter personal work choices for your employees.

   See: Entering Work Choices for a Job or Position: page 3 – 17

   See: Entering Work Choices: page 13 – 19

3. If you use Line Manager Direct Access, use the Succession Planning option to record one or more next positions for each employee.

   Note: This option does not require you to have set up career paths using position hierarchies.

4. If you are not doing step 3, consider holding succession plan information against people as attachments or using a special information type.

   See: Defining Special Information Types: page 27 – 10
Defining Career Paths

You define career paths in the Career Path Names window and the Map Career Path window.

To define a career path:

1. Enter the names of the career paths you want to define in the Career Path Names window. Save the names.
2. Open the Map Career Path window. In the Name field, select the top job in the career path you are mapping.
3. Select the name of the career path in the Career Path Name field.

4. In the Job Progression From block, select all the jobs that are one level down from the top job in this career path.

5. To extend the career path from any one of these jobs, check the corresponding Down check box.

   The window is redisplayed with your selected job now showing in the Name field.

   You can move back up the career path by checking the Up check box.

6. Save your work.
CHAPTER

22

Matching People to Posts and Vacancies

This chapter explains how you use Oracle Human Resources to match your employees to posts and vacancies.
Matching People Using Web–Based Access

Career Management provides you with web–based access for many line manager and employee end–user processes. You can use the powerful web based tool ‘Suitability Search’ to search for and match the most suitable person to a job or position. This might be performed during recruitment, succession planning, and so on. You can search by:

• personal characteristics
• assignment characteristics and competencies
• a combination

In your search, you can identify which competencies are required and which are optional. You can also search for people with a proficiency level in a specific competence, at a required level and above (or below). Suitability Search then produces a list of all people who possess the required and optional competencies, at the level defined. For example, if you asked for people proficient in a competence at level 3 and above, the search will not include people below 3 in that competence in the search.

You can also rank any of the optional competencies, and the Suitability Search Match module then produces a list of all people (or jobs and positions) who possess the required competencies, and ranks those according to the rating given to the optional competencies.

In future releases, you’ll be able to include work choices in your search. These are factors that can affect an employee’s, applicant’s, contractor’s or ex–employee’s capacity to be deployed within the enterprise (or to customers). You can hold work choices at both job and position or at person level. Look at the flexibility Career Management provides by enabling you to identify, for example, that a specific job or position requires the incumbent to be able to work in any country, and the search returns only people who match that criterion.

Suitability searching also enables you to:

• match and rank people against a specific organization, job or position, for example, to fill a vacancy or to deploy a person
• match and rank people against a set of competencies, for example, to fill a vacancy or project
• match a person against organizations, jobs or positions, and rank them, for example, to define a person’s career path
Viewing the Results of Suitability Matches

You can view the results of the matching in three different ways:

- by rank order of matches for the whole group
- by individual results for each person
- by comparative results for each competence

How Suitability Matching Works

In the Competence Match Criteria window, you set the range of levels and the matching type for each competence.

Range of Levels

The range of levels determines whether a match can be made. You have three main choices in setting this range:

- to set both a low and a high level
- to set a low level but not a high level, or to set a high level but not a low level
- not to set a level at all

Setting both a high and a low level establishes an exact range for the match. If the person’s competence level is within the range this counts as a match. If it is either above or below the range there is no match.

To set just a low level for the competence means that any competence at or above this level counts as a match. To set a high level only means that any competence at or below this level counts as a match.

To set no level at all means that any score for this competence counts as a match.

Matching Type

The type of match you select can determine what effect a match or a non-match has on the person’s score as a whole.

If you select **essential** for any competence, a person who fails to score a match for this competence over the range you set will not appear in the ranked list at all. Even if the person scores matches for other competencies, the failure to score a match in this essential competence rules him or her out of the list.

If you select **desirable**, a person who fails to score a match for this competence and range will still be ranked if he or she scores matches in other competencies. If the person scores matches in no competencies he or she will not be listed.
If you select not required, the competence itself does not count for the competence matching exercise. For example, a person scores matches with four competencies in the list. One of these competencies is marked ‘not required’. The person’s score is shown as three.
If you choose not to develop the competency approach to career management, you can, instead, hold skills information using Special Information Types. This was the recommended approach in earlier releases of Oracle Human Resource Management Systems.

This chapter explains how to use Special Information Types to hold and match skills information.
The Special Information Approach to Skills Matching

From Release 11, the recommended approach to holding and matching skills information is to define a framework of competencies. These provide the common language for a wide range of human resource activities including assessments, appraisals, employee profiling, career development, and recruitment. You can build up a wealth of skills information that can be maintained and used by employees and line managers themselves, using the web Direct Access interface.

However, Oracle HRMS continues to support the earlier approach to handling skills information, using Special Information Types. This is an alternative to the new competency approach.

Special Information Types are a flexible way to hold any additional information you require about people and, if necessary, to compare this information with the requirements of jobs or positions. For each Special Information Type you can define up to thirty fields to hold details of competences, professional qualifications, education, and valid experience. For each person, job, or position, you can make multiple entries for each Special Information Type.

For example, suppose you want to store details of technical skills. You could set up the following fields:

- Skills – with a list of valid values to control the vocabulary used to describe the skills
- Years Experience – to hold the number of years of experience in using the skills

You can display the fields you define in one or more of the following windows:

- Special Information, to record skills or experience for an employee or applicant
- Job Requirements, to hold skill requirements for a job
- Position Requirements, to hold skill requirements for a position
- Skill Provisions, to record the skills or qualifications provided by training activities in Oracle Training Administration.

Using views and reports, you can then match people to posts, according to their skills or other attributes.
Tips for Defining Special Information Types to Hold Skills Information

- If you want to give different sets of people access to different categories of skills information, define each category as a separate Special Information Type. You can customize the Special Information window to display just one Special Information Type.

- If you want to match on a range of skills levels, it is easier to use numeric values. Use a description field to provide the meaning for each level. The description appears automatically when the number is chosen.

- You can use cross-validation to ensure that users enter correct combinations of segments. For example, you could ensure that when a language skill is entered, a fluency level is also selected.

- You can speed up data entry and minimize errors by defining an 'Alias' for common combinations of segment values. For
example, completion of a course might always give a specific certificate from a particular licensing body. A user could enter all of these values with a single Alias.

- If you want users to enter the precise title of a qualification (perhaps read from a resume), you cannot supply a list of values. However, consider providing additional fields with lists of values using broad terms such as ‘degree–level’ or ‘science’ to help users searching for information.

**Unstructured Information**

You may want to hold some skills information, such as resumes, as unstructured, free text information. You can store this information as attachments to the People and Special Information windows.

**See Also**

- Entering Special Information: page 13 – 24
- Entering Job and Position Requirements: page 3 – 16
- Defining Special Information Types: page 27 – 10
- Using Attachments: page 32 – 6
**Viewing and Reporting Skills Matching Information**

There is a standard skills matching report supplied with Oracle Human Resources. This report matches people against all the requirements you have entered for one job or position (held in Special Information Types).

The List People By Special Information window displays a list of people who match a particular profile for one Special Information Type.

**See Also**

Listing People by Special Information: page 13 – 26

**Skills Matching Report**

Using this report, you can match employees, applicants, or both against the requirements of one job or position (held in Special Information Types). You can select the closeness of the match you require.

You run reports in the Submit Requests window.

**To run the Skills Matching Report:**

1. In the Name field, select Job and Position Skills Matching Report.
2. Enter the Parameters field to open the Parameters window.
3. Select the Job or Position to which you want to match people.
4. In the Person Type field, select who you want to match:
   - applicants, or
   - employees, or
   - both
5. Select the closeness of match you require from one of the following levels:
   - one or more essential skills
   - all essential skills
   - all essential and one or more desirable skills
6. Choose the Submit button.
Absence Management

To manage your employees’ absences from work, you must be able to:

- identify the types of absence your enterprise recognizes
- record the reasons, dates and times for projected and actual absences, and maintain records of time taken for each absence type
- group related absence types together for reporting and analysis
- set up and administer PTO accrual plans, whereby employees can accrue time off for vacation or sick leave as they put in time at work.
- calculate Sick Pay and Maternity Pay according to statutory legislation.

This chapter explains how to set up an effective absence recording system in Oracle HRMS, how to enter and obtain information about employee absences, and how to set up, maintain and report on plans for accrual of paid time off.
Absence Management

Employees take paid or unpaid time off from work for a variety of purposes, such as illness or injury, vacation, medical appointments, childbirth, death of a close relative, jury duty, labor representation, and professional activities. Maintaining information on employee absences for reporting and analysis is an important aspect of human resource management.

Many enterprises permit employees to accrue hours or days of PTO (paid time off) as they work, to use for sick or vacation leave. In such enterprises, setting up and maintaining PTO plans is another part of absence management.

In the UK there is also government legislation regarding the payment of employees during periods of sickness and maternity leave. (SSP and SMP).

See Also

Absence Types: page 24 – 3
Plans for Accrual of PTO: page 24 – 18
Absence Management Setup Steps: page 24 – 8
Entering Absences: page 24 – 13
Viewing and Reporting on Absence Information: page 24 – 15
Introduction to SSP and SMP,
Oracle SSP/SMP User’s Guide
Absence Types

Oracle HRMS provides a convenient way to maintain information about the various absence types your enterprise recognizes. To facilitate reporting and analysis of employee absences, you can distinguish between absence types and absence categories. An absence category is a group of related absence types, as for example:

<table>
<thead>
<tr>
<th>Absence Category</th>
<th>Absence Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Medical Leave</td>
<td>Illness or Injury</td>
</tr>
<tr>
<td></td>
<td>Work-related Injury</td>
</tr>
<tr>
<td></td>
<td>Work-related Illness</td>
</tr>
<tr>
<td></td>
<td>Medical Appointment</td>
</tr>
<tr>
<td>Family Leave</td>
<td>Paid Maternity/Paternity</td>
</tr>
<tr>
<td></td>
<td>Unpaid Maternity/Paternity</td>
</tr>
<tr>
<td></td>
<td>Dependent Care</td>
</tr>
<tr>
<td>Personal Leave</td>
<td>Compassionate Leave</td>
</tr>
<tr>
<td></td>
<td>Personal Business</td>
</tr>
<tr>
<td>Professional Leave</td>
<td>Certification Classes</td>
</tr>
<tr>
<td></td>
<td>Meeting Attendance</td>
</tr>
</tbody>
</table>

Table 24 – 1  Example Absence Categories and Types

Also to assist with absence reporting and analysis, you can provide reasons to select from when recording employees’ time taken for an absence type. For example, if you need information to analyze the particular family-related responsibilities that cause employees to miss work, you can define reasons for absence types as follows:

<table>
<thead>
<tr>
<th>Absence Category</th>
<th>Absence Type</th>
<th>Absence Reasons</th>
</tr>
</thead>
<tbody>
<tr>
<td>Family Leave</td>
<td>Paid Maternity/Paternity</td>
<td>Birth of a child</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Adoption of a child</td>
</tr>
<tr>
<td>Dependent Care</td>
<td></td>
<td>Child Care</td>
</tr>
</tbody>
</table>

Table 24 – 2  Example Absence Category, Types and Reasons
Setup of Absence Types

Setting up each absence type is essentially a two–step process. One step involves defining the type, that is, entering its name, and optionally selecting a category and reasons for it. The other step involves defining an element to associate with the type. This element serves two important purposes:

- It provides a way to maintain a running total of time taken for the absence type. When you record an absence for an employee, the amount of time taken goes as an entry to the input value of the element associated with the absence type.

  For example, if you record 8 hours of Compassionate Leave for an employee, the input value of the element for this absence type receives an entry of 8. If a second 4 hour absence of this type occurs the input value gets an entry of 4, which adds in for a total of 12 hours Compassionate Leave taken to date.

- It provides a way to restrict employee eligibility for the absence type. The links you build for the element establish which employees are eligible to use the type.

  For example, if the absence type Compassionate Leave is available only to full time employees, you link its element to the employment category Full Time.

  See: Element Eligibility Rules: page 7 – 10

To hold a single running total of time taken for two or more absence types, you associate all the types with the same absence element. For example, your absence category Personal Leave may include two absence types you need for certain reporting purposes, Compassionate Leave and Personal Business. However, you require just one running total to be kept of employees’ time taken for both types of personal leave. In this case you simply associate both absence types with the same absence element.
Note: If you have a use for absence types for which you do not maintain running totals of time taken or time remaining, and which do not require any eligibility rules, you can define the type with no associated element.

Absence Elements

Each element you define and associate with an absence type has an input value with either hours or days as its unit of measure. To maintain a running total of the hours or days a employee has taken for an absence type, this input value is said to hold an increasing balance.

Increasing Balances of Time Taken

As you would expect, an increasing balance for an absence type starts with no time entered, and increases as you enter employees’ hours or days absent. For example, if the absence type Compassionate Leave has an increasing balance, the balance starts from zero for each employee and increases by the number of hours entered for each absence of this type.

<table>
<thead>
<tr>
<th>Input Value</th>
<th>Unit of Measure</th>
<th>Initial Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hours</td>
<td>Hours in decimal format</td>
<td>(none)</td>
</tr>
</tbody>
</table>

Table 24–3  Example Element for the Absence Type Compassionate Leave

Increasing balances are appropriate for most or all absence types. For absence types for which your enterprise sets a maximum time allowed, the system issues a message when an entry of time absent exceeds this maximum, or Oracle Alert can notify you when an employee reaches the maximum time or takes excess time.

See: Oracle Alert User’s Guide

When defining an absence type for a PTO accrual plan, you give it an increasing balance that will show accrued time the employee has used. To see the amount of accrued time a plan participant has available for use as vacation or sick leave, you use the Accruals window.

See: Reviewing Employees’ PTO Accruals: page 24–32

Decreasing Balances of Time Remaining

If your enterprise sets a maximum time allowed for an absence type that is not connected to a PTO accrual plan, you have the option of
setting up a decreasing balance for this type, instead of an increasing balance.

For example, suppose your enterprise allows certain employees 32 hours leave per year for professional development. The Professional Leave absence element can have a decreasing balance, and an initial entry of 32 hours.

<table>
<thead>
<tr>
<th>Input Value</th>
<th>Unit of Measure</th>
<th>Initial Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount</td>
<td>Hours in decimal format</td>
<td>32</td>
</tr>
</tbody>
</table>

Table 24 – 4 Example Element for the Absence Type Professional Leave

If you record an employee absence of 4 hours for this absence type, the decreasing balance shows 28 hours still available to be taken.

Decreasing absence balances require more maintenance than increasing balances. They need a prorated initial balance entry for all eligible new hires throughout the year, and require resetting each year for all eligible employees.

Notice that an absence element cannot have both a decreasing and an increasing balance; it has one or the other.

**Initializing an Absence Balance**

Oracle HRMS provides two ways to initialize both increasing and decreasing absence balances at the year’s start, and to enter initial amounts of any decreasing balances:

- the Element Entries window, for individual employees
  
  See: Entering Elements: page 9 – 4
- the MIX batch entry facility, for batches of employees.
  
  See: Creating and Updating Batches of Element Entries: page 9 – 8

**Referencing Absent Time in Payroll Runs**

You can reference absence time taken (amount of an increasing balance) or absence time remaining (amount of a decreasing balance) for absence types in formulas for earnings, deductions, or other items Oracle Payroll processes in payroll runs. When defining the input value to hold the absence balance for an absence type’s element, you can check the Database Item box. Entries to this input value then become database items that formulas for payroll calculations can access.
Absence Recording

When you record an absence for an employee using the Absence Detail window, you must always select an absence type. This ensures that you always have on record, information about the nature of and reasons for the absence.

Dates and Times

In the Absence Detail window you can conveniently record for an employee either a projected or an actual start and end dates and times of a particular type of absence, as well as the date you receive notification of the absence. When an actual absence occurs in accordance with projected absence information already entered, you record this by simply clicking a button.

The system records an employee’s absences using the same calendar upon which the employee’s payroll is based. This means that all employees for whom you record absence information must have a payroll component in their assignments.

See: Components of the Assignment: page 14 – 5

Authorization and Replacement

When recording a projected or actual absence in the Absence Detail window, you can select both the name of an employee authorizing the absence, and of an employee replacing the absent worker.
Absence Management Setup Steps

To set up absence recording:

1. Define a nonrecurring absence element, with the Termination Rule *Actual Termination* and with at least one input value, for each absence type. Link this element.

   See: Defining and Linking an Absence Element: page 24 – 9

   **Note:** To set up an absence type for which you do not need to maintain a running total of time taken or remaining, and do not need eligibility rules, omit this step.

   To keep a single record of employees’ time taken for two or more different absence types, you can define one element only to associate with all the types.

   See: Setup of Absence Types: page 24 – 4

2. Define categories of absence types as values for the QuickCode Type ABSENCE_CATEGORY, and your absence reasons as values for the QuickCode Type ABSENCE_REASON.

   You can select the same reason for different absence types.

   See: Adding QuickCode Values: page 31 – 3

3. Define each absence type, associating with the type its absence element.

   See: Defining an Absence Type: page 24 – 11

4. For an absence type with a decreasing balance, use the Element Entries window or the MIX batch facility to make initial element entries for employees eligible for the type.

   See:

   Entering Elements: page 9 – 4

   Creating and Updating Batches of Element Entries: page 9 – 8
Defining and Linking an Absence Element

Define an absence element in the Element window.

To define an absence element:

1. Set your effective date to a day on or before the start of the first payroll period for which you want to enter absences.
2. Enter a name for the element, and select the classification Information.
   
   Suggestion: Give the absence element and its absence type the same name, or coordinate the element name with the type name. For example, for the absence type Compassionate Leave, name the element Compassionate Leave or Compassionate Leave Absence.
3. Select the processing type Nonrecurring, and the termination rule Actual Termination.
4. Check the Multiple Entries Allowed box to enable employees to have several instances of this type of absence in a pay period.
5. If this is an absence element for a PTO accruals plan, do not select Process in Run. Uncheck this box if necessary.
6. If employees must be a certain age or have served for a certain number of years to be allowed this absence, enter this information in the Qualifying Conditions region.
   
   Note: If this is an absence element for a PTO accrual plan, the plan setup relates length of service to accrued time off. Do not make an entry here for length of service.
7. Save the element, then choose the Input Values button.
8. In the Input Values window, create an input value to hold the amount of time taken. Select units of Day, Hours in “HH” format, or Hours in Decimal Format (to one, two, or three decimal places).
   
   Attention: If this is an absence element for a PTO accrual plan, give the input value the name Hours or Days, to accord with the unit of measure of the plan. When you define the plan using the Accrual Plan window, this input value name appears in the Units field of the Absence Information region.
9. You can define minimum and maximum days or hours that can be entered in an absence record. If you do this, select what happens if these limits are breached:
   
   • Select Warning for the system to warn users but allow them to breach the limits.
• Select Error for the system to issue an error message and prevent users from saving an entry that breaches the limits.

10. Save your work.

**To link the absence element**

1. Set your effective date to a day on or before the start of the first payroll period for which you want to enter absences.
2. In the Element Link window, select the absence element.
3. Select eligibility criteria for this absence element. If you want to make the element available to all employees, do not select any criteria.
4. Save the link. Then define the absence type associated with this absence element.

**See Also**

Defining an Element (HR Users): page 8 – 3
Defining Element Links: page 8 – 10
Defining an Absence Type

Use the Absence Attendance Type window to define an absence type for association with the nonrecurring element representing an absence.

**Prerequisites**

- Define and link the element for the absence type.  
  See: Defining and Linking an Absence Element: page 24 – 9
- Define categories of absence types as values for the QuickCode Type ABSENCE_CATEGORY, and define your absence reasons as values for the QuickCode Type ABSENCE_REASON.
  
  You can select the same reason for different absence types.
  
  See: Adding QuickCode Values: page 31 – 3

![Absence Attendance Type window](image)

To define an absence type:

1. Enter a name and category for the absence type.

   **Suggestion:** Give the absence type and its associated element the same name, or coordinate the type name with its element name. For example, name the absence type for a PTO accrual plan Salaried Sick PTO Plan, and its associated element, Salaried Sick PTO Absence.
2. In the Associated Element region, select the element defined for this absence type. The name of the element’s input value that holds the time taken or time remaining for this absence type appears in the Input Value field, and the unit of measure for the input value appears in the Units region.

3. In the Balance region, select Increasing for each entry to the absence element’s input value to add to a running total of time taken to date for this absence type. Select increasing balances for absence types for PTO accrual plans, and for most other absence types.

   For absence types that have a set maximum amount of hours or days allowed, you may select Decreasing. In this case, each absence recorded reduces an initial balance entered for the absence type, to show time remaining to be taken for the type.

   Decreasing balances require more maintenance. You must enter an initial balance amount for each new hire eligible for the absence type, and must initialize the balance for all eligible employees at the start of each year.

4. Optionally, select reasons that are valid for entries of this type of absence.

5. Save the absence type.
Entering Absences

To enter projected or actual absences for an employee, use the Absence Detail window.

Prerequisites

- Because the calendar holding absence records for an employee is the same as that of the employee’s payroll, the assignments of employees for whom you enter absence information must include an assignment to a payroll. The effective date of this assignment must be no later than the start of the current payroll period.
  See: Entering a New Assignment: page 14 – 8

- Similarly, the definition and linking of the element associated with the absence type must have occurred on or before the start of the current payroll period.
  See: Defining and Linking an Absence Element: page 24 – 11

To enter absences for an employee:

1. Select the absence type. The following information appears:
   - The category of the type.
   - The occurrence of the new absence record you are entering. For example, if the employee has already incurred two absences of this type, the occurrence of the new record is 3.
• The running total of hours or days absent for the absence type. For absence types with increasing balances, this is the number of days or hours absent already recorded (in the past or future). For any types with decreasing balances, this is or the number of hours or days remaining to be taken.

• The number of days absence recorded for the absence type in the current calendar year.

• The name of the element that maintains each employee’s time taken or time remaining for this absence type.

2. Do one of the following:

• Enter projected dates for the absence. You can later copy them to the Actual Date fields by choosing the Confirm Projected Dates button.

• Enter actual dates and duration as days or hours, according to the units of the balance. For a duration in hours, you must enter start and end times, as well as start and end dates.

3. You can also select:

• reasons for the absence

• the employee authorizing the absence

• the employee who replaces the absent employee for the duration of the absence

4. Save your work.
Viewing and Reporting on Absence Information

For monitoring and analyzing recorded employee absences unconnected with a PTO accrual plan, use:

- the View Absence History window: page 24 – 15
- the List Employees by Absence Type window: page 24 – 16
- the Absences Report: page 24 – 17

For reviewing PTO plan participants’ accrued time earned and taken, use the Accruals window.

See: Reviewing Employees’ PTO Accruals: page 24 – 32

Viewing Absence History

Use the View Absence History window to view all absences for an employee.

- To view absences for an employee:
  - Select an employee then choose the Find button.
The absences appear in the lower part of the window. Use the standard Folder features to select a subset of these absence records, and to choose the fields to see.

Listing Employees by Absence Type

Use the List Employees by Absence Type window to see all the absence records for a particular absence type, or category of types.

To list employees by absence type:

- Enter any combination of absence type, category, and start and end dates to define the absences to view. Choose the Find button.

The absences appear in the lower part of the window. Use the standard Folder features to select a subset of these absence records, and to choose the fields to see.
Absences Report

The Absences Report shows information about employee absences during a specified period. It can show absences:

- for an individual employee, or for all the employees in an organization
- for all types of absence, or as many as 10 selected types.

The report summarizes the information as totals for each absence type since the employee was first hired.

Run reports in the Submit Requests window.

To run the Absences Report:

1. In the Name field, select Absences Report.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. Select either an organization or an employee.
5. Enter the start and end dates of the period for which you want to report absences.
6. You can choose up to 10 absence types for the report. To report on all types, leave the absence type fields blank. Choose OK.
7. Choose the Submit button.
Accrual plans permit eligible employees to accrue PTO (paid time off) each year as they work, to use for vacation or sick leave. Oracle HRMS has no restrictions on the number of plans you can set up, each with its own units of accrued time (hours or days) and its own rules.

The system calculates accruals for all plans on a calendar year basis. That is, on 1 January of each year, accruals for that year begin. Accruals for new hires can begin on their hire date, six months after their hire date, or at the beginning of the next calendar year.

For all plans, participants’ payroll periods determine the frequency with which they accrue PTO. Employees on a monthly payroll accrue time each month, employees on semi-monthly payrolls accrue time twice each month, and so on. PTO accrual occurs automatically for each eligible plan participant on the last day of his or her pay period, independently of any payroll run.

For example, if employees on a semi-monthly payroll participate in a vacation PTO plan permitting the accrual of 84 hours per year, they accrue 3.5 hours on the last day of the year’s first pay period, say 15 January. They then accrue another 3.5 hours on 31 January, another 3.5 hours on 14 February and so forth.

Because accrual plans use employees’ payroll calendars to schedule accruals, the assignment of every employee participating in an accrual plan must include an assignment to a payroll.

Accrual Plan Structure

Just as elements constitute the underlying structure of absence types, so they provide the structure of accrual plans. To set up an accrual plan, you first set up absence recording for the plan, including an element to hold information about absences taken under the plan.

See: Absence Management Setup Steps: page 24 – 8

With absence recording in place, you can then enter information for setup of the accrual plan itself. This information includes:

- a start rule, to determine when employees can begin to accrue PTO under the plan
- length of service bands, which establish how PTO accrued under the plan increases with employees’ length of service.

In response to the information entered for plan setup, the system generates three elements for the plan:

- an element representing the plan. You use this element to enroll participants in the plan.
• an element to hold participants’ unused PTO that is available for carryover to the next year
• an element to hold residual PTO, that is, unused PTO not available for carryover under plan rules.

Accrual Start Rules

Accrual plans differ with respect to the date from which they permit plan participants to start accruing PTO. In Oracle HRMS, the accrual start rule determines this date for a plan. The system includes these accrual start rules:

- Hire Date
- Beginning of Calendar Year
- Six Months after Hire Date

Enterprises have many different rules governing their accrual starts, so you may need start rules other than the three provided. You can either modify the existing rules, or add new ones.

Start Rule: Hire Date

For plans with this rule, participants’ accruals begin from the first full period following their hire date. For example, if the hire date of a participant on a semi-monthly payroll falls on the first day of either the first or second period in the month, PTO accrual starts as of that date. If the hire date falls sometime after the first of the month but before the end of the first period, accruals start in the second period of the month. If the hire date falls after the first day of the second period but before its end, accruals start with the first period in the next month.

Start Rule: Beginning of Calendar Year

With this start rule, participants’ accruals begin from the start of the year following the year in which they are hired. This means that a participant with a hire date of 2 January 1996 and another with a hire date of 31 December 1996 both start to accrue time as of 1 January 1997. Notice that the amount of PTO each accrues may not be the same, as accrual amounts often depend on employees’ length of service.

Period of Ineligibility

Plans with the start rule Hire Date or Beginning of Year can require participants to work for a period of time, perhaps three or six months,
before they are eligible to accrue PTO. If plan participants in fact take vacation or sick leave during this period, the system does not accept entry of this time against the accrual plan. Many enterprises set up an absence type for “approved but unpaid leave” to use for absences taken during periods of ineligibility.

The period of ineligibility is not applicable to plans with the start rule Six Months After Hire.

Start Rule: Six Months After Hire

For plans with this start rule, participants’ accruals do not begin until the first full pay period after the six–month anniversary of their hire date. For example, someone on a semi–monthly payroll who is hired on 5 February 1996, completes six months of service on 5 August 1996, and starts to accrue PTO in the second period in August.

Notice that if people are hired on the first day of a period, their accruals begin with the pay period of the six–month anniversary of their hire date. For example, someone on a semi–monthly payroll who is hired on 1 February 1996 completes six months of service on 1 August 1996, and hence starts to accrue PTO in the first period in August.
Length of Service and Accrual Amount Rules

In Oracle HRMS, the **first day of the month of an employee’s hire date** is the default date from which his or her length of service is calculated for accrual purposes. For example, someone hired on 18 January 1997 completes one year of service on 1 January 1997, and someone hired on 31 December 1996 completes one year of service on 1 December 1997.

**Length of Service Override**

For individual accrual plan participants, you can override the default date from which a plan starts its length of service calculations. This is useful for managing exceptional cases that arise when, for example, employees who already have accumulated periods of service in your enterprise transfer from one place to another. You enter the date override when enrolling a participant in a plan.

See: Enrolling Employees in PTO Accrual Plans: page 24 – 29

**Length of Service Bands**

For many accrual plans, the time off that plan participants can accrue increases with their length of service. That is, *length of service bands* determine accrual amounts. In addition, these bands can determine ceiling and maximum carryover amounts for plans that have these rules.

For each accrual plan in Oracle HRMS, you set up one or more length of service bands, supplying for each the hours or days of PTO that participants can accrue each year, together with any ceiling and maximum carryover of accrued time.

**Ceiling Rules**

The ceiling rule, found in some vacation accrual plans, sets a maximum amount of PTO an employee can hold at any time. When a participant’s accrued PTO reaches the ceiling, no additional time accrues. Accruals begin again only after the participant uses some accrued time.

**Maximum Carryover Rules**

Maximum carryover rules, found in both vacation and sick leave plans, set the maximum amount of unused PTO a participant can carry over from one year to the next.

**Carried Over and Residual PTO**

To manage the carryover to a new calendar year of employees’ unused PTO, you run the PTO Carry Over process at year end. This process
first calculates participants’ net PTO as of the last day of the year’s last pay period. This calculation insures that this period’s accruals do not exceed any plan ceilings that may exist. The process then checks the maximum carryover permitted, to determine for each participant both the amount to carry over, and the amount of any residual PTO that cannot be carried over.

For employees with unused, accrued time to carry over, it enters this time on the element generated to hold carried over time for the plan. Similarly, for employees with unused, accrued time they cannot carry over, it enters this time on the element generated for the plan to hold residual time.

PTO Sale or Purchase

Your enterprise may have policies permitting accrual plan participants, under certain circumstances, to sell back PTO they have accrued but not used. You may also permit them to purchase additional PTO. Because such policies and rules are not standard across enterprises, Oracle HRMS has no method in place for managing PTO sale or purchase. However, you can design a method and define elements for doing this, customized to your own requirements.

See: Reviewing or Changing Net Accrual Calculations: page 24 – 26
Accrual Plan Setup Steps

To set up a PTO accrual plans:

1. Define and link an element for the plan’s absence type.
   See: Defining and Linking an Absence Element: page 24 – 9
2. If you expect to record accrued time taken under the plan using the Absence Detail window, define an absence type for the plan, associating its absence element with this type.
   See: Defining an Absence Type: page 24 – 11
3. Define the accrual plan.
   See: Defining a PTO Accrual Plan: page 24 – 23
4. Set up length of service bands for the plan.
   See: Setting Up Length of Service Bands: page 24 – 25

Defining a PTO Accrual Plan

Use the Accrual Plan window to define an accrual plan.

Prerequisite

Before setting up the plan, set up a way to track absences taken under the plan. To do this you define and link an element for recording accrued time taken under this plan, and optionally, associate this element with absence type information.

See: Absence Management Setup Steps: page 24 – 8
To define a PTO accrual plan:

1. Enter the plan name, and select an accrual category of either Sick or Vacation for it.

   **Suggestion:** Coordinate the names of the accrual plan, the plan’s absence type if any, and the element used to record absences taken under the plan. For example, for the Hrly Vacation PTO Plan for your hourly workers, you could name the absence type and its element Hrly Vacation PTO Absence.

2. Select the start rule for the plan in the Accrual Start field. This rule determines the date on which a plan participant begins to accrue PTO.

   See: Accrual Start Rules: page 24 – 19

3. Select Days or Hours in the Accrual Units field. This selection must accord with the input value units selected for the element that records accrued time taken under this plan.

   See: Defining an Absence Type: page 24 – 11

4. In the Name field of the Absence Information region, select the element associated with the plan’s absence type. The name of the element’s input value that holds the entries or hours or days absent appears in the Units field.
5. If the start rule for this plan is Hire Date or Beginning of Year, you can enter a period of ineligibility, during which a plan participant can accrue PTO but cannot use accrued PTO. For example, enter 3 in the Length field and select Calendar Month in the next field. See: Period of Ineligibility: page 24 – 19

6. Save your work, and then set up length of service bands for the plan. Choose the Accrual Bands button to go to the Accrual Bands window.

Choose the Net Calculation Rules button to view or change the rules for calculating employees’ net PTO.

Setting Up Length of Service Bands

Use the Accrual Bands window to define length of service bands for an accrual plan.

Prerequisite
- Define the accrual plan for which you are entering length of service bands.

To set up length of service bands for a PTO plan:

1. For each length of service band applicable to this plan, establish the band’s duration by making an entry in the To field. The first band...
starts from zero years of service. If it extends for five years, enter 5 in the To field. The system then sets the From field for the second band at 5, as the second band starts after five years of service.

For the last band you enter, in order to cover all participants with any length of service beyond the band’s From entry, enter 99 in the To field. For example, if your bands cover service of 0–5 years, 5–10 years and 10+ years, the third band’s From and To entries should be 10 and 99.

If length of service is not relevant for this plan, define one band only for it, with a From entry of 0 and a To entry of 99.

2. For each band, enter In the Yearly Accrual field the number of hours or days that participants whose length of service falls into this band can accrue each year. For example, if plan participants accrue 80 hours of vacation per year during their first five years of service (band 0 – 5), enter 80 in the Yearly Accrual field.

3. If a band does not permit participants to carry unused accrued time over to the next year, leave the Accrual Carryover field blank. Otherwise, enter in this field the maximum number of accrued, unused hours or days that participants at this band may carry forward.

See: Length of Service and Accrual Amount Rules: page 24 – 21

4. If a band has no ceiling that limits the total number of hours or days participants at this band can accrue at any one time, leave the Ceiling field blank. Otherwise, enter the ceiling number for the band.

5. Save your work.

When you do this, the system generates three new elements for the plan, one to represent the plan and one each to hold carried over and residual amounts of accrued, unused PTO. Define for these elements, the same links as those of the plan’s absence element.

---

**Reviewing or Changing Net Accrual Calculations**

The rules for automatic calculation of employees’ net PTO appear in the Net Calculation Rules window. Here the system displays the rules that carried over time adds to net PTO, and hours or days absent subtract from the net. You enter this window by choosing the Net Calculation Rules button in the Accrual Plan window.
The Net Accrual Calculation for Net Entitlement of PTO

The calculation dynamically adds up a plan participant’s regular accruals to date. Then it adds in any carried over PTO from the previous year, obtained from the plan’s Carried Over element, to produce the gross accrual to date.

The calculation next adds up all PTO taken to date, obtained from the entries in each period to the element of the plan’s absence type. It then subtracts the amount of time taken to date from the gross accrual to date, to obtain the net accrual to date.

Gross PTO accrual = Accrued PTO + PTO carried over
Net PTO accrual = Gross PTO accrual – PTO taken this year

If your enterprise allows employees to purchase additional PTO or sell unused PTO, you can define elements to record information about purchased or sold amounts, query them in the Net Calculation Rules window, and select for the elements’ input values, rules governing their addition or subtraction in the net accruals calculation.

Residual PTO

Notice that the system does no automatic processing of the entries of employees’ residual PTO. Your enterprise may want to use these entries to inform employees of accrued but unused time they may forfeit, or to make payments for part or all of this time.
Linking the Accrual Plan Elements

When you save your entries in the Accrual Bands window, the system creates three elements:

- An element representing the plan that has the plan name, for example, Hrly Vacation PTO Plan. Use this element to enroll employees in the plan.
- An element to hold for each plan participant, any accrued, unused hours or days that can be carried over to the next year.
- An element to hold each participant’s residual time, that is, any accrued, unused hours or days that cannot be carried over.

The Carried Over and Residual elements each have an input value Hours or Days (depending on the plan’s units), which automatically receive entries when you run the PTO Carryover process at year end.

For the three elements generated for each PTO accrual plan, you must build links that are the same as those of the plan’s absence element, whose name appears in the Absence Information region of the Accrual Plan window.

To link the accrual plan elements:

1. Set your effective date to the date the accrual plan goes into effect.
2. In the Element Link window, select one of the following:
   - the element representing the plan (for example, Hrly Vacation PTO Plan)
   - the plan’s Carried Over element (for example, Carried Over Hrly Vacation PTO Plan)
   - the plan’s Residual element (for example, Residual Hrly Vacation PTO Plan)
3. Select the same eligibility criteria for the element as those selected for the plan’s absence element. If you save a link without selecting any criteria, the element is available to all employees.
4. Save the link.

You are now ready to enroll employees in the plan, and record absences for plan participants when they use time they have accrued.
Maintaining PTO Plan Records

When a PTO accrual plan setup is complete, you enroll employees in their plans, and record their accrued time taken. At year end, you run the PTO Carry Over process to clear down each employee’s balance of unused accrued time, recording both unused time available for carryover, and residual time unavailable for carryover.

The net accrual calculation produces for an employee, his or her amount of accrued PTO at a given point in time. The results of this calculation are always available for review.

Enrolling Employees in PTO Accrual Plans

Enroll individual participants in an accrual plan by entering for them the element generated to represent the plan.

► To enroll participants in a PTO accrual plan:
  ■ Do one of the following:
    • For enrollment of an individual employee, perhaps as a part of the hiring process, enter the element representing the plan for him or her using the Element Entries window.
      See: Entering Elements: page 9 – 4
    • For enrollment of a batch of employees in a plan, perhaps a newly–developed plan, use the MIX batch entry facility.
      See: Creating and Updating Batches of Element Entries: page 9 – 8

If an accrual plan should calculate a participant’s length of service from a date other than the default date deriving from the plan’s start rule, give the plan a date to use for this participant when enrolling him or her.

See: Length of Service Override: page 24 – 21

► To override the date for calculating length of service:
  ■ When enrolling the participant, enter the override date in the input value Continuous Service Date of the element representing the plan. This entry overrides the default date derived from the plan’s accrual start rule.
Recording Accrued Time Taken

For PTO accrual plans associated with an absence type, you can use the Absence Detail window to record a plan participant’s accrued time taken.

See: Entering Absences: page 24 – 13

For plans not associated with an absence type, you can make entries for individual participants directly to the plan’s absence element, using the Element Entries window.

Recording PTO Sold or Purchased

If your enterprise pays employees for time they have accrued but not used, or if you permit employees to buy additional time, you may decide to define your own PTO–related elements to record information about these transactions. In this case, you can enter these elements and select the rules governing the subtraction or addition of sold or purchased PTO in the Net Calculation Rules window.

Running the PTO Carry Over Process

Run this process at year end for each PTO accrual plan, to clear down participants’ balances of unused, accrued time. For each participant, the process stores time available for carryover to the new year on the plan’s Carried Over <plan name> element, and stores time they cannot carry over on the plan’s Residual <plan name> element.

Run the PTO Carry Over process from the Submit Requests window.

To run the PTO Carry Over process:

1. Select PTO Carry Over in the Name field. If the Parameters window does not open automatically, click in the Parameters field.
2. The date in the PTO Year Earned field defaults to the year before the current year. You can enter a different year.
3. Select the name and category of the accrual plan for which you are running the process.
4. The Reprocess All Participants field defaults to No, so that the process affects only those plan participants not previously processed for this year. To process all participants regardless of any previous processing, select Yes in this field.
5. When the entry of parameters is complete, choose OK. Choose Submit to submit the request.
The net accrual calculation for PTO includes carried over PTO in determining an employee’s accrued PTO to date. To set the net calculation rules, use the Net Calculation Rules window. To review an employee’s carryover of accrued time, use the Accruals window.

See Also

Reviewing or Changing Net Accrual Calculations: page 24 – 26
Reviewing Employees’ PTO Accruals

To view information on employees’ accrued PTO, use the Accruals window.

To view an employee’s net PTO accrual:

1. In the Assignments Folder, query the employee’s name. Choose the Accruals button to go to the Accruals window.

2. Query the accrual plan in the Name window. The field Net Entitlement displays the net accrued days or hours as of the effective dates that appear. If you allow maintenance of negative balances of accrued time at your installation and an employee’s time absent exceeds time accrued, the net entitlement appears as a negative number.

   The Entitlement Details region shows the amounts of **current accrued time**, the **accrued time carried over** and **accrued time taken** used in the calculation of the net PTO accrual.

   **Attention:** When reviewing employee accruals at year end, remember that:

   - the last day of the final period of the current calendar year may fall between a date in late December and one in early January
- Accruals for the new calendar year do not go on record until the last day of the first period of the new year.
- Carried over and residual PTO appear only after the PTO Carry Over process is run.
Oracle Human Resource Management Systems provides a full featured event management system in the form of Oracle Training Administration. However, Oracle Human Resources itself provides a simple way to record attendance at events and to schedule employee reviews. This chapter explains how to:

- set up events
- book employees and applicants onto events
- record information about employee interviews, such as disciplinary hearings and performance reviews
Setting Up Events

Oracle Training Administration provides all the power and flexibility you need to schedule, administer and track training events. For example, you can:

- control enrollments throughout the lifecycle of an event using event statuses, such as Planned, Full, and Closed
- manage waiting lists and allocate places by enrollment date, priority, status, or by organization or customer
- restrict enrollments to employees in specified jobs, positions or organizations
- group events into programs for coordinated enrollment and attendance tracking

See: Overview of Oracle Training Administration, Oracle Training Administration User’s Guide

In Oracle Human Resources, you can create events for employees or applicants in the Event Bookings window. While this window does not provide the powerful scheduling and enrollment features of Oracle Training Administration, it is useful for recording attendance at events.

**Note:** The system administrator can create customized versions of the Event Bookings window so that you use one version for employees and another version for applicants.

Creating an Event

**Prerequisites**

- Define types of event, such as departmental meeting or marketing presentation, as values for the QuickCode Types EMP_EVENT_TYPE and APL_EVENT_TYPE.

  **Suggestion:** You could set up the Additional Event Details descriptive flexfield to record booking statuses (such as Wait Listed, Confirmed, and Attended). This descriptive flexfield displays on the Event Bookings window, the Employee Review window, and the Applicant Interview window.
To create an event:

1. Select the type of event then enter the date, time, supplying organization, location, and contact name.
2. Save the event.
3. You can select attendees by name or number in the Bookings block of this window.

Managing Bookings and Attendance

You can view all the events a person has attended or is scheduled to attend in the Book Events window. You can also enter new bookings here.
Employee Reviews

You can use the Employee Review window to record information about any employee interview, such as a performance review, disciplinary hearing, or medical test.

To prepare for a performance review, you can view the employee’s:

- career history, using the Assignment History window
  See: Assignment History: page 14 – 32
- personal competence profile, using the Personal Competence Profile window if you are using Career Management, or the Special Information window, if you are recording skills information using Special Information Types
  See: Entering a Personal Competence Profile,
  See: Entering Special Information: page 13 – 24
- likely career paths or succession plans
  See: Career and Succession Planning: page 21 – 2

Line managers can use the web Direct Access interface to Career Management to complete assessment and appraisal templates for their employees.

Entering an Employee Review

You can record details of a review event using the Employee Review window.

Prerequisites

Define the different types of employee interview you want to record, such as disciplinary hearings and performance reviews, as values for the QuickCode Type EMP_INTERVIEW_TYPE.
To enter a review for an employee:

1. Select an interview type, and enter a start date. The other fields are optional.
2. Save the review.
3. You can select reviewers by name or employee number. Save your work.
4. If you want to enter a performance rating for the employee associated with this review, navigate to the Salary Administration window.

**Entering Performance Ratings**

You can carry forward details from the Employee Review window to the Performance window (which opens from the Salary Administration window). In this window, you can enter performance ratings, schedule the next performance review, and, optionally, associate a salary change with a performance review.

**Prerequisites**

- Define a list of performance ratings as values for the QuickCode Type PERFORMANCE_RATING.
To enter a performance rating:

1. Select an existing review or enter a new review and its date.
2. Select a rating.
3. If you entered a time period for regular performance reviews in the Salary Information region of the Assignment window, the date of the next review appears automatically. You can change this date.

See Also

Entering Salaries and Salary Changes: page 10 – 9
Using Letters to Manage Recruitment and Enrollment

This chapter describes how you can issue standard letters to applicants and students. There are examples of the types of standard letter that can be used, and the chapter then explains:

- how to set up standard letters
- how to use concurrent processing with a word processor
- how to use concurrent processing from Oracle reports
You can use standard letters to help you to manage your enterprise’s recruitment or enrollment activities. You do this by issuing standard letters to applicants (Oracle Human Resources) or to students (Oracle Training Administration), triggered by changes in assignment or enrollment status. For example, you can set up a standard enrollment confirmation letter that is triggered when a student’s enrollment status is set to Placed or you can set up a rejection letter that is triggered when an applicant’s assignment status is set to Rejected.

Here are a few examples of letters you can set up to help you to manage your enterprise’s recruitment or enrollment activities:

<table>
<thead>
<tr>
<th><strong>Oracle Human Resources</strong></th>
<th><strong>Oracle Training Administration</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Acknowledgement letters (for all active applications)</td>
<td>Acknowledgement letters (for all requested enrollments)</td>
</tr>
<tr>
<td>Confirmation letters (for interviews)</td>
<td>Confirmation letters (for placed enrollments, including event joining instructions based on the date, venue, and trainers)</td>
</tr>
<tr>
<td>Reports for interviewers and schedules</td>
<td>Reports for trainers (listing the students to attend an event)</td>
</tr>
<tr>
<td>Offer and Rejection letters (for applicants)</td>
<td>Chase–up letters (for non–response or non–payment)</td>
</tr>
<tr>
<td></td>
<td>Acknowledgement letters (for cancellations)</td>
</tr>
<tr>
<td></td>
<td>Certificates (of successful course completion)</td>
</tr>
</tbody>
</table>
Setting Up Standard Letters

Oracle HRMS provides you with two different methods to create standard letters:

- Concurrent Processing
- Online:
  - using Oracle Application Data Export (ADE)
  - using Object Linking and Embedding (OLE) to generate Microsoft Word letters only

Which Method Should You Use?

Use the online method, ADE or OLE, if you want to generate and review your letters immediately.

Alternatively, you can use the concurrent processing method to set up your standard letters. With concurrent processing, you can generate and review your letters without interfering with the other work you perform at your terminal. You can control when a concurrent process runs and schedule long-running processes to run at times when the system is lightly loaded. Another advantage of using concurrent processing is that you do not need Windows 95, Excel or Lotus 123 installed.

See: Concurrent Processing: page 26 – 5

Using ADE

You can use ADE to generate standard letters and reports. ADE retrieves data and exports it to a data file that is merged with a standard word processed document. The word processed document includes all the merge fields required to merge the data and the standard text for the letter. ADE is fully compatible with Microsoft Word 6.

You can use ADE to generate standard letters for recruitment or enrollment by performing a mail merge from the Request Letter window in your application.

If you want to use ADE to set up your standard letters instead of using the concurrent processing method, refer to the ADE documentation.

See: Application Data Export (ADE) Online Help

Using OLE

You can use Object Linking and Embedding (OLE) to generate Microsoft Word letters instead of using ADE, if required.
Attention: In future releases of Oracle HRMS, generating Microsoft Word letters using Object Linking and Embedding (OLE) will be replaced by ADE.

Concurrent Processing

There are two methods of using concurrent processing to set up your standard letters:

- Using word processors
- Using Oracle reports

Using Word Processors

You can use any word processor to produce standard letters from Oracle HRMS. If you use a word processor, you can submit a concurrent request in the Letter Request window to generate the mail merge file. When the concurrent request is complete, you can use your word processor’s mail merge facilities to create the merged letters.

See: Using a Word Processor: page 26 – 6

Using Oracle Reports

As an alternative to using a word processor to produce standard letters, you can use the Standard Letter and Label features of Oracle Reports. Use this method if you do not want to use word processors to print your letters (or if you do not have word processors).

See: Using Oracle Reports: page 26 – 22
To create standard letters using a word processor, you need to extract the data you want to include in the letters from the Oracle HRMS database. To do this, you create a program, such as a SQL*Plus script, to extract the data, which is then stored in a Data file. You also write skeleton standard letters using your word processor.

Each time you run your SQL*Plus script, it extracts data to the Data file. You then use the mail merge features of your word processor to merge this data with the skeleton standard letters you previously prepared. This merging process creates the actual letters that you send out to students and applicants.

An overview of creating standard letters using a word processor is illustrated in Figure 26 – 1.
Oracle HRMS supplies SQL*Plus script templates for use with MultiMate, WordPerfect and Microsoft Word. It also supplies two sample Microsoft Word documents containing merge codes for the SQL*Plus scripts. You can copy the SQL*Plus script templates (or Word documents) and modify them to create the standard letters you require.

If you use Microsoft Word as your word processor, not only can you use the concurrent processing method to produce your standard letters, but you can also generate letters online. You can generate Microsoft Word letters using OLE or Oracle Application Data Export (ADE). See: Setting Up Standard Letters: page 26 – 3.

If you are setting up standard letters using the concurrent processing method with MultiMate or WordPerfect (or if you are using the concurrent processing method with Microsoft Word), see Flowchart for Setting Up Standard Letters Using MultiMate or WordPerfect: page 26 – 7

If you are setting up standard letters to be generated online for Microsoft Word, see Flowchart for Setting Up Standard Letters Using Microsoft Word: page 26 – 17

Flowchart for Setting Up Standard Letters Using MultiMate or WordPerfect

Figure 26 – 2 illustrates the sequence in which you set up standard letters using the concurrent processing method with MultiMate or WordPerfect (or if you are using the concurrent processing method with Microsoft Word).
Figure 26 – 2
Using MultiMate and WordPerfect

LEGEND

System Administrator

HRMS Manager

Step 1
Planning

Step 2
Writing a SQL*Plus Script

Step 3
Registering the SQL*Plus Script

Step 4
Linking the SQL*Plus Script With a Letter

Step 5
Writing Skeleton Letters

Step 6
Requesting Letters

Step 7
Merging the Data Files
One of the first tasks you need to perform is to identify which data you want to extract from the database to include in your standard letters. You need to identify the select statements to use to provide you with the data as the *content* of your letters. Oracle HRMS supplies you with SQL*Plus scripts as templates to help you do this. You also need to identify the text that you want to include as the *body* of your letters.

The next decision you need to make is whether to associate your standard letters with student enrollment or applicant assignment statuses.

If you do want to link your standard letters to student enrollment or applicant assignment statuses, your next decision is to identify which student enrollment or applicant assignment statuses you want to trigger your standard letters. For example, do you want to link your standard enrollment confirmation letter to the status Placed so that the letter is triggered when you set a student’s enrollment status to Placed? Alternatively, do you want to link your standard rejection letter to the status Rejected so that it is triggered when an applicant’s assignment status is set to Rejected?

**Writing a SQL*Plus Script for MultiMate or WordPerfect**

Now that you have identified whether you want to associate the standard letters with student enrollment or applicant assignment statuses, you are ready to write your program to extract the data from the database.

Oracle HRMS supplies you with SQL*Plus scripts as templates. You can copy the SQL*Plus script templates and modify them to create the standard letters you require. Copy the SQL*Plus scripts from the server side sql directory of the HR product tree (consult your installation guide for details). The following example applies to HR—Oracle Training Administration does not provide template scripts—but we provide an example of a Confirmation letter SQL mail merge file.

Once you have written your script, save the file with the name PERWP*** (or OTAWP*** for OTA). You must use this prefix for the system to recognise it as a type of letter. See your Oracle Applications installation server guides for details of where the concurrent manager places the files.

The template scripts Oracle HRMS provides are:
### Scripts

<table>
<thead>
<tr>
<th>Python</th>
<th>Purpose</th>
<th>Used By</th>
</tr>
</thead>
<tbody>
<tr>
<td>PERWPMUK.sql</td>
<td>Example UK SQL*Plus script for MultiMate</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPMUS.sql</td>
<td>Example US SQL*Plus script for MultiMate</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPWUK.sql</td>
<td>Example US SQL*Plus script for WordPerfect</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPWUS.sql</td>
<td>Example US SQL*Plus script for WordPerfect</td>
<td>HR</td>
</tr>
</tbody>
</table>

One of the template SQL*Plus scripts (PERWPWUK.sql) is provided as an example, see Template SQL*Plus Script PERWPWUK: page D–6. Oracle Training Administration does not provide template scripts, but we provide an example of a Confirmation letter SQL mail merge file, see OTA SQL*Plus Script: page D–8

#### To write a SQL*Plus script for MultiMate or WordPerfect:

1. Write a SQL*Plus script to select data from the database in a format your word processor can read and that is compatible with the standard letter.
2. Name the program PERWP*** (or OTAWP*** for OTA).
3. Save the program. (Consult your installation guide for details).

---

### Registering the SQL*Plus Script for MultiMate or WordPerfect

You now need to register your SQL*Plus program with Oracle HRMS. You register your program so that you can run it as a concurrent program. Name the file PERWP*** (or OTAWP***). You must use this prefix for the system to recognise it as a type of letter.

You use the Concurrent Programs window to register your program (using a system administrator responsibility).

See: Concurrent Programs Window, Oracle Applications System Administrator’s Guide
Linking the SQL*Plus Script With a Letter for MultiMate or WordPerfect

You need to link your SQL*Plus script with a letter and one or more statuses. In Oracle Human Resources, you can link one or more applicant assignment statuses with each recruitment letter. A request for the letter is then created automatically when an applicant is given an associated assignment status. For example, you can link your standard recruitment rejection letter to the status Rejected so that the letter is triggered when you set an applicant’s assignment status to Rejected.

In Oracle Training Administration, you can link one or more enrollment statuses with each enrollment letter. A request for the letter is then created automatically when an enrollment is given an associated status. Define your standard letter types in the Letter window.

To define a standard letter type:

1. Enter a name for the letter in the Name field.
2. Select the Concurrent Program Name assigned by your System Administrator to the SQL*Plus script.
3. Select one or more applicant assignment statuses to create letter requests automatically for applicants, and check the Enabled box.
   When an applicant is given one of these statuses, a pending request for this letter type is created automatically. If a pending letter
request already exists, the applicant is added to the list of people to receive the letter when you submit the request.

For Oracle Training Administration:
4. Select one or more enrollment statuses to create letter requests automatically for enrollments, and check the Enabled box.

When an enrollment is given one of these statuses, a pending request for this letter type is created automatically. If a pending letter request already exists, the enrollment is added to the list of people to receive the letter when you submit the request.

Writing a Skeleton Letter

You now need to write a skeleton letter using your word processor. Include the appropriate merge codes from the data source for the word processor you are using.

The mail merge feature of any word processor enables you to merge text from the data file you create into a standard letter. Each line in the data file contains the text to merge into one standard letter for one recipient.

Within the program, you can format the data and include the characters that are recognized as separators by your word processor.

A standard letter comprises standard text with a number of embedded variables in it. When you print the letter, the variables are replaced with specific items of data, such as name and address details for different people.
Merging Data with Standard Letters

Figure 26–3

Skeleton Letter

Dear &Title &Last Name

Thank you for your application for the position of &Position.

After careful consideration of your application I regret to inform you that we will not be short listing you for interview.

Merge Codes

Data File

&Business, &Addr1, &Addr2, &Post, &Date, &Reference, &Title, &LastName, &Position

&Business, &Addr1, &Addr2, &Post, &Date, &Reference, &Title, &LastName, &Position

&Business, &Addr1, &Addr2, &Post, &Date, &Reference, &Title, &LastName, &Position

&Business, &Addr1, &Addr2, &Post, &Date, &Reference, &Title, &LastName, &Position
Requesting Letters for MultiMate or WordPerfect

When you, or other users, set the status for an applicant or enrollment that triggers your standard letters, Oracle HRMS creates a letter request automatically, with the status of Pending. It also adds the applicant’s or student’s name to the request. You can view the pending request and names through the Request Letter window.

Then, when you change the letter request from Pending to Requested, Oracle HRMS runs the SQL*Plus script that you previously wrote and creates the data file for mail merge. (Consult your installation guide for details of the location Concurrent Manager places the output file).

You can add further names to the list manually, if required. For example, you might have a last minute acknowledgement letter to send.

You can also create manual letter requests. If you do, enter the status of Pending yourself, then enter all the recipients of the letter before changing the status of the letter to Requested.

To submit an automatic letter request:

1. Query the letter you require in the Letter Name field.
2. Ensure that the method is Automatic.
3. Move to the Requested for block to query the applicants, events or students which have been entered automatically on this request, according to their status. You can add further names manually.
4. Update the status from Pending to Requested.
5. Save your changes.
A concurrent request ID number appears in the Concurrent Request field. When the Concurrent Manager has processed the request it changes the status to Completed.

6. You can query the request ID in the Concurrent Requests window and monitor its progress.

   Note: Consult your installation guide for details of the location Concurrent Manager places the output file.

---

To create a manual letter request:

1. Select the Letter Name for the letter type you want to request.
2. Ensure that the method is Manual.
3. Leave the status of the request as Pending.
4. Save the changes.

---

Adding the Names

5. Select the names to add:
   - Select employees or applicants (for Oracle Human Resources) to receive the letter in the Requested For region.
     The Assignment field displays the organization to which the person is assigned. You can view the other components of the assignment by choosing List of Values from the Edit menu.
   - Select events or students or both (for Oracle Training Administration) in the Requested For region.
6. Save the changes.

---

Changing the Status

7. Update the status from Pending to Requested.
8. Save the changes.

   A concurrent request ID number appears in the Concurrent Request field. When the Concurrent Manager has processed the request it changes the status to Completed.

9. You can query the request ID in the Concurrent Requests window and monitor its progress.

   Note: Consult your installation guide for details of the location Concurrent Manager places the output file.
Merging the Data File With the Standard Letter MultiMate or WordPerfect

The last step is to merge the data in the Data File with your skeleton letters to create your standard letters. The merging of text and data files is normally carried out using the mail merge features of your word processor.

If you do not have access to the directory where the Data File resides (consult your installation guide for details of the location Concurrent Manager places the file), you need to transfer the mail merge files created by the concurrent process to your word processor before you can merge the data file with the skeleton letters.

Saving the Letters You Generate

If you are using a word processor to merge the data file, you need to save the merged letters you generate. If you do not save the merged letters, when you exit the word processor you lose the letters. You do not lose the data file or the skeleton letter, however.
Flowchart for Setting Up Standard Letters Using Microsoft Word

Figure 26 – 4 illustrates the sequence in which you set up standard letters using Microsoft Word.

**Legend**

- System Administrator
- HRMS Manager
If you use Microsoft Word as your word processor, not only can you use the concurrent processing method to produce your standard letters, but you can also generate letters online.

You can use either one of two methods:

- Generate Microsoft Word letters using Object Linking and Embedding (OLE)
- Application Data Export (ADE)

**Attention:** In future releases of Oracle HRMS, generating Microsoft Word letters using Object Linking and Embedding (OLE) will be replaced by ADE.

See: Application Data Export (ADE) Online Help

If you are setting up standard letters using the concurrent processing method, follow the same sequence as for MultiMate or WordPerfect. See: Flowchart for Setting Up Standard Letters Using MultiMate or WordPerfect: page 26 – 7

If you are generating Microsoft Word letters using Object Linking and Embedding (OLE), see Writing a SQL*Plus Script for Microsoft Word: page 26 – 18

---

**Writing a SQL*Plus Script for Microsoft Word**

Now that you have identified whether you want to associate the standard letters with student enrollment or applicant assignment statuses, you are ready to identify which data you want to extract from the database.

Oracle HRMS supplies SQL*Plus script templates. It also supplies two sample Microsoft Word documents containing merge codes for the SQL*Plus scripts. You can copy the SQL*Plus scripts from the server side sql directory of the HR or product tree. (Consult your installation guide for details).

Oracle Training Administration does not provide template scripts, but we provide an example of a Confirmation letter SQL mail merge file, see OTA SQL*Plus Script: page D – 8

You can copy the word documents from the client–side directory [APPL_TOP]\PER76\LETGEN.

You can run the scripts on the server side and make them accessible to other users across the network, or you must copy them to a directory which is accessible from the PC, such as a network drive. You must
also make the Microsoft Word documents accessible to other users across the network, or you must copy them to each PC.

Templates Provided

The template scripts and Microsoft Word documents Oracle HRMS provides are:

<table>
<thead>
<tr>
<th>Scripts and Documents</th>
<th>Purpose</th>
<th>Used By</th>
</tr>
</thead>
<tbody>
<tr>
<td>PERWPOUS.sql</td>
<td>Example US Offer letter SQL mail merge file</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPOUK.sql</td>
<td>Example UK Offer letter SQL mail merge file</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPIUS.sql</td>
<td>Example US Interview letter SQL mail merge file</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPIUK.sql</td>
<td>Example UK Interview letter SQL mail merge file</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPOUS.doc</td>
<td>Example US Offer MS Word document</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPOUK.doc</td>
<td>Example UK Offer MS Word document</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPIUS.doc</td>
<td>Example US Interview MS Word document</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPIUK.doc</td>
<td>Example UK Interview MS Word document</td>
<td>HR</td>
</tr>
</tbody>
</table>

One of the template SQL*Plus scripts is provided as an example, see Template SQL*Plus Script PERWPOUK: page D – 2

Oracle Training Administration does not provide template scripts, but we provide an example of a Confirmation letter SQL mail merge file, see OTA SQL*Plus Script: page D – 8

To write a SQL*Plus script for Microsoft Word:

1. Write a SQL*Plus script to select data from the database in a format your word processor can read and is compatible with the standard letter.
2. Name the program PERWP*** (or OTAWP***).
3. Save the program. (Consult your installation guide for details).
Generating a Microsoft Word Letter

You can generate the Microsoft Word letter online using the Letter Generation window. This window uses Object Linking and Embedding (OLE) to display the Microsoft Word letter. When you start Microsoft Word from this window, your standard letter is automatically loaded and ready to be merged with the mail merge file.

To generate and merge a Microsoft Word document:

1. Select one of the following in the Letter region:
   - *Request* if you want to process a pending letter request that the system has created automatically for applicants, or that you have created manually in the Request Letter window. Select the name of the letter request.
   - *Custom* if you want to process a custom program that is not associated with a letter type.

2. Position the cursor in the Document field and choose the Browse button.

3. Select the Microsoft Word document that is your skeleton letter.

4. Position the cursor in the Merge field and choose the Browse button.
5. Select the extract program (such as a SQL script) that extracts data from the database to create the mail merge file.

You can run the scripts on the server side (consult your installation guide for details). Make them accessible to other users across the network, or copy them to each PC. You must also make the Microsoft Word documents accessible to other users across the network, or you must copy them to each PC.

6. Check View Generated Merge File if you want to examine the generated mail merge file before activating the Microsoft Word document then choose the Generate button to create the mail merge file.

If the View Generated Merge File check box is checked, the file displays in the Windows Notepad application.


The document displays in the Document Preview and Activation block.

8. Merge the data with the document.

If the Microsoft Word document already contains mail merge fields, the mail merge file you have generated is automatically loaded in Microsoft Word.

9. You must open the merge file as the Data Source and insert the merge fields in your document if the document does not yet contain mail merge fields.

10. Save the document using the filename of your mail merge file, with a .doc extension.

**Note:** If you do not save the merged letters when you exit the word processor you lose them.
Using Oracle Reports

You can create a report for each letter using Oracle Reports, or another tool of your choice. The report contains the skeleton letter text and Select statements specifying the data to be extracted from the Oracle database.

Figure 26–5 illustrates the sequence in which you set up standard letters using Oracle Reports.
Planning the Content and Layout

One of the first tasks you need to perform is to identify which data you want to extract from the database to include in your standard letters. You need to identify the select statements to use to provide you with the data as the \textit{content} of your letters. You also need to identify the text that you want to include as the \textit{body} of your letters.

The next decision you need to make is whether you want to associate your standard letters with student enrollment or applicant assignment statuses.

If you do want to link your standard letters to student enrollment or applicant assignment statuses, your next decision is to identify which student enrollment or applicant assignment statuses you want to trigger your standard letters. For example, do you want to link your standard enrollment confirmation letter to the status Placed so that the letter is triggered when you set a student’s enrollment status to Placed? Alternatively, do you want to link your standard rejection letter to the status Rejected so that it is triggered when an applicant’s assignment status is set to Rejected?

Writing the Report

Now that you have identified whether you want to associate the standard letters with student enrollment or applicant assignment statuses, you are ready to identify which data you want to extract from the database.

Write your skeleton letter text and Select statements specifying the data to be extracted from the Oracle database

Registering the Report

You now need to register your report with Oracle HRMS. You register your report so that you can run it as a concurrent program. Name the file PERWP*** (or OTAWP*** for OTA). You must use this prefix for the system to recognise it.

You use the Concurrent Programs window to register your report (using a system administrator responsibility).

See: Concurrent Programs Window, \textit{Oracle Applications System Administrator’s Guide}
Linking the Report With a Letter

You need to link your report with a letter and one or more statuses. In Oracle Human Resources, you can link one or more applicant assignment statuses with each recruitment letter. A request for the letter is then created automatically when an applicant is given an associated assignment status. In Oracle Training Administration, you can link one or more enrollment statuses with each enrollment letter. A request for the letter is then created automatically when an enrollment is given an associated status.

For example, you can link your standard recruitment rejection letter to the status Rejected so that the letter is triggered when you set an applicant’s assignment status to Rejected.

Define your standard letter types in the Letter window.

To define a standard letter type:

1. Enter a name for the letter in the Name field.
2. Select the Concurrent Program Name assigned by your System Administrator to the report.
3. Select one or more applicant assignment statuses to create letter requests automatically for applicants, and check the Enabled box.

When an applicant is given one of these statuses, a pending request for this letter type is created automatically. If a pending letter
Using Letters to Manage Recruitment and Enrollment

request already exists, the applicant is added to the list of people to receive the letter when you submit the request.

Running the Report

When you, or other users, set the status for an applicant or enrollment that triggers your standard letters. Oracle HRMS creates a letter request automatically, with the status of Pending. It also adds the applicant’s or student’s name to the request. You can view the pending request and names through the Request Letter window.

Then, when you change the letter request from Pending to Requested, Oracle HRMS runs the report that you created.

You can add further names to the list manually, if required. For example, you might have a last minute acknowledgement letter to send.

You can also create manual letter requests. If you do, enter the status of Pending yourself, then enter all the recipients of the letter before changing the status of the letter to Requested.

To submit an automatic letter request:

1. Query the letter you require in the Letter Name field.
2. Ensure that the method is Automatic.
3. Move to the Requested for block to query the applicants, events or students which have been entered on this request automatically, according to their status. You can add further names manually.
4. Update the status from Pending to Requested.

5. Save your changes.
   
   A concurrent request ID number appears in the Concurrent Request field. When the Concurrent Manager has processed the request it changes the status to Completed.

6. You can query the request ID in the Concurrent Requests window and monitor its progress.

   **Note:** Oracle HRMS saves the data file (consult your installation guide for details).

To create a manual letter request:

1. Select the Letter Name for the letter type you want to request.
2. Ensure that the method is Manual.
3. Leave the status of the request as Pending.
4. Save the changes.

**Adding the Names**

5. Select the names to add:
   
   • Select employees or applicants (for Oracle Human Resources) to receive the letter in the Requested For region.

   The Assignment field displays the organization to which the person is assigned. You can view the other components of the assignment by choosing List of Values from the Edit menu.

   • Select events or students or both (For Oracle Training Administration) in the Requested For region.

6. Save the changes.

**Changing the Status**

7. Update the status from Pending to Requested.

8. Save the changes.

   A concurrent request ID number appears in the Concurrent Request field. When the Concurrent Manager has processed the request it changes the status to Completed.

9. You can query the request ID in the Concurrent Requests window and monitor its progress.

   **Note:** Oracle HRMS saves the data file, consult your installation guide for details.
This chapter focuses on three aspects of setup that affect how you record and track people in your system:

- **Person Types** – choosing the types of people you need to identify and the sorts of information you want to hold about each type
- **Assignment Statuses** – choosing statuses to track temporary or permanent departures of employees from your enterprise
- **Special Information Types** – designing fields to hold any special information, not provided by the main system, you want to hold about people, jobs and positions, and training activities
Person Types

In any enterprise there is a need to identify different groups of people. For each group that exists in your enterprise there may be different types of information you need to keep. You may also want to control access to the records of different groups of people.

There are three basic types of people for whom you maintain information in your human resource system. These are:

- Employees, both current and ex-employees
- Applicants, both current and ex-applicants
- External people

A special category of the External type is contact. A contact is someone associated with an employee or an applicant.

For example, you may want to record the name, address and phone number of an emergency contact for every employee. Or, you may need to keep information on dependents of an employee for medical insurance purposes, or for calculation of additional payments.

Using Person Types

Oracle HRMS comes with a set of Person Types. You can change the names of these types when you install the system, and you can add your own subgroups of Person Types. For example, you might have two types of employee in your enterprise:

- Regular Employee
- Contractor

You can define these as subgroups of the Employee person type to:

- enable fast identification of these groups
- manage different kinds of personal information for each group
- change employees from Contractor to Regular Employee, without changing current work information

**Note:** Each employee’s assignment can be described by an employment category such as Full Time – Regular or Part Time – Temporary. So you do not use Person Types to distinguish the category of assignment.

In another example, you might want to distinguish between internal and external applicants for vacancies. You may also be involved in a redundancy program or a program of staff layoffs, and need to identify employees as preferred candidates for any vacancies. You can do this with the following subgroups of applicant:
Defining Person Types

There are eight Person Types recognized by the system, and identified by a system name. For each, there is a predefined user name. You can change the predefined name and you can enter other user names.

One user name must be the default. This is the name the system enters in certain circumstances if you do not select a Person Type manually. For example, when you hire an applicant, the system automatically updates the Person Type to the default user name for the system name ‘Employee’.

You enter user names for person types in the Person Types window.

First consider whether the existing user names are meaningful in your enterprise.

► To change a user name for a person type:
  - Delete the contents of the User Name field and type in your preferred name.

► To map other user names to a person-type system name:
  1. Select New Record from the Edit menu.
  2. Enter a unique User Name and select the System Name you want to map on to.
Deactivating User Names

You cannot delete user names in use in the system, but you can deactivate them by unchecking the Active check box. Notice that you cannot deactivate a default User Name. You must first select another user name as the default.

Person Types and Information Management

The system uses its Person Types to control the type of information you can enter. For example, you cannot enter earnings or deductions for an applicant. You can use Person Types in the following ways:

- To control access to people’s records on the system, according to their Person Type. For example, you might give all managers in a department access to employee records, but only give recruitment officers access to records of applicants and ex–employees.

  Your system administrator can achieve this by creating customized versions of the People window.

  See: Restricting the Data Displayed in a Window: page 30 – 3

- When you set up your own fields to hold additional information, you can tie them to particular Person Types. For example, you might want a user–defined field holding visa information for foreign workers to appear for employees and applicants, but not for other people.

  You can do this by setting up the descriptive flexfield on the People window.

  See: Adding New Fields to Windows: page 30 – 2

  **Suggestion:** If you want to define rules of eligibility for a compensation or benefits element based on the type of employee, you cannot use the Person Type directly. However, you can use Person Type in a *formula* to validate the values entered for an employee.

  Also, consider whether you can meet your needs using the assignment status and employment category to control eligibility for compensation and benefits.

  See: Components of the Assignment: page 14 – 5
Assignment Statuses

You use assignment statuses to track temporary or permanent departures of employees from your enterprise. Temporary departures include paid or unpaid leaves of absence that you may allow employees to take for a number of reasons.

Examples may include absences caused by industrial action or jury service.

Primary Statuses

There are four system statuses for employee assignments:

- Active Assignment, used to show that the employee is working in accordance with his or her usual conditions of employment
- Suspend Assignment, used to show that the employee is on leave of absence, but remains an employee of your enterprise
- Terminate Assignment, used to show that your enterprise no longer employs the person in that assignment. It can still be possible to make payments through Oracle Payroll for assignments at this status.
- End, meaning that all payroll processing for the assignment is complete and the assignment has become a historical record. This status is not recorded on the assignment; it causes the assignment to end.

On your system, you may give these statuses different user statuses appropriate to your enterprise. Each system status can have several user statuses related to it. For example, for the system status Suspend Assignment, you can have the user statuses Maternity Leave, Paternity Leave, and Military Leave.

These statuses are primary because they determine how the system processes and manages the assignment. An assignment must have one, and only one, primary status at a given time. You enter this status in the Assignment window.

See: Entering a New Assignment: page 14 – 8

Using Assignment Statuses to Control Compensation

When you define user statuses, consider how you will use them in reports, inquiries, and processing.

When you use a validation formula to validate entries to element input values, you can make the valid values for an entry dependent on the assignment status.
To use the statuses to control whether the payroll run processes an employee assignment, you choose a payroll status of Process or Do not Process for each user status. Additionally, in Oracle Payroll you can set up your pay calculation formulas so that a status change also changes the formula used to calculate the employee’s pay. For example, an employee might receive half pay while on Military Leave.


**Additional Information:** Refer to your Oracle Payroll manual for information on the use of assignment statuses in the Formula Result Rules window to control the payroll formula that processes for an employee.

---

**Secondary Assignment Statuses**

For analysis and reporting purposes, you can set up and use *secondary* assignment statuses, for both employee and applicant assignments. These statuses have no effect on assignment processing.

For example, suppose your primary status Maternity Leave applies to employees both when a child is born and when one is adopted, and you want to study its use in these two cases. To accomplish this you can set up the secondary statuses Maternity Birth and Maternity Adopt, and enter them for employees taking maternity leave.

You enter secondary statuses for an employee assignment or an applicant assignment in the Secondary Statuses window.

To enter reasons for giving secondary statuses to assignments, define valid reasons as values for the QuickCode Type EMP_SEC_ASSIGN_REASON (for employee assignments) and APL_SEC_ASSIGN_REASON (for applicant assignments).
Defining Assignment Statuses

You define both primary and secondary user statuses your enterprise uses for employee and applicant assignments in the Assignment Statuses window.

Defining Primary User Statuses

You can give your own user status names to the predefined system statuses. For example, for applicants you could use the user status “Rejected” for the system status “Terminate Application”. Oracle HRMS users see user statuses only.

You can also supply more than one user status for each system status. For example, for employees you can define several different user statuses for the system status Suspend Assignment, such as Maternity Leave, Paternity Leave, Disability Leave, Military Leave or Education Leave.

For applicants, you can track the stages of your selection process by means of user statuses. You can define user statuses such as Application Received, Application Acknowledged, First Interview, and Second Interview for the system status Active Application. These statuses can trigger production of standard letters.

See: Tracking Applicant Progress: page 15 – 15

▶ To rename a user status:
  ■ Delete the contents of the User Status field and type in your preferred name.

▶ To supply additional user statuses for a system status:
  1. Select New Record from the Edit menu.
2. Type in your user status, and select an HR System Status.

3. For an employee assignment status, also select a Payroll System Status. The payroll system status controls whether Oracle Payroll processes the assignment in a payroll run.

4. Save the new status.

   **Note:** For each HR System Status, you must have one default user status. The system automatically uses the default in certain situations. For example, when you create a new employee assignment, it automatically has the default user status corresponding to the system status ‘Active Assignment’. You can override this default.

You cannot delete a user status, but you can prevent its use by deactivating it. To deactivate a user status, uncheck the Active check box.

---

**Defining Secondary Statuses**

A user status associated with a system status is called a *primary* status because it determines how the system processes the assignment. You can also define *secondary* statuses not associated with a system status. You use secondary statuses for analysis and reporting, but not to control pay processing for assignments.

► **To create a secondary status:**

1. Select New Record from the Edit menu in the Assignment Statuses window.

2. Type in a user status and do not select a system status.

   The Type field displays *Secondary*. 
Setup To Allow Processing After Termination

To enable payroll processing for employees after they leave your enterprise, in your system setup you must do the following:

- Set the Termination Rule to *Final* on the element definition of all elements you want to process after the actual leaving date.

  If you use Oracle Payroll and have a Payroll responsibility, you can set the Termination Rule to *Last Standard Process* for elements whose entries should close down after the last normal payroll run. Set the Termination Rule to *Final* for elements you want to process as late payments after the last normal payroll run.

- Use the Assignment Statuses window to make sure your system has a user status that corresponds to:
  - the HR system status of *Terminate Assignment*
  - the Payroll system status of *Process*

Your startup data includes the user status Terminate Process Assignment, which matches this definition. Use this status (or your own equivalent status) when you terminate employment or end an assignment.
Defining Special Information Types

In Oracle HRMS, you use the Personal Analysis key flexfield to define any special information not provided by the main system that you want to hold about people, jobs and positions, and training activities.

You can define any number of instances of the Personal Analysis key flexfield. Each instance is called a Special Information Type. For example, you might set up types to hold performance reviews or medical details.

Each Special Information Type can have up to thirty fields (where each field is a segment of the flexfield). You can set up cross-validation to ensure that users enter correct combinations of segments. You can also speed up data entry and minimize errors by defining an ‘Alias’ for common combinations of segment values.

When you enable Special Information Types for your Business Group, you select how you plan to use each type.

In Oracle Human Resources, you can use Special Information Types for:

- job requirements
- position requirements
- personal information

In Oracle Training Administration, you can use Special Information Types for:

- skills provided by training activities

Each Special Information Type can be used for one or more of these purposes. The options you select control the windows in which each Special Information Type appears.

In Oracle Human Resources, you can also customize the windows that handle Special Information Types to restrict them to just one Type, such as medical records. This is useful if you want to restrict access to particular types of information for security reasons, or to aid users’ efficiency by giving them access to just the information they require for a particular task.

Special Information Setup Steps

- **To set up Special Information Types:**
  1. Define each Special Information Type as an instance of the Personal Analysis key flexfield.
2. Enable the Special Information Types you want to use in your Business Group and select how you want to use them.

3. Consider whether you want to create customized versions of the windows in which you can enter and display Special Information. These are the Special Information window and the List People by Special Information window.

   See: Restricting the Data Displayed in a Window: page 30 – 3

4. Design the task flows for entering personal information, which should include the Special Information window.


5. Design your navigation menus, including the List People by Special Information window (or your customized versions of it) and the personal information task flows.

   See: Setting Up Navigation Menus: page 30 – 18

6. Consider your special information reporting requirements. A standard Skills Matching report is supplied. This compares the special information, such as skills, held by employees and applicants with the requirements of a job or position.

   See: Viewing and Reporting Skills Matching Information: page 23 – 5

See Also

The Special Information Approach to Skills Matching: page 23 – 2
Enabling Special Information Types

Use the Special Information Types window to enable Special Information Types for the Business Group, and to select how you want to use them.

To enable Special Information Types:

1. Select the Special Information Types you want to use in your Business Group.
2. Enable each Type by checking the Enabled check box.
3. Check the other boxes to specify how you plan to use the Special Information Type. This makes it available in the list of values in other windows as follows:
   - **Job**: in the Job Requirements window
   - **Position**: in the Position Requirements window
   - **Other**: in the Special Information window
   - **Skill**: in the Skill Provisions and Search for Event windows in Oracle Training Administration

The OSHA and ADA check boxes are used in Oracle Human Resources in the US only.
The HRMS system administrator looks after the day to day administration of the system. This chapter summarises the tasks performed by the system administrator and explains how to:

- set user profiles to predefine aspects of your users’ work environment
- enable the currencies used in your Business Group
The Role of the System Administrator

The system administrator takes responsibility for the day to day administration of one or more Oracle Applications. Many jobs are more efficiently performed by one designated person. For example, the system administrator defines printers, and balances the system’s processing workload between online data entry and background processing, such as report generation.

A database management system can be conceptually divided into two parts: user applications and their underlying data structures. This division lends itself to two job categories: database administrator (DBA), and system administrator.

- An Oracle Applications System Administrator administers the user interface or applications side of the database management system.
- An Oracle Database Administrator or DBA administers the data the various applications enter, update, delete, and use for company business.

Ideally the system administrator should be someone from within the user group who knows how the system has been defined and can act as the first level of support for the application users. The system administrator role is clearly defined with a specific set of practical tasks to be carried out.

The HRMS System Administrator

For Oracle HRMS these practical tasks normally include:

- customizing the application, including setting up Key and Descriptive Flexfields. See:
  - User Definable Key Flexfields: page B – 2
  - User Definable Descriptive Flexfields: page B – 5
- imposing limits on what users can access through menus, security profiles, and responsibilities
  - See: Setting up Security in Oracle HRMS: page 33 – 10
- defining audit requirements
  - See: Setting Up AuditTrail: page 34 – 2
- setting up user profiles
  - See: Setting User Profile Options: page 28 – 4
• defining the formats for displaying currency amounts
  See: Enabling Currencies: page 28 – 7
• setting up and maintaining QuickCode types and values
  See: Defining QuickCode Types: page 31 – 5 and: Adding
  QuickCode Values: page 31 – 3
• installing printers and managing concurrent processing
  See: *Oracle Applications System Administrator’s Guide*
Setting User Profile Options

A user profile is a set of changeable options that affect the way your application runs. The system administrator can set user profiles at different levels:

Site level: These settings apply to all users at an installation site.

Application level: These settings apply to all users of any responsibility associated with the application.

Responsibility level: These settings apply to all users currently signed on under the responsibility.

User level: These settings apply to an individual user, identified by their application username.

Values set at a higher level cascade as defaults to the lower levels. Values set at a lower level override any default from a higher level.

Suggestion: Set site-level options first to ensure that all options have a default. If a profile option does not have a default value, it might cause errors when you use windows, run reports, or run concurrent requests.

You use the System Profile Values window to set profile options at each level for your user community. If you change a user profile option value, your change takes effect as soon as your users log on again or change responsibilities.
Application users can the Personal Profile Values window to set their own profile options at the user level. Not all profile options are visible to users, and some profile options, while visible, cannot be updated by end users. Any changes a user makes to his or her personal profile options take effect immediately.

### List of User Profile Options

There are a number of User Profile Options that are of specific importance to HRMS system administrators. These are listed in Table 28 – 1 and Table 28 – 2. The only one of these options that a user can change is DateTrack:Reminder.

<table>
<thead>
<tr>
<th>HR Option</th>
<th>Purpose</th>
</tr>
</thead>
</table>
| HR:Business Group          | Business Group that is linked to the security profile for a responsibility. This option is used online to control access to records that are not related to organization, position, or payroll.  
                              | This option is seeded at Site level with the start-up Business Group. It is view only. Values are derived from the HR:Security Profile user profile option.                                                                 |
| HR:Security Profile        | Restricts access to the organizations, positions, and payrolls defined in the security profile. This option is seeded at Site level with the view–all security profile created for the Startup Business Group. |
| HR:User Type               | Limits field access on windows shared between Oracle Human Resources and Oracle Payroll. If you do not use Oracle Payroll, it must be set to HR User for all responsibilities.  
                              | If you do use Oracle Payroll, you can give each Responsibility one of the following user types, depending on the work role of the holders of the responsibility:  
                              | HR User, HR with Payroll User, Payroll User                                                                                              |
| HR:Query Only Mode         | Restricts access to view–only for all HR and Payroll forms on a menu.                                                                                                                                  |
| HR:Use Standard Attachments| Disables the facility to attach short text comments to records. Enables the attachment of multiple items of various types including OLE objects, Web pages, images, and word processed documents.                   |

Table 28 – 1 HR User Profile Options
DateTrack Option | Purpose
--- | ---
DateTrack:Date Security | Controls the way users can change their effective date:
- **All** (users can change to any date),
- **Past** (users can change to dates in the past only),
- **Present** (users cannot change their effective date),
- **Future** (users can change to dates in the future only)

DateTrack:Reminder | Determines whether the Decision window appears when a datetracked window opens:
- **Always** (the window always appears),
- **Never** (the window never appears),
- **Not Today** (the window appears only if the effective date is not the system date)

Table 28 – 2 DateTrack User Profile Options

See Also

*Oracle Applications System Administrator’s Guide*
Enabling Currencies

Oracle HRMS allows you to use multiple currencies for entering information about employee compensation and benefits. You can also record your payment methods to employees in different currencies.

For example, if you have employees living and working temporarily in other countries, you might want to record specific earnings or deductions for these employees in local currencies. You might also want to pay these employees a fixed amount into a bank account in their home currency. The remainder you would pay in a local currency.

Your startup data includes the definitions of all world currencies. These definitions are shared by all Oracle Applications and are controlled by the system administrator responsibility. You enable those currencies you want to use in the Currencies window.

**Note:** You must enable at least one currency as the default currency for all information related to money in your system. This default is known as the *Base Currency for your Business Group.*

- **To enable a currency:**
  - Query the currency you want to enable and check the Enabled check box. Save your choice to enable the currency.
  
  You can never delete a currency, but you can disable it.

- **To disable a currency:**
  - Uncheck Enabled, or enter an End Date for the currency.
This chapter introduces the inquiry and reporting tools you can use with Oracle HRMS. It summarizes the reports and inquiry windows that are supplied with Oracle Human Resources and Oracle Payroll. It also explains how you can create and run your own QuickPaint reports for fast online reporting on people and assignments.
Overview of Inquiry and Reporting Tools

Oracle HRMS provides a range of inquiry and reporting mechanisms to meet the needs of different users:

- inquiry windows (including folders)
- predefined reports that can be scheduled and grouped for periodic processing
- DateTrack History, to view the changes to datetracked information over time
- QuickPaint, to create your own online inquiries and reports about people and assignments

In addition, you can use Oracle Reports or other tools to write your own reports. You can register these with the system so that they can be run in the same way as the predefined reports.

You can extract mail merge information from the human resource database to send to your word processing system. For example, you might want to produce standard letters for applicants as part of your recruitment process.

It is also possible to download information from the human resource database to other tools for reporting or editing. For example, you can use Oracle Application Data Export (ADE) to download information to a spreadsheet.

See Also

Viewing DateTracked Information and History: page 1 – 13
Using Oracle HRMS with Spreadsheets: page 32 – 5
Using a Word Processor: page 26 – 6
Oracle HRMS includes some inquiry windows to meet the most common online reporting requirements. In these windows, you typically enter selection criteria in the first block then choose the Find button to view a list of people, assignments, or other entities that match your criteria. Some of these windows use folders to display the information retrieved by your criteria.

Folders are online views that you can customize. By default, the folder block in an inquiry window displays all records matching your inquiry and all fields available within the folder. However, you can create your own folders to display a subset of these records and fields. You can also choose the field labels, their size and order, and the sort sequence of the retrieved records.

For example, in the Assignment Folder window, you could create a folder called Sales Employees by Grade. This folder has the query criteria Organization = 'Sales', and it is sorted by grade.

You can define public folders, which all users can view, as well as private folders for your own use.

<table>
<thead>
<tr>
<th>Inquiry Window</th>
<th>Information Provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignments Folder</td>
<td>Lists of assignments in a folder</td>
</tr>
<tr>
<td>Employee Assignment Processes (Oracle Payroll)</td>
<td>All the assignment processes for one employee assignment, which you can view, retry or roll back, with further information on run messages, run results, balances, payment details and costing</td>
</tr>
<tr>
<td>Payroll Processes (Oracle Payroll)</td>
<td>All the payroll processes for one payroll for a specified period, which you can view, retry or roll back, with further details on assignment processes, run messages and costing</td>
</tr>
<tr>
<td>People Folder</td>
<td>Lists of people in a folder</td>
</tr>
<tr>
<td>Salary Management Folder</td>
<td>List of assignments with their current approved salary and proposed new salary</td>
</tr>
<tr>
<td>Position Occupancy Folder</td>
<td>Lists of people who have held a selected position, or are applying for it, and the dates of their occupancy</td>
</tr>
<tr>
<td>List Assignments</td>
<td>Assignments that match the assignment components you specify for current applicants, employees, or both</td>
</tr>
<tr>
<td>List People by Assignment</td>
<td>People whose assignments match the assignment components you specify for current or former applicants, employees, or both</td>
</tr>
</tbody>
</table>

Table 29 – 1 Inquiry Windows in Oracle HRMS
<table>
<thead>
<tr>
<th>Inquiry Window</th>
<th>Information Provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>List Employees by Organization</td>
<td>All employees assigned to one organization and, optionally, to all organizations below it in a specified hierarchy</td>
</tr>
<tr>
<td>Assignment History</td>
<td>The dates of assignments and periods of service for an employee who has had more than one assignment. NOTE: use DateTrack History on the Assignment window to see historical changes to one assignment.</td>
</tr>
<tr>
<td>List Employees by Position</td>
<td>All employees assigned to a specified position or organization and job</td>
</tr>
<tr>
<td>List Employees by Position Hierarchy</td>
<td>Current holders of positions at and below a specified position in a position hierarchy</td>
</tr>
<tr>
<td>View Employee Grade Comparatio</td>
<td>The amount employees receive for a specified element as a percentage of the mid-value of their grade rate range</td>
</tr>
<tr>
<td>List Employees by Absence Type</td>
<td>All absences of a particular absence type or category within, optionally, a specified time period</td>
</tr>
<tr>
<td>View Employee Absence History</td>
<td>Periods of absence for a specified employee</td>
</tr>
<tr>
<td>List People by Special Information</td>
<td>All people for whom you have entered details about a specified special information type</td>
</tr>
<tr>
<td>List Employees by Element</td>
<td>All employee assignments receiving a specified compensation element within a given time period</td>
</tr>
<tr>
<td>View Element Entry History for Employee</td>
<td>The history of entries of one or more elements for an employee assignment</td>
</tr>
<tr>
<td>List Position Budget Variance</td>
<td>Variances between the number of actual position holders and the values entered in a specified budget for positions below a chosen position in a hierarchy</td>
</tr>
<tr>
<td>List Budget Variance by Organization</td>
<td>Variances between the number of actual position holders and the values entered in a specified budget for all positions in organizations at and below a chosen organization in a hierarchy</td>
</tr>
<tr>
<td>View Vacancies</td>
<td>Vacancies matching assignment components and other criteria you select</td>
</tr>
</tbody>
</table>

Table 29 – 1 Inquiry Windows in Oracle HRMS
Predefined and User Defined Reports

There are a number of predefined reports that you can use immediately without any further set up (see Table 29 – 2). They have a predefined format but you can choose which records to view by entering a set of parameters when you submit the report.

These reports run in batch mode: you submit them for processing in the Submit Requests window and can view their progress using the View Requests window. The requests are handled by a concurrent manager so you can continue working online while your request is processed.

You can schedule the reports to run regularly and you can group them with other reports and processes to run as a set. You can also control access to the reports and control their printing. For example, the system administrator might want to ensure that users in one location always print their reports on a local printer.

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Information Provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absences</td>
<td>Absence details for an employee or organization, for some or all absence types</td>
</tr>
<tr>
<td>Assignment Status</td>
<td>All employees, applicants, or both assigned to selected work structures</td>
</tr>
<tr>
<td>Assignments Unavailable for Processing (Oracle Payroll)</td>
<td>Assignments that will not be processed by particular payroll runs, and reasons for their exclusion</td>
</tr>
<tr>
<td>Costing Breakdown Report for Costing Run (Oracle Payroll)</td>
<td>Summarized totals of payroll calculations for a specified costing process</td>
</tr>
<tr>
<td>Costing Breakdown Report for Date Range (Oracle Payroll)</td>
<td>Summarized totals of payroll calculations for a consolidation set or payroll over a specified period</td>
</tr>
<tr>
<td>Current and Projected Progression Point Values</td>
<td>The expected results of running the Increment Progression Points process, that is, the projected point and value changes for a group of employees</td>
</tr>
<tr>
<td>Element Link Details</td>
<td>The eligibility criteria for an element or a group of elements</td>
</tr>
<tr>
<td>Element Result Listing (Oracle Payroll)</td>
<td>Run results processed for a particular element over a defined period, and run results for selected input values of each employee’s last assignment process</td>
</tr>
<tr>
<td>Employee Increment Results</td>
<td>The actual results of running the Increment Progression Points process, that is, progression point and value changes for a group of employees</td>
</tr>
</tbody>
</table>

Table 29 – 2 Standard Reports in Oracle HRMS
<table>
<thead>
<tr>
<th>Report Name</th>
<th>Information Provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Organization Movements</td>
<td>New hires, terminations, transfers in and transfer out of a selected organization, or organization hierarchy</td>
</tr>
<tr>
<td>Employee Payroll Movements</td>
<td>New hires, terminations, transfers in and transfer out of a selected payroll</td>
</tr>
<tr>
<td>Employee Summary</td>
<td>Addresses, contacts, period of service, assignments, special information, personal payment methods, and element entries for a selected employee</td>
</tr>
<tr>
<td>Full Applicant Details</td>
<td>Applications and applicant interviews for one applicant</td>
</tr>
<tr>
<td>Full Assignment Details</td>
<td>Assignment information including periods of service, payment methods, and element entries for one employee</td>
</tr>
<tr>
<td>Full Personal Details Report Set</td>
<td>Person details, applicant details, assignment details, and work details for one employee</td>
</tr>
<tr>
<td>Full Person Details</td>
<td>Addresses and information entered in the Person window, such as name, date of birth, nationality, and work telephone number for one employee</td>
</tr>
<tr>
<td>Full Work Details</td>
<td>Miscellaneous work information, including special information, absences, recruitment activities, and contacts for one employee</td>
</tr>
<tr>
<td>Gross to Net (Oracle Payroll)</td>
<td>Details of total earnings and deductions summarized for a specified payroll and payroll period</td>
</tr>
<tr>
<td>Job and Position Skills Matching</td>
<td>Lists of employees, applicants, or both that meet some or all skill requirements of a job or position</td>
</tr>
<tr>
<td>NI Car Detail (Oracle Payroll)</td>
<td>All the NI Y amounts due from employees on a given payroll who have a company car benefit</td>
</tr>
<tr>
<td>Organization Hierarchy</td>
<td>The organizations (and optionally their managers) below a selected organization in a particular hierarchy</td>
</tr>
<tr>
<td>P45 (Oracle Payroll)</td>
<td>P45 details for terminated employees, for issue to the tax office and the leaver; P45 details for current employees for issue to different tax offices</td>
</tr>
<tr>
<td>P45 Alignment (Oracle Payroll)</td>
<td>Draft printer alignment for your P45 reports</td>
</tr>
<tr>
<td>Pay Advice (Oracle Payroll)</td>
<td>Pay advice details in a customizable format, either for single assignments or for all assignments on a payroll, after Pre-payments is complete for the payroll</td>
</tr>
<tr>
<td>Pay Advice Alignment (Oracle Payroll)</td>
<td>Draft printer alignment for your sample pay advice</td>
</tr>
</tbody>
</table>

Table 29 – 2 Standard Reports in Oracle HRMS
### Report Name and Information Provided

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Information Provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payments Summary (Oracle Payroll)</td>
<td>Payments totalled by payment method type and organizational payment method, with payment bank account details</td>
</tr>
<tr>
<td>Payroll Statutory Calendar (Oracle Payroll)</td>
<td>The sequence of regular payment dates for each payroll, and the numbers of assignments completed, pre-paid and paid within a run</td>
</tr>
<tr>
<td>Position Hierarchy</td>
<td>The positions (and optionally their holders) below a selected position in a particular hierarchy</td>
</tr>
<tr>
<td>Requisition Summary</td>
<td>Applicants and their interview schedules for a selection of vacancies</td>
</tr>
<tr>
<td>Salary Review</td>
<td>Current, past, and proposed salaries for a selected list of employees</td>
</tr>
<tr>
<td>Staffing Budget Details</td>
<td>Actual staffing level with budgeted levels over a specified period</td>
</tr>
<tr>
<td>Start of Year: Unmatched P9 Records (Oracle Payroll)</td>
<td>Valid records on the Inland Revenue P9 tape that do not fully match your database records after running the Start of Year process</td>
</tr>
<tr>
<td>Tax Payments Listing (Oracle Payroll)</td>
<td>Details of employees' PAYE and National Insurance deductions</td>
</tr>
<tr>
<td>Terminations</td>
<td>The number of employees from selected organizations leaving your enterprise within a particular period, and the reasons for leaving</td>
</tr>
</tbody>
</table>

#### Table 29 – 2 Standard Reports in Oracle HRMS

You can create your own reports using Oracle Reports or SQL*Plus or another tool of your choice. You can register them with Application Object Library. This means you can run them from the standard Submit Requests window, and you can schedule them in report sets with other reports and processes.

**See Also**

- Assignment Status Report: page 14 – 29
- Employee Summary Report: page 14 – 30
- Employee Movements Report: page 14 – 30
- Terminations Report: page 14 – 16
- Employee Increment Results Report: page 4 – 19
- Current and Projected Progression Point Values Report: page 4 – 19
Organization Hierarchy Report: page 2 – 29
Position Hierarchy Report: page 3 – 25
Salary Review Report: page 10 – 17
Reviewing Element Links: page 8 – 13

Submitting a Request
(Oracle Applications User’s Guide)

Oracle Application Object Library Reference Manual
QuickPaint

QuickPaint is a powerful and flexible tool to design reports about assignments in the format you require. You can include the following sorts of information in a QuickPaint report:

- Personal information
- Contact information
- Assignment information
- Application information
- Compensation and benefit information
- Descriptive Flexfield information

Once you have designed a QuickPaint report, you and other users can run the report online for any assignment or set of assignments. You can view the results online or print them.
Defining QuickPaint Reports

You can design QuickPaint reports in the Define QuickPaint Report window.

In the Report Definition area, you can enter *free text* to introduce the report and to label the information that the report extracts from the database. You can also select *database items*, which are tags representing the information to be extracted from the database. When you run the report, the database item names are replaced by the appropriate data for the assignment or set of assignments for which the report is run.

You must be careful how you position the database items so that QuickPaint interprets them correctly and formats the report in the layout you require.

To define a QuickPaint Report:

1. Enter a name, and optionally a description, of the report.

   The Protected field is display only; some reports provided by localization teams are protected against edits.

2. In the Report Definition area, enter free text exactly as you want it to appear on the report.
3. To select database items, choose the Show Items button and run a query to display a list of database items, then select and copy items to the Report Definition area.

Notice that the database item name must begin with an ampersand (&). Names without an ampersand are treated as free text.

4. Save the report definition.

Positioning Items

If you want to add free text immediately after a database item, you must separate it from the database item with at least one space. Otherwise QuickPaint reads the database item as free text.

Both free text and database items appear in the report results on the line on which you painted them in the Report Definition area. They also generally appear in the column in which you painted them. However, it might be that the data replacing a database item name is long enough to push later items on the same line to the right.

For example, if you paint database items and free text like this:

```
&ASG_JOB       in &ASG_ORG
```

the report results print like this:

```
Technician     in Biochemistry
Scientific Officer in Biochemistry
```

Notice that, in the second result, the free text ‘in’ is pushed to the right and one space is entered before it.

If you know the number of the column in which you want text or a database item to appear, you can enter it like this:

```
&ASG_JOB       &32in &ASG_ORG
```

However, the text ‘in’ will still be pushed to the right if the preceding database item (&ASG_JOB) extends beyond column 32. If you would prefer the preceding database item to be truncated, paint the line as follows:

```
&ASG_JOB       &&32in &ASG_ORG
```

The report results will look like this:

```
Technician     in Biochemistry
Scientific Off in Biochemistry
```
If you want one space between two database items or between a
database item and text, then paint them separated by a single space.
The single space is always preserved. For example, this definition:

\&EMP\_FIRST\_NAME \&EMP\_LAST\_NAME

gives the following report results:

Alice Hollister
Ray Garcia

**Adding Conditions or Calculations to QuickPaint Reports**

When you save a report definition, QuickPaint generates a formula to
extract the information required by the report. You can view this
formula in the Formulas window. To query the formula, enter the
name of your QuickPaint report preceded by the prefix QP_.

Formulas generated from QuickPaint definitions do not contain
conditional logic or mathematical computations. If you need these
features, query the formula in the Formulas window and copy it. Edit
the copy to add the logic you require.

**Attention:** You should not edit the original QuickPaint
formula. Always edit a copy. Any edits of the original formula
are overwritten if you change the report definition in the
QuickPaint Report window.

**See Also**

Static Database Items: page C – 2
Dynamic Database Items: page C – 19
Using Oracle FastFormula to Define QuickPaint Reports: *(Oracle
FastFormula User’s Guide)*
You run QuickPaint reports from the Run QuickPaint Report window. You can run a report for one assignment or for a group of assignments.

Prerequisites

- To run a QuickPaint report for a group of assignments, you must first define an assignment set.

To run a report for one assignment:

1. Select the type Assignment.
2. In the Assignment region, select the assignment for which you want to run the report.
3. In the Report field, select the report you want to run.
4. Choose the Run Report button.
   The message line tells you when the report is complete.
5. Choose the View Report button to see the report results.

When you run a QuickPaint report, the system runs the formula associated with the report. The first time you run a report, the
system may take several seconds to identify all of the related data and bring it back to the screen. All subsequent inquiries for other employees or applicants will run very quickly.

To run a report for an assignment set:

1. Select the type Assignment Set.
2. In the Assignment Set region, select the assignment set for which you want to run the report.
3. In the Report field, select the report you want to run.
4. Choose the Run Report button.
   The message line tells you when the report is complete.
5. Choose the View Report button to see the report results.

Customizing the Run QuickPaint Reports Window

Using the standard QuickPaint Report window, you can run the report for an assignment or an assignment set. The assignments can be held by current employees or applicants.

Your system administrator can create customized versions of this window to restrict the reports you can run and the people you can report on. A customized version might be subject to one or more of the following restrictions:

- report on one person type only (employees OR applicants)
- run one report only
- report on single assignments only, or report on assignment sets only

If the window is subject to the third type of restriction, it will look different to the standard version since it will contain either the assignment region or the assignment set region, but not both.

See Also

Restricting the Data Displayed in a Window: page 30 – 3
Creating an Assignment Set

There are two uses of assignment sets in Oracle HRMS:

- You can run a QuickPaint report for a set of assignments, rather than individual assignments.

- In Oracle Payroll, you can process subsets of the employees assigned to a payroll. Normally you initiate payroll runs and other post-run processes for one or more payrolls at a time. However, if you need to process smaller groups within a single payroll, you define an assignment set.

There are three ways to define the set:

- You can enter selection criteria, which the system generates into a formula. When you use the assignment set, Oracle FastFormula runs the formula to find the assignments that match the criteria. It checks all the assignments in the Business Group or, if you select a payroll when you define the set, all the assignments to that payroll. When you define the set you can also include or exclude individual assignments to modify the set created by the formula.

- You can select individually all the assignments you want to include in the set.

- You can start from a full set of all the employees in the Business Group or all the employees assigned to a selected payroll. Then you can exclude individual assignments from the set.

Use the Assignment Set window to define your set.

To define an assignment set using criteria for a formula:

1. Enter a unique name for the set.
2. Do one of the following:
   - If you are defining an assignment set for payroll processing, you must select a payroll. You cannot process an assignment set drawn from more than one payroll.
• If you are defining an assignment set for other purposes, selecting a payroll is optional. If you select a payroll, the formula generated from your selection criteria will select assignments from this payroll only. If you do not select a payroll, the formula will select assignments from the whole Business Group.

3. Save the new set and choose the Criteria button.

4. In the Assignment Criteria window, enter one criterion in each row, and join the criteria with AND or OR in the Condition field. Field details are as follows:

   **No.**: The sequence number of each condition in your rule. If you use sequence numbers that are multiples of 10, it will be easier to insert new conditions later.

   **Condition**: Leave the first row blank. Enter AND or OR for second and subsequent rows.

   **Database Item**: Select database items as variables for your definition. All database items are prefixed by an ampersand (&).

   **Operator**: Select operators to determine relationships between database items or values. The list of operators is shown in Table 29 – 4.

   **Value/Database Item**: Select database items for the second variable. Alternatively, you can enter a fixed value of the same type as the database item. Enter text values in single quotes.

As an example, here is a definition for an assignment set of employees with salaries between 16,000 and 24,000:

<table>
<thead>
<tr>
<th>No.</th>
<th>Condition</th>
<th>Database Item</th>
<th>Operator</th>
<th>Value/Database Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td></td>
<td>&amp;SALARY_PAY_VALUE_ENTRY_VALUE</td>
<td></td>
<td>16000</td>
</tr>
<tr>
<td>20</td>
<td>AND</td>
<td>&amp;SALARY_PAY_VALUE_ENTRY_VALUE</td>
<td>&lt;=</td>
<td>24000</td>
</tr>
</tbody>
</table>

Table 29 – 3 Assignment Set Criteria

5. Save your criteria and choose the Generate button to generate the formula.

   You can view and edit the formula in the Formula window. Its name is the same as the assignment set name. See: Using Oracle FastFormula to Define Assignment Sets: *(Oracle FastFormula User’s Guide)*

6. If you want to include or exclude individual assignments from the set defined by your criteria, choose the Amendment button. Select the assignments you want to include or exclude from the set.
Note: The list of assignments you see in this window is either all the assignments in the Business Group or, if you selected a payroll, all the assignments to that payroll. It does not show the assignments matching your criteria since these are identified dynamically each time the formula runs.

7. Save the set.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Symbols</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equals</td>
<td>=</td>
<td>The condition is true if both expressions have exactly the same value. For text, the case of the expression must be the same. So, for example, ‘Smith’ is not equal to ‘SMITH’.</td>
</tr>
<tr>
<td>Not Equal</td>
<td>!=</td>
<td>The condition is true if the result of the first expression does NOT have the same value as the result of the second expression.</td>
</tr>
<tr>
<td>Greater than</td>
<td>&gt;</td>
<td>The condition is true if the first expression is alphabetically after, or has a numerically greater value, or a later date than the second expression.</td>
</tr>
<tr>
<td>Less than</td>
<td>&lt;</td>
<td>The condition is true if the first expression is alphabetically before, or has a numerically smaller value, or an earlier date than the second expression.</td>
</tr>
<tr>
<td>Greater than or equal to</td>
<td>&gt;=</td>
<td>The condition is true if either the greater than OR the equal to operator returns a true result.</td>
</tr>
<tr>
<td>Less than or equal to</td>
<td>&lt;=</td>
<td>The condition is true if either the less than OR the equal to operator returns a true result.</td>
</tr>
</tbody>
</table>

Table 29 – 4 Values in Operator Field

To define a set by including or excluding assignments:

1. Enter a unique name for the set.
2. If you are defining a set for payroll processing, select a Payroll.
3. Save the new set.
4. Choose the Amendment button.
5. Do one of the following:
   - If you want to create a small set of assignments, select Include in the Inc/Exc field and select all the assignments for the set.
   - If you want to start from the full set of assignments for the payroll or Business Group, select Exclude in the Inc/Exc field and select assignments to remove from the set.
Attention: Do not create a mixture of Include and Exclude rows if you have not entered criteria and generated a formula.

6. Save your set.
Custom Reports

The Custom Reports function provides a generic reporting capability that makes use of a single report to print out a custom definition. This report is called PERGENRP.

The report is registered as a concurrent process and prints, in landscape format, the contents of the temporary table PER_GENERIC_OUTPUT_REPORT.

This table contains the individual components of a custom report and is populated by the PL/SQL package PERGENRP.pkb, stored in $PER_TOP/admin/sql. This package is executed when you select the Generate Report button on the Custom Reports window.

To submit a Custom Report:

1. Navigate to the Custom Reports window.
2. Select the report by name.
3. Enter any parameters for this report.
4. Choose the Generate Report button.
   
   **Attention:** Parameter values are not validated until you choose the Generate Report button.

Creating New Report Formats

A special feature of Custom Reports is that you do not need to create multiple reports. You modify the generic package (PERGENRP.pkb) and report to provide additional formats and parameters.
Three sample report formats are provided, each with a different set of parameters:

- **PERCS001 – Custom Report 1**
  
  There is one parameter: Vacancy. The format in PERGENRP is *Full Name of Applicant* and *Gender*.

- **PERCS002 – Custom Report 2**
  
  Parameters are Vacancy and Gender. The format in PERGENRP is *Full Name of Applicant* in uppercase.

- **PERCS003 – Custom Report 3**
  
  Parameters are Vacancy, Gender and Marital Status. The format in PERGENRP is *Full Name of Applicant*, *Gender* and then *Full Name* in uppercase.

You can edit the generic package to change:

- Report Title Page
- Header
- Footer
- Body Text

After you have modified the package, you need to register a new custom report, with the parameter set for that report. This is a task for the System Administrator.

**To register a new Custom Report with parameters:**

1. Navigate to the Concurrent Programs window.
2. Enter the name of the Custom Report as the Program.
3. Enter a short name for the Custom Report.

**Attention:** You must start the short name with PERCS. This will limit the list of values available to users in the Custom Report window.
As part of your implementation plan, you identify who will use Oracle HRMS, what information they require, and how they will use it. You can group together users with similar requirements and give them the same view of the system. For each group, you can:

- set up menus using structures and names that make sense to the users
- link windows into flows that the users follow to complete a task
- restrict the data they can view and edit in certain windows, so they only see what they need to see

These customizations provide security for your data and an efficient interface designed for your users’ needs.

In addition to these customizations for groups of users, you can customize windows for all users by adding data fields to hold additional information required by your enterprise.
Adding New Fields to Windows

The predefined fields in Oracle HRMS windows are designed to meet your core information requirements. However, like all enterprises, you may have special requirements that are best met by fields that you design yourself. Oracle HRMS provides a flexible mechanism called descriptive flexfields to enable you to add fields to windows.

Figure 30 – 1 illustrates the distinctive appearance of descriptive flexfields. When users click in a flexfield that you have set up, a window opens, displaying up to 20 segments that you have defined.

Defining Segments

For each segment, you can define its prompt, the type of data it can contain, and the values a user can enter. You can provide a list or range of valid values. You also control the size and display characteristics of each segment and the order in which the segments appear.

You can define two types of descriptive flexfield segments:

- Global segments, which always appear in the flexfield window
- Context sensitive segments, which appear only when a defined context exists. You can prompt the user to provide the context, or you can provide the context automatically from a reference field in the same zone.

For example, a segment to hold details of an employee’s disability might display only when the Disabled field contains the value Yes.

Attention: Some descriptive flexfields appear in more than one window. For example, the Additional Evaluation Details flexfield appears in the Job Evaluation window and the Position Evaluation window.

Check all of the windows that use a descriptive flexfield before you define any of the segments. This is especially important if you intend to make the flexfield context sensitive to another field. You must ensure that the reference field is present in all of the windows that use the flexfield.

See Also

List of Descriptive Flexfields: page B – 6

Oracle Applications Flexfields Guide
Restricting the Data Displayed in a Window

Many of the standard Oracle HRMS forms are multipurpose. For example, in the Person form, you can enter or view details of employees, applicants, contacts, or other person types that you have defined. In the Element Entries form, you can make entries for all the elements you have defined.

You may prefer to have multiple versions of these forms, each version being used for just one purpose. This approach restricts the list of values on certain fields and therefore provides for faster data entry. It also allows you to limit access to certain types of information.

For example, you might create a customized version of the View Element Entry History for Employee form that does not display the earnings elements representing salary, bonus, and commission. Most users’ menus would only give them access to this customized version of the form. For the small group of people authorized to view salary, bonus, and commission figures, your system administrator can define a menu function to allow access to the uncustomized form.

Table 30 – 1 lists the forms you can customize and the criteria you can use to restrict access to information.

<table>
<thead>
<tr>
<th>Form</th>
<th>Restrict By</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust Balance</td>
<td>Element Set</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Element Processing Type</td>
<td>Recurring, Nonrecurring</td>
</tr>
<tr>
<td>Assignment Folder</td>
<td>Person Type</td>
<td>User defined</td>
</tr>
<tr>
<td>Define User Values</td>
<td>Table Name</td>
<td>User defined</td>
</tr>
<tr>
<td>Element Entries</td>
<td>Element Set</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Element Processing Type</td>
<td>Recurring, Nonrecurring</td>
</tr>
<tr>
<td></td>
<td>Entry Type</td>
<td>Override</td>
</tr>
<tr>
<td>Event Bookings</td>
<td>Employee or Applicant</td>
<td>Employee, Applicant</td>
</tr>
<tr>
<td>List Employees by Element</td>
<td>Element Set</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Element Processing Type</td>
<td>Recurring, Nonrecurring</td>
</tr>
</tbody>
</table>

Table 30 – 1 List of Customizable Forms
<table>
<thead>
<tr>
<th>Form</th>
<th>Restrict By</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>List People by Special Information</td>
<td>Employee or Applicant</td>
<td>Employee, Applicant</td>
</tr>
<tr>
<td></td>
<td>Special Information Type</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Person Type</td>
<td>User defined</td>
</tr>
<tr>
<td>Organization</td>
<td>Organization Classification</td>
<td>List of Organization Classifications</td>
</tr>
<tr>
<td>Payroll and Assignment Processes</td>
<td>Action Type</td>
<td>List of Action Types (e.g. Run, Pre–payments, Reversal)</td>
</tr>
<tr>
<td>(Oracle Payroll form)</td>
<td>Person Type</td>
<td>User defined</td>
</tr>
<tr>
<td>People Folder</td>
<td>Person Type</td>
<td>User defined</td>
</tr>
<tr>
<td>People (PERWSEPI), People and Assignment (PERWSHRG)</td>
<td>Person Function</td>
<td>Enter Employee, Enter Applicant, Hire people already on system</td>
</tr>
<tr>
<td></td>
<td>Person Type</td>
<td>User defined</td>
</tr>
<tr>
<td>Position Occupancy Folder</td>
<td>Employee or Applicant</td>
<td>Employee, Applicant</td>
</tr>
<tr>
<td>Run QuickPaint Report</td>
<td>QuickPaint Inquiry</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Person Type</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Assignments</td>
<td>Assignment Sets, Assignments</td>
</tr>
<tr>
<td>Special Information</td>
<td>Special Information Type</td>
<td>User defined</td>
</tr>
<tr>
<td>View Element Entry History for Employee</td>
<td>Element Set</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Element Processing Type</td>
<td>Recurring, Nonrecurring</td>
</tr>
</tbody>
</table>

Table 30 – 1 List of Customizable Forms
Types of Data Restrictions

You can restrict the information that appears in a customized form by the following sorts of criteria:

- element type (recurring or nonrecurring)
- element set (user defined)
- person function (enter employee, enter applicant, hire someone on system)
- person type (user defined)
- special information type (user defined)
- organization classification
- employee or applicant
- QuickPaint Report (user defined)

If you want to restrict the data by a user defined information type, you must create it first:

- To restrict by element set, create the set in the Element and Distribution Set window.
- To restrict by QuickPaint Report, create the report in the Define QuickPaint Report window.
  See: Defining QuickPaint Reports: page 29 – 10
- To restrict by Special Information Type, define your information type as an instance of the Personal Analysis key flexfield.
  See: Defining Special Information Types: page 27 – 10
- To restrict by person types, define your user person types in the Person Types window.
  See: Defining Person Types: page 27 – 3
Defining an Element or Distribution Set

In the Element and Distribution Set window, you can select element classifications or individual elements to define a set. There are three types of set:

- Customization set: You can use a Customization set to restrict the elements that can be entered or viewed on a customized version of the Element Entries window.
- Run set: Oracle Payroll users can use a Run set to specify the elements to be processed in a payroll run.
- Distribution set: Oracle Payroll users can use a Distribution set to define the elements over which the costs of other elements are to be distributed.

To define an element or distribution set:

1. Enter a unique name for the set and select the Type: Distribution, Run, or Customization. Save your new set.
2. If you want to include all elements in a classification, choose the Classification Rules button.
   - In the Classification Rules window, select one or more classifications to include. Save the set and close this window. The elements in the classifications you choose are now listed in the Elements region.
   - If you want to exclude individual elements, place your cursor in the element’s row and choose the Exclude Element button.
3. If you want to include particular elements from other classifications, choose the Include Element button.
   - In the Elements window, select the element you want to include and choose the OK button.

   **Note:** After you include a particular element, you cannot go to the Classification Rules window and include the classification to which this element belongs.

4. Save your set.

5. If you want to see a list of the individual elements you have included or excluded from the set, choose the Element Rules button. The Element Rules window is view-only.
Defining Customized Forms

You can define customized versions of certain forms in the Form Customization window.

See: Table 30–1 List of Customizable Forms: page 30–4

Note: If you want to restrict access to query–only for a form, you do not need to create a customized version. Instead you create a new form function, setting the QUERY_ONLY parameter to YES.

See: Setting Up Query–only Access to Forms: page 30–21

To define a customized version of a form:

1. Select the name of the standard form in the Form to be customized field. All GUI Smart Client form names are prefixed by F4.
2. Enter the name of your new version in the Name field. This name is used when defining menus but it is not seen by users.
3. Select Enabled if you want the restrictions to come into effect. If you do not select this option, the customized version of the form behaves the same way as the standard version.
4. Enter the titles to appear in the new version of the form:
   - In the Standard Title field, enter the window title to be seen by users who can use the form for data entry and editing.
• In the Query Title field, enter the window title to be seen by users who have view-only access to the form.

5. Save your new version.
6. In the Restrictions block, select the Type and Value of the restriction you want to define. The types and values available depend on the form you are customizing.

Adding the Customized Form to a Menu or Task Flow

If you want to add the customized form to a task flow, you must create a Task Flow Node for it.

If the customized form is called directly from the Navigator window, your System Administrator must define a menu function to call the form with the customization. The System Administrator can add this function to any menu.

Note: If you want to use a customized version of the People form, People Folder, or Assignment Folder to start a task flow, you should define a new customized task flow node and then define a menu function to call the task flow.

See Also

Calling Customized Forms and Task Flows from Menus: page 30 – 22
Linking Windows in Task Flows

To complete many tasks, users need to use more than one window. For example, to hire a new employee, users typically go from the Person window, to the Address window, to the Special Information window, to the Assignment window, and so on.

You can link these windows together in a *task flow* so that the user can choose a button to bring up each window in turn without returning to the menu. The first window in the task flow defines the context of the subsequent windows. For example, if the task flow begins with the People window, all subsequent information is entered for the person you enter or query in the People window.

You can include customized forms in task flows. For example, you might create a customized version of the People window that handles applicants only. Then you could use this customization in a recruitment task flow.

Oracle HRMS supplies a predefined task flow that includes all the windows that you can use in task flows. It is designed as a simple structure to use during implementation, not as a recommended structure for users.

![Sequential Task Flow Diagram](image-url)
You can create your own task flows using the windows listed in Table 30 – 2, or customized versions of them. Some of these windows require the context of an assignment. This means that either the Assignment window or the Assignments Folder window or the Application window (for applicant assignments) must appear above them in the task flow.

All task flows must begin with one of the following forms:

- People and Assignment (PERWSHRG)
- People (PERWSEPI)
- People Folder (PERWSFPE)
- Assignments Folder (PERWSFAS)
- Job (PERWSDJT)
- Position (PERWSDPO)

**Attention:** Using the combined People and Assignment form (PERWSHRG), rather than the separate forms (PERWSEPI and PERWSEMA), the Assignment window opens more quickly from the People window. We therefore recommend that you use the combined form in any taskflow that requires both windows. The seeded taskflows use the combined form.

<table>
<thead>
<tr>
<th>Window</th>
<th>Context Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absence Detail</td>
<td>Person (employee)</td>
</tr>
<tr>
<td>Address</td>
<td>Person</td>
</tr>
<tr>
<td>Window</td>
<td>Context Required</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Adjust Balances (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Applicant Interview</td>
<td>Assignment (applicant)</td>
</tr>
<tr>
<td>Application</td>
<td>Person (applicant)</td>
</tr>
<tr>
<td>Assignment</td>
<td>Person (employee)</td>
</tr>
<tr>
<td>Assignment Budget Values</td>
<td>Assignment</td>
</tr>
<tr>
<td>Assignments Folder</td>
<td>None</td>
</tr>
<tr>
<td>Book Events</td>
<td>Person (employee or applicant)</td>
</tr>
<tr>
<td>Competence Profile</td>
<td>Person</td>
</tr>
<tr>
<td>Costing</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Element Entries</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Employee Review</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>External/Manual Payments (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Grade Step Placement</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>P45 (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>People Folder</td>
<td>None</td>
</tr>
<tr>
<td>People</td>
<td>None</td>
</tr>
<tr>
<td>Personal Payment Method</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Phone Numbers</td>
<td>Person</td>
</tr>
<tr>
<td>Picture</td>
<td>Person</td>
</tr>
<tr>
<td>Position</td>
<td>None</td>
</tr>
<tr>
<td>Position Occupancy</td>
<td>Position</td>
</tr>
<tr>
<td>Qualifications</td>
<td>Person</td>
</tr>
<tr>
<td>QuickPay (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Reverse Payroll Run (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Salary Administration</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Salary History</td>
<td>Assignment (employee)</td>
</tr>
</tbody>
</table>

Table 30 – 2 Windows You Can Use in Task Flows
<table>
<thead>
<tr>
<th>Window</th>
<th>Context Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schools and Colleges (Establishment Attandances)</td>
<td>Person</td>
</tr>
<tr>
<td>Secondary Statuses</td>
<td>Assignment</td>
</tr>
<tr>
<td>SOE Report (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Special Information</td>
<td>Person</td>
</tr>
<tr>
<td>Statutory Details (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Terminate</td>
<td>Person (employee)</td>
</tr>
<tr>
<td>Terminate Applicant</td>
<td>Person (applicant)</td>
</tr>
<tr>
<td>View Element Entry History</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Work Choices (Job or Position)</td>
<td>Job or Position</td>
</tr>
<tr>
<td>Work Choices (Person)</td>
<td>Person</td>
</tr>
</tbody>
</table>

Table 30 – 2 Windows You Can Use in Task Flows
Defining Task Flow Nodes

Each form in a task flow is a node. There are predefined nodes for every form that you can include in a task flow. However, if you create a customization of one of these forms, you must create a node for the customization before you can include it in a task flow.

You create nodes in the Define Task Flow Nodes window.

To create a task flow node:

1. Enter a name for the node. You select this name when you create a task flow containing the node. It is not visible to users.
2. Select the form that you customized. Leave the Block field blank.
3. Select the customization that you created.
4. Save the new node.
Defining Task Flows

You define task flows in the Define Task Flow window. If there is a similar existing task flow, you can copy it to form the basis of your new flow.

Including the Assignment Window in Taskflows

Using the combined People and Assignment form (PERWSHRG), rather than the separate forms (PERWSEPI and PERWSEMA), means the Assignment window opens more quickly from the People window.

Attention: We therefore recommend that you use the combined form in any taskflow that requires both windows. The seeded taskflows use the combined form.

When users move down a task flow from the combined form, the Assignment window remains visible in the background. They can return to the Assignment window by closing their current window. Therefore you should not define a button to call the Assignment window.

However, if you are defining a task flow to the Assignment window from any window except the People window, you should use the Assignment form (PERWSEMA). In this case you may wish to add an Assignment button to any forms below the Assignment window in the taskflow. This allows users to return to the Assignment window without going back to the top window.

Prerequisites

- First create nodes for any form customizations you want to include in the task flow.
To define a task flow:

1. Enter a name for the task flow and save it.
2. In the Node block, select the name of the node that you want to be the first form in the task flow.
3. For this node, select the Top Node check box.
4. Create a new record in the Node block and select another node. You must create all the nodes for the task flow before you can begin entering the navigation paths between them.
5. In the Navigation Options region, for each node, select the other nodes to which you can navigate.
6. Enter a sequence number to determine the order in which the navigation options appear as buttons (from left to right) along the base of the window or as options in a navigation list.
7. Select the Button check box for the navigation options that should appear as buttons. There is a limit on the number of buttons that can appear on each form. This number varies from form to form. The other options are displayed in a navigation list when the user chooses a button labelled Others. Or, if there is only one other option, this form displays when the user chooses a button labelled Next.
8. There is a default label that appears on buttons or in the navigation list for every form. You can override this with your own label.
If the label in the Define Taskflow window appears blue, this is the default value. It is a dynamic default: if the seeded value changes (for example, as the result of an upgrade), the label will be updated automatically in all task flows where it has not been overridden.

If the label appears black, the default value has been overridden. To re-inherit the default label, clear the field.

9. To define an access key (or keyboard shortcut) for a navigation option, precede the appropriate letter in the label with an ampersand (&). For example, to use ALT+P (in the Microsoft Windows environment) as the access key for the Picture window, enter the label &Picture.

   **Note:** Do not use the following letters since they are used on the Oracle Applications menu: A, E, F, G, H, Q, S, W.

   There is no validation to prevent the same letter being used more than once for a group of buttons.

10. Save the task flow.

    **To copy an existing task flow:**

    1. Query the existing flow and choose the Copy To button.
    2. Enter the name of the new task flow and choose OK.
    3. Query your new task flow and edit it as required.

**See Also**

Calling Customized Forms and Task Flows from Menus: page 30 – 22
Setting Up Navigation Menus

Users access standard windows, customized windows, and the first window in a task flow through the menu structure displayed in the Navigator window. Each responsibility is associated with a single menu structure. Using Function Security System Administrators can further restrict access to individual menu options.

By defining menus with function security for groups of users, you can:

- limit the range of information users can access for the applicant and employee records available to them
- improve users’ efficiency in using the system by reducing menu choices
- restrict users to query-only access to some or all windows

Each responsibility you define must be linked to one root menu, which is the list of menu options displayed when the Navigator window first opens.
The Default Menu Structure

The AutoInstall program creates a default menu structure for your HRMS product. This menu structure lets you access all of the windows for your system. Normally, only a System Administrator has access to the full default menu structure.

Using function security you can use this default menu for any number of responsibilities and restrict access to the default menu options. You can also define any number of new functions and menus to restrict the access of other users. To view the hierarchy of menus you have defined, you can run the Menu Structures Report.

The supplied menus give you access to all of the available submenus. However, a number of seeded functions are not enabled on these menus. You need to add them for the responsibilities that should have access to these functions:

- **HR View Medical**
  This function causes the Medical Information alternative region to display in the People window.

- **HR View Background**
  This function causes the Background Information alternative region to display in the People window.

- **HR View Rehire**
  This function causes the Rehire Information alternative region to display in the People window.

- **Salary Administration: Approve**
  This function enables the user to approve salary proposals in the Salary Administration window and the Salary Management folder.

Suggestions for Structuring Menus

Menus can be structured in different ways:

- following a sequence of tasks, such as:
  1. Define a Requisition and Vacancy
  2. Define a Recruitment Activity
  3. Enter Applicant Information

- by type, such as inquiry windows, in which case the grouping is important but the sequence is not
When you define a new menu you should start by drawing it out on paper. This will help you to decide the best structure and the best prompts and descriptions. Work from the lowest level of sub-menu to the highest and define the root menu as the last step in the sequence.

You can define as many submenus as you require under each menu option. We recommend that you restrict the number of menu levels to three because a menu structure with more levels is cumbersome to use.

Opening Multiple Forms

In most Oracle Applications, you can open multiple forms from the Navigator window without closing the form you already have open.

**Attention:** You must disable this feature on a menu structure that accesses Oracle HRMS task flows. To prevent the confusion of working with multiple effective dates, you should also disable this feature if your menu structure accesses Oracle HRMS datetracked forms.

To disable the Multiple Open Form feature:

1. Add a Function type menu entry to the top-level menu referenced by your new responsibility.
2. Select the function whose User Function Name and Function Name are:
   - Disable Multiform, Multisession
   - FND_FNDSCSGN_DISABLE_MULTIFORM
3. Save your changes.

See Also

Default Navigation Menus for HR Responsibility: page A – 9

Menus
*Oracle Applications System Administrator’s Guide*

Menu Report
*Oracle Applications System Administrator’s Guide*
Setting Up Query–only Access to Forms

You can restrict access to query–only for all HR and Payroll forms on a menu by setting the user profile option HR:Query Only Mode to Yes. You can set this profile for individual responsibilities or users, or at the site or application level.

If you want to give query–only access to some forms and full access to other forms, set the HR:Query Only Mode profile to No and use the parameter QUERY_ONLY=YES at form function level to restrict access to individual forms.

**Note:** You can set the parameter QUERY_ONLY=YES for a form function that also launches a task flow. In this case, specify two parameters in the Form Function window:

QUERY_ONLY=Yes
WORKFLOW_NAME="taskflow name"

The entire task flow will be query–only, not just the first form.

To restrict access to query–only mode for an individual form:

1. In the Form Functions window, select the form and specify the parameter QUERY_ONLY=YES. If you want to specify other parameters for this form function, separate them with a space.

2. Enter a user function name to identify your new function, and save it.

3. In the Menus window, select your new function instead of the supplied form function.
Calling Customized Forms and Task Flows from Menus

For certain options you must define menu functions that include a parameter in the Parameters field of the Form Functions window, as follows:

• If the menu entry calls a customized form, use the following parameter:
  
  \[ HR\_CUSTOMIZATION = "customization name" \]

• If the menu entry calls the first form in a task flow, use the following parameter:

  \[ WORKFLOW\_NAME = "task flow name" \]

• If the menu entry calls a form in query–only mode, use the following parameter:

  \[ QUERY\_ONLY=YES \]

• If the menu entry calls the Define Rate form (PAYWSGEV), use the following parameter:

  \[ FORM\_MODE = "grade" \] (for the Grade Rate window)

  \[ FORM\_MODE = "spine" \] (for the Scale Rate window)

• If the menu entry calls the Payroll and Assignment Processes form (PAYWSACT – used in Oracle Payroll), use the following parameter:

  \[ FORM\_MODE = "assignment" \] (for the Assignment Processes window)

  \[ FORM\_MODE = "payroll" \] (for the Payroll Processes window)

If you need to specify more than one parameter for a form function, separate the parameters with a space.
QuickCodes and User Tables

QuickCodes provide lists of valid values on certain fields throughout the system. For many types of code you can add your own values and change the values that are predefined. You can also set up your own types of QuickCode.

You can set up user tables to provide matrices of valid values that vary according to a factor such as age, or job, or number of years service. You can access these values from formulas, or your own forms or reports, using a supplied function.

This chapter explains how to set up QuickCode Types and how to add values to predefined QuickCodes. It lists the predefined QuickCodes to which you can add values. It also explains how to set up user tables and enter values for the rows and columns you define.
QuickCodes

Providing lists of valid values for certain items of information has two key advantages:

- It ensures that all users use the same terminology, which makes it easier to inquire and report on the information.
- It speeds up data entry because you can enter just enough to identify the value, and the system completes the entry.

In Oracle HRMS, a list of values is called a QuickCode Type. Each value comprises a code and a meaning. For example:

<table>
<thead>
<tr>
<th>QuickCode Type</th>
<th>Code</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>YES_NO</td>
<td>Y</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>N</td>
<td>No</td>
</tr>
</tbody>
</table>

The codes are used internally; users do not see them. There is a maximum of 250 QuickCodes for each QuickCode Type.

Predefined QuickCode Types

A number of QuickCode Types are included in Oracle HRMS. Some contain codes as startup data. You can never delete these codes, but you can change their meaning. For some QuickCode Types, you can also disable the codes that are supplied. Your ability to disable codes and add new codes is determined by the access level of the QuickCode Type:

- User: You can add codes and you can disable supplied codes.
- Extensible: You can add new codes, but you cannot disable supplied codes because the system uses them.
- System: You can neither add codes nor disable supplied codes. You can only change the meaning or description of supplied codes.

Table 31 – 1 lists the predefined QuickCode Types with an access level of User or Extensible.

You can also create your own QuickCode Types in the QuickCode Type window. These all have an access level of User.
Adding QuickCode Values

To add, disable, or change the meaning of a QuickCode, use the QuickCodes window.

To add QuickCodes:

1. Query the QuickCode Type to which you want add a value. You cannot add values if the Access Level is System.
2. Enter a code and meaning. Optionally, enter a start and end date. If you do not enter a start date, the new QuickCode is valid immediately. If you do not enter an end date, the new QuickCode is valid indefinitely.
Removing QuickCode Values

You cannot delete QuickCodes after saving them, but you can stop them appearing in lists of values.

To remove a user defined QuickCode:

- In the QuickCodes window, do one of the following:
  - Disable the code by unchecking the Enabled check box if you want to prevent users selecting this value on any date.
  - Enter an end date if you want to prevent users selecting this value after a certain date.
  - Change the meaning and description to create a replacement QuickCode.

If you disable the QuickCode or set an end date, users cannot select this value when they create new records. However, they can continue to see the value when they query records that contain it.

If you add, disable, or change the meaning of a QuickCode, users must log out and log back in again for your changes to take effect.
Defining QuickCode Types

You can create your own QuickCode Types to provide lists of values, for example to validate element entries.

Define the new type in the QuickCode Types window, then query it in the QuickCodes window to define the values that appear in lists.

To define a new QuickCode Type:

1. Enter the name and meaning of your new type.
2. Save your work.
3. Optionally, choose the Usages button and select other Oracle Applications in which you want to use this new QuickCode Type.
## User and Extensible QuickCodes

<table>
<thead>
<tr>
<th>Field</th>
<th>QuickCodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category (absence)</td>
<td>ABSENCE_CATEGORY</td>
</tr>
<tr>
<td>Reason (for absence)</td>
<td>ABSENCE_REASON</td>
</tr>
<tr>
<td>Account Type (for bank details)</td>
<td>ACC_TYPE</td>
</tr>
<tr>
<td>Address Type</td>
<td>ADDRESS_TYPE</td>
</tr>
<tr>
<td>Reason (for application assignment status)</td>
<td>APL_ASSIGN_REASON</td>
</tr>
<tr>
<td>Type (event type for applicant)</td>
<td>APL_EVENT_TYPE</td>
</tr>
<tr>
<td>Type (interview type for applicant)</td>
<td>APL_INTERVIEW_TYPE</td>
</tr>
<tr>
<td>Reason (for secondary assignment status)</td>
<td>APL_SEC_ASSIGN_REASON</td>
</tr>
<tr>
<td>Appraisal and Assessment Status (Appraisal and Assessment on the Web)</td>
<td>APPRAISAL_ASSESSMENT_STATUS</td>
</tr>
<tr>
<td>Appraisal and Assessment Type (Appraisal and Assessment on the Web)</td>
<td>APPRAISAL_TYPE</td>
</tr>
<tr>
<td>State (Australian addresses)</td>
<td>AU_STATE</td>
</tr>
<tr>
<td>Blood Type</td>
<td>BLOOD_TYPE</td>
</tr>
<tr>
<td>Measurement Type (for budget)</td>
<td>BUDGET_MEASUREMENT_TYPE</td>
</tr>
<tr>
<td>Cash Analysis (for a cash payment)</td>
<td>CASH_ANALYSIS</td>
</tr>
<tr>
<td>Census Metropolitan Area (Canada)</td>
<td>CA_CMA</td>
</tr>
<tr>
<td>Province (Canadian addresses)</td>
<td>CA_PROVINCE</td>
</tr>
<tr>
<td>Method</td>
<td>CERTIFICATION_METHOD</td>
</tr>
<tr>
<td>User friendly names for cheque-ordering SQL statement</td>
<td>CHEQUE_PROCEDURE</td>
</tr>
<tr>
<td>User friendly names for cheque-writing SRW2 reports.</td>
<td>CHEQUE_REPORT</td>
</tr>
<tr>
<td>Primary Evaluation Method</td>
<td>COMPETENCE_EVAL_TYPE</td>
</tr>
<tr>
<td>Competence Type</td>
<td>COMPETENCE_TYPE</td>
</tr>
<tr>
<td>Type (relationship of one person to another)</td>
<td>CONTACT</td>
</tr>
<tr>
<td>Type (of MIX batch control total)</td>
<td>CONTROL_TYPE</td>
</tr>
</tbody>
</table>

Table 31-1 User and Extensible QuickCodes
<table>
<thead>
<tr>
<th>Field</th>
<th>QuickCodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason (for element entry)</td>
<td>ELE_ENTRY_REASON</td>
</tr>
<tr>
<td>Reason (for employee assignment)</td>
<td>EMP_ASSIGN_REASON</td>
</tr>
<tr>
<td>Employment Category</td>
<td>EMP_CAT</td>
</tr>
<tr>
<td>Type (of employee event)</td>
<td>EMP_EVENT_TYPE</td>
</tr>
<tr>
<td>Type (of interview for employee)</td>
<td>EMP_INTERVIEW_TYPE</td>
</tr>
<tr>
<td>Reason (for secondary assignment status)</td>
<td>EMP_SEC_ASSIGN_REASON</td>
</tr>
<tr>
<td>Ethnic Origin</td>
<td>ETH_TYPE</td>
</tr>
<tr>
<td>System (job or position evaluation system)</td>
<td>EVAL_SYSTEM</td>
</tr>
<tr>
<td>Measurement In (type for EVAL SYSTEM)</td>
<td>EVAL_SYSTEM_MEAS</td>
</tr>
<tr>
<td>Type (of formula)</td>
<td>FORMULA_TYPE</td>
</tr>
<tr>
<td>Authority (for PAYE details)</td>
<td>GB_AUTHORITY</td>
</tr>
<tr>
<td>Bank Name</td>
<td>GB_BANKS</td>
</tr>
<tr>
<td>Certificate (for element NI)</td>
<td>GB_CERTIFICATE</td>
</tr>
<tr>
<td>Cheque Style</td>
<td>GB_CHEQUE_REPORT</td>
</tr>
<tr>
<td>County (UK addresses)</td>
<td>GB_COUNTY</td>
</tr>
<tr>
<td>Pension</td>
<td>GB_PENSION</td>
</tr>
<tr>
<td>Sequence (for the BACS process)</td>
<td>GB_SORT_SEQUENCE</td>
</tr>
<tr>
<td>Reason (for leaving)</td>
<td>LEAV_REAS</td>
</tr>
<tr>
<td>Marital Status</td>
<td>MAR_STATUS</td>
</tr>
<tr>
<td>Nationality</td>
<td>NATIONALITY</td>
</tr>
<tr>
<td>Name (of organization classification)</td>
<td>ORG_CLASS</td>
</tr>
<tr>
<td>Organization Type</td>
<td>ORG_TYPE</td>
</tr>
<tr>
<td>Category</td>
<td>PER_CATEGORIES</td>
</tr>
</tbody>
</table>

Table 31 – 1 User and Extensible QuickCodes
<table>
<thead>
<tr>
<th>Field</th>
<th>QuickCodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FTE Capacity</td>
<td>PER_FTE_CAPACITY</td>
</tr>
<tr>
<td>Minimum Service</td>
<td>PER_LENGTHS_OF_SERVICE</td>
</tr>
<tr>
<td>Relocation</td>
<td>PER_RELOCATION_PREFERENCES</td>
</tr>
<tr>
<td>Status</td>
<td>PER_SUBJECT_STATUSES</td>
</tr>
<tr>
<td>Subject</td>
<td>PER_SUBJECTS</td>
</tr>
<tr>
<td>Work Duration</td>
<td>PER_TIME_SCALES</td>
</tr>
<tr>
<td>Tuition Method</td>
<td>PER_TUITION_METHODS</td>
</tr>
<tr>
<td>Work Hours</td>
<td>PER_WORK_HOURS</td>
</tr>
<tr>
<td>Work Schedule</td>
<td>PER_WORK_SCHEDULE</td>
</tr>
<tr>
<td>Rating</td>
<td>PERFORMANCE_RATING</td>
</tr>
<tr>
<td>Type</td>
<td>PHONE_TYPE</td>
</tr>
<tr>
<td>Reason (for grade step placement)</td>
<td>PLACEMENT_REASON</td>
</tr>
<tr>
<td>Status (of a vacancy)</td>
<td>VACANCY_STATUS</td>
</tr>
<tr>
<td>Source of Proficiency Rating</td>
<td>PROFICIENCY_SOURCE</td>
</tr>
<tr>
<td>Reason (for salary proposal)</td>
<td>PROPOSAL_REASON</td>
</tr>
<tr>
<td>Units (qualifying units for probation period)</td>
<td>QUALIFYING_UNITS</td>
</tr>
<tr>
<td>Type (of recruitment activity)</td>
<td>REC_TYPE</td>
</tr>
<tr>
<td>Reason (for terminating application)</td>
<td>TERM_APL_REASON</td>
</tr>
<tr>
<td>Prefix</td>
<td>TITLE</td>
</tr>
</tbody>
</table>

Table 31 – 1 User and Extensible QuickCodes
User–defined Tables

You may need to set up your own tables in your Oracle HRMS system, to hold data such as wage codes, shift differentials, or the amounts of certain deductions. You can set up all the tables you require using the Table Structure window. Using Oracle FastFormula, you can write simple formulas for validating entries made in table columns.

Notice that the Oracle HRMS user–defined tables are different from the database tables of the Oracle Relational Database Management System. When you set up a user table, you define the rows as well as the columns, like a matrix. For example, you could set up a table showing bonus amounts (the column) against years of service (the rows).

Your Oracle HRMS startup data includes some predefined user tables. These are maintained by your Oracle localization team.

Entering and Accessing Table Values

To enter values in tables, you use the Table Values window. Table entries and rows are both datetracked, so you can delete existing entries or rows, and add new ones, as of an effective date.

Oracle HRMS provides the GET_TABLE_VALUE function to access table values. You can yourself write formulas that include calls to this function, perhaps for QuickPaint inquiries. Also, it is easy for MIS personnel to write PL/SQL statements that call this function, to include in the code for a form or report process, for example.

See Also

Functions: (Oracle FastFormula User’s Guide)
Setting Up User Tables

You set up user tables in the Table Structure window.

Prerequisites

- Plan what your table rows and columns will contain, and whether you will use formulas to validate table column entries.
- If you plan to use formulas to validate entries into the table columns, write these formulas and enter them in your database.


To set up the structure of a table:

1. Set your effective date to the date from which you want the table’s row labels to take effect.

2. Enter the table name.

3. For the table’s match type, select Match or Range. Select Match if each row is for one item, such as one job or one code. Select Range if each row is for a range of numeric values, such as an age range or a pay range.

4. If the match type is Match, select Date, Number or Text as the Key Units of Measure, depending on whether entries in the rows are dates (DD–MON–YYYY), numbers, or alphanumeric text.

   If the table’s match type is Range, the Key Units of Measure automatically becomes Number.

5. Enter the row label as the Row Title.

   For example, if the table rows refer to rate codes, an appropriate row title would be Rate Code. If the rows refer to age ranges, you might use the title Age Range.
6. Save your work, and choose the Columns button to go to the Columns window.

---

**To enter column labels:**

1. Enter labels for the table columns in the Name field. To add a new column to a table that already exists, place the cursor on the name of the column after which you want to enter the new column name, and choose Insert Record from the Edit menu to obtain a clear field.

2. If you are using formula validation for a column’s entries, select the name of the validation formula for the column.

3. Save your work and close the window. In the Table Structure window, choose the Rows button to go to the Rows window.
To enter row labels:

1. If the match type of the table is Match, enter the label for each table row in the fields under the heading Exact. If the match type of the table is Range, enter numbers representing the lower and upper boundary of each row’s range.

2. In the Sequence fields, you can optionally enter a number for each row label to determine the order in which it appears on a list in the Table Values window. Logical sequencing of row labels helps users enter table values rapidly and accurately.

3. When you are finished, save your work and close the window. Your table is now set up and ready to receive entries into its columns.
If you have set up user-defined tables, you can enter and maintain values in the Table Values window.

**Note:** The system administrator can create customized versions of the Table Values window so that you use each version for one user table only.

**Prerequisite**

Before you can enter values into a table’s columns, the table with its columns and rows must be completely set up.

---

**To enter values into table columns:**

1. Set your effective date to the date from which you want the entries to take effect.
2. Query the table name.
3. With the cursor in the Column Name field, use the up and down arrows to locate the name of the column in which you want to make entries.
4. In the Values region, select each row for which you want to make an entry. You select rows in the Exact field or the Lower Bound field, depending on the match type of the table.
5. For each row, make the appropriate entry in the Value field.
6. Save your work.
Oracle Human Resources can be integrated with a number of Oracle and third party products. This chapter explains how to set up Oracle Human Resources to integrate with the following products.

- Oracle Payroll
- spreadsheets

It also explains how to attach text, images, OLE objects, and Web pages to individual records.
Using Oracle Human Resources with Oracle Payroll

Oracle Human Resources and Oracle Payroll are available for purchase together as the components of a closely integrated human resources management system. This system combines Oracle Human Resources and Oracle Payroll windows under a single menu structure, sharing windows and underlying tables wherever possible to eliminate redundant data entry, maintenance and storage.

For Oracle Human Resources or Oracle Payroll, you enter and maintain the same fundamental human resource information about your structure and operations, your employees and their assignments, and employee compensation and benefits. You then add the specialized information you need specifically for human resources or payroll management and administration.

Shared Information in Oracle HRMS

The common core of fundamental information used by both human resources and payroll managers and staff includes:

- **Your operational basics:**
  - payrolls with their calendars and pay periods
  - the currencies and methods of payment you use

- **Your organizational structure:**
  - internal organizations, such as companies, divisions, departments, work groups, or production team
  - external organizations of key importance to you, such as employment agencies, tax authorities, or union headquarters
  - organization location information, including addresses and telephone numbers
  - hierarchies showing the relationships between your organizations
  - any grade and grade scale structures you use

- **Your employees’ essential personal information**, such as:
  - name and address
  - marital status
  - birth date
  - nationality
• ethnic origin

• **Your employees’ current work statuses**, such as:
  – active assignment
  – on maternity leave
  – terminated

• **Your employees’ assignments to**:
  – internal organizations
  – grades, or grades and grade steps
  – groups having a compensation-related factor in common, such as membership in an insurance or pension plan or participation in an employee stock purchase plan
  – jobs, or jobs and positions
  – payrolls

• **Elements of your employees’ pay and benefits**:
  – earnings such as salary, wages, commissions, bonuses, allowances
  – employer charges such as employer contributions to legislatively-mandated or private insurance or pension plans
  – deductions such as contributions for union dues or employee stock purchase plans
  – nonpayment benefits such as vacation time or a company car

**Shared Windows in Oracle HRMS**

While many of the windows in your system relate exclusively to the human resources or payroll function, some include information relevant to both functions. These latter windows are *shared* windows.

Shared windows can include some information fields relevant to both human resources and payroll users, and other fields for information specific to either human resources or payroll users but not both.

**Using Shared Windows**

You can control the use of fields on shared windows by the value your system administrator gives to each user or responsibility for the HR:User Type profile option. The three valid values are:
• HR with Payroll User
• HR User
• Payroll User

Users with an HR User profile are restricted in their use of fields on certain windows. In particular:

• they do not see certain fields on the Element window, which are only required if you are processing elements
• they cannot assign employees to a payroll if both Oracle Payroll and Oracle Human Resources are installed
• they do not see the Statutory Information field in the Payroll window
• they cannot adjust element entry Pay Values
Using Oracle HRMS with Spreadsheets

Spreadsheets are commonly used in many enterprises to provide managers and other users with a powerful modelling and analysis tool. Often it is the ability to represent complex numeric data in a simple graphical format that makes them so popular.

You can use Oracle Application Data Export (ADE) to download information from the HRMS database to a spreadsheet for analysis and manipulation. For example, you can download data on current and proposed salaries for a group of employees. You can adjust the salary proposals in the spreadsheet, or enter new ones, and upload the revised data to the database. The ADE upload process reports any errors and ensures that only valid data is saved in the database.

To download information from a form to a spreadsheet using ADE, your system administrator needs to create a style in ADE. The style defines the form it is used for, the responsibilities that can use it, and the columns (or fields) to be downloaded. You determine which records are downloaded by running a query in the form before launching ADE.

A style for downloading salary proposals is predefined.

See Also

Using the Salary Management Folder: page 10 – 13

Application Data Export User’s Guide
Using Attachments

You can attach short comments, word processed documents, images, video, OLE objects, or Web pages to many records in Oracle HRMS. For example, you could attach a resume to an applicant record and a position description to a position record.

Each record can have one or more attachments, and you can copy attachments from one record to another. You can store the attachments in the database or in your file system.

You view or add new attachments by clicking the Attachments icon. By default, clicking the attachments icon displays a Comments window where you can enter text up to 2000 characters. This is the Comments facility available in earlier releases of Oracle HRMS. If you want to replace this facility with the ability to attach multiple items, ask your system administrator to set your user profile option HR:Use Standard Attachments to Yes.

The HRMS entities that support attachments are as follows:

- Absence
- Absence Type
- Address
- Application
- Assignment
- Balance (Oracle Payroll)
- Batch Header
- Booking
- Budgets
- Budget Version
- Calendar
- Career Path
- Consolidation Set (Oracle Payroll)
- Contact Relationship
- Customization
- Element
- Element Entry
- Element Link
• Element Set
• Event
• Grade
• Grade Rate
• Job
• Job Evaluation
• Job Requirement
• Letter Type
• Monetary Unit (Oracle Payroll)
• Organization
• Organization Payment Method
• Organization Hierarchy
• Pay Scale
• Payroll Process (Oracle Payroll)
• Period of Service
• Person
• Person Analysis/Special Information
• Personal Payment Method
• Position
• Position Hierarchy
• Recruitment Activity
• Requisition
• Salary Basis
• Salary Proposal
• Salary Proposal Component
• Secondary Assignment Status
• Special Information Type
• Status Processing Rules (Oracle Payroll)
• Vacancy
• Valid Grade

See Also

Working With Attachments
*Oracle Applications User’s Guide*
Setting User Profile Options: page 28 – 4
Employees’ personal and pay-related information is highly sensitive. You must be able to reliably secure this information from unauthorized access by users of your Oracle Applications.

Oracle HRMS gives you a flexible approach to controlling access to records, windows, and functions. This means you can suit each employee’s level of access to his or her work responsibilities. You can partition data by organization, position, or payroll.

Management of security is normally part of the system administrator’s role. This chapter explains how to secure information in Oracle HRMS.
Security in Oracle HRMS

You can control users’ access to human resources information by record, window, and function.

You can restrict access to records of applicants and employees assigned to certain work structures. For example, you can give department managers access only to the records of the employees in their own department.

Further, within a given department, you can control access to records of employees at or above a certain level. For example, you can give a department’s administrator access to all department employee records except those of the manager and assistant manager. You do this by defining security profiles.

You can use the same security profiles to restrict the records accessed by a reporting user, who runs reports against the system but does not have online access through the Oracle HRMS forms.

You can also restrict access to certain information types. For example, you can create customized versions of some windows to restrict access to certain elements and person types.

Another important area of security is control over information change. For each group of employees sharing a responsibility, you can set up a menu controlling the windows to which they have access. If it is important to know who makes changes to information in certain windows, you can enable full data auditing for these windows.

You can specify which processes and reports a user can use by setting up security groups.

Access Control through User Responsibilities

You control access to Oracle HRMS through responsibilities that you create and assign to users of the system. Users can sign on to Oracle HRMS only through the responsibilities you give them. So their responsibilities control what they can see and do in the system.

A responsibility always includes a security profile and a menu structure. It may also include a security group. Optionally, you can restrict access to specific sub-menus or functions in your chosen menu.

- Security profiles determine the organizations, positions and payrolls whose applicant and employee records responsibility holders can access.
- Menu structures and functions control:
– the particular windows a responsibility holder can access
– whether he or she can perform data entry, change or deletion on these windows

You can produce customized versions of some Oracle HRMS windows. Each customized version allows access to a subset of certain types of information, such as person types, special information types, or elements. You define additional menu functions to call customized windows or task flows, and then you add these functions to a menu structure, which is linked to a responsibility.

- Security groups determine the group of processes and reports a responsibility holder can initiate. A security group is an optional component of a responsibility. If holders of a responsibility should not initiate any reports or processes, you do not include a security group in the responsibility.

For each responsibility, you must also define two user profile options:

- HR:Security Profile
- HR:User Type
Single and Multiple Responsibilities

You can develop as many different responsibilities as your enterprise requires. Typically, most employees need one responsibility only. However you can assign multiple responsibilities to users who need to:

- access applicant and employee records from two or more security profiles.
- use more than one menu structure to view or make changes to the records they can access.
- use more than one Oracle Application. For example, some people may use windows in both Oracle HRMS and Oracle General Ledger.
- access records for more than one Business Group. For example, an enterprise with international operations may have a US–based Business Group and a UK–based Business Group. A few of your employees might need access to both.

See Also

Setting User Profile Options: page 28 – 4

Security Profiles

The security profile attached to a responsibility determines which applicant and employee records are available to holders of that responsibility. You associate a security profile with work structures. The records of employees and applicants assigned to these work structures are then accessible to holders of the responsibility.

The work structures you can name in security profiles are:

- internal organizations and organization hierarchies. Organizations include structures like departments, sections, groups and teams. Each security profile allows access to one Business Group only.
- positions and position hierarchies. Positions are jobs performed within specified organizations, such as:
  - Clerk, Accounting Section (organization is Accounting Section and job is clerk)
  - Quality Control Technician (organization is Quality Control Group and job is technician)
- payrolls, such as Weekly Payroll, Monthly Payroll, or Sales Payroll.
Organizations and Organization Hierarchy

To set up a security profile that permits access to employee records of certain organizations only, you make use of organization hierarchies. You can build any number of additional hierarchies to meet your security requirements.

For example, suppose you build this Sales Organization hierarchy:

![Sales Organization Hierarchy Diagram]

You can create a security profile that permits access to employee records throughout the sales organization. This profile references the Sales Organization hierarchy. It names the Sales Department as the highest organization in the hierarchy through which profile holders have access to employee records.

Next, you want the directors of the two sales regions to have access to all employee records in their region only. You create Eastern and Western Sales Director security profiles. These profiles also reference the Sales hierarchy. But, they name the Eastern and Western Regions, respectively, as the top organizations for these profiles’ access to employee records.

When you name an organization as the top organization, you specify whether it is inclusive or not. You must include the top organization if...
you want holders of the profile to access records of people assigned to the top organization.

**Positions and Position Hierarchies**

After establishing limits on record access using organization hierarchies, you can further restrict access by means of position hierarchies.

Suppose, for example, within the Sales Department, you want to give the Sales Research Director access to her subordinates’ records only. You can start by building the following Sales Positions Hierarchy:

![Sales Positions Hierarchy Diagram]

Now you create the Sales Research Director security profile. This profile references the Sales Positions hierarchy and names the Sales Research Director as the top position for access to employee records.
Security Profile: SALES RESEARCH DIRECTOR

Organization Hierarchy: Sales Organization
Top Organization: Sales Department
Position Hierarchy: Sales Positions
Top Position: Sales Research Director
Include Top Position: Yes

When you give the Sales Research Director a responsibility including this security profile, she can access the records of her subordinates. But, she cannot access records of:

- the VP or Associate VP of Sales
- the Regional Sales Director
- the Regional Sales Director’s subordinates.

As with organization hierarchies, you can specify that profiles do not include access to the top position.

Payrolls

The third way to restrict access to employee records is by payroll. For example, you can give payroll staff who work on the Sales payroll access to records of employees on this payroll only.

Controlling security by payroll assignment limits the employee records users can see and update on employee–related windows, such as those for employee information, and element entry.

Of course, if an employee assignment does not include a payroll, payroll security cannot apply to this assignment. Payroll security never applies to applicant records since applicants are not assigned to payrolls.

The windows for compensation definition are unrelated to any particular employee records or payroll assignments. Therefore limiting access by payroll does not affect users’ access to these windows.

See Also

Database Access Without Online Access

You may need to set up access restrictions for employees who never use Oracle HRMS windows and do not change database information, but do access the database. These individuals are reporting users. A reporting user can use Oracle reporting tools to access database information for reports. A reporting user can report on, or query, the information in the HRMS database, but cannot insert, update, or delete that information.

You can make any of your security profiles available not only for regular Oracle HRMS users, but also for reporting users. The security profile restricts a reporting user’s access to employee records in exactly the same way as it limits regular users’ access.

Menu Structures

Each responsibility includes a security profile to restrict users’ access to employee records. It also includes a menu structure to restrict the windows users can access, and what they can do on these windows.

By using different menu structures and functions for groups of users, you can:

- limit the range of information users can access for the applicant and employee records available to them
- improve users’ efficiency in using the system by reducing menu choices

Menu functions can include:

- standard windows, displayed in edit or view-only mode
- customized windows, on which you have restricted the range of data that can be displayed
- the first window in task flows that link a number of windows that are used in sequence to complete a task

The AutoInstall program creates the default menu structure for your Oracle HRMS product. You can run a report to produce a listing of this structure.

The default menu structure lets you access all of the windows for your system. Normally, only a System Administrator has access to the full default menus. You can define any number of new functions and menus to restrict the access of other users.
See Also

Setting Up Navigation Menus: page 30 – 18

Security Groups

When you build a responsibility for employees who must initiate reports or processes, you can attach a security group to the responsibility. The security group lists a group of processes and reports its holders can run. Holders of responsibilities with no security groups cannot run any processes or reports.

The seeded groups US/UK HRMS Reports and Processes give access to all predefined reports and processes.
Setting Up Security in Oracle HRMS

Figure 33 – 4 depicts the relationship between the security items you define when you set up security for Oracle HRMS.

The key definition is the responsibility, which allows access to the records specified by the security profile, using the windows specified by the menu structure, and the reports and processes specified by the report security group.

At most, one responsibility can see all records for one Business Group. When you create a new Business Group, a view–all security profile is automatically created. It provides access to all employee records, and all applicant records in the Business Group. The system administrator creates a responsibility that includes this view–all security profile, then assigns this responsibility to the users who are setting up the system. They in turn can set up security profiles for other users.
To set up a new responsibility for Oracle HRMS:

2. Set up any new functions or menus required for the responsibility.
   For menu functions calling customized forms or task flows, you must enter a parameter in the Parameter field of the Form Functions window.
   See: Setting Up Navigation Menus: page 30 – 18
3. Define the new responsibility.
4. Create usernames and passwords related to the new responsibility.
   A username can be related to more than one responsibility.
5. Set the HR User Profile Options for the new responsibility. The options you must set are:
   - HR:Security Profile
   - HR:User Type
   You can set other User Profile Options.
6. Run the HRMS security processes
   See: Running the HRMS Security Processes: page 33 – 15

Security for Reporting Users

Reporting users do not have online access to the database through Oracle HRMS forms. They use Oracle reporting tools to prepare reports on the information to which their security profiles grant access.

All secure users connect to the APPS ORACLE ID. This is created when the system is installed. However, for reporting users, you should create one or more new reporting user ORACLE IDs and associate each with a restricted security profile.

The first step in this procedure is the job of the ORACLE database administrator. The other steps are normally done by the system administrator.

To set up a new reporting user:

1. Create a new reporting user ORACLE ID.
2. Register the new ORACLE ID with Application Object Library.
3. Using a view–all responsibility, define a security profile in the Security Profile window for the new ORACLE ID.
4. Run the HRMS security processes
   See: Running the HRMS Security Processes: page 33 – 15
Defining Security Profiles

Using a view–all responsibility, you can define security profiles in the Security Profile window.

Prerequisites

- If you want to associate a reporting user with the new security profile, the ORACLE database administrator must create a new reporting user ORACLE ID. The system administrator must register the new ORACLE IDs with the Application Object Library.

To define a security profile:

1. Enter a name for the security profile and select a Business Group. This does not need to be the Business Group you are logged on to.

2. If you want reporting users to be able to use this security profile, select the Reporting User name for the ID set up by the database administrator.

3. Uncheck the View All Employees and View All Applicants check boxes if you want to restrict access to these person types by organizations, positions, or payrolls.

4. To restrict access by organization, uncheck the View All Organizations check box. Select an organization hierarchy, and a top organization. Check the Include Top Organization check box if you want to allow access to this organization.
5. To restrict access by position, uncheck the View All Positions check box. Select a position hierarchy, and a top position. Check the Include Top Position check box if you want to allow access to this position.

6. In the Payroll Security alternative region:
   - To give access to many payrolls, check the View All Payrolls check box, and uncheck the Include check box. Select the payrolls you want to exclude.
   - To give access to a small number of payrolls, uncheck the View All Payrolls check box, and check the Include check box. Select the payrolls to include.

7. Save your work.
Running the HRMS Security Processes

There are three HRMS security processes:

• Run the Grant Permissions To Roles process when you install Oracle HRMS, or when you upgrade the system.

• Run the Generate Secure User process when you create a new security profile that references a reporting user.

• Run the Security List Maintenance process every night.

You run these processes using a system administrator responsibility from the Submit Requests window.

Grant Permissions To Roles Process (ROLEGEN)

All reporting users in Oracle HRMS share access to a set of synonyms for tables. The synonyms are created by the Autoinstall process. You must run the Grant Permissions To Roles process to create the public grants to make those synonyms usable.

Run this process when you install Oracle HRMS, or when you upgrade the system. You must run this process before you run the Generate Secure User Process for the first time.

The process grants SELECT permissions to the role "hr_reporting_user". Permissions are not granted on the secured tables, but only on the secure views of those tables. All permissions previously granted to the role are revoked.

Generate Secure User Process (SECGEN)

This process grants permissions to new reporting users. It grants the "hr_reporting_user" role to the REPORTING_ORACLE_USERNAME specified in the security profile.

Run this process when you have created a new security profile that references a reporting user. In the Submit Requests window, select the name of the new security profile. This is the only parameter to the process.

Security List Maintenance Process (LISTGEN)

This process maintains the lists of organizations, positions, payrolls, employees and applicants that security profile holders can access. You should schedule it to run every night to take account of changes made during the day. If a disruption, such as a power cut, occurs while the
process is running, you can manually restart it from the Submit Requests window.

There is one required parameter for this process: Effective Date, which should normally be set to SYSDATE. You can also enter a security profile name to generate list entries for that security profile only.

**Attention:** LISTGEN should normally run when there are no users logged on to Oracle HRMS. Users attached while LISTGEN is running may experience unexpected results; for example, additional employees may become visible or previously visible employees may disappear from view.
AuditTrail provides a flexible approach to tracking the changes to your data. You can choose which data to audit and how long to keep the audit data. You can use the supplied audit report or design your own.

This chapter explains how to set up AuditTrail and how to report on audit data.
AuditTrail

AuditTrail lets you keep a history of changes to your important data: what changed, who changed it, and when. With AuditTrail, you can easily determine how any data row or element obtained its current value. You can track information on most types of fields, including character, number and date fields.

You enable auditing for audit groups. These are groups of tables and columns you want to audit, where you do not necessarily need to include all the columns in a given table. You typically group together those tables that belong to the same business process, such as employee compensation tables.

During implementation you need to decide:

- which tables and columns you want to audit
- how you plan to report on the audit data
- how long you want to keep the audit data active

Setting Up AuditTrail

Setting up AuditTrail is normally a task for the system administrator.

The first four steps must be done to enable auditing of any Oracle Applications table. They are explained in more detail in the Oracle Applications System Administrator’s Guide. The fifth step is required only for tables in the HR account.

To set up AuditTrail:

1. Have your database administrator grant SELECT privileges on SYS.DBA_TABLES to the APPLSYS account. Normally this step would already have been done as part of your installation or upgrade.

2. Select the tables you want to audit in the Audit Groups window, and select which columns in these tables you want to audit in the Audit Tables window.

   **Note:** You cannot audit LONG, RAW, or LONG RAW columns.

3. Select the registered ORACLE IDs you want to audit in the Audit Installations window.

4. Run the Audit Trail Update Tables process. You do this in the Submit Requests window for a System Administrator responsibility. This process:
• creates database triggers on your audited tables
• creates one shadow table for each audited table, to contain the audit information
• builds special views on non-datetracked tables, which you can use to retrieve your audit data for reporting

5. Run the Audit Trail Update Datetracked Tables process. You do this in the Submit Requests window for an HRMS responsibility. For each datetracked table, this process:

• creates an index on the shadow table
• creates the function <tablename>_TT and the procedure <tablename>_VP, which extracts information from the shadow table when you run the predefined audit report

Attention: You must rerun these processes any time you update any of your audit definitions.

Disabling AuditTrail

You can disable the auditing of an audit group at any time by selecting a Disable state in the Audit Groups window.

Suggestion: If you are planning high volume transactions on an audited table, such as loading a batch of information from another system, consider disabling auditing for the table’s audit group. This will enable the batch loading to complete more quickly.

Before you restart auditing, you should archive your audit data, according to your business needs, and purge the shadow tables. You purge the tables by setting the audit group to Disable – Purge Table and running the Audit Trail Update Tables report. To restart auditing, you set the audit group to Enable Requested and rerun the Audit Trail Update Tables process and the Audit Trail Update Datetracked Tables process.

See Also

Setting Up Release 10 AuditTrail
Oracle Applications System Administrator’s Guide
Disabling AuditTrail and Archiving Audit Data
Oracle Applications System Administrator’s Guide
Reporting on Audit Information

For any non-datetracked tables, you can write a report that uses the views on the shadow tables to access the audit data. However, for datetracked tables, the information from the shadow tables must be extracted and written to the HR_AUDITS table and the HR_AUDIT_COLUMNS table before you can report on it.

The Oracle HRMS audit report performs this additional processing. You can use it as supplied or as an example of how to report on audit information. It can report on both datetracked and non-datetracked tables that have a numeric primary key.

**Note:** It can report on up to approximately 90 columns in datetracked tables and 80 columns in non-datetracked tables.

The report lists every change made to the table you select in the time period you specify when you run the report. You can restrict the reported changes to those made by a specified username. The changes are listed by date and time of the change. For each change, the report shows:

- the date and time of the change
- the user id who made the change
- the type of change
- the fields that changed and either their old values, or their new values, or both, depending on the type of change

Table 34 – 1 lists the 12 types of change and what information is shown in the audit report for each type.

<table>
<thead>
<tr>
<th>Type of Change</th>
<th>Field Values Shown in the Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal Insert (creates a non-datetracked record)</td>
<td>The non-null values in the new record.</td>
</tr>
<tr>
<td>Normal Update (updates a non-datetracked record)</td>
<td>The old and new values for all fields that changed.</td>
</tr>
<tr>
<td>Normal Delete (deletes a non-datetracked record)</td>
<td>The non-null values in the record that was deleted.</td>
</tr>
<tr>
<td>DT First Insert (creates a datetracked record)</td>
<td>The non-null values in the new record.</td>
</tr>
<tr>
<td>DT Update (date-effectively ends the last row on a datetracked record and creates a new row)</td>
<td>The old and new values of all fields that changed, and the new effective end date on the old row.</td>
</tr>
</tbody>
</table>

Table 34 – 1 Transaction Types in the Audit Report
<table>
<thead>
<tr>
<th>Type of Change</th>
<th>Field Values Shown in the Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>DT Correction</td>
<td>The old and new values of all fields that changed, and the effective dates of the corrected row.</td>
</tr>
<tr>
<td>DT Replace</td>
<td>The non-null values in the rows that were deleted, the new effective end date on the row preceding the new row, and the old and new values of all fields that changed.</td>
</tr>
<tr>
<td>DT Insert</td>
<td>The old and new values of all fields that changed, and the new effective end date on the row preceding the new row.</td>
</tr>
<tr>
<td>DT Purge</td>
<td>The non-null values in all rows of the record that was deleted.</td>
</tr>
<tr>
<td>DT End Date</td>
<td>The new effective end date of the row.</td>
</tr>
<tr>
<td>DT All</td>
<td>The non-null values in the rows that were deleted, and the new effective end date on the last row.</td>
</tr>
<tr>
<td>DT Next</td>
<td>The non-null values in the row that was deleted, and the old and new effective end dates on the preceding row.</td>
</tr>
</tbody>
</table>

Table 34 – 1 Transaction Types in the Audit Report

To run the predefined audit report:
1. In the Submit Requests window, select Audit Report in the Name field.
2. Enter the Parameters field to open the Parameters window.
3. Select an audited table (that is, one in an audit group).
4. Select a value for the Initialization parameter:
   - **Yes** means that the report removes obsolete data related to your selected table from the HR_AUDITS table and the HR_AUDIT_COLUMNS table. It populate the tables with new values, then reports on these.
   - **No** means that the report runs on the existing data in the HR_AUDITS table and the HR_AUDIT_COLUMNS table.
• Refresh means that the report removes all obsolete data from the HR_AUDITS table and the HR_AUDIT_COLUMNS table. It populate the tables with new values, then reports on these.

5. If you only want to report on the changes made by one user, enter the username.

6. Enter start and end dates to limit the time period for reporting audit information.

7. Choose the Submit button.

You can use the View Requests window to check the progress of the report.

Designing Your Own Audit Report

If you want to design your own audit report, you can copy the supplied report and use it as the basis of your own version. The supplied report uses a dynamic SQL structure to retrieve information for the report, and an Oracle Report to format it.

Dynamic SQL Structure

For a non-datetracked table, the dynamic SQL structure retrieves information and uses a private procedure to retrieve the new values for an update.

For a datetracked table, the dynamic SQL structure retrieves information from the function and procedure created for each datetracked table by the Audit Trail Update Datetracked Tables process:

• The <tablename>_TT function identifies the type of datetracked transaction represented by each row of the shadow table.

• The <tablename>_VP procedure gets new values from the shadow table for update and insert transactions. It writes these to the HR_AUDITS and HR_AUDIT_COLUMNS tables.

The dynamic SQL structure comprises several character strings, which are concatenated into one long string, then parsed and executed using the dynamic SQL generator. If you change a string, you must ensure that you do not exceed the text space allocated to it, as listed in the package header.

The structure is built up by identifying the audited table column information, which is retrieved from the FND_AUDIT_COLUMNS table. The logic varies depending on the data type being audited.
The package for the dynamic SQL is called pyAudit_report_pkg. It is found in the script pyadyn.pkh/pyadyn.pkb.

**HR Audit Tables**

The HR_AUDITS table holds audit information about the transaction. The HR_AUDIT_COLUMNS table holds the changed column information for that transaction. The structure of these tables is as follows:

**HR_AUDITS Table**

<table>
<thead>
<tr>
<th>COLUMN</th>
<th>TYPE</th>
<th>NULL</th>
</tr>
</thead>
<tbody>
<tr>
<td>audit_id</td>
<td>number(15)</td>
<td>not null</td>
</tr>
<tr>
<td>commit_id</td>
<td>number(9)</td>
<td>not null</td>
</tr>
<tr>
<td>current_session_id</td>
<td>number(9)</td>
<td>not null</td>
</tr>
<tr>
<td>primary_key</td>
<td>varchar2(30)</td>
<td>not null</td>
</tr>
<tr>
<td>primary_key_value</td>
<td>number(15)</td>
<td>not null</td>
</tr>
<tr>
<td>sequence_id</td>
<td>number(9)</td>
<td>not null</td>
</tr>
<tr>
<td>session_id</td>
<td>number(9)</td>
<td>not null</td>
</tr>
<tr>
<td>table_name</td>
<td>varchar2(30)</td>
<td>not null</td>
</tr>
<tr>
<td>timestamp</td>
<td>date</td>
<td>not null</td>
</tr>
<tr>
<td>transaction</td>
<td>varchar2(30)</td>
<td>not null</td>
</tr>
<tr>
<td>transaction_type</td>
<td>varchar2(30)</td>
<td>not null</td>
</tr>
<tr>
<td>user_name</td>
<td>varchar2(100)</td>
<td>not null</td>
</tr>
<tr>
<td>effective_end_date</td>
<td>date</td>
<td>null</td>
</tr>
<tr>
<td>effective_start_date</td>
<td>date</td>
<td>null</td>
</tr>
</tbody>
</table>

**HR_AUDIT_COLUMNS Table**

<table>
<thead>
<tr>
<th>COLUMN</th>
<th>TYPE</th>
<th>NULL</th>
</tr>
</thead>
<tbody>
<tr>
<td>audit_id</td>
<td>number(15)</td>
<td>not null</td>
</tr>
<tr>
<td>column_id</td>
<td>number(9)</td>
<td>not null</td>
</tr>
<tr>
<td>column_name</td>
<td>varchar2(30)</td>
<td>not null</td>
</tr>
<tr>
<td>new_value</td>
<td>varchar2(240)</td>
<td>null</td>
</tr>
<tr>
<td>old_value</td>
<td>varchar2(240)</td>
<td>null</td>
</tr>
</tbody>
</table>
This appendix shows you the default menu path for every window in Oracle Human Resources and Oracle Payroll. Refer to chapter 30 Customizing Windows and Menus for information about setting up your own menu structures.

The first two sections show the structure of the default menus for the default responsibilities. The third section is arranged alphabetically by window title and shows how to find each window.
# Default Navigation Menus for HR with Payroll Responsibility

<table>
<thead>
<tr>
<th>MENU ENTRY</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>People</td>
<td>Enter personal and assignment information</td>
</tr>
<tr>
<td></td>
<td>Enter people, assignments, and applications</td>
</tr>
<tr>
<td>1 Person</td>
<td></td>
</tr>
<tr>
<td>2 Address</td>
<td></td>
</tr>
<tr>
<td>2 Picture</td>
<td></td>
</tr>
<tr>
<td>2 Assignment</td>
<td>3 Salary</td>
</tr>
<tr>
<td>2 Special Info</td>
<td>3 Entries</td>
</tr>
<tr>
<td>2 Bookings</td>
<td>3 Tax Information</td>
</tr>
<tr>
<td>2 Absence</td>
<td>3 Pay Method</td>
</tr>
<tr>
<td>2 Contact</td>
<td>3 Costing</td>
</tr>
<tr>
<td>2 Application</td>
<td>3 Grade Step</td>
</tr>
<tr>
<td>3 Address</td>
<td>3 Budgets</td>
</tr>
<tr>
<td>3 Interview</td>
<td>3 Secondary Status</td>
</tr>
<tr>
<td>3 Secondary Status</td>
<td>3 Salary History</td>
</tr>
<tr>
<td>3 Budgets</td>
<td>3 Entry History</td>
</tr>
<tr>
<td>2 Competence Profile</td>
<td>3 Reviews</td>
</tr>
<tr>
<td>2 Qualifications</td>
<td>3 P45</td>
</tr>
<tr>
<td>2 Work Choices</td>
<td>3 QuickPay</td>
</tr>
<tr>
<td>2 Schools and Colleges Attended</td>
<td>3 Statement of Earnings</td>
</tr>
<tr>
<td>2 End Application</td>
<td>3 External/Manual Payment</td>
</tr>
<tr>
<td>2 End Employment</td>
<td>3 Reverse Run</td>
</tr>
<tr>
<td>2 Phones</td>
<td>3 Adjust Balance</td>
</tr>
<tr>
<td>2 Payroll</td>
<td>3 Advance Pay</td>
</tr>
</tbody>
</table>

- **Events and Bookings**: Enter events and bookings
- **Delete Personal Records**: Remove all records for any person
- **Salary Management**: Manage salary details
- **FastPath**: Enter personal and assignment information quickly
<table>
<thead>
<tr>
<th>MENU ENTRY</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Enter address details</td>
</tr>
<tr>
<td>Picture</td>
<td>Enter pictures for a person</td>
</tr>
<tr>
<td>Special Information</td>
<td>Enter special information</td>
</tr>
<tr>
<td>Contact Information</td>
<td>Enter contact information</td>
</tr>
<tr>
<td>Event for Person</td>
<td>Book a training event</td>
</tr>
<tr>
<td>Phone Numbers</td>
<td>Enter phone numbers</td>
</tr>
<tr>
<td>Absence Information</td>
<td>Enter absence information</td>
</tr>
<tr>
<td>Application</td>
<td>Enter application details</td>
</tr>
<tr>
<td>End Application</td>
<td>End a person’s application</td>
</tr>
<tr>
<td>Assignment</td>
<td>Enter a person’s assignment details</td>
</tr>
<tr>
<td>Assignment Costing</td>
<td>Enter costing for an assignment</td>
</tr>
<tr>
<td>Assignment Budget Values</td>
<td>Enter budget values for an assignment</td>
</tr>
<tr>
<td>Grade Step Placement</td>
<td>Enter grade step placement details</td>
</tr>
<tr>
<td>Secondary Status</td>
<td>Enter a person’s secondary status</td>
</tr>
<tr>
<td>Pay Method</td>
<td>Enter a pay method</td>
</tr>
<tr>
<td>End Employment</td>
<td>End a person’s employment</td>
</tr>
<tr>
<td>Employee Review</td>
<td>Perform an employee review</td>
</tr>
<tr>
<td>Salary Review</td>
<td>Perform a Salary Review</td>
</tr>
<tr>
<td>Salary History</td>
<td>View a person’s salary history</td>
</tr>
<tr>
<td>Element Entry</td>
<td>Enter compensation and benefits for employee assignment</td>
</tr>
<tr>
<td>Accruals</td>
<td>View net accruals to date</td>
</tr>
<tr>
<td>UK Tax Statement</td>
<td>Enter and view PAYE and NI information</td>
</tr>
<tr>
<td>UK Statement of Earnings</td>
<td>View statement of earnings</td>
</tr>
<tr>
<td>UK P45 Form</td>
<td>Print a P45 form</td>
</tr>
<tr>
<td>Adjust Balances</td>
<td>Adjust balances</td>
</tr>
<tr>
<td>QuickPay</td>
<td>Run QuickPay</td>
</tr>
<tr>
<td>Reverse Payroll</td>
<td>Run a reverse payroll</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>External Manual Payments</td>
<td>Enter external or manual payments</td>
</tr>
<tr>
<td>Recruitment</td>
<td>Manage recruiting</td>
</tr>
<tr>
<td>Requisition and Vacancy</td>
<td>Enter a requisition and any vacancies</td>
</tr>
<tr>
<td>Recruitment Activity</td>
<td>Enter a recruitment activity</td>
</tr>
<tr>
<td>Applicant Quick Entry</td>
<td>Quick entry of personal and application information</td>
</tr>
<tr>
<td>Mass Update of Applicants</td>
<td>Mass Update of Applicants</td>
</tr>
<tr>
<td>Request Recruitment Letter</td>
<td>Request a mailmerge file or a standard letter</td>
</tr>
<tr>
<td>Career Management</td>
<td>Career Management</td>
</tr>
<tr>
<td>Rating Scales</td>
<td>Define general methods of measuring competencies</td>
</tr>
<tr>
<td>Competencies</td>
<td>Define competencies</td>
</tr>
<tr>
<td>Competence Types</td>
<td>Group competencies into types</td>
</tr>
<tr>
<td>Competence Requirements</td>
<td>Define requirements for enterprise, organizations, jobs and positions</td>
</tr>
<tr>
<td>Schools &amp; Colleges</td>
<td>Define name and location of training establishments</td>
</tr>
<tr>
<td>Qualification Types</td>
<td>Define, categorize and rank qualifications</td>
</tr>
<tr>
<td>Assessment Template</td>
<td>Select competencies and rating scale for an assessment</td>
</tr>
<tr>
<td>Appraisal Template</td>
<td>Select questionnaire and rating scale for an appraisal</td>
</tr>
<tr>
<td>Work Structures</td>
<td>Enter work structures</td>
</tr>
<tr>
<td>Location</td>
<td>Enter locations</td>
</tr>
<tr>
<td>Organization</td>
<td>Enter organizational information</td>
</tr>
<tr>
<td>Description</td>
<td>Enter information for an organization</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>Structure organizations into hierarchies</td>
</tr>
<tr>
<td>Job</td>
<td>Enter job–related information</td>
</tr>
<tr>
<td>Description</td>
<td>Enter job names</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Path Name</td>
<td>Enter names for job career paths</td>
</tr>
<tr>
<td>Career Path</td>
<td>Enter career paths for jobs</td>
</tr>
<tr>
<td>Position</td>
<td>Enter position-related information</td>
</tr>
<tr>
<td>Description</td>
<td>Enter position names</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>Structure positions into hierarchies</td>
</tr>
<tr>
<td>Mass Move</td>
<td>Enter details of a mass move</td>
</tr>
<tr>
<td>Grade</td>
<td>Enter grade-related information</td>
</tr>
<tr>
<td>Description</td>
<td>Enter grade names</td>
</tr>
<tr>
<td>Grade Rate</td>
<td>Enter rates and values for grades</td>
</tr>
<tr>
<td>Pay Scale</td>
<td>Create a pay scale of fixed progression points</td>
</tr>
<tr>
<td>Point Values</td>
<td>Enter values for progression points</td>
</tr>
<tr>
<td>Grade Steps and Points</td>
<td>Enter grade steps and fixed point values for each step</td>
</tr>
<tr>
<td>Salary Basis</td>
<td>Enter available salary bases for salary administration</td>
</tr>
<tr>
<td>Budget Calendar</td>
<td>Define calendars for headcount and position budgets</td>
</tr>
<tr>
<td>Budget</td>
<td>Enter headcount and position budgets</td>
</tr>
<tr>
<td>Status</td>
<td>Define employee and applicant assignment statuses</td>
</tr>
<tr>
<td>Recruitment Letter Type</td>
<td>Associate letter types with applicant statuses</td>
</tr>
<tr>
<td>Payroll</td>
<td>Enter information for payrolls</td>
</tr>
<tr>
<td>Description</td>
<td>Enter payroll groups</td>
</tr>
<tr>
<td>Consolidation</td>
<td>Define consolidation sets for payroll run results</td>
</tr>
<tr>
<td>Payment Methods</td>
<td>Define available payment methods</td>
</tr>
<tr>
<td>GL Flexfield Map</td>
<td>Map payroll costing to Oracle GL flexfield segments</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Update Payroll</td>
<td>Update consolidation set or pay advice date</td>
</tr>
<tr>
<td>Run</td>
<td></td>
</tr>
<tr>
<td>Assignment Set</td>
<td>Define employee assignment sets</td>
</tr>
<tr>
<td>Element Set</td>
<td>Define element and distribution sets</td>
</tr>
<tr>
<td>RetroPay Set</td>
<td>Define retropay sets using balances and elements</td>
</tr>
<tr>
<td>Exchange Rates</td>
<td>Enter exchange rates for your base currency</td>
</tr>
<tr>
<td>Monetary Units</td>
<td>Enter monetary units for cash analysis and distribution</td>
</tr>
</tbody>
</table>

**Compensation and Benefits**
- Enter information on compensation and benefits
- Element Description: Enter compensation and benefit information
- Link: Enter eligibility rules for compensations and benefits
- Absence Types: Define absence types
- Accrual Plans: Enter accrual plans
- Write Formulas: Enter and modify formulas
- Formula Results: Define what happens to formula results
- Global Values: Enter global values for use in formulas
- Balance: Enter balances with feeds and dimensions
- Classification: Define additional element classifications

**View Histories**
- Employee Assignment: Employee assignment history
- Absence: Employee absence history folder
- Run Results: Employee run result history
- Salary: Salary history for an employee assignment
  - 1 Assignment Folder ——> 2 Salary History
<table>
<thead>
<tr>
<th>MENU ENTRY</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Entries</strong></td>
<td></td>
</tr>
<tr>
<td>1 Assignment Folder</td>
<td></td>
</tr>
<tr>
<td>2 Entry History</td>
<td>Entry history for an employee assignment</td>
</tr>
<tr>
<td><strong>Lists</strong></td>
<td></td>
</tr>
<tr>
<td>People Folder</td>
<td>People folder</td>
</tr>
<tr>
<td>Assignment Folder</td>
<td>Assignment folder</td>
</tr>
<tr>
<td>People by Assignment</td>
<td>List people by assignment folder</td>
</tr>
<tr>
<td>Assignments</td>
<td>List assignments folder</td>
</tr>
<tr>
<td>Employees by Organization</td>
<td>List employees by organization folder</td>
</tr>
<tr>
<td>Employees by Position</td>
<td>List employees by position folder</td>
</tr>
<tr>
<td>Emps by Position Hierarchy</td>
<td>List employees by position hierarchy folder</td>
</tr>
<tr>
<td>Employees by Element</td>
<td>List employees by element</td>
</tr>
<tr>
<td>Employees by Absence Type</td>
<td>List employees by absence type folder</td>
</tr>
<tr>
<td>People by Special Information</td>
<td>List people by special information folder</td>
</tr>
<tr>
<td><strong>Vacancies</strong></td>
<td></td>
</tr>
<tr>
<td>View vacancies folder</td>
<td></td>
</tr>
<tr>
<td><strong>Organization Budgets</strong></td>
<td></td>
</tr>
<tr>
<td>View organization budget variance folder</td>
<td></td>
</tr>
<tr>
<td><strong>Position Budgets</strong></td>
<td></td>
</tr>
<tr>
<td>View position budget variance folder</td>
<td></td>
</tr>
<tr>
<td><strong>Grade Comparatio</strong></td>
<td></td>
</tr>
<tr>
<td>View employee grade comparatio folder</td>
<td></td>
</tr>
<tr>
<td><strong>Employee Accruals</strong></td>
<td></td>
</tr>
<tr>
<td>View net accruals to date</td>
<td></td>
</tr>
<tr>
<td><strong>Payroll Process Results</strong></td>
<td>View process results for a payroll</td>
</tr>
<tr>
<td><strong>Assignment Process Results</strong></td>
<td>View process results for an employee assignment</td>
</tr>
<tr>
<td><strong>System Messages</strong></td>
<td>View system level messages</td>
</tr>
<tr>
<td><strong>Processes and Reports</strong></td>
<td></td>
</tr>
<tr>
<td>Submit processes or run standard reports</td>
<td></td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>View Requests</td>
<td>View any requests submitted for processing</td>
</tr>
<tr>
<td>View Reports</td>
<td>View reports online</td>
</tr>
<tr>
<td>Workflow Notifications</td>
<td>Workflow Notifications In–Box</td>
</tr>
<tr>
<td>Define a QuickPaint Report</td>
<td>Set up the report layout</td>
</tr>
<tr>
<td>Run a QuickPaint Report</td>
<td>View or print the report for a set of people</td>
</tr>
<tr>
<td>Generate MS Word Letter</td>
<td>Generate MS Word Letter</td>
</tr>
<tr>
<td>Submit Custom Reports</td>
<td>Submit custom reports</td>
</tr>
<tr>
<td>Mass Information eXchange: MIX</td>
<td>Enter timecard and other information batches</td>
</tr>
<tr>
<td>Batch Element Entry</td>
<td>Enter, validate, and transfer element entry batches.</td>
</tr>
<tr>
<td>Other Definitions</td>
<td>Other Definitions</td>
</tr>
<tr>
<td>Person Types</td>
<td>Enter names for types of employees, applicants and other people</td>
</tr>
<tr>
<td>QuickCode Values</td>
<td>Enter values and meanings for QuickCode types</td>
</tr>
<tr>
<td>QuickCode Types</td>
<td>Define your own QuickCode types</td>
</tr>
<tr>
<td>Special Information Types</td>
<td>Join special information types to the current business group</td>
</tr>
<tr>
<td>Table Structure</td>
<td>Set up tables you require</td>
</tr>
<tr>
<td>Table Values</td>
<td>Enter table values</td>
</tr>
<tr>
<td>Time Periods</td>
<td>Define time period types for use in budget calendars</td>
</tr>
<tr>
<td>User Profile Options</td>
<td>Review your personal profile options</td>
</tr>
<tr>
<td>Formula Functions</td>
<td>Register your user defined functions</td>
</tr>
<tr>
<td>Security</td>
<td>Define security restrictions</td>
</tr>
<tr>
<td>Profile</td>
<td>Define security profiles to restrict record access</td>
</tr>
<tr>
<td>CustomForm</td>
<td>Define customizations to restrict information access in windows</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>Report Sets</td>
<td>Define sets to restrict report and process access</td>
</tr>
<tr>
<td>Task Flow Nodes</td>
<td>Define task flow nodes and customizations</td>
</tr>
<tr>
<td>Task Flow Definitions</td>
<td>Define task flows</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>People</strong></td>
<td>Enter personal and assignment information</td>
</tr>
<tr>
<td>Enter and Maintain</td>
<td>Enter people, assignments, and applications</td>
</tr>
<tr>
<td><strong>1 Person</strong></td>
<td></td>
</tr>
<tr>
<td>2 Address</td>
<td>3 Salary</td>
</tr>
<tr>
<td>2 Picture</td>
<td>3 Entries</td>
</tr>
<tr>
<td>2 Assignment</td>
<td>3 Pay Method</td>
</tr>
<tr>
<td>2 Special Info</td>
<td>3 Costing</td>
</tr>
<tr>
<td>2 Bookings</td>
<td>3 Grade Step</td>
</tr>
<tr>
<td>2 Absence</td>
<td>3 Budgets</td>
</tr>
<tr>
<td>2 Contact ––––&gt;</td>
<td>3 Secondary Status</td>
</tr>
<tr>
<td>2 Application –&gt;</td>
<td>3 Salary History</td>
</tr>
<tr>
<td>2 Competence Profile</td>
<td>3 Entry History</td>
</tr>
<tr>
<td>2 Qualifications</td>
<td>3 Reviews</td>
</tr>
<tr>
<td>2 Work Choices</td>
<td></td>
</tr>
<tr>
<td>2 Schools and Colleges Attended</td>
<td></td>
</tr>
<tr>
<td>2 End Application</td>
<td></td>
</tr>
<tr>
<td>2 End Employment</td>
<td></td>
</tr>
<tr>
<td>2 Phones</td>
<td></td>
</tr>
<tr>
<td><strong>Events and Bookings</strong></td>
<td>Enter events and bookings</td>
</tr>
<tr>
<td><strong>Delete Personal Records</strong></td>
<td>Remove all records for any person</td>
</tr>
<tr>
<td><strong>Salary Management</strong></td>
<td>Manage salary details</td>
</tr>
<tr>
<td><strong>FastPath</strong></td>
<td>Enter personal and assignment information quickly</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Address</td>
<td>Enter address details</td>
</tr>
<tr>
<td>Picture</td>
<td>Enter pictures for a person</td>
</tr>
<tr>
<td>Special Information</td>
<td>Enter special information</td>
</tr>
<tr>
<td>Contact Information</td>
<td>Enter contact information</td>
</tr>
<tr>
<td>Event for Person</td>
<td>Book a training event</td>
</tr>
<tr>
<td>Phone Numbers</td>
<td>Enter phone numbers</td>
</tr>
<tr>
<td>Absence Information</td>
<td>Enter absence information</td>
</tr>
<tr>
<td>Application</td>
<td>Enter application details</td>
</tr>
<tr>
<td>End Application</td>
<td>End a person’s application</td>
</tr>
<tr>
<td>Assignment</td>
<td>Enter a person’s assignment details</td>
</tr>
<tr>
<td>Assignment Costing</td>
<td>Enter costing for an assignment</td>
</tr>
<tr>
<td>Assignment Budget Values</td>
<td>Enter budget values for an assignment</td>
</tr>
<tr>
<td>Grade Step Placement</td>
<td>Enter grade step placement details</td>
</tr>
<tr>
<td>Secondary Status</td>
<td>Enter a person’s secondary status</td>
</tr>
<tr>
<td>Pay Method</td>
<td>Enter a pay method</td>
</tr>
<tr>
<td>End Employment</td>
<td>End a person’s employment</td>
</tr>
<tr>
<td>Employee Review</td>
<td>Perform an employee review</td>
</tr>
<tr>
<td>Salary Review</td>
<td>Perform a Salary Review</td>
</tr>
<tr>
<td>Salary History</td>
<td>View a person’s salary history</td>
</tr>
<tr>
<td>Element Entry</td>
<td>Enter compensation and benefits for employee assignment</td>
</tr>
<tr>
<td>Accruals</td>
<td>View net accruals to date</td>
</tr>
<tr>
<td>Recruitment</td>
<td>Manage recruiting</td>
</tr>
<tr>
<td>Requisition and Vacancy</td>
<td>Enter a requisition and any vacancies</td>
</tr>
<tr>
<td>Recruitment Activity</td>
<td>Enter a recruitment activity</td>
</tr>
<tr>
<td>Applicant Quick Entry</td>
<td>Quick entry of personal and application information</td>
</tr>
<tr>
<td>Mass Update of Applicants</td>
<td>Mass Update of Applicants</td>
</tr>
<tr>
<td>Request Recruitment Letter</td>
<td>Request a mailmerge file or a standard letter</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Career Management</td>
<td>Career Management</td>
</tr>
<tr>
<td>Rating Scales</td>
<td>Define general methods of measuring competencies</td>
</tr>
<tr>
<td>Competencies</td>
<td>Define competencies</td>
</tr>
<tr>
<td>Competence Types</td>
<td>Group competencies into types</td>
</tr>
<tr>
<td>Competence Requirements</td>
<td>Define requirements for enterprise, organizations, jobs and positions</td>
</tr>
<tr>
<td>Schools &amp; Colleges</td>
<td>Define name and location of training establishments</td>
</tr>
<tr>
<td>Qualification Types</td>
<td>Define, categorize and rank qualifications</td>
</tr>
<tr>
<td>Assessment Template</td>
<td>Select competencies and rating scale for an assessment</td>
</tr>
<tr>
<td>Appraisal Template</td>
<td>Select questionnaire and rating scale for an appraisal</td>
</tr>
<tr>
<td>Work Structures</td>
<td>Enter work structures</td>
</tr>
<tr>
<td>Location</td>
<td>Enter locations</td>
</tr>
<tr>
<td>Organization</td>
<td>Enter organizational information</td>
</tr>
<tr>
<td>Description</td>
<td>Enter information for an organization</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>Structure organizations into hierarchies</td>
</tr>
<tr>
<td>Job</td>
<td>Enter job–related information</td>
</tr>
<tr>
<td>Description</td>
<td>Enter job names</td>
</tr>
<tr>
<td>Path Name</td>
<td>Enter names for job career paths</td>
</tr>
<tr>
<td>Career Path</td>
<td>Enter career paths for jobs</td>
</tr>
<tr>
<td>Position</td>
<td>Enter position–related information</td>
</tr>
<tr>
<td>Description</td>
<td>Enter position names</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>Structure positions into hierarchies</td>
</tr>
<tr>
<td>Mass Move</td>
<td>Enter details of a mass move</td>
</tr>
<tr>
<td>Grade</td>
<td>Enter grade–related information</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Description</td>
<td>Enter grade names</td>
</tr>
<tr>
<td>Grade Rate</td>
<td>Enter rates and values for grades</td>
</tr>
<tr>
<td>Pay Scale</td>
<td>Create a pay scale of fixed progression points</td>
</tr>
<tr>
<td>Point Values</td>
<td>Enter values for progression points</td>
</tr>
<tr>
<td>Grade Steps and Points</td>
<td>Enter grade steps and fixed point values for each step</td>
</tr>
<tr>
<td>Salary Basis</td>
<td>Enter available salary bases for salary administration</td>
</tr>
<tr>
<td>Budget Calendar</td>
<td>Define calendars for headcount and position budgets</td>
</tr>
<tr>
<td>Budget</td>
<td>Enter headcount and position budgets</td>
</tr>
<tr>
<td>Status</td>
<td>Define employee and applicant assignment statuses</td>
</tr>
<tr>
<td>Recruitment Letter Type</td>
<td>Associate letter types with applicant statuses</td>
</tr>
<tr>
<td>Payroll</td>
<td>Enter information for payrolls</td>
</tr>
<tr>
<td>Description</td>
<td>Enter payroll groups</td>
</tr>
<tr>
<td>Payment Methods</td>
<td>Define available payment methods</td>
</tr>
<tr>
<td>Assignment Set</td>
<td>Define employee assignment sets</td>
</tr>
<tr>
<td>Element Set</td>
<td>Define element and distribution sets</td>
</tr>
<tr>
<td>Compensation and Benefits</td>
<td>Enter information on compensation and benefits</td>
</tr>
<tr>
<td>Element Description</td>
<td>Enter compensation and benefit information</td>
</tr>
<tr>
<td>Link</td>
<td>Enter eligibility rules for compensations and benefits</td>
</tr>
<tr>
<td>Absence Types</td>
<td>Define absence types</td>
</tr>
<tr>
<td>Accrual Plans</td>
<td>Enter accrual plans</td>
</tr>
<tr>
<td>Write Formulas</td>
<td>Enter and modify formulas</td>
</tr>
<tr>
<td>Global Values</td>
<td>Enter global values for use in formulas</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>View</td>
<td>View HRMS information</td>
</tr>
<tr>
<td>Histories</td>
<td></td>
</tr>
<tr>
<td>Employee Assignment</td>
<td>Employee assignment history</td>
</tr>
<tr>
<td>Absence</td>
<td>Employee absence history folder</td>
</tr>
<tr>
<td>Salary</td>
<td>Salary history for an employee assignment</td>
</tr>
<tr>
<td>1 Assignment 1 Assignment 2 Salary History Folder</td>
<td>Entry history for an employee assignment</td>
</tr>
<tr>
<td>1 Assignment 1 Assignment 2 Salary History Folder</td>
<td>Entry history for an employee assignment</td>
</tr>
<tr>
<td>Entries</td>
<td></td>
</tr>
<tr>
<td>People Folder</td>
<td>People folder</td>
</tr>
<tr>
<td>Assignment Folder</td>
<td>Assignment folder</td>
</tr>
<tr>
<td>People by Assignment</td>
<td>List people by assignment folder</td>
</tr>
<tr>
<td>Assignments</td>
<td>List assignments folder</td>
</tr>
<tr>
<td>Employees by Organization</td>
<td>List employees by organization folder</td>
</tr>
<tr>
<td>Employees by Position</td>
<td>List employees by position folder</td>
</tr>
<tr>
<td>Emps by Position Hierarchy</td>
<td>List employees by position hierarchy folder</td>
</tr>
<tr>
<td>Employees by Element</td>
<td>List employees by element</td>
</tr>
<tr>
<td>Employees by Absence Type</td>
<td>List employees by absence type folder</td>
</tr>
<tr>
<td>People by Special Information</td>
<td>List people by special information folder</td>
</tr>
<tr>
<td>Vacancies</td>
<td>View vacancies folder</td>
</tr>
<tr>
<td>Organization Budgets</td>
<td>View organization budget variance folder</td>
</tr>
<tr>
<td>Position Budgets</td>
<td>View position budget variance folder</td>
</tr>
<tr>
<td>Grade Comparatio</td>
<td>View employee grade comparatio folder</td>
</tr>
<tr>
<td>Employee Accruals</td>
<td>View net accruals to date</td>
</tr>
<tr>
<td>1 Assignment 1 Assignment 2 Accruals History Folder</td>
<td>View net accruals to date</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td><strong>Processes and Reports</strong></td>
<td></td>
</tr>
<tr>
<td>Submit Processes and Reports</td>
<td>Submit processes or run standard reports</td>
</tr>
<tr>
<td>View Requests</td>
<td>View any requests submitted for processing</td>
</tr>
<tr>
<td>Workflow Notifications</td>
<td>Workflow Notifications</td>
</tr>
<tr>
<td>View Reports</td>
<td>View reports online</td>
</tr>
<tr>
<td>In–Box</td>
<td></td>
</tr>
<tr>
<td>Define a QuickPaint Report</td>
<td>Set up the report layout</td>
</tr>
<tr>
<td>Run a QuickPaint Report</td>
<td>View or print the report for a set of people</td>
</tr>
<tr>
<td>Generate MS Word Letter</td>
<td>Generate MS Word Letter</td>
</tr>
<tr>
<td>Submit Custom Reports</td>
<td>Submit custom reports</td>
</tr>
<tr>
<td>Batch Element Entry</td>
<td>Enter, validate, and transfer element entry batches.</td>
</tr>
<tr>
<td><strong>Mass Information eXchange: MIX</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Other Definitions</strong></td>
<td></td>
</tr>
<tr>
<td>Person Types</td>
<td>Enter names for types of employees, applicants and other people</td>
</tr>
<tr>
<td>QuickCode Values</td>
<td>Enter values and meanings for QuickCode types</td>
</tr>
<tr>
<td>QuickCode Types</td>
<td>Define your own QuickCode types</td>
</tr>
<tr>
<td>Special Information Types</td>
<td>Join special information types to the current business group</td>
</tr>
<tr>
<td>Table Structure</td>
<td>Set up tables you require</td>
</tr>
<tr>
<td>Table Values</td>
<td>Enter table values</td>
</tr>
<tr>
<td>Time Periods</td>
<td>Define time period types for use in budget calendars</td>
</tr>
<tr>
<td>User Profile Options</td>
<td>Review your personal profile options</td>
</tr>
<tr>
<td>Formula Functions</td>
<td>Register your user defined functions</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td></td>
</tr>
<tr>
<td>Profile</td>
<td>Define security restrictions</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>CustomForm</td>
<td>Define customizations to restrict information access in windows</td>
</tr>
<tr>
<td>Report Sets</td>
<td>Define sets to restrict report and process access</td>
</tr>
<tr>
<td>Task Flow Nodes</td>
<td>Define task flow nodes and customizations</td>
</tr>
<tr>
<td>Task Flow Definitions</td>
<td>Define task flows</td>
</tr>
</tbody>
</table>
Windows and their Navigation Paths

This topic shows the default navigation paths for all the windows in Oracle HRMS, as they are supplied. You can use taskflow windows directly from the menu, or from the People and Assignment windows.

The responsibility that you use determines which of these windows you can use and how you access them. Your system administrator sets up navigation menus and task flows for your responsibility. They may also create customized versions of some of these windows using different window titles.

Absence Detail

Do one of the following:

1. Choose People –> Enter and Maintain in the Navigator.
2. Choose the Others button and select Absence.

Or:

2. In the resulting Find window, query the person.

Absence Attendance Type

- Choose Compensation and Benefits –> Absence Types in the Navigator.

Accrual Bands

2. Enter or query an accrual plan name.
3. Choose the Accrual Bands button.

Accrual Plans

Choose Compensation and Benefits –> Accrual Plans in the Navigator.

Accruals

Do one of the following:

1. Choose View –> Employee Accruals in the Navigator.
2. Run a query in the Assignments Folder window.
3. Select an employee assignment and choose the Accruals button.

Or:
1. Choose People -> Fastpath -> Accruals in the Navigator.
2. In the resulting Find window, query the person.

**Address**

Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query a person.
3. Choose the Address button.

Or:
1. Choose People -> Fastpath -> Address in the Navigator.
2. In the resulting Find window, query the person.

**Adjust Balance** (Oracle Payroll only)

Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Adjust Balance.

Or:
1. Choose People -> Fastpath -> Adjust Balances in the Navigator.
2. In the resulting Find window, query the person.

**Advance Pay** (Oracle Payroll only)

1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Advance Pay.

**Alter Effective Date**

- Choose the Alter Effective Date icon from the toolbar.
Applicant Entry
- Choose Recruitment –> Applicant Quick Entry in the Navigator.

Applicant Interview
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an applicant.
3. Choose the Others button and select Application.
4. Choose the Interview button.

Application
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an applicant.
3. Choose the Others button and select Application.
Or:
1. Choose People –> Fastpath –> Application in the Navigator.
2. In the resulting Find window, query the person.

Appraisal Template
- Choose Career Management –> Appraisal Template in the Navigator.

Assessment Template
- Choose Career Management –> Assessment Template in the Navigator.

Assign Monetary Units to a Currency (Oracle Payroll only)
- Choose Payroll –> Monetary Units in the Navigator.

Assignment
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
Or:
1. Choose People → Fastpath → Assignment in the Navigator.
2. In the resulting Find window, query the person.

Assignment Budget Values
Do one of the following:
1. Choose People → Enter and Maintain in the Navigator.
2. Enter or query an applicant or an employee.
3. Do one of the following:
   For an applicant:
   • Choose the Others button and select Application.
   • Choose the Budgets button.
   For an employee:
   • Choose the Assignment button.
   • Choose the Others button and select Budgets.
Or:
1. Choose People → Fastpath → Assignment Budget Values in the Navigator.
2. In the resulting Find window, query the person.

Assignment Criteria
1. Choose Payroll → Assignment Set in the Navigator.
2. Enter or query an assignment set.
3. Choose the Criteria button.

Assignment History
- Choose View → Histories → Employee Assignment in the Navigator.

Assignment Processes
1. Choose View → Payroll Process Results in the Navigator.
2. Enter or query a payroll process.
3. Choose the Assignment Process button.

Assignment Set
- Choose Payroll → Assignment Set in the Navigator.
Assignment Statuses

- Choose Work Structures \( \rightarrow \) Status in the Navigator.

Assignments Folder

- Choose View \( \rightarrow \) Lists \( \rightarrow \) Assignments Folder in the Navigator.

Balance (Oracle Payroll only)

- Choose Compensation and Benefits \( \rightarrow \) Balance in the Navigator.

Balance Classifications (Oracle Payroll only)

1. Choose Compensation and Benefits \( \rightarrow \) Balance in the Navigator.
2. Enter or query a balance.
3. Choose the Classifications button.

Balance Dimensions (Oracle Payroll only)

1. Choose Compensation and Benefits \( \rightarrow \) Balance in the Navigator.
2. Enter or query a balance.
3. Choose the Dimensions button.

Balance Feed Control (Oracle Payroll only)

1. Choose Compensation and Benefits \( \rightarrow \) Element Description in the Navigator.
2. Enter or query an element.
3. Choose the Balance Feed Control button.

Balance Feeds (Oracle Payroll only)

- Note: This instance of the Balance Feeds window lets you select more than one element to feed the balance.
1. Choose Compensation and Benefits \( \rightarrow \) Element in the Navigator.
2. Enter or query an element.
3. Choose the Feeds button.

**Batch Header**
- Choose Mass Information eXchange: MIX → Batch Element Entry in the Navigator.

**Batch Lines**
2. Choose the Lines button.

**Book Events**
1. Choose People → Enter and Maintain in the Navigator.
2. Enter or query an employee or applicant.
3. Choose the Others button and select Bookings.

**Budget**
- Choose Work Structures → Budget in the Navigator.

**Budget Value Defaults**
2. Enter or query a Business Group.
3. Choose the Others button and select Budget Value Defaults.

**Budgetary Calendar**
- Choose Work Structures → Budget Calendar in the Navigator.

**Business Group Information**
2. Enter or query a Business Group.
3. Choose the Others button and select Business Group Information.

**Career Path Names**
- Choose Work Structures → Job → Path Name in the Navigator.
Calendars (SSP/SMP only)
1. Choose SSP –> SSP Qualifying Patterns in the Navigator.
2. Enter or query a pattern.
3. Choose the Calendars button.

Calendar Usages (SSP/SMP only)
1. Choose SSP –> SSP Qualifying Patterns in the Navigator.
2. Enter or query a pattern.
3. Choose the Calendars button.
4. Choose the Calendar Usages button.

Columns
1. Choose Other Definitions –> Table Structure in the Navigator.
2. Enter or query a table.
3. Choose the Columns button.

Competence Profile
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query a person.
3. Choose the Others button and select Competence Profile.

Competence Requirements
- Choose Career Management –> Competence Requirements in the Navigator.

Competence Types
- Choose Career Management –> Competence Types in the Navigator.

Competencies
- Choose Career Management –> Competencies in the Navigator.

Concurrent Requests
- Choose Processes and Reports –> View Requests in the Navigator.

Consolidation Sets (Oracle Payroll only)
- Choose Payroll –> Consolidation in the Navigator.
Contact
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee or applicant.
3. Choose the Others button and select Contact.
Or:
1. Choose People –> Fastpath –> Contact Information in the Navigator.
2. In the resulting Find window, query the person.

Control Totals
2. Choose the Totals button.

Costing
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Costing.
Or:
2. In the resulting Find window, query the person.

Costing Information
2. Enter or query an organization.
3. Choose the Others button and select Costing Information.

Custom Reports
- Choose Processes and Reports –> Submit Custom Reports in the Navigator.
Database Items
1. Choose Compensation and Benefits -> Write Formulas in the Navigator.
2. Enter or query a formula.
3. Choose the Show Items button.

DateTrack History Change Field Summary
- Choose the DateTrack History icon from the toolbar.

Define Function
- Choose Other Definitions -> Formula Functions in the Navigator.

Define QuickPaint Report
- Choose Processes and Reports -> Define a QuickPaint Report in the Navigator.

Define Task Flow

Delete Person
- Choose People -> Delete Personal Records in the Navigator.

Edit Formula
1. Choose Compensation and Benefits -> Write Formulas in the Navigator.
2. Enter or query a formula.
3. Choose the Edit button.

Element
- Choose Compensation and Benefits -> Element Description in the Navigator.

Element and Distribution Set
- Choose Payroll -> Element Set in the Navigator.
**Element Classifications** (Oracle Payroll only)

- Choose Compensation and Benefits → Classification in the Navigator.

**Element Entries**

Do one of the following:

1. Choose People → Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Entries button.

Or:

1. Choose People → Fastpath → Element Entries in the Navigator.
2. In the resulting Find window, query the person.

**Element Link**

- Choose Compensation and Benefits → Link in the Navigator.

**Element Withholding Reasons** (SSP/SMP only)

- Choose SSP/SMP → Element Withholding Reasons in the Navigator.

**Employee Assignment Processes** (Oracle Payroll only)

- Choose View → Assignment Process Results in the Navigator.

**Employee Review**

Do one of the following:

1. Choose People → Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Reviews.

Or:

1. Choose People → Fastpath → Employee Review in the Navigator.
2. In the resulting Find window, query the person.
**Employee Run Result History** (Oracle Payroll only)

- Choose View -> Histories -> Run Results in the Navigator.

**End Application**

1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Others button and select End Application.

Or:

1. Choose People -> Fastpath -> End Application in the Navigator.
2. In the resulting Find window, query the person.

**End Employment**

Do one of the following:

1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Others button and select End Employment.

Or:

1. Choose People -> Fastpath -> End Employment in the Navigator.
2. In the resulting Find window, query the person.

**Entry Values**

Do one of the following:

- Choose People -> Enter and Maintain in the Navigator.

Or:

1. Choose People -> Fastpath -> Event for Person in the Navigator.

2. In the resulting Find window, query the person.
**Exchange Rates** (Oracle Payroll only)
- Choose Payroll –> Exchange Rates in the Navigator.

**External/Manual Payments** (Oracle Payroll only)
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select External Pay.
Or:
2. In the resulting Find window, query the person.

**Form Customization**
- Choose Security –> CustomForm in the Navigator.

**Formula**
- Choose Compensation and Benefits –> Write Formulas in the Navigator.

**Formula Result Rules** (Oracle Payroll only)
- Choose Compensation and Benefits –> Formula Results in the Navigator.

**GL Map** (Oracle Payroll only)
- Choose Payroll –> GL Flexfield Map in the Navigator.

**Globals**
- Choose Compensation and Benefits –> Global Values in the Navigator.

**Grade Rate**
- Choose Work Structures –> Grade –> Grade Rate in the Navigator.

**Grade Scale**
- Choose Work Structures –> Grade –> Grade Steps and Points in the Navigator.
Grade Step Placement
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Grade Step.
Or:
1. Choose People –> Fastpath –> Grade Step Placement in the Navigator.
2. In the resulting Find window, query the person.

Grades
- Choose Work Structures –> Grade –> Description in the Navigator.

Input Values
1. Choose Compensation and Benefits –> Element Description in the Navigator.
2. Enter or query an element.
3. Choose the Input Values button.

Job
- Choose Work Structures –> Job –> Description in the Navigator.

Job Evaluation
2. Enter or query a job.
3. Choose the Evaluation button.

Job Requirements
2. Enter or query a job.
3. Choose the Requirements button.

Letter
- Choose Work Structures –> Recruitment Letter Type in the Navigator.
Link Input Values
1. Choose Compensation and Benefits -> Link in the Navigator.
2. Enter or query an element.
3. Choose the Input Values button.

List Assignments
- Choose View -> Lists -> Assignments in the Navigator.

List Budget Variance by Organization
- Choose View -> Organization Budgets in the Navigator.

List Employees by Absence Type
- Choose View -> Lists -> Employees by Absence Type in the Navigator.

List Employees by Element
- Choose View -> Lists -> Employees by Element in the Navigator.

List Employees by Organization
- Choose View -> Lists -> Employees by Organization in the Navigator.

List Employees by Position
- Choose View -> Lists -> Employees by Position in the Navigator.

List Employees by Position Hierarchy
- Choose View -> Lists -> Emps by Position Hierarchy in the Navigator.

List People by Assignment
- Choose View -> Lists -> People by Assignment in the Navigator.

List People by Special Information
- Choose View -> Lists -> People by Special Information in the Navigator.

List Position Budget Variance
- Choose View -> Position Budgets in the Navigator.
**Location**
- Choose Work Structures -> Location in the Navigator.

**Map Career Path**
- Choose Work Structures -> Job -> Career Path in the Navigator.

**Mass Move**
- Choose Work Structures -> Mass Update in the Navigator.

**Mass Move – Assignments**
2. Complete the Mass Move window and save your work.
3. Choose the Positions button.
4. Complete the Find Positions window.
5. Choose the Find button.
7. Choose the Assignments button.

**Mass Move – Messages**
2. Complete the Mass Move window and save your work.
3. Choose the Positions button.
4. Complete the Find Positions window and choose the Find button.
5. Complete the Mass Move – Positions window and choose the Assignments button.
6. Complete the Mass Move – Assignments window and close it.
7. From the Mass Move – Positions window, choose the Valid Grades button.
8. Complete the Valid Grades window and close it.
10. From the Mass Move window, choose the Execute button.
11. If the Status field shows In Error or Complete with Warnings, a Message button appears.
12. If the Message button appears, choose it to view messages in the Mass Move – Messages window.

   **Note:** Alternatively, you can view messages for saved (but not yet successfully executed) mass moves as follows:
   
   2. Enter the name of the saved mass move in the Description field.
   3. When the Mass Move window is populated with data and the Message button appears, choose the Message button.

**Mass Move – Positions**

2. Complete the Mass Move window.
3. Save your work.
4. Choose the Positions button.
5. In the resulting Find Positions window, select or enter a Source Job and Source Position.
6. Choose the Find button.

**Mass Move – Valid Grades**

2. Complete the Mass Move window and save your work.
3. Choose the Positions button.
4. Complete the Find Positions window.
5. Choose the Find button.
7. Choose the Valid Grades button.

**Mass Update of Applicants**

- Choose Recruitment –> Mass Update of Applicants in the Navigator.

**Maternity (SSP/SMP only)**

1. Choose SSP/SMP –> Person Details in the Navigator.
2. Enter or query a person.
3. Choose the Maternity button.
Maternity Evidence (SSP/SMP only)
1. Choose SSP/SMP –> Person Details in the Navigator.
2. Enter or query a person.
3. Choose the Absence button.
4. Enter or query a maternity absence.
5. Choose the Evidence button.

Maternity Pay (SSP/SMP only)
1. Choose SSP/SMP –> Person Details in the Navigator.
2. Enter or query a person.
3. Choose the Absence button.
4. Enter or query a maternity absence.
5. Choose the SSP/SMP button.

Messages
2. Choose the Messages button.

MIX Batch Header
- Choose Mass Information eXchange: MIX –> Batch Element Entry in the Navigator.

MIX Batch Lines
2. Choose the Lines button.

Net Calculation Rules
2. Enter or query an accrual plan name.
3. Choose the Net Calculation Rules button.
Organization

Choose Work Structures -> Organization -> Description in the Navigator.

Organization Hierarchy

Choose Work Structures -> Organization -> Hierarchy in the Navigator.

Organizational Payment Method

Choose Payroll -> Payment Methods in the Navigator.

P45 (Oracle Payroll only)

Do one of the following:

1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Tax Information.

Or:

1. Choose People -> Fastpath -> UK P45 Form in the Navigator.
2. In the resulting Find window, query the person.

Parent Organization

2. Enter or query an organization.
3. Choose the Others button and select Parent Organization.

Pattern (SSP/SMP only)

Choose SSP/SMP -> SSP Qualifying Patterns in the Navigator.

Pattern Time Units (SSP/SMP only)

Choose SSP/SMP -> Pattern Time Units in the Navigator.

Pay Advice Report (Oracle Payroll only)

Do one of the following:

1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Statement of Earnings.

Or:
2. In the resulting Find window, query the person.

Pay Scale
- Choose Work Structures –> Grade –> Pay Scale in the Navigator.

Payroll Processes (Oracle Payroll only)
- Choose View –> Payroll Process Results in the Navigator.

People
- Choose People –> Enter and Maintain in the Navigator.

People Folder
- Choose View –> Lists –> People Folder in the Navigator.

Performance
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee, and choose the Assignment button.
3. Choose the Salary button.
4. Choose the Performance button.

Period Dates
1. Choose Payroll –> Description in the Navigator.
2. Enter or query a payroll.
3. Choose the Period Dates button.

Period Types
- Choose Other Definitions –> Time Periods in the Navigator.
Person Types
- Choose Other Definitions –> Person Types in the Navigator.

Personal Payment Method
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Pay Method button, or choose the Others button and select Pay Method.
Or:
2. In the resulting Find window, query the person.

Personal Profile Values
- Choose Other Definitions –> User Profile Options in the Navigator.

Phone Numbers
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Others button.
4. Choose Phones.
Or:
1. Choose People –> Fastpath –> Phone Numbers in the Navigator.
2. In the resulting Find window, query the person.

Picture
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator
2. Enter or query a person.
3. Choose the Picture button.
Or:
2. In the resulting Find window, query the person.

**Position**

- Choose Work Structures –> Position –> Description in the Navigator.

**Position Evaluation**

2. Enter or query a position.
3. Choose the Evaluation button.

**Position Hierarchy**


**Position Occupancy Folder**

2. Query a position.
3. Choose the Occupancy button.

**Position Reporting To**

2. Enter or query a position.
3. Choose the Reporting To button.

**Position Requirements**

2. Enter or query a position.
3. Choose the Requirements button.

**Prior Employment SSP (SSP1L) (SSP/SMP only)**

1. Choose SSP/SMP –> Person Details in the Navigator.
2. Enter or query a person.
3. Choose the SSP1L button.

Qualifications
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query a person.
3. Choose the Others button and select Qualifications.

Qualification Types
- Choose Career Management –> Qualification Types in the Navigator.

QuickCode Type Usages
1. Choose Other Definitions –> QuickCode Types in the Navigator.
2. Enter or query a user–defined Type.
3. Choose the Usages button.

QuickCode Types
- Choose Other Definitions –> QuickCode Types in the Navigator.

QuickCodes
- Choose Other Definitions –> QuickCode Values in the Navigator.

QuickPaint Inquiry
2. Query a report that has been run.
3. Choose the View Report button.

QuickPay (Oracle Payroll only)
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select QuickPay.
Or:
2. In the resulting Find window, query the person.

**Rating Scales**
- Choose Career Management –> Rating Scales in the Navigator.

**Recruiting For**
2. Enter or query a recruitment activity.
3. Choose the Recruiting For button.

**Recruitment Activity**
- Choose Recruitment –> Recruitment Activity in the Navigator.

**Request Letter**
- Choose Recruitment –> Request Recruitment Letter in the Navigator.

**Request Set**

**Requisition and Vacancy**
- Choose Recruitment –> Requisition and Vacancy in the Navigator.

**RetroPay Set** (Oracle Payroll only)
- Choose Payroll –> RetroPay Set in the Navigator.

**Reverse Payroll Run** (Oracle Payroll only)

Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Reverse Run.

Or:
2. In the resulting Find window, query the person.
Rows
1. Choose Other Definitions -> Table Structure in the Navigator.
2. Enter or query a table.
3. Choose the Rows button.

Run QuickPaint Report
- Choose Processes and Reports -> Run a QuickPaint Report in the Navigator.

Salary Administration
Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Salary button.

Or:
1. Choose People -> Fastpath -> Salary Administration in the Navigator.
2. In the resulting Find window, query the person.

Salary Basis
- Choose Work Structures -> Salary Basis in the Navigator.

Salary History
Do one of the following:
2. Run a query in the Assignments Folder window.
3. Select an employee assignment and choose the Salary History button.

Or:
1. Choose People -> Fastpath -> Salary History in the Navigator.
2. In the resulting Find window, query the person.

Salary Management Folder
- Choose People -> Salary Management in the Navigator.
Scale Rate

- Choose Work Structures -> Grade -> Point Values in the Navigator.

Schedules (SSP/SMP only)

1. Choose SSP/SMP -> SSP Qualifying Patterns in the Navigator.
2. Enter or query a pattern.
3. Choose the Calendars button.
4. Choose the Schedules button.

Schools and Colleges

- Choose Career Management -> Schools and Colleges in the Navigator.

Schools and Colleges (Attended)

1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query a person.
3. Choose the Others button and select Schools/Colleges.

Secondary Statuses

Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an applicant or employee.
3. Do one of the following:
   - For an applicant:
     - Choose the Others button and select Application.
     - Choose the Secondary Status button.
   - For an employee:
     - Choose the Assignment button.
     - Choose the Others button and select Secondary Status.

Or:
2. In the resulting Find window, query the person.
Security Profile

- Choose Security –> Profile in the Navigator.

Sickness Control Rules (SSP/SMP only)
2. Enter or query a Business Group
3. Choose the Others button and select Sickness Control Rules.

Sickness Evidence (SSP/SMP only)
1. Choose SSP/SMP –> Person Details in the Navigator.
2. Enter or query a person.
3. Choose the Absence button.
4. Enter or query a sickness absence.
5. Choose the Evidence button.

Sickness Pay (SSP/SMP only)
1. Choose SSP/SMP –> Person Details in the Navigator.
2. Enter or query a person.
3. Choose the Absence button.
4. Enter or query a sickness absence.
5. Choose the SSP/SMP button.

Special Information
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query a person.
3. Choose the Special Info button.
Or:
1. Choose People –> Fastpath –> Special Information in the Navigator.
2. In the resulting Find window, query the person.

Special Information Types
- Choose Other Definitions –> Special Information Types in the Navigator.
Statutory Details (Oracle Payroll only)
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Tax Information.

Or:
2. In the resulting Find window, query the person.

Submit a New Request
2. Select Single Request or a Request Set.

Table Structure
- Choose Other Definitions –> Table Structure in the Navigator.

Table Values
- Choose Other Definitions –> Table Values in the Navigator.

Tax Details References
2. Enter or query a Business Group.
3. Choose the Others button and select Tax Details References.

Update Payroll Run (Oracle Payroll only)
- Choose Payroll –> Update Payroll Run in the Navigator.

Valid Grades
2. Choose either Job –> Description or Position –> Description.
3. Enter or query a job or position.
4. Choose the Valid Grades button.
Valid Payment Methods
1. Choose Payroll –> Description in the Navigator.
2. Enter or query a payroll.
3. Choose the Valid Payment Methods button.

View Absence History
- Choose View –> Histories –> Absence in the Navigator.

View Element Entry History for Employee
2. Run a query in the Assignments Folder window.
3. Select an employee assignment and choose the Entry History button.

View Employee Grade Comparatio
- Choose View –> Grade Comparatio in the Navigator.

View Run Messages (Oracle Payroll only)
- Choose View –> System Messages in the Navigator.

View Vacancies
- Choose View –> Vacancies in the Navigator.

Work Choices (Job or Position)
2. Enter or query a job or position.
3. Choose the Work Choices button.

Work Choices (Person)
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query a person.
3. Choose the Others button and select Work Choices.

Work Day Information
2. Enter or query an organization.
3. Choose the Others button and select Work Day Information.

**Workflow Notifications**
- Choose Processes and Reports–> Workflow Notifications in the Navigator
Key and Descriptive Flexfields

A flexfield is a flexible field that allows you to customize and extend Oracle Applications. Each flexfield has the characteristics of separate fields known as segments. There are two types of flexfield:

- Descriptive flexfields allow you to define additional information you want to record in the windows.
- Key flexfields are the mechanism by which you customize some important parts of the system.

Both types of flexfield have also been used by localization teams to customize Oracle HRMS for your legislation.

This chapter lists the flexfields in Oracle HRMS and summarizes what you need to set up.
User Definable Key Flexfields

In Oracle HRMS there are six user definable key flexfields, for each of which you can define up to 30 segments:

- Job
- Position
- Grade
- People Group
- Personal Analysis
- Cost Allocation

The Personal Analysis key flexfield is different from the others. You can set up an unlimited number of structures for this flexfield. Each separate structure can have up to 30 segments.

How the Key Flexfields Are Used

Oracle HRMS uses key flexfields in a number of distinct ways:

**Unique Identifiers**

The Job, Position, and Grade Name flexfields let you create a unique name, which is a combination of separate components or segments. You use these flexfields when you are defining the work structures that exist in your enterprise.

*Suggestion:* When you are defining your requirements for these key flexfields you should consider the following points.

The task of defining the segment combinations is normally restricted to one or two users only. Therefore, you may not need to use value sets, or cross validation rule options to control the values that can be entered.

The names that users see are made up of a combination of segment values. The segment values are displayed, not the meanings.

Avoid segments containing information that may change regularly. There is no history of changes to the combinations you create. For example, do not define minimum and maximum values for grades as segments of the Grade flexfield.
Analysis Information
The People Group and Personal Analysis flexfields let you add key information to records of employee assignments and people. You can use the individual segments of these flexfields to identify or report on specific groups of people.

Payroll Costing
The Cost Allocation key flexfield is used to collect and to accumulate costs associated with running a payroll.

What You Must Set Up
The key flexfields are central to Oracle HRMS, therefore you must create certain definitions before you can set up your Business Group.

Job, Position, And Grade Key Flexfields
- You can only define one structure per Business Group for each of these flexfields.
- You can define up to 30 segments within the structure.
- Use of these flexfields is optional, but almost all Oracle HRMS installations use job and grade. Positions are used most often in large, highly structured enterprises, such as those in the areas of government, education, and health care.
- You must define a structure name for these three flexfields before you can define a Business Group.
- You associate these structures with a Business Group in the Business Group Information window, which opens from the Organization window.

People Group Key Flexfield
- You can only define one structure per Business Group for this flexfield.
- You can define up to 30 segments within the structure.
- You do not create separate combinations of segments for the People Group flexfield. You enter values for each employee as part of the employee assignment.
- You must define a structure name for this flexfield before you can define a Business Group.
• You must define at least one segment for the People Group flexfield in order to be able to use the Assignment window.

**Personal Analysis Key Flexfield**

• You can create any number of structures per Business Group for this flexfield. Each one represents a Special Information Type.

• You can define up to 30 segments within each structure.

• You do not need to define any structures for the Personal Analysis flexfield before you can use Oracle HRMS.

• You link each structure to a Business Group in the Special Information Types window while you are logged on to that Business Group.

• You can customize windows to restrict access to specific Information Types, such as medical or disciplinary information.

**Cost Allocation Key Flexfield**

• You can only define one structure per Business Group for this flexfield.

• You can define up to 30 segments within the structure.

• You can control the levels at which users can enter cost information by using the flexfield qualifiers.

• You must define a structure name for this flexfield before you can define a Business Group.

• A number of windows in Oracle HRMS check for the existence of a valid flexfield structure for Cost Allocation. You must define at least one segment for your Cost Allocation flexfield.

**Creating Key Flexfield Database Items**

The *Create Key Flexfield DB Items* process turns data in key flexfields into database items that Oracle FastFormula can access. It is essential to run this process whenever you create or change the Grade, Job, Position, or People Group key flexfield definitions. Submit the process from the Submit Requests window.

**See Also**

*Oracle Applications Flexfields Guide*
User Definable Descriptive Flexfields

All window blocks in which you can enter information contain a user definable descriptive flexfield. You decide in which blocks you want to record additional information. Each user definable descriptive flexfield has 20 segments that you can define. After you define a descriptive flexfield, Oracle HRMS treats the segments as part of the window.

For each segment, you can define its prompt, the type of data it can contain, and the values a user can enter. You can provide a list or range of valid values. You also control the size and display characteristics of each segment and the order in which the segments appear.

You can define two types of descriptive flexfield segments:

- Global segments, which always appear in the window.
- Context sensitive segments, that appear only when a defined context exists. You can prompt the user to provide the context, or you can provide the context automatically from a reference field in the same block.

For example, a segment to hold information about an employee’s disability might appear only when the Disabled field is checked.

**Attention:** Some descriptive flexfields appear in more than one window. For example, the *Additional Evaluation Details* flexfield appears in the Job Evaluation window and the Position Evaluation window.

Check all of the windows that use a descriptive flexfield before you define any of the segments. This is especially important if you intend to make the flexfield context sensitive to another field. You must ensure that the reference field is present in all of the windows that use the flexfield.

Refer to Table B – 1 for a full list of descriptive flexfields in Oracle HRMS.
Creating Descriptive Flexfield Database Items

You can use descriptive flexfield segments in QuickPaint reports and formulas if there are database items for these segments. Table B–1 marks the descriptive flexfields for which you can create database items. To do this you run the *Create Descriptive Flexfield DB Items* process. It is essential to run this process from the Submit Requests window whenever you create or change these descriptive flexfield definitions.

**Note:** The process can only create database items for global segments. It does not create database items for context–sensitive segments.

### List of Descriptive Flexfields

The following table lists all the descriptive flexfields in Oracle HRMS.

<table>
<thead>
<tr>
<th>Descriptive Flexfield Title</th>
<th>Window Title</th>
<th>Database Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Absence Details</td>
<td>Absence Detail, View Absence History</td>
<td>ABSENCES_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Absence Type Details</td>
<td>Absence Attendance Type</td>
<td>ABSENCE_TYPES_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Address Details</td>
<td>Address, Applicant Entry, Contact</td>
<td>PERSON_ADDRESSES_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Application Details</td>
<td>Applicant Entry, Application, Terminate Applicant</td>
<td>APPLICATIONS_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Assignment Details</td>
<td>Applicant Interview, Book Events, Employee Review,Event Bookings</td>
<td>ASSIGNMENTS_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Assignment Status Details</td>
<td>Secondary Statuses</td>
<td></td>
</tr>
<tr>
<td>Additional Balance Type Information</td>
<td>Balance (Oracle Payroll only)</td>
<td></td>
</tr>
<tr>
<td>Additional Benefit Contribution Details</td>
<td>Benefit Contributions (US only)</td>
<td></td>
</tr>
<tr>
<td>Additional Booking Details</td>
<td>Applicant Interview, Book Events, Employee Review,Event Bookings</td>
<td></td>
</tr>
</tbody>
</table>

**Table B–1 User Definable Descriptive Flexfields**
<table>
<thead>
<tr>
<th>Descriptive Flexfield Title</th>
<th>Window Title</th>
<th>Database Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Budget Details</td>
<td>Budget</td>
<td></td>
</tr>
<tr>
<td>Additional Budget Version Details</td>
<td>Budget</td>
<td></td>
</tr>
<tr>
<td>Additional Calendar Information</td>
<td>Budgetary Calendar</td>
<td></td>
</tr>
<tr>
<td>Additional Career Path Details</td>
<td>Career Path Names</td>
<td></td>
</tr>
<tr>
<td>Additional COBRA Benefit Details</td>
<td>COBRA Benefits (US only)</td>
<td></td>
</tr>
<tr>
<td>Additional COBRA Coverage Details</td>
<td>COBRA Coverage (US only)</td>
<td></td>
</tr>
<tr>
<td>Additional COBRA Payment Details</td>
<td>COBRA Payment (US only)</td>
<td></td>
</tr>
<tr>
<td>Additional COBRA Status Details</td>
<td>COBRA Status (US only)</td>
<td></td>
</tr>
<tr>
<td>Additional Contact Relationship Details</td>
<td>Contact</td>
<td>CONTACTS_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Element Entry Information</td>
<td>Adjust Balance (Oracle Payroll only), Element Entries, View Element Entry History for Employee</td>
<td></td>
</tr>
<tr>
<td>Additional Element Link Information</td>
<td>Element</td>
<td></td>
</tr>
<tr>
<td>Additional Element Type Details</td>
<td>Element</td>
<td></td>
</tr>
<tr>
<td>Additional Evaluation Details</td>
<td>Job, Position</td>
<td></td>
</tr>
<tr>
<td>Additional Event Details</td>
<td>Applicant Interview, Employee Review, Event Bookings</td>
<td>EVENTS_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Grade Details</td>
<td>Grade</td>
<td>GRADES_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Job Details</td>
<td>Job</td>
<td>JOBS_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Letter Details</td>
<td>Letter</td>
<td></td>
</tr>
<tr>
<td>Additional Location Details</td>
<td>Location</td>
<td></td>
</tr>
<tr>
<td>Additional Organization Information</td>
<td>Organization</td>
<td></td>
</tr>
<tr>
<td>Additional Organization Payment Method Details</td>
<td>Organizational Payment Method</td>
<td></td>
</tr>
<tr>
<td>Additional Organization Structure Detail</td>
<td>Organization Hierarchy</td>
<td></td>
</tr>
<tr>
<td>Additional Organization Unit Details</td>
<td>Organization</td>
<td>ORGANIZATION_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Pay Scale Information</td>
<td>Pay Scale</td>
<td></td>
</tr>
</tbody>
</table>

**Table B – 1 User Definable Descriptive Flexfields**
<table>
<thead>
<tr>
<th>Descriptive Flexfield Title</th>
<th>Window Title</th>
<th>Database Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Pay Rate Details</td>
<td>Payroll</td>
<td>PAYROLLS_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Payroll Details</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Additional Period Information</td>
<td>Budgetary Calendar, Period Dates (Payroll form)</td>
<td></td>
</tr>
<tr>
<td>Additional Period of Service Details</td>
<td>Terminate</td>
<td>PERIODS_OF_SERVICE_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Period Type Information</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Additional Person Analysis Details</td>
<td>Special Information, List People By Special Information</td>
<td></td>
</tr>
<tr>
<td>Additional Personal Details</td>
<td>Applicant Entry, Contact, People, People Folder</td>
<td>PEOPLE_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Personal Payment Method Details</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Additional Position Details</td>
<td>Position, Find Positions (Mass Move form)</td>
<td>POSITION_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Position Structure Details</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Additional Recruitment Activity Details</td>
<td>Recruitment Activity</td>
<td>RECRUITMENT_ACTIVITIES_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Requirement Details</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Additional Requisition Details</td>
<td>Requisition and Vacancy</td>
<td></td>
</tr>
<tr>
<td>Additional Salary Administration Details</td>
<td>Salary Administration</td>
<td></td>
</tr>
<tr>
<td>Additional Salary Basis Information</td>
<td>Salary Basis</td>
<td></td>
</tr>
<tr>
<td>Additional Telephone Number Details</td>
<td>Phone Numbers</td>
<td></td>
</tr>
<tr>
<td>Additional Vacancy Details</td>
<td>Requisition and Vacancy</td>
<td></td>
</tr>
<tr>
<td>Additional Valid Grade Details</td>
<td>Job, Position</td>
<td></td>
</tr>
<tr>
<td>Additional Year Information</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Table B – 1 User Definable Descriptive Flexfields</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Descriptive Flexfields with Startup Data

Oracle HRMS supplies two predefined descriptive flexfields to hold address information in different styles for different countries. These are the Personal Address Information descriptive flexfield and the Location Address descriptive flexfield.

You can use these descriptive flexfields to add new address styles or to change the styles included in Oracle HRMS.

**Attention:** If you change the predefined styles, your changes will be overwritten when you upgrade Oracle HRMS. If you add new styles, your changes may be overwritten if new startup data contains address styles for these countries.

---

Changing Address Styles

Address styles vary between countries, so Oracle HRMS provides two descriptive flexfields that use *context sensitive* segments to hold each line of an address.

<table>
<thead>
<tr>
<th>Title</th>
<th>Table Name</th>
<th>Window Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personal Address Information</td>
<td>PER_ADDRESSES</td>
<td>Address, Applicant Entry</td>
</tr>
<tr>
<td>Location Address</td>
<td>HR_LOCATIONS</td>
<td>Location, Organization</td>
</tr>
</tbody>
</table>

Table B – 2  Address Styles in Oracle HRMS

The available address styles are defined as the contexts for these flexfields. The values used are the territory codes. These codes can be found in the FND_TERRITORIES table. You can have only one Address Style for each Territory in the FND_TERRITORIES table.

Address styles are provided as startup data in these flexfields. If you require additional address styles, you need to define a new context and segments.

To change the address style for any country, disable those segments you do not want to use. Then define new segments to record your own information. However, these changes will be overwritten when you upgrade Oracle HRMS.
Oracle HRMS supplies two key flexfields and six descriptive flexfields that are predefined and protected. Your localization team defines these flexfields to meet the specific legislative and reporting needs of your country.

The protected key flexfields are the Soft Coded Legislation key flexfield and the Bank Details key flexfield.

Table B – 3 lists the protected descriptive flexfields.

<table>
<thead>
<tr>
<th>Title</th>
<th>Table Name</th>
<th>Window Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Further Element Information</td>
<td>PAY_ELEMENT_TYPES_F</td>
<td>Element</td>
</tr>
<tr>
<td>Further Assignment Information</td>
<td>PER_ASSIGNMENT_EXTRA_INFO</td>
<td>Assignment</td>
</tr>
<tr>
<td>Further Payment Method Information</td>
<td>PAY_ORG_PAYMENT_METHODS_F</td>
<td>Organizational Payment Method</td>
</tr>
<tr>
<td>Further Person Information</td>
<td>PER_PEOPLE_F</td>
<td>People, Applicant Entry</td>
</tr>
<tr>
<td>Further Person Information (Datetracked)</td>
<td>PER_PEOPLE_EXTRA_INFO</td>
<td>People</td>
</tr>
<tr>
<td>Further Job Information</td>
<td>PER_JOB_EXTRA_INFO</td>
<td>Job</td>
</tr>
<tr>
<td>Further Position Information</td>
<td>PER_POSITION_EXTRA_INFO</td>
<td>Position</td>
</tr>
<tr>
<td>Further Organization Information</td>
<td>HR_ORGANIZATION_INFORMATION</td>
<td>Organization</td>
</tr>
<tr>
<td>Further Location Information</td>
<td>HR_LOCATION_EXTRA_INFO</td>
<td>Location</td>
</tr>
</tbody>
</table>

Your localization team determines which of these flexfields are required for your legislation, and what segments they should contain. Ensure that you select the appropriate legislation code when you define your Business Group so that you can see these flexfields.

⚠️ **Warning:** Do not attempt to alter the definitions of these protected flexfields. These definitions are a fundamental part of Oracle HRMS. Any change to them may lead to errors in the operating of the system.

It is possible that Oracle HRMS will use other segments of these flexfields in the future. Therefore, do not add segments to any protected flexfield. This can affect your ability to upgrade your system in the future.
Soft Coded Legislation Key Flexfield

This key flexfield holds legislation–specific information. The legislation of your Business Group determines the flexfield structure that you see.

Each localization team defines a flexfield structure and uses qualifiers to define the level at which each segment is visible. Therefore, you may be able to enter information specific to your legislation at one or more of the following levels:

- Business Group – Organization window
- Payroll – Payroll window
- Employee Assignment – Assignment window

Bank Details Key Flexfield

This flexfield holds legislation–specific bank account information. The legislation of your Business Group determines the flexfield structure that you see. Each localization team defines a flexfield structure that allows you to record the bank account information relevant to your legislation. You enter this information in the Organizational Payment Method window and Personal Payment Method window.
This appendix lists the database items available to you in Oracle HRMS for writing formulas and defining QuickPaint reports. The database items are grouped into two listings:

- Static Database Items
- Dynamic Database Items

Static database items are shipped with the system and you cannot modify them. Dynamic database items are created by Oracle HRMS processes whenever you define new elements or other related entities.
Static Database Items

Static database items are shipped with the system and you cannot modify them.

### Applicant Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>APL_DATE_END</td>
<td>The date the application ended</td>
</tr>
<tr>
<td>APL_DATE_RECEIVED</td>
<td>The date the application was received</td>
</tr>
</tbody>
</table>

Table C – 1

### Employee Assignment Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG_ASSIGNMENT_SEQUENCE</td>
<td>This is used as a default for assignment number</td>
</tr>
<tr>
<td>ASG_DATE_FROM</td>
<td>The date from which this assignment information is effective</td>
</tr>
<tr>
<td>ASG_DATE_TO</td>
<td>The date to which this assignment information is effective</td>
</tr>
<tr>
<td>ASG_EMPLOYMENT_CATEGORY</td>
<td>The employment category for the assignment</td>
</tr>
<tr>
<td>ASG_END_TIME</td>
<td>The standard end time for the assignment</td>
</tr>
<tr>
<td>ASG_FREQ</td>
<td>The frequency for which the assignment working hours are measured</td>
</tr>
<tr>
<td>ASG_GRADE</td>
<td>The employee's grade</td>
</tr>
<tr>
<td>ASG_GRADE_DATE_FROM</td>
<td>The date from which this assignment grade information is effective</td>
</tr>
</tbody>
</table>

Table C – 2
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG_GRADE_DATE_TO</td>
<td>The date to which this assignment grade information is effective</td>
</tr>
<tr>
<td>ASG_GROUP</td>
<td>The employee’s group</td>
</tr>
<tr>
<td>ASG_HOURS</td>
<td>The standard number of working hours for the assignment</td>
</tr>
<tr>
<td>ASG_INT_ADDR_LINE</td>
<td>The internal address of the assignment</td>
</tr>
<tr>
<td>ASG_JOB</td>
<td>The employee’s job</td>
</tr>
<tr>
<td>ASG_JOB_DATE_FROM</td>
<td>The date from which this assignment job information is effective</td>
</tr>
<tr>
<td>ASG_JOB_DATE_TO</td>
<td>The date to which this assignment job information is effective</td>
</tr>
<tr>
<td>ASG_LAST_CHANGE_REASON</td>
<td>The reason the salary was changed</td>
</tr>
<tr>
<td>ASG_LAST_PERFORMANCE_DATE</td>
<td>Last performance review date</td>
</tr>
<tr>
<td>ASG_LAST_PERFORMANCE_LOCATION</td>
<td>Last performance review location</td>
</tr>
<tr>
<td>ASG_LAST_PERFORMANCE_RATING</td>
<td>Last performance review rating</td>
</tr>
<tr>
<td>ASG_LAST_PERFORMANCE_TYPE</td>
<td>Last performance review type</td>
</tr>
<tr>
<td>ASG_LAST_PROC_PAYROLL_NAME</td>
<td>The payroll name the assignment was last processed</td>
</tr>
<tr>
<td>ASG_LAST_PROC_PERIOD_ID</td>
<td>The time period ID the assignment was last processed</td>
</tr>
<tr>
<td>ASG_LAST_PROC_PERIOD_NAME</td>
<td>The period name the assignment was last processed</td>
</tr>
<tr>
<td>ASG_LAST_PROC_PERIOD_NUMBER</td>
<td>The period number the assignment was last processed</td>
</tr>
<tr>
<td>ASG_LAST_PROPOSED_SALARY_CHANGE</td>
<td>The proposed salary change</td>
</tr>
<tr>
<td>ASG_LAST_PROPOSED_SALARY_PERCENT</td>
<td>The proposed salary change as a percentage</td>
</tr>
<tr>
<td>ASG_LAST_SALARY_CHANGE_APPROVED</td>
<td>Whether the last proposed salary change has been approved</td>
</tr>
<tr>
<td>ASG_LAST_SALARY_DATE</td>
<td>The last salary change date</td>
</tr>
<tr>
<td>ASG_LOCATION</td>
<td>The employee’s location</td>
</tr>
</tbody>
</table>

Table C – 2
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG_LOC_INACTIVE_DATE</td>
<td>The date to which the location information is effective</td>
</tr>
<tr>
<td>ASG_MANAGER</td>
<td>Whether the assignment is a managerial assignment (yes/no)</td>
</tr>
<tr>
<td>ASG_NEXT_PERFORMANCE_DATE</td>
<td>Next performance review date</td>
</tr>
<tr>
<td>ASG_NEXT_SALARY_DATE</td>
<td>The date of the next salary change</td>
</tr>
<tr>
<td>ASG_NUMBER</td>
<td>The assignment number</td>
</tr>
<tr>
<td>ASG_ORG</td>
<td>The employee's organization</td>
</tr>
<tr>
<td>ASG_ORG_DATE_FROM</td>
<td>The date from which assignment organization information is effective</td>
</tr>
<tr>
<td>ASG_ORG_DATE_TO</td>
<td>The date to which assignment organization information is effective</td>
</tr>
<tr>
<td>ASG_PAYROLL</td>
<td>The employee's payroll</td>
</tr>
<tr>
<td>ASG_PERFORMANCE_REVIEW_FREQUENCY</td>
<td>The performance review frequency for the assignment</td>
</tr>
<tr>
<td>ASG_PERFORMANCE_REVIEW_PERIOD</td>
<td>The performance review frequency for the assignment</td>
</tr>
<tr>
<td>ASG_PER_STATUS_DP</td>
<td>Personal status for the assignment (as of Date Paid)</td>
</tr>
<tr>
<td>ASG_POSITION</td>
<td>The employee's position</td>
</tr>
<tr>
<td>ASG_POS_DATE_FROM</td>
<td>The date from which this assignment position information is effective</td>
</tr>
<tr>
<td>ASG_POS_DATE_TO</td>
<td>The date to which this assignment position information is effective</td>
</tr>
<tr>
<td>ASG_POS_END_TIME</td>
<td>The standard end time for the assignment position</td>
</tr>
<tr>
<td>ASG_POS_FREQ</td>
<td>The frequency for which the assignment position’s hours is measured</td>
</tr>
<tr>
<td>ASG_POS_HOURS</td>
<td>The standard number of working hours for the position</td>
</tr>
</tbody>
</table>

Table C – 2
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG_POS_PROB_PERIOD</td>
<td>The probation period for the assignment position</td>
</tr>
<tr>
<td>ASG_POS_START_TIME</td>
<td>The standard start time for the assignment position</td>
</tr>
<tr>
<td>ASG_PRIMARY</td>
<td>Whether this is the employee’s primary assignment (yes/no)</td>
</tr>
<tr>
<td>ASG_PROB_END_DATE</td>
<td>The probation period end date</td>
</tr>
<tr>
<td>ASG_PROB_PERIOD</td>
<td>The assignment’s probation period</td>
</tr>
<tr>
<td>ASG_PROB_UNITS</td>
<td>The units of the assignment’s probation period</td>
</tr>
<tr>
<td>ASG_REC_FULL_NAME</td>
<td>The full name for the recruiter</td>
</tr>
<tr>
<td>ASG_RELIEF</td>
<td>The relief position if the current position holder is absent</td>
</tr>
<tr>
<td>ASG_SALARY_BASES</td>
<td>The current salary for an employee</td>
</tr>
<tr>
<td>ASG_SALARY_BASIS</td>
<td>The payment basis (i.e. frequency) for the assignment, e.g. monthly</td>
</tr>
<tr>
<td>ASG_SALARY_BASIS_CODE</td>
<td>The payment basis lookup code for the assignment</td>
</tr>
<tr>
<td>ASG_SALARY_BASIS_NAME</td>
<td>The salary basis name for the assignment</td>
</tr>
<tr>
<td>ASG_SALARY_ELEMENT</td>
<td>The display element name</td>
</tr>
<tr>
<td>ASG_SALARY_ELEMENT_VALUE_NAME</td>
<td>The display input value name</td>
</tr>
<tr>
<td>ASG_SALARY_GRADE_RATE</td>
<td>The display rate name</td>
</tr>
<tr>
<td>ASG_SALARY_RATE_BASIS</td>
<td>The salary rate basis</td>
</tr>
<tr>
<td>ASG_SALARY_RATE_BASIS_CODE</td>
<td>The salary review frequency for the assignment</td>
</tr>
<tr>
<td>ASG_SALARY_RATE_BASIS_NAME</td>
<td>The salary review period for the assignment</td>
</tr>
<tr>
<td>ASG_SALARY_REVIEW_FREQUENCY</td>
<td>The salary review frequency for the assignment</td>
</tr>
<tr>
<td>ASG_SALARY_REVIEW_PERIOD</td>
<td>The salary review period for the assignment</td>
</tr>
<tr>
<td>ASG_START_DATE</td>
<td>The start date of the assignment</td>
</tr>
<tr>
<td>ASG_START_TIME</td>
<td>The standard start time for the assignment</td>
</tr>
<tr>
<td>ASG_STATUS</td>
<td>The primary status for the assignment</td>
</tr>
</tbody>
</table>

Table C – 2
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG_SUCCESSOR</td>
<td>The position name that will succeed into this position</td>
</tr>
<tr>
<td>ASG_SUP_FULL_NAME</td>
<td>The full name for the supervisor</td>
</tr>
<tr>
<td>ASG_TYPE</td>
<td>Whether this is an employee or applicant assignment</td>
</tr>
<tr>
<td>ASG_VACANCY</td>
<td>The name of the vacancy applied for</td>
</tr>
</tbody>
</table>

Table C – 2
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CON_ADR_CITY</td>
<td>The name of the contact’s town or city</td>
</tr>
<tr>
<td>CON_ADR_COUNTRY</td>
<td>The name of the contact’s country</td>
</tr>
<tr>
<td>CON_ADR_DATE_FROM</td>
<td>The first date on which the contact can be contacted</td>
</tr>
<tr>
<td>CON_ADR_DATE_TO</td>
<td>The last date on which the contact can be contacted</td>
</tr>
<tr>
<td>CON_ADR_LINE_1</td>
<td>The first line of the contact’s address</td>
</tr>
<tr>
<td>CON_ADR_LINE_2</td>
<td>The second line of the contact’s address</td>
</tr>
<tr>
<td>CON_ADR_LINE_3</td>
<td>The third line of the contact’s address</td>
</tr>
<tr>
<td>CON_ADR_PHONE_1</td>
<td>The contact’s first telephone number</td>
</tr>
<tr>
<td>CON_ADR_PHONE_2</td>
<td>The contact’s second telephone number</td>
</tr>
<tr>
<td>CON_ADR_PHONE_3</td>
<td>The contact’s third telephone number</td>
</tr>
<tr>
<td>CON_ADR_POSTAL_CODE</td>
<td>The contact’s postal code</td>
</tr>
<tr>
<td>CON_ADR_REGION_1</td>
<td>The first line of the contact’s region</td>
</tr>
<tr>
<td>CON_ADR_REGION_2</td>
<td>The second line of the contact’s region</td>
</tr>
<tr>
<td>CON_ADR_REGION_3</td>
<td>The third line of the contact’s region</td>
</tr>
</tbody>
</table>

Table C – 3
## Contact Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CON_AGE</td>
<td>The contact’s age</td>
</tr>
<tr>
<td>CON_APP_NUMBER</td>
<td>The contact’s applicant number</td>
</tr>
<tr>
<td>CON_CURRENT_APP</td>
<td>Whether the contact is a current applicant (yes/no)</td>
</tr>
<tr>
<td>CON_CURRENT_EMP</td>
<td>Whether the contact is a current employee (yes/no)</td>
</tr>
<tr>
<td>CON_DATE_OF_BIRTH</td>
<td>The contact’s date of birth</td>
</tr>
<tr>
<td>CON_DISABLED</td>
<td>Whether the contact is disabled (yes/no)</td>
</tr>
<tr>
<td>CON_EMP_NUMBER</td>
<td>The contact’s employee number</td>
</tr>
<tr>
<td>CON_END_DATE</td>
<td>The date to which this contact information is effective</td>
</tr>
<tr>
<td>CON_FIRST_NAME</td>
<td>The contact’s first name</td>
</tr>
<tr>
<td>CON_FULL_NAME</td>
<td>The contact’s full name</td>
</tr>
<tr>
<td>CON_KNOWN_AS</td>
<td>The contact’s preferred name</td>
</tr>
<tr>
<td>CON_LAST_NAME</td>
<td>The contact’s last name</td>
</tr>
<tr>
<td>CON_MARITAL_STATUS</td>
<td>The contact’s marital status</td>
</tr>
<tr>
<td>CON_MIDDLE_NAMES</td>
<td>The contact’s middle names</td>
</tr>
<tr>
<td>CON_NATIONALITY</td>
<td>The contact’s nationality</td>
</tr>
<tr>
<td>CON_PERSON_TYPE</td>
<td>The contact’s person type – employee or applicant, for example</td>
</tr>
<tr>
<td>CON_RELATIONSHIP</td>
<td>The relationship of the contact to the employee</td>
</tr>
<tr>
<td>CON_SEX</td>
<td>The contact’s sex</td>
</tr>
<tr>
<td>CON_START_DATE</td>
<td>The date from which this contact information is effective</td>
</tr>
</tbody>
</table>

Table C – 4
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CON_TITLE</td>
<td>The contact’s title</td>
</tr>
<tr>
<td>CON_WORK_PHONE</td>
<td>The contact’s work telephone number</td>
</tr>
</tbody>
</table>

Table C – 4
### Employee Hire Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMP_HIRE_DATE</td>
<td>The employee’s hire date</td>
</tr>
<tr>
<td>EMP_LAST_PROCESS_DATE</td>
<td>The date the employee was last processed</td>
</tr>
<tr>
<td>EMP_LEAVING_REASON</td>
<td>The reason the employee left</td>
</tr>
<tr>
<td>EMP_TERM_ACCEPTED_BY</td>
<td>The person who accepted the employee’s notice</td>
</tr>
<tr>
<td>EMP_TERM_DATE</td>
<td>The employee’s termination date</td>
</tr>
</tbody>
</table>

Table C – 5

### Location Details

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOC_ADR_LINE_1</td>
<td>The first line of the assignment’s work address</td>
</tr>
<tr>
<td>LOC_ADR_LINE_2</td>
<td>The second line of the assignment’s work address</td>
</tr>
<tr>
<td>LOC_ADR_LINE_3</td>
<td>The third line of the assignment’s work address</td>
</tr>
<tr>
<td>LOC_ADR_POSTAL_CODE</td>
<td>The postal code for the assignment’s work address</td>
</tr>
<tr>
<td>LOC_ADR_REGION_1</td>
<td>The first line of the assignment’s region</td>
</tr>
<tr>
<td>LOC_ADR_REGION_2</td>
<td>The second line of the assignment’s region</td>
</tr>
<tr>
<td>LOC_ADR_REGION_3</td>
<td>The third line of the assignment’s region</td>
</tr>
<tr>
<td>LOC_ADR_PHONE_1</td>
<td>The assignment’s first work telephone number</td>
</tr>
<tr>
<td>LOC_ADR_PHONE_2</td>
<td>The assignment’s second work telephone number</td>
</tr>
</tbody>
</table>

Table C – 6
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOC_ADR_PHONE_3</td>
<td>The assignment’s third work telephone number</td>
</tr>
<tr>
<td>LOC_ADR_CITY</td>
<td>The town or city where the assignment works</td>
</tr>
<tr>
<td>LOC_ADR_COUNTRY</td>
<td>The country where the assignment works</td>
</tr>
</tbody>
</table>

Table C – 6

**Work Address Details (US only)**

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOC_ADR_US_COUNTY</td>
<td>The assignment’s work county (US only)</td>
</tr>
<tr>
<td>LOC_ADR_US_STATE</td>
<td>The assignment’s work state (US only)</td>
</tr>
<tr>
<td>LOC_ADR_US_STATE_CODE</td>
<td>The assignment’s work state code (US only)</td>
</tr>
</tbody>
</table>

Table C – 7

**Work Address Details (UK only)**

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOC_ADR_UK_COUNTY</td>
<td>The assignment’s work county (UK only)</td>
</tr>
</tbody>
</table>

Table C – 8
## Payroll Details

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAY_PERIODS_PER_YEAR</td>
<td>The number of pay periods in the year</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_CUT_OFF_DATE</td>
<td>The cut off date for the payroll period</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_DATE_PAID</td>
<td>The date the payroll was paid</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_DIRECT_DEPOSIT_DATE</td>
<td>The direct deposit date for the payroll period</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_END_DATE</td>
<td>The end date of the payroll period</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_ID</td>
<td>The ID of the time period for the payroll</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_NAME</td>
<td>The period name for the payroll</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_PAY_ADVICE_DATE</td>
<td>The pay advice date for the payroll period</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_START_DATE</td>
<td>The start date of the payroll period</td>
</tr>
</tbody>
</table>

Table C – 9
# People Addresses

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER_ADR_CITY</td>
<td>The name of the person’s town or city</td>
</tr>
<tr>
<td>PER_ADR_COUNTRY</td>
<td>The name of the person’s country</td>
</tr>
<tr>
<td>PER_ADR_DATE_FROM</td>
<td>The first date on which the person can be contacted at this address</td>
</tr>
<tr>
<td>PER_ADR_DATE_TO</td>
<td>The last date on which the person can be contacted at this address</td>
</tr>
<tr>
<td>PER_ADR_LINE_1</td>
<td>The first line of the person’s address</td>
</tr>
<tr>
<td>PER_ADR_LINE_2</td>
<td>The second line of the person’s address</td>
</tr>
<tr>
<td>PER_ADR_LINE_3</td>
<td>The third line of the person’s address</td>
</tr>
<tr>
<td>PER_ADR_PHONE_1</td>
<td>The person’s first contact number</td>
</tr>
<tr>
<td>PER_ADR_PHONE_2</td>
<td>The person’s second contact number</td>
</tr>
<tr>
<td>PER_ADR_PHONE_3</td>
<td>The person’s third contact number</td>
</tr>
<tr>
<td>PER_ADR_POSTAL_CODE</td>
<td>The person’s postal code</td>
</tr>
<tr>
<td>PER_ADR_REGION_1</td>
<td>The first line of the person’s region</td>
</tr>
<tr>
<td>PER_ADR_REGION_2</td>
<td>The second line of the person’s region</td>
</tr>
<tr>
<td>PER_ADR_REGION_3</td>
<td>The third line of the person’s region</td>
</tr>
</tbody>
</table>

Table C – 10
### Home Address Details (US only)

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER_ADR_US_COUNTY</td>
<td>The person’s county (US only)</td>
</tr>
<tr>
<td>PER_ADR_US_STATE</td>
<td>The person’s state (US only)</td>
</tr>
<tr>
<td>PER_ADR_US_STATE_CODE</td>
<td>The person’s state code (US only)</td>
</tr>
</tbody>
</table>

Table C – 11

### Home Address Details (UK only)

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER_ADR_UK_COUNTY</td>
<td>The person’s home county (UK only)</td>
</tr>
</tbody>
</table>

Table C – 12
# People Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER_AGE</td>
<td>The person’s age</td>
</tr>
<tr>
<td>PER_APPLICANT_NUMBER</td>
<td>The person’s applicant number</td>
</tr>
<tr>
<td>PER_CURRENT_APP</td>
<td>Whether the person is a current applicant (yes/no)</td>
</tr>
<tr>
<td>PER_CURRENT_EMP</td>
<td>Whether the person is a current employee (yes/no)</td>
</tr>
<tr>
<td>PER_DATE_OF_BIRTH</td>
<td>The person’s date of birth</td>
</tr>
<tr>
<td>PER_DATE_VERIFIED</td>
<td>The date the employee last verified his or her personal data</td>
</tr>
<tr>
<td>PER_DISABLED</td>
<td>Whether the person is disabled (yes/no)</td>
</tr>
<tr>
<td>PER_EMP_NUMBER</td>
<td>The person’s employee number</td>
</tr>
<tr>
<td>PER_FIRST_NAME</td>
<td>The person’s first name</td>
</tr>
<tr>
<td>PER_FULL_NAME</td>
<td>The person’s full name</td>
</tr>
<tr>
<td>PER_KNOWN_AS</td>
<td>The person’s preferred name</td>
</tr>
<tr>
<td>PER_LAST_NAME</td>
<td>The person’s last name</td>
</tr>
<tr>
<td>PER_MAIL_DESTINATION</td>
<td>The person’s mail destination</td>
</tr>
<tr>
<td>PER_MARITAL_STATUS</td>
<td>The person’s marital status</td>
</tr>
<tr>
<td>PER_MIDDLE_NAMES</td>
<td>The person’s middle names</td>
</tr>
<tr>
<td>PER_NATIONALITY</td>
<td>The person’s nationality</td>
</tr>
<tr>
<td>PER_NATIONAL_IDENTIFIER</td>
<td>The person’s national identifier</td>
</tr>
<tr>
<td>PER_PERSON_TYPE</td>
<td>Type of person – employee or applicant, for example</td>
</tr>
<tr>
<td>PER_PREV_LAST_NAME</td>
<td>The person’s previous last name</td>
</tr>
<tr>
<td>PER_SEND_EXPENSES</td>
<td>Where to send the person’s expenses (home/office)</td>
</tr>
<tr>
<td>PER_SEX</td>
<td>The person’s sex</td>
</tr>
</tbody>
</table>

Table C – 13
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER_TITLE</td>
<td>The person’s title</td>
</tr>
<tr>
<td>PER_WORK_PHONE</td>
<td>The person’s work telephone number</td>
</tr>
</tbody>
</table>

Table C – 13
## Recruiter Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>REC_CURRENT_APP</td>
<td>Whether the recruiter is a current applicant (yes/no)</td>
</tr>
<tr>
<td>REC_CURRENT_EMP</td>
<td>Whether the recruiter is a current employee (yes/no)</td>
</tr>
<tr>
<td>REC_EMP_NUMBER</td>
<td>The recruiter’s employee number</td>
</tr>
<tr>
<td>REC_GRADE</td>
<td>The recruiter’s grade</td>
</tr>
<tr>
<td>REC_INT_ADDR_LINE</td>
<td>The recruiter’s internal address</td>
</tr>
<tr>
<td>REC_JOB</td>
<td>The recruiter’s job</td>
</tr>
<tr>
<td>REC_LOCATION</td>
<td>The recruiter’s work location</td>
</tr>
<tr>
<td>REC_MANAGER</td>
<td>Whether the assignment is a managerial assignment (yes/no)</td>
</tr>
<tr>
<td>REC_ORG</td>
<td>The name of the recruiter’s organization</td>
</tr>
<tr>
<td>REC_PERSON_TYPE</td>
<td>The recruiter’s person type – employee or applicant, for example</td>
</tr>
<tr>
<td>REC_POSITION</td>
<td>The recruiter’s position</td>
</tr>
<tr>
<td>REC_WORK_PHONE</td>
<td>The recruiter’s work telephone number</td>
</tr>
</tbody>
</table>

Table C – 14
### Supervisor Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUP_CURRENT_EMP</td>
<td>Whether the supervisor is a current employee (yes/no)</td>
</tr>
<tr>
<td>SUP_DATE_FROM</td>
<td>The date from which this supervisor information is effective</td>
</tr>
<tr>
<td>SUP_DATE_TO</td>
<td>The date to which this supervisor information is effective</td>
</tr>
<tr>
<td>SUP_EMP_NUMBER</td>
<td>The supervisor’s employee number</td>
</tr>
<tr>
<td>SUP_GRADE</td>
<td>The supervisor’s grade</td>
</tr>
<tr>
<td>SUP_INT_ADDR_LINE</td>
<td>The supervisor’s internal address</td>
</tr>
<tr>
<td>SUP_JOB</td>
<td>The supervisor’s job</td>
</tr>
<tr>
<td>SUP_LOCATION</td>
<td>The supervisor’s work location</td>
</tr>
<tr>
<td>SUP_MANAGER</td>
<td>Whether the assignment is a managerial assignment (yes/no)</td>
</tr>
<tr>
<td>SUP_ORG</td>
<td>The supervisor’s organization</td>
</tr>
<tr>
<td>SUP_PERSON_TYPE</td>
<td>The supervisor’s person type</td>
</tr>
<tr>
<td>SUP_POSITION</td>
<td>The supervisor’s position</td>
</tr>
<tr>
<td>SUP_WORK_PHONE</td>
<td>The supervisor’s work telephone number</td>
</tr>
</tbody>
</table>

Table C – 15

### Date Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SESSION_DATE</td>
<td>The effective date from FND_SESSIONS</td>
</tr>
<tr>
<td>SYSDATE</td>
<td>The system date</td>
</tr>
</tbody>
</table>

Table C – 16
Dynamic Database Items

Dynamic database items are created by Oracle HRMS processes whenever you define new elements or other related entities.

Element Database Items

When you define a new element, Oracle HRMS runs a process to create a number of related database items for it. To ensure easy recognition of these items, the process adds the element name `<ENAME>` to each one. It also creates further database items for each pay and input value you use `<INAME>`.

Here is a list of database items created each time you define an element using the Element window:

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;ENAME&gt;_BEN_CLASS</code></td>
<td>The element’s benefit classification</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_CLASSIFICATION</code></td>
<td>The element’s classification</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_CLOSED_FOR_ENTRY</code></td>
<td>Yes/no flag: if yes, the element’s entries cannot be modified</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_CLOSED_FOR_ENTRY_CODE</code></td>
<td>Yes/no flag: if yes, the element’s entries cannot be modified</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_COSTABLE_TYPE</code></td>
<td>The element’s costable type (from lookup table)</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_COSTABLE_TYPE_CODE</code></td>
<td>The element’s costable type (code values)</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_COUNT</code></td>
<td>The element entry count</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_END_DATE</code></td>
<td>The date to which this element is effective</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_INPUT_CURRENCY_CODE</code></td>
<td>The element’s input currency code</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_LENGTH_OF_SERVICE</code></td>
<td>The element’s qualifying length of service</td>
</tr>
</tbody>
</table>

Table C – 17
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;ENAME&gt;_OUTPUT_CURRENCY_CODE</code></td>
<td>The element’s output currency code</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_PROCESSING_PRIORITY</code></td>
<td>The element’s processing priority</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_QUALIFYING_AGE</code></td>
<td>The element’s qualifying age</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_QUALIFYING_UNITS_CODE</code></td>
<td>The qualifying length of service units (code values)</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_QUALIFYING_UNITS</code></td>
<td>The qualifying length of service units (from lookup table)</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_REPORTING_NAME</code></td>
<td>The element’s reporting name</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_STANDARD_LINK</code></td>
<td>Yes/no flag: yes = standard, no = discretionary</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_STANDARD_LINK_CODE</code></td>
<td>Yes/no flag: yes = standard, no = discretionary</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_UNIT_OF_MEASURE</code></td>
<td>The element’s unit of measure (from lookup table)</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_UNIT_OF_MEASURE_CODE</code></td>
<td>The element’s unit of measure (code values)</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_DEFAULT</code></td>
<td>The element’s default input value</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_MIN</code></td>
<td>The element’s minimum input value</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_MAX</code></td>
<td>The element’s maximum input value</td>
</tr>
</tbody>
</table>

In addition to the items above, Oracle HRMS creates the following four items for elements defined with multiple entries not allowed:

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_ENTRY_VALUE</code></td>
<td>The element value</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_USER_ENTERED_CODE</code></td>
<td>Whether a value exists at the element entry level (yes/no)</td>
</tr>
</tbody>
</table>
In addition to the common list above, Oracle HRMS creates the following item for elements defined with multiple entries allowed whose input values are numeric (that is, hours, integer, money or number).

The units for '<ENAME> <INAME> ENTRY VALUE' are generated for both recurring and nonrecurring elements and are user-definable. Oracle HRMS modifies the definition text to retrieve the entry value in the unit of measure as specified in the 'pay_input_values_f' table.
Grade Rate Database Items

When you define a grade rate, Oracle HRMS runs a process to create a number of related database items for it. To ensure easy recognition of these items, the process adds the grade rate name <NAME> to each one.

Here is a list of database items created each time you define a grade rate using the Grade Rate window:

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GRADE_&lt;NAME&gt;_VALUE</td>
<td>The grade rate's value</td>
</tr>
<tr>
<td>GRADE_&lt;NAME&gt;_MINIMUM</td>
<td>The grade rate's minimum value</td>
</tr>
<tr>
<td>GRADE_&lt;NAME&gt;_MAXIMUM</td>
<td>The grade rate's maximum value</td>
</tr>
</tbody>
</table>

Table C – 20

Pay Scale Rate Database Items

When you define a pay scale rate, Oracle HRMS runs a process to create the following database item for it. To ensure easy recognition of this item, the process adds the rate name <NAME> to it.

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPINE_&lt;NAME&gt;_VALUE</td>
<td>The pay scale rates value</td>
</tr>
</tbody>
</table>

Table C – 21
Descriptive Flexfield Database Items

When you define descriptive flexfield segments you make them available for use in QuickPaint by running the Create Descriptive Flexfield DB Items process from the Submit Requests window. This process creates database items for each of the descriptive flexfields listed below.

To ensure easy recognition of these items, the process adds the descriptive flexfield segment name `<SEGMENT_NAME>` to each one.

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PEOPLE_&lt;SEGMENT_NAME&gt;</td>
<td>People descriptive flexfield database items</td>
</tr>
<tr>
<td>PAYROLLS_&lt;SEGMENT_NAME&gt;</td>
<td>Payroll descriptive flexfield database items</td>
</tr>
<tr>
<td>ASSIGNMENTS_&lt;SEGMENT_NAME&gt;</td>
<td>Assignment descriptive flexfield database items</td>
</tr>
<tr>
<td>GRADES_&lt;SEGMENT_NAME&gt;</td>
<td>Grade descriptive flexfield database items</td>
</tr>
<tr>
<td>ABSENCES_&lt;SEGMENT_NAME&gt;</td>
<td>Absence descriptive flexfield database items</td>
</tr>
<tr>
<td>ABSENCE_TYPES_&lt;SEGMENT_NAME&gt;</td>
<td>Absence type descriptive flexfield database items</td>
</tr>
<tr>
<td>PERSON_ADDRESSES_&lt;SEGMENT_NAME&gt;</td>
<td>Person Address descriptive flexfield database items</td>
</tr>
<tr>
<td>EVENTS_&lt;SEGMENT_NAME&gt;</td>
<td>Events descriptive flexfield database items</td>
</tr>
<tr>
<td>JOBS_&lt;SEGMENT_NAME&gt;</td>
<td>Jobs descriptive flexfield database items</td>
</tr>
<tr>
<td>CONTACTS_&lt;SEGMENT_NAME&gt;</td>
<td>Contacts descriptive flexfield database items</td>
</tr>
<tr>
<td>PERIODS_OF_SERVICE_&lt;SEGMENT_NAME&gt;</td>
<td>Periods of Service descriptive flexfield database items</td>
</tr>
<tr>
<td>RECRUITMENT_ACTIVITIES_&lt;SEGMENT_NAME&gt;</td>
<td>Recruitment Activities descriptive flexfield database items</td>
</tr>
<tr>
<td>POSITION_&lt;SEGMENT_NAME&gt;</td>
<td>Position descriptive flexfield database items</td>
</tr>
</tbody>
</table>

Table C – 22
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>APPLICATIONS_&lt;SEGMENT_NAME</td>
<td>Applications descriptive flexfield database items</td>
</tr>
<tr>
<td>ORGANIZATION_&lt;SEGMENT_NAME&gt;</td>
<td>Organization descriptive flexfield database items</td>
</tr>
</tbody>
</table>

Table C – 22
Key Flexfield Database Items

When you define key flexfield segments you make them available for use in QuickPaint by running the Create Key Flexfield DB Items process from the Submit Requests window. This process creates database items for each of the key flexfields listed below.

To ensure easy recognition of these items, the process adds the key flexfield segment name `<SEGMENT_NAME>` to each one.

Run this process for each of your Business Groups. If you define context-dependent key flexfield structures using BUSINESS_GROUP_ID as the reference field, the process creates database items for those flexfield segments as well. BUSINESS_GROUP_ID is the only reference field that the Create Key Flexfield DB Items process supports.

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GRADE_KF_&lt;SEGMENT_NAME&gt;</td>
<td>Grade key flexfield database items</td>
</tr>
<tr>
<td>JOB_KF_&lt;SEGMENT_NAME&gt;</td>
<td>Job key flexfield database items</td>
</tr>
<tr>
<td>POS_KF_&lt;SEGMENT_NAME&gt;</td>
<td>Position key flexfield database items</td>
</tr>
<tr>
<td>GROUP_KF_&lt;SEGMENT_NAME&gt;</td>
<td>Group key flexfield database items</td>
</tr>
</tbody>
</table>

Table C – 23
Absence Database Items

When you define an absence type, Oracle HRMS runs a process to create the following database item for it. To ensure easy recognition of this item, the process adds the absence type name `<ABSENCE_NAME>` to it.

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;ABSENCE_NAME&gt;_CUM_BALANCE</code></td>
<td>The cumulative balance for an absence type</td>
</tr>
</tbody>
</table>

Table C – 24
This appendix provides template SQL*Plus scripts to extract data to include in standard letters.
Purpose

WHENEVER SQLERROR EXIT FAILURE ROLLBACK

REM Define the MS Word mail merge record separator
DEFINE ch=",'%'
REM Define the column width for returning query results
COLUMN L1 FORMAT A2000
SET PAUSE OFF
SET FEEDBACK OFF
SET RECSEP OFF
SET VERIFY OFF
SET TERMOUT OFF
SET PAGESIZE 0

This section defines the required SQL*Plus environment settings. You should produce this section exactly as you see it when you define your mail merge file.

REM Insert session row
insert into fnd_sessions(session_id, effective_date)
select userenv('SESSIONID'),
to_date(&2,'DD–MON–YYYY')
from sys.dual

This section creates a row in the Application Object Library table (AOL) FND_SESSIONS. This enables the datetrack security views to be accessed for the session.
The &2 argument contains the current SQL*Forms session date.
You should produce this section exactly as you see it when you define your mail merge file.
/REM Set length of the header
SET LINESIZE 220

REM Create the mail merge ‘header’ record
for MS Word
REM Note: SPOOL command commented out for concurrent manager.
REM PC based solution required the SPOOL command.
REM spool perwpouk.txt

This section has two functions:
1) To set the mail merge header linesize. This is dependant on the character length of all the mail merge items you want to use. In the example, the header linesize equates approximately to 220 characters.
2) To enable the spooling of the SQL results.
   You must remove the REM keyword from the line that spools output to a file for the Microsoft Mailmerge. If you use concurrent processing to generate the data source file, Concurrent Manager creates the output file.

select 'address_line1' || &ch || 'address_line2' || &ch || 'address_line3' || &ch || 'town_or_city' || &ch || 'country' || &ch || 'postal_code' || &ch || 'applicant_title' || &ch || 'applicant_last_name' || &ch || 'position_name' || &ch || 'organization_name' || &ch || 'grade_name' || &ch || 'projected_hire_date' || &ch || 'recruiter_title' || &ch || 'recruiter_last_name' || &ch from sys.dual

This section defines the mail merge header information. These are the mail merge fields you integrate with your word processed letter. Each mail merge field is delimited by the pre-defined &ch character. Ensure that the field size does not exceed 40 characters and that the field name does not include white spaces.

Do not forget that the length in characters of this selected row from sys.dual is the LINESIZE value you specified above.

REM re-initialise the linesize to the maximum 2000 varchar2 length
SET LINESIZE 2000

After selecting your mail merge header information, you must re-set the LINESIZE to the maximum to VARCHAR2 size which is 2000.
REM Mail merge interview query

select  rpad(
    nvl(pa.address_line1,' ')
    ||&ch|
    nvl(pa.address_line2,' ')
    ||&ch|
    nvl(pa.address_line3,' ')
    ||&ch|
    nvl(pa.town_or_city,' ')
    ||&ch|
    nvl(ft.territory_short_name, ' ')
    ||&ch|
    nvl(pa.postal_code,' ')
    ||&ch|
    nvl(hl1.meaning, ' ')
    ||&ch|
    nvl(pp1.last_name, ' ')
    ||&ch|
    nvl(pos.name, ' ')
    ||&ch|
    pou.name
    ||&ch|
    nvl(pg.name, ' ')
    ||&ch|
    nvl(to_char(pappl.projected_hire_date,
            'fmDay fmddth
            "of" fmMonth YYYY'), ' ')     ||&ch|
    nvl(hl2.meaning, ' ')
    ||&ch|
    nvl(pp2.last_name, ' ')
    ||&ch,
    2000, '#') L1

This section is the main SQL*Plus query that generates the mail merge field information. Note that the columns are merged together using the &ch character as the field delimiter.

The RPAD function pads out the row of information with # for all white spaces. Without this function, mail merge cannot distinguish when a row/record has ended.

The SQL*Plus query in this example is generated from letter requests. Therefore the &1 argument is used to identify which letter_request_id is being generated.

from            per_addresses
                      fnd_territories
                      hr_lookups
                       hl1,
                      hr_lookups
                       hl2,
                      hr_all_organization_units
                       pou,
                      per_positions
                       pos,
                      per_grades
                       pg,
                      per_applications
                       pappl,
                      per_all_people
                       ppl,
                      per_all_people
                       pp2,
                      per_all_assignments
                       pasgl,
                      per_letter_request_lines
                      plr
where plr.letter_request_id = &1
and plr.person_id = ppl.person_id
and pa.primary_flag (+) = 'Y'
and pp1.person_id (+) = ppl.person_id
and ft.territory_code (+) = pa.country
and h11.lookup_code (+) = ppl.title
and h11.lookup_type (+) = 'TITLE'
and pasg1.assignment_id (+) = plr.assignment_id
and pos.position_id (+) = pasg1.position_id
and pou.organization_id (+) = pasg1.organization_id
and pg.grade_id (+) = pasg1.grade_id
and pappl.application_id (+) = pasg1.application_id
and pp2.person_id (+) = pasg1.recruiter_id
and h12.lookup_code (+) = pp2.title
and h12.lookup_type (+) = 'TITLE'
/
REM Note: SPOOL command commented out for concurrent manager.
REM PC based solution required the SPOOL command.
REM spool off

REM update the letter request_status from PENDING to COMPLETE
update per_letter_requests plr
set plr.request_status = 'COMPLETE'
where plr.letter_request_id = &1
and plr.request_status = 'PENDING'
/

REM delete the session row created
delete from fnd_sessions fs
where fs.session_id = userenv('sessionid')
and fs.effective_date = to_date('&2','DD–MON–YYYY')
/
REM commit the changes
commit
/
exit

This section updates the letter request from Pending to Complete (as the example is for letter requests).
This section deletes the row inserted into FND_SESSIONS.
This section commits the changes and exits the SQL*Plus session.
## PERWPWUK.sql

### Purpose

This section defines the required SQL*Plus environment settings. You should produce this section exactly as you see it when you define your mail merge file.

```sql
REM
DEFINE line_size=80
DEFINE field_size= &line_size–1
DEFINE ch=’%’
SET PAGESIZE 0
SET LINESIZE &line_size
BREAK ON L1 SKIP PAGE
COLUMN L1 FORMAT A&line_size
COLUMN L2 FORMAT A&line_size
COLUMN L3 FORMAT A&line_size
COLUMN L4 FORMAT A&line_size
COLUMN L5 FORMAT A&line_size
COLUMN L6 FORMAT A&line_size
COLUMN L7 FORMAT A&line_size
COLUMN L8 FORMAT A&line_size
COLUMN L9 FORMAT A&line_size
SET FEEDBACK OFF
SET RECSEP OFF
SET HEADING OFF
SET VERIFY OFF
SET TERMOUT OFF
```

### This section creates a row in the Application Object Library table (AOL) FND_SESSIONS. The &2 argument contains the current SQL*Forms session date. You should produce this section exactly as you see it when you define your mail merge file.

```sql
insert into fnd_sessions
(session_id ,effective_date)
select userenv('SESSIONID')
,      to_date('&2','DD-MON-YYYY')
from sys.dual
```

### After selecting your mail merge header information, you must re-set the LINESIZE to the maximum to VARCHAR2 size which is 2000.

```sql
REM re-initialise the linesize to the maximum 2000 varchar2 length
SET LINESIZE 2000
```

---

**Template SQL*Plus Script PERWPWUK**
```sql
/\select nvl(t.meaning||' '||p.first_name||' '||p.last_name,'')||&ch||nvl(a.address_line1,' ')||&ch||nvl(a.address_line2,' ')||&ch||nvl(a.address_line3,' ')||&ch||nvl(a.town_or_city,' ')||&ch||nvl(a.region_1,' ')||&ch||nvl(a.postal_code,' ')||&ch||nvl(t.meaning||' '||p.last_name,'') from per_addresses a,
per_people p,
per_letter_request_lines s,
hr_lookups t
where a.person_id (+)
- p.person_id
and p.person_id
- s.person_id
and p.title
- t.lookup_code (+)
and t.lookup_type (+)
- 'TITLE'
and s.letter_request_id
- &1
/
```

This section is the main SQL*Plus query that generates the mail merge field information. Note that the columns are merged together using the &ch character as the field delimiter. The SQL*Plus query in this example is generated from letter requests. Therefore the &1 argument is used to identify which letter_request_id is being generated.

```sql
update per_letter_requests r
set r.letter_request_id = &1
where r.letter_request_id = &1
/update per_letter_request_lines rl
set rl.letter_request_id = &1
where rl.letter_request_id = &1
```

This section updates the letter request from Pending to Complete (as the example is for letter requests).

```sql
/commit
/exit
/
```

This section commits the changes and exits the SQL*Plus session.
OTA SQL*Plus Script to Produce Confirmation Letters

<table>
<thead>
<tr>
<th>OTA.sql</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>WHENEVER SQLERROR EXIT FAILURE ROLLBACK REM</td>
<td>This section defines the required SQL*Plus environment settings.</td>
</tr>
<tr>
<td>Define the MS Word mail merge record separator</td>
<td>You should produce this section exactly as you see it when you define</td>
</tr>
<tr>
<td>DEFINE ch=&quot;’‘&quot;REM Define the column width for returning query results</td>
<td>your mail merge file.</td>
</tr>
<tr>
<td>COLUMN L1 FORMAT A2000 SET PAUSE OFF</td>
<td></td>
</tr>
<tr>
<td>SET FEEDBACK OFF</td>
<td></td>
</tr>
<tr>
<td>SET RECSSEP OFF</td>
<td></td>
</tr>
<tr>
<td>SET HEADING OFF</td>
<td></td>
</tr>
<tr>
<td>SET VERIFY OFF</td>
<td></td>
</tr>
<tr>
<td>SET TERMOUT OFF</td>
<td></td>
</tr>
<tr>
<td>SET PAGESIZE 0</td>
<td></td>
</tr>
<tr>
<td>REM Insert session row</td>
<td>This section creates a row in the Application Object Library (AOL)</td>
</tr>
<tr>
<td>insert into fnd_sessions(session_id, effective_date)</td>
<td>FND_SESSIONS. This enables the datetrack security views to be</td>
</tr>
<tr>
<td>select userenv('SESSIONID'),</td>
<td>accessed for the session.</td>
</tr>
<tr>
<td>to_date('&amp;2','DD-MON-YYYY')</td>
<td>The &amp;2 argument contains the current SQL*Forms session date.</td>
</tr>
<tr>
<td>from sys.dual</td>
<td>You should produce this section exactly as you see it when you define</td>
</tr>
<tr>
<td>/</td>
<td>your mail merge file.</td>
</tr>
</tbody>
</table>
REM Set length of the header
SET LINESIZE 200
REM Create the mail merge 'header' record for MS Word
REM Note: SPOOL command commented out for concurrent manager.
REM PC based solution required the SPOOL command.spool xxxx.txt

This section has two functions:
1) To set the mail merge header linesize. This is dependant on the character length of all the mail merge items you want to use. In the example, the header linesize equates approximately to 220 characters.
2) To enable the spooling of the SQL results. The spool file should match the name of the SQL file you are writing, but with a text file extension.

select 'student_title' ||&ch||
     'student_first_name' ||&ch||
     'student_last_name'
||&ch||
     'event_name' ||&ch||
     'event_code'
||&ch||
     'event_end_date'
||&ch
from sys.dual
/

This section defines the mail merge header information. These are the mail merge fields you integrate with your word processed letter. Each mail merge field is delimited by the pre-defined &ch character. Ensure that the field size does not exceed 40 characters and that the field name does not include white spaces. Do not forget that the length in characters of this selected row from sys.dual is the LINESIZE value you specified above.
After selecting your mail merge header information, you must re-set the LINESIZE to the maximum to VARCHAR2 size which is 2000.

### REM Mail merge confirmation query

```
REM Mail merge confirmation query
select rpad(
    initcap(nvl(d.delegate_title_messaging,'')) ||&ch||
    nvl(d.delegate_first_name,'') ||&ch||
    nvl(d.delegate_last_name,'') ||&ch||
    nvl(v.description,'') ||&ch||
    nvl(d.event_activity_version_name,'') ||&ch||
    to_char(d.course_end_date, 'DD
    fmMonth YYYY') ||&ch,
   2000, '#')
L1
from ota_delegate_bookings_v
d,
ota_activity_versions
v,
per_letter_request_lines
plr
where plr.letter_request_id = &1
and (plr.ota_booking_id = d.booking_id
     or plr.ota_event_id = d.event_id)
and d.activity_version_id = v.activity_version_id
/
```

This section is the main SQL*Plus query that generates the mail merge field information. Note that the columns are merged together using the &ch character as the field delimiter. The RPAD function pads out the row of information with # for all white spaces. Without this function, mail merge cannot distinguish when a row/record has ended. The SQL*Plus query in this example is generated from letter requests. Therefore the &1 argument is used to identify which letter_request_id is being generated.

**REM Note:** SPOOL command commented out for concurrent manager.

**REM** PC based solution required the SPOOL command.

```
spool off
```
<table>
<thead>
<tr>
<th>SQL Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>REM Update the letter request status from PENDING to COMPLETE &lt;br&gt; update per_letter_requests &lt;br&gt; plr &lt;br&gt; set plr.request_status = 'COMPLETE' &lt;br&gt; where plr.letter_request_id = &amp;1 &lt;br&gt; and plr.request_status = 'PENDING' /</td>
<td>This section updates the letter request from Pending to Complete (as the example is for letter requests).</td>
</tr>
<tr>
<td>REM delete the session row created &lt;br&gt; delete from fnd_sessions &lt;br&gt; fs &lt;br&gt; where fs.session_id = userenv('sessionid') &lt;br&gt; and fs.effective_date = to_date('&amp;2','DD-MON-YYYY') /</td>
<td>This section deletes the row inserted into FND_SESSIONS.</td>
</tr>
<tr>
<td>REM commit the changes &lt;br&gt; commit / exit /</td>
<td>This section commits the changes and exits the SQL*Plus session</td>
</tr>
</tbody>
</table>
Glossary

A

Absence Types Categories of absence, such as medical leave or vacation leave, that you define for use in absence windows.

Alternative Regions Parts of a window that appear in a stack so that only one is visible at any time. You click on the name of the region to pop up a list of the other regions in the stack. Select the name of a region to bring it to the top of the stack.

Applicant A candidate for employment in a Business Group.

Appraisal A ‘superset’ of recording opinions and setting and achieving objectives, plans and so on. See also: Assessment.

Assignment An employee’s assignment identifies his or her role and payroll within a Business Group. The assignment is made up of a number of assignment components. Of these, organization is mandatory, and payroll is a required component for payment purposes.

Assignment Number A number that uniquely identifies an employee’s assignment. An employee with multiple assignments has multiple assignment numbers.

Assignment Set A grouping of employees and/or applicants that you define for running QuickPaint reports and processing payrolls. See also: QuickPaint Report.

Assignment Status For employees, used to track their permanent or temporary departures from your enterprise, and to control the remuneration they receive. For applicants, used to track the progress of their applications.

BACS Banks Automated Clearing System. This is the UK system for making direct deposit payments to employees.

Base Currency The currency in which Oracle Payroll performs all payroll calculations for your Business Group. If you pay employees in different currencies to this, Oracle Payroll calculates the amounts based on exchange rates defined on the system.

Behavioral Indicators Characteristics that identify how a competence is exhibited in the work context. See also: Proficiency Level.
Benefit  Any part of an employee’s remuneration package that is not pay. Vacation time, employer-paid medical insurance and stock options are all examples of benefits. See also: Elements

Block  The largest subordinate unit of a window, containing information for a specific business function or entity. Every window consists of at least one block. Blocks contain fields and, optionally, regions. They are delineated by a bevelled edge. You must save your entries in one block before navigating to the next. See also: Region, Field

Budget Value  In Oracle Human Resources you can enter staffing budget values and actual values for each assignment to measure variances between actual and planned staffing levels in an organization or hierarchy.

Business Group  The highest level organization in the Oracle HRMS system. A Business Group may correspond to the whole of your enterprise or to a major grouping such as a subsidiary or operating division. Each Business Group must correspond to a separate implementation of Oracle HRMS.

Calendar Exceptions  In Oracle SSP/SMP you define calendar exceptions for an SSP qualifying pattern, to override the pattern on given days. Each calendar exception is another pattern which overrides the usual pattern.

Career Map  A plan showing the expected routes by which employees can progress from one job to another within the Business Group.

Compensation  The pay you give to employees, including wages or salary, and bonuses. See also: Elements

Competence  Any measurable behavior required by an organization, job or position that a person may demonstrate in the work context. A competence can be a piece of knowledge, a skill, an attitude or an attribute.

Competence Profile  Where you record applicant and employee accomplishments, for example, proficiency in a competence.

Competence Requirements  Competencies required by an organization, job or position. See also: Competence, Core Competencies

Competence Type  A group of related competencies

Consolidation Set  A grouping of payroll runs within the same time period for which you can schedule reporting, costing, and post–run processing.

Contact  A person who has a relationship to an employee that you want to record. Contacts can be dependents, relatives, partners or persons to contact in an emergency.
Core Competencies  Competencies required by every person to enable the enterprise to meet its goals. See also: Competence

Costable Type  A feature that determines the processing an element receives for accounting and costing purposes. There are four costable types in Oracle HRMS: costed, distributed costing, fixed costing, and not costed.

Costing  Recording the costs of an assignment for accounting or reporting purposes. Using Oracle Payroll, you can calculate and transfer costing information to your general ledger and into systems for project management or labor distribution.

Customizable Forms  Forms that your system administrator can modify for ease of use or security purposes by means of Custom Form restrictions. The Form Customization window lists the forms and their methods of customization.

Database Item  An item of information in Oracle HRMS that has special programming attached, enabling Oracle FastFormula to locate and retrieve it for use in formulas.

Date To and Date From  These fields are used in windows not subject to DateTrack. The period you enter in these fields remains fixed until you change the values in either field. See also: DateTrack, Effective Date

DateTrack  When you change your effective date (either to past or future), DateTrack enables you to enter information that takes effect on your new effective date, and to review information as of the new date. See also: Effective Date

Deployment Factors  See: Work Choices

Descriptive Flexfield  A field that your organization can customize to capture additional information required by your business but not otherwise tracked by Oracle Applications. See also: Key Flexfield

Effective Date  The date for which you are entering and viewing information. You set your effective date in the Alter Effective Date window. See also: DateTrack

Elements  Components in the calculation of employee pay. Each element represents a compensation or benefit type, such as salary, wages, stock purchase plans, and pension contributions.

Element Classifications  These control the order in which elements are processed and the balances they feed. Primary element classifications and some secondary classifications are predefined by Oracle Payroll. Other secondary classifications can be created by users.

Element Entry  The record controlling an employee’s receipt of an element, including the period of time for which the employee receives the element and its value. See also: Recurring Elements, Nonrecurring Elements

Element Link  The association of an element to one or more components of an employee assignment. The link establishes employee eligibility for that element. Employees whose assignment components match the components of the link are eligible for the element. See also: Standard Link

Element Set  A group of elements that you define to process in a payroll run, or to control access to compensation information from a customized form, or for distributing costs.

Event An activity such as a training day, review, or meeting, for employees or applicants.

Expected Week of Confinement (EWC) The week in which an employee’s baby is due. The Sunday of the expected week of confinement is used in the calculations for Statutory Maternity Pay (SMP).

Field A view or entry area in a window where you enter, view, update, or delete information. See also: Block, Region

Form A predefined grouping of functions, called from a menu and displayed, if necessary, on several windows. Forms have blocks, regions and fields as their components. See also: Block, Region, Field

Global Value A value you define for any formula to use. Global values can be dates, numbers or text.

Grade A component of an employee’s assignment that defines their level and can be used to control the value of their salary and other compensation elements.

Grade Comparatio A comparison of the amount of compensation an employee receives with the mid-point of the valid values defined for his or her grade.

Grade Rate A value or range of values defined as valid for a given grade. Used for validating employee compensation entries.

Grade Scale A sequence of steps valid for a grade, where each step corresponds to one point on a pay scale. You can place each employee on a point of their grade scale and automatically increment all placements each year, or as required. See also: Pay Scale

Grade Step An increment on a grade scale. Each grade step corresponds to one point on a pay scale. See also: Grade Scale

Group A component that you define, using the People Group key flexfield, to assign employees to special groups such as pension plans or unions. You can use groups to determine employees’ eligibility for certain elements, and to regulate access to payrolls.

Hierarchy An organization or position structure showing reporting lines or other relationships. You can use hierarchies for reporting and for controlling access to Oracle HRMS information.

Input Values Values you define to hold information about elements. In Oracle Payroll, input values are processed by formulas to calculate the element’s run result. You can define up to fifteen input values for an element.
Key Flexfield  A flexible data field made up of segments. Each segment has a name you define and a set of valid values you specify. Used as the key to uniquely identify an entity, such as jobs, positions, grades, cost codes, and employee groups. See also: Descriptive Flexfield

Leaver’s Statement Records details of Statutory Sick Pay (SSP) paid during a previous employment (issued as form SSP1L) which is used to calculate a new employee’s entitlement to SSP. If a new employee falls sick, and the last date that SSP was paid for under the previous employment is less than eight calendar weeks before the first day of the PIW for the current sickness, the maximum liability for SSP is reduced by the number of weeks of SSP shown on the statement.

Linking Interval  The number of days that separate two periods of incapacity for work. If a period of incapacity for work (PIW) is separated from a previous PIW by less than the linking interval, they are treated as one PIW according to the legislation for entitlement to Statutory Sick Pay (SSP). An employee can only receive SSP for the maximum number of weeks defined in the legislation for one PIW.

Linked PIWs  Linked periods of incapacity for work are treated as one to calculate an employee’s entitlement to Statutory Sick Pay (SSP). A period of incapacity for work (PIW) links to an earlier PIW if it is separated by less than the linking interval. A linked PIW can be up to three years long.

Maternity Pay Period  The period for which Statutory Maternity Pay (SMP) is paid. It may start at any time from the start of the 11th week before the expected week of confinement and can continue for up to 18 weeks. The start date is usually agreed with the employee, but can start at any time up to the birth. An employee is not eligible to SMP for any week in which she works or for any other reason for ineligibility, defined by the legislation for SMP.

Menus  You set up your own navigation menus, to suit the needs of different users.

Nonrecurring Elements  Elements that process for one payroll period only unless you make a new entry for an employee. See also: Recurring Elements

Oracle FastFormula  An Oracle tool that allows you to write Oracle HRMS formulas without using a programming language.

Organization  A required component of employee assignments. You can define as many organizations as you want within your Business Group. Organizations can be internal, such as departments, or external, such as recruitment agencies. You can structure your organizations into organizational hierarchies for reporting purposes and for system access control.
Pattern  A pattern comprises a sequence of time units that are repeated at a specified frequency. Oracle SSP/SMP uses SSP qualifying patterns to determine employees entitlement to Statutory Sick Pay (SSP).

Pattern Time Units  A sequence of time units specifies a repeating pattern. Each time unit specifies a time period of hours, days or weeks.

Pay Scale  A set of progression points, which can be related to one or more rates of pay. Employee’s are placed on a particular point on the scale according to their grade and, usually, work experience. See also: Grade Scale

Payment Type  There are three standard payment types for paying employees: check, cash and direct deposit. You can define your own payment methods corresponding to these types.

Payroll  A group of employees that Oracle Payroll processes together with the same processing frequency, for example, weekly, monthly or bimonthly. Within a Business Group, you can set up as many payrolls as you need.

Performance (within Assessment) An expectation of “normal” performance of a competence over a given period. For example, a person may exceed performance expectation in the communication competence. See also: Proficiency (within Assessment), Competence, Assessment

Period of Incapacity for Work (PIW)  A period of sickness that lasts four or more days in a row, and is the minimum amount of sickness for which Statutory Sick Pay can be paid. If a PIW is separated by less then the linking interval, a linked PIW is formed and the two PIWs are treated as one.

Period Type  A time division in a budgetary calendar, such as week, month, or quarter.

Person Type  There are eight system person types in Oracle HRMS. Seven of these are combinations of employees, ex-employees, applicants, and ex-applicants. The eighth category is ‘External’. You can create your own user person types based on the eight system types.

Position  A specific role within the Business Group derived from an organization and a job. For example, you may have a position of Shipping Clerk associated with the organization Shipping and the job Clerk.

Proficiency (within Assessment)  The perceived level of expertise of a person in a competence, in the opinion of the assessor, over a given period. For example, a person may demonstrate the communication competence at Expert level. See also: Performance (within Assessment), Competence, Assessment

Proficiency Level  A system for expressing and measuring how a competence is exhibited in the work context. See also: Behavioral Indicators.

Progression Point  A pay scale is calibrated in progression points, which form a sequence for the progression of employees up the pay scale. See also: Pay Scale
**Qualification Type**  An identified qualification method of achieving proficiency in a competence, such as an award, educational qualification, a license or a test. See: Competence

**Qualifying Days**  Days on which Statutory Sick Pay (SSP) can be paid, and the only days that count as waiting days. Qualifying days are normally work days, but other days may be agreed.

**Qualifying Pattern**  See: SSP Qualifying Pattern

**Qualifying Week**  The week during pregnancy that is used as the basis for the qualifying rules for Statutory Maternity Pay (SMP). The date of the qualifying week is fifteen weeks before the expected week of confinement and an employee must have been continuously employed for at least 26 weeks continuing into the qualifying week to be entitled to SMP.

**QuickCode Types**  Categories of information, such as nationality, address type and tax type, that have a limited list of valid values. You can define your own QuickCode Types, and you can add values to some predefined QuickCode Types.

**QuickPaint Report**  A method of reporting on employee and applicant assignment information. You can select items of information, paint them on a report layout, add explanatory text, and save the report definition to run whenever you want. See also: Assignment Set

**Rating Scale**  Used to describe an enterprise’s competencies in a general way. You do not hold the proficiency level at the competence level. See also: Proficiency Level

**Recruitment Activity**  An event or program to attract applications for employment. Newspaper advertisements, career fairs and recruitment evenings are all examples of recruitment activities. You can group several recruitment activities together within an overall activity.

**Recurring Elements**  Elements that process regularly at a predefined frequency. Recurring element entries exist from the time you create them until you delete them, or the employee ceases to be eligible for the element. Recurring elements can have standard links. See also: Nonrecurring Elements, Standard Link

**Region**  A collection of logically related fields in a window, set apart from other fields by a rectangular box or a horizontal line across the window. See also: Block, Field

**Report Parameters**  Inputs you make when submitting a report to control the sorting, formatting, selection, and summarizing of information in the report.

**Report Security Group**  A list of reports and processes that can be submitted by holders of a particular responsibility. See also: Responsibility

**Report Set**  A group of reports and concurrent processes that you specify to run together.

**Requisition**  The statement of a requirement for a vacancy or group of vacancies.

**Rates**  A set of values for employee grades or progression points. For example, you can define salary rates and overtime rates.
Responsibility  A level of authority in an application. Each responsibility lets you access a specific set of Oracle Applications forms, menus, reports, and data to fulfill your business role. Several users can share a responsibility, and a single user can have multiple responsibilities. See also: Security Profile, User Profile Options, Report Security Group

Salary Basis  The period of time for which an employee’s salary is quoted, such as hourly or annually. Defines a group of employees assigned to the same salary basis and receiving the same salary element.

Security Profile  Security profiles control access to organizations, positions and employee and applicant records within the Business Group. System administrators use them in defining users’ responsibilities. See also: Responsibility, User Profile Options

SMP  See: Statutory Maternity Pay

Special Information Types  Categories of personal information, such as skills, that you define in the Personal Analysis key flexfield.

SSP  See: Statutory Sick Pay

SSP Qualifying Pattern  An SSP qualifying pattern is a series of qualifying days that may be repeated weekly, monthly or some other frequency. Each week in a pattern must include at least one qualifying day. Qualifying days are the only days for which Statutory Sick Pay (SSP) can be paid, and you define SSP qualifying patterns for all the employees in your organization so that their entitlement to SSP can be calculated.

Standard Link  Recurring elements with standard links have their element entries automatically created for all employees whose assignment components match the link. See also: Element Link, Recurring Elements

Statutory Maternity Pay  You pay Statutory Maternity Pay (SMP) to female employees who take time off work to have a baby, providing they meet the statutory requirements set out in the legislation for SMP.

Statutory Sick Pay  You pay Statutory Sick Pay (SSP) to employees who are off work for four or more days because they are sick, providing they meet the statutory requirements set out in the legislation for SSP.

Task Flows  A sequence of windows linked by buttons to take you through the steps required to complete a task, such as hiring a new recruit. System administrators can create task flows to meet the needs of groups of users.

Terminating Employees  You terminate an employee when he or she leaves your organization. Information about the employee remains on the system but all current assignments are ended.

Termination Rule  Specifies when entries of an element should close down for an employee who leaves your enterprise. You can define that entries end on the employee’s actual termination date or remain open until a final processing date.
**U**

**User Profile Options** Features that allow system administrators and users to tailor Oracle HRMS to their exact requirements. See also: *Responsibility, Security Profile*

**V**

**Waiting Days** Statutory Sick Pay is not payable for the first three qualifying days in period of incapacity for work (PIW), which are called waiting days. They are not necessarily the same as the first three days of sickness, as waiting days can be carried forward from a previous PIW if the linking interval between the two PIWs is less than 56 days.

**Work Choices** Also known as Deployment or Work Factors. These can affect a person’s capacity to be deployed within an enterprise, such willingness to travel or relocate. You can hold work choices at both job and position, or at person level.

**Work Structures** The fundamental definitions of organizations, jobs, positions, grades, payrolls and other employee groups within your enterprise that provide the framework for defining the work assignments of your employees.
Index

A
Absence categories, for absence types, 24 – 2 to 24 – 4
Absence elements
  balances for, 24 – 5 to 24 – 7
  definition and linking of, 24 – 9 to 24 – 10
Absence types
  database items, C – 26
  definition of, 24 – 11 to 24 – 15
  listing by, 24 – 16
ABSENCE_CATEGORY, 24 – 8, 24 – 11
ABSENCE_REASON, 24 – 8, 24 – 11
Absences
  authorization of and replacements for, 24 – 7
  batch entry of, 24 – 30
  defining and linking elements for, 24 – 9
  defining types of, 24 – 11 to 24 – 15
  elements for, 24 – 4 to 24 – 7
  employee’s history of, 24 – 15
  initializing balances for, 24 – 6
  recording of, 24 – 7, 24 – 13 to 24 – 14
  referencing in payroll runs, 24 – 6
  relief position, 3 – 11
  reviewing, 24 – 15 to 24 – 17
  setup for recording, 24 – 8 to 24 – 12
  types, categories and reasons, 24 – 2 to 24 – 4
Accepted assignment status, 15 – 15
Accrual plans. See PTO accrual plans
Active application assignment status, 15 – 15
Active assignment status, 27 – 5
Additional element entries, 8 – 5, 8 – 7, 9 – 5
Address styles, B – 9
ADDRESS_TYPE, 13 – 10
Addresses
  floor or office numbers, 14 – 9
  for people, 13 – 10
  for work sites, 2 – 2 to 2 – 3
Adjustments, for Pay Values, 9 – 6
Alerts, competencies, 17 – 10
APL_ASSIGN_REASON, 15 – 12, 15 – 16
APL_EVENT_TYPE, 15 – 18, 25 – 2
APL_INTERVIEW_TYPE, 15 – 17
Applicant assignment statuses, 15 – 15 to 15 – 18
  mass update of, 15 – 19
  reporting on, 14 – 29
  secondary statuses, 15 – 16
  user statuses for, 27 – 7
Applicant assignments, 15 – 10
Applicant Details Report, 13 – 29
Applicant information, 13 – 6
Applicant number, 13 – 5
Applicants
  entering, 15 – 10
  hiring, 15 – 20
  interviewing, 15 – 17
  listing, 13 – 3
  mass update of status, 15 – 19
referring to another recruiter, 15 – 19
reporting on, 15 – 10, 15 – 22
skills matching, 15 – 5
terminating, 15 – 21
tracking progress of, 15 – 15 to 15 – 16
Application Data Export, 32 – 5

Appraisal
  overview, 20 – 14
  questionnaire, 20 – 15
  creating, 20 – 17, 20 – 23
  template, 20 – 15
  creating or changing, 20 – 30

Appraisals, 16 – 12, 25 – 4

Assessment
  competence–based, 20 – 3
  measuring competencies, 20 – 4
  template, 20 – 4
  calculating scores, 20 – 8
  changing or deleting, 20 – 10
  different types, 20 – 5
  proficiency levels, 20 – 7

Assessments, 16 – 12

Assignment Details Report, 13 – 29

Assignment reporting
  Assignment Status Report, 14 – 29
  Assignments Folder, 14 – 22

Assignment sets, 29 – 15

Assignments
  for applicants, 15 – 10
  for employees, 14 – 4
  verifying for a mass move, 3 – 32

Attachments, 32 – 6

Audit groups, 34 – 2

AuditTrail, 34 – 2
  setting up audit groups, 34 – 2

B

Background check information, 13 – 7

BACS, setting processing date, 5 – 6

Balancing qualifier, 11 – 4

Bank account information, B – 11

Bank information, for BACS payment methods, 14 – 20

Base currency, 28 – 7
Batch entry using MIX, 9 – 7
Batch processing, generating letters, 26 – 5 to 26 – 8
BEE, procedures for, 9 – 8
Behavioral indicators, competencies, 17 – 3
Blood type, entry of, 13 – 7
Booking events, 15 – 18, 25 – 3
Budget value defaults, 2 – 16
BUDGET_MEASUREMENT_TYPE, 2 – 16, 12 – 4

Budgets
  for people, 12 – 2 to 12 – 13
  for salaries, 10 – 18 to 10 – 19, 12 – 6 to 12 – 13
  in centralized management enterprises, 10 – 19
  in devolved management enterprises, 10 – 19
  in project based enterprises, 6 – 5
  in rule based enterprises, 6 – 8, 10 – 18, 12 – 6
  viewing variances, 12 – 10

Business Groups, 2 – 4 to 2 – 5
  additional information for, 2 – 12
  defaults for, 2 – 16
  defining, 2 – 10 to 2 – 13
  startup data, 2 – 5

C

Calendars
  for budgets, 12 – 8
  for employee absences, 24 – 7
  for payrolls, 5 – 8
  for PTO accrual plans, 24 – 18

Career Management, defining your enterprise competencies, 16 – 10

Career paths
  defining, 21 – 8
  naming, 21 – 5, 21 – 7, 21 – 8

Career planning, 16 – 15, 21 – 2 to 21 – 10

Careers, planning, 21 – 2

College attendances, 13 – 15

Comments, 32 – 6
Common framework, competence approach, advantages, 16–3
Comparatio values for grades, 4–10
Comparing with accomplishments, requirements, competence approach, 18–3
Compensation and benefits
costing, 7–13
defining a working model for, 7–2
eligibility for, 7–10 to 7–13
entering, 7–5, 9–2 to 9–7
history, 9–18
inquiries, 9–16
planning, 8–16
qualifying conditions, 7–11, 8–6
relating grades to, 4–3, 4–6
salary administration, 10–2 to 10–17
steps to setting up, 8–2 to 8–4
tracking changes, 8–15 to 8–16
Competence approach
common framework, advantages, 16–3
controlling your operation, 16–8
identifying your business goals, 16–10
Competence gap analysis, 16–14
Competence profile, copying competencies, 13–15
Competence profiles, 13–15
Competence requirements
creating, 18–2
overview, 16–11
Competence types
creating, 17–16
deleting, 17–16
Competencies
a definition, 17–2
alerts, 17–10
behavioral indicators, 17–3
certification, 17–13
copying, competence profile, 13–15
core, 18–2
creating, 17–10
essential, 18–4
grouping, 17–14
leadership, 18–2
proficiency levels, 17–3
structuring, 17–4
general method, 17–5
individual method, 17–4
which method, 17–6
Competencies and OTA, 16–14
setting up Career Management, 19–2
Concurrent managers, 29–5
CONTACT, 13–13
Contacts, 13–13, 27–2
Contract staff, 6–12
CONTROL_TYPE, 9–8
Controlling your operation, Career Management, 16–8
Copying competencies, competence profile, 13–15
Core competencies, creating, 18–2
Cost Allocation key flexfield, 11–3, B–4
Cost centers, 11–5
for organizations, 2–7
Costing
accumulating cost figures, 11–2
for assignments, 9–5, 11–5
for elements, 7–13, 8–11, 11–4
for organizations, 2–20, 11–5
for payrolls, 5–7
salary budgeting, 10–18 to 10–19, 12–6 to 12–13
Costing information, for projects, 6–4
Country-specific features
address styles, B–9
in key flexfields, B–10
Currencies
enabling, 28–7
of element entries, 8–5
Current and Projected Progression Point Values Report, 4–19
Customizing
Element Entries window, 8–14
Event Bookings window, 25–2
List People by Special Information window, 13–26
menu structures, 30–18 to 30–20
People Folder window, 13–3
People window, 13–4
QuickPaint Report window, 29–14
Special Information window, 13–24
Table Values window, 31–13
windows, 30–2, 30–3 to 30–9
D

Database items
from element input values, 8 – 8
in QuickPaint reports, 29 – 11
list of dynamic items, C – 19
list of static items, C – 2
DateTrack, 1 – 9, 1 – 11 to 1 – 19
changing datetracked information, 1 – 14 to 1 – 15
Date Security user profile option, 1 – 11
deleting datetracked information, 1 – 16
Reminder user profile option, 1 – 12
DateTrack History, 1 – 13
DateTrack: Date Security, 28 – 6
DateTrack:Reminder, 28 – 6
Define Rate form, modes, 30 – 22
Dependents, 13 – 13
Descriptive flexfields
creating database items, B – 6
defining segments of, 30 – 2 to 30 – 4
explained, 30 – 2, B – 5
for address styles, B – 9
list of user definable, B – 6 to B – 9
protected, B – 10
Disability leave, 27 – 7
Distribution sets, 30 – 6
Double entry accounting, 11 – 4

E

Education leave, 27 – 7
Effective dates, 1 – 9, 1 – 11
ELE_ENTRY_REASON, 9 – 5
Element classifications, 7 – 4
Element entries, 9 – 2 to 9 – 7
additional, 8 – 5, 8 – 7, 9 – 5
automatic, 7 – 12, 9 – 3
batch, 9 – 7
customizing Element Entries window, 8 – 14
defaults for different groups, 7 – 11
history, 9 – 18
hot defaults, 8 – 8, 9 – 5
multiple, 8 – 5, 8 – 7
nonrecurring, 9 – 3
overrides, 9 – 5
preventing, 8 – 5
recurring, 9 – 3
validation, 7 – 8, 8 – 3
Element Link Details Report, 8 – 13
Element links
costing, 11 – 4
defining, 8 – 10 to 8 – 13
maintaining, 8 – 15
reporting on, 8 – 13
standard, 7 – 12, 8 – 6
using, 7 – 10 to 7 – 13
Element sets, 30 – 6
Elements
database items, C – 19
defining, 8 – 3 to 8 – 6
defining, for absence types, 24 – 9 to 24 – 11
eligibility rules, 7 – 10 to 7 – 13
entering, 7 – 5 to 7 – 11, 9 – 4 to 9 – 7
examples of, 7 – 3
for salaries, 10 – 5
generated, for PTO accrual plans, 24 – 18 to 24 – 19
input values for, 7 – 7 to 7 – 11, 8 – 8 to 8 – 12
maintaining, 8 – 15
nonrecurring, 5 – 2
qualifying conditions, 7 – 11, 8 – 6, 8 – 12
Email ID information, entry of, 13 – 6
EMP_ASSIGN_REASON, 14 – 9
EMP_EVENT_TYPE, 25 – 2
EMP_INTERVIEW_TYPE, 25 – 4
Employee assignment number, 14 – 9
Employee assignment statuses, 27 – 5 to 27 – 6
and payroll processing, 27 – 5
element entries valid for, 27 – 5
reporting on, 14 – 29
secondary statuses, 27 – 6
Employee assignments
allocation of costs for, 14 – 6
and work structures, 14 – 4 to 14 – 17
changes to, and DateTrack, 14 – 11
components of, 14 – 5
defining as primary, 14 – 9
definition, 14 – 4
ending all, 14 – 14 to 14 – 15
ending one of multiple, 14 – 13
entering, 14–8 to 14–10
history, 14–32
inquiring and reporting on, 14–22 to 14–32
manager-level, 14–9
numbers for, 14–6
payment methods for, 14–19 to 14–21
position based, 6–6
primary assignments, 14–5
project based, 6–2 to 6–6
using multiple assignments, 14–5
Employee groups, 5–10
Employee Increment Results Report, 4–19
Employee lists
  by absence type, 24–16
  by assignment components, 14–22
  by assignment statuses, 14–29
  by organization, 14–25
  by personal information, 13–3
  by position, 14–27
  by position hierarchy, 14–28
  by special information type, 13–26
Employee numbers, 13–5, 14–6
Employee Organization Movements Report, 14–30
Employee Payroll Movements Report, 14–30
Employee Summary Report, 14–30
Employment
  hiring, 13–8
  history, 14–32
Employment categories
  adding new, 14–5
  assigning employees to, 14–9
  full time and part time, 14–5
  in startup data, 14–5
Employment information
  making changes to, 14–3
  table of, 14–2
End assignment status, 14–13, 27–5
End Dates, removing, 1–16
Enterprise competencies, Career Management, 16–10
Essential, competencies, 18–4
EVAL_SYSTEM, 3–13
EVAL_SYSTEM_MEAS, 3–13
Evaluation systems, 3–13
Event management, 15–18, 25–2
External organizations, 2–6, 2–7

F
Folders, 29–3 to 29–9
FORM_MODE, 30–22
Formulas, for validation, 8–9, 27–4
Free text information, 23–4
FREQUENCY, 2–19
Full Applicant Details Report, 15–10
Full Personal Details Report Set, 13–29
Further name information, 13–7

G
General Ledger, 11–4
Generate Secure User process, 33–15
Generating letters, batch processing, 26–5 to
  26–8
Grade Name key flexfield, 4–2, B–3
Grade rates, 4–8 to 4–10
  for salary proposal validation, 10–7
Grade scales, 4–12
Grade steps, 4–15
  incrementing placements, 4–18
  placing employees on, 4–17
Grades, 4–2 to 4–5
  assigning an employee to, 14–8
  comparatio values, 4–10
  defining, 4–4 to 4–6
  relating to progression points, 4–15
  valid grades for jobs and positions, 3–15, 4
  3–3
Grant Permissions To Roles process, 33–15
Graphics, 13–13
Grouping competencies, 17–14

H
Headcount, 12–2 to 12–13, 15–4
Health and safety requirements, for jobs or positions, 3 – 6
Hiring people, 13 – 8, 15 – 20
History
  of assignments, 14 – 32
  of element entries, 9 – 18
Honors, entry of, 13 – 7
Hot defaults, of element entries, 8 – 8, 9 – 5
Hours of work, 14 – 9
  entering defaults for, 2 – 5, 2 – 19
HR Organizations, additional information for, 2 – 13
HR User Type, 8 – 3, 32 – 3
HR:Business Group, 28 – 5
HR:Query Only Mode, 28 – 5
HR:Security Profile, 28 – 5
HR:Use Standard Attachments, 28 – 5
HR:User Type, 28 – 5
HR_CUSTOMIZATION, 30 – 22
Human resource management
  budgeting, 12 – 2 to 12 – 13
  career planning, 21 – 2 to 21 – 10
  cycle of functions, 1 – 4
  employee reviews, 25 – 4 to 25 – 7
  evaluating jobs and positions, 3 – 13 to 3 – 16
  integrating with payroll management, 1 – 3
  salary administration and performance reviews, 10 – 2 to 10 – 17

I
Identifying your business goals, competence approach, 16 – 10
Implementation of HRMS
  in hybrid enterprise structures, 6 – 10 to 6 – 12
  in project based enterprises, 6 – 2 to 6 – 6
  in rule based enterprises, 6 – 6 to 6 – 13
Increment Progression Points process, 4 – 18
Information infrastructure, 16 – 4
Input values, 7 – 7, 8 – 8, 8 – 12
Inquiry windows, list of, 29 – 3
Insurance carriers, defining, 2 – 11
International relocation, employee preferences, 13 – 19
Interviews
  with applicants, 15 – 17
  with employees, 25 – 4

J
Job and Position Skills Matching Report, 23 – 5
Job codes, 3 – 5
Job Name key flexfield, 3 – 5, B – 3
Jobs
  assigning an employee to, 14 – 9
  career paths, 21 – 8
  contrasting with positions, 3 – 2
  defining, 3 – 8
  entering valid grades, 3 – 15
  evaluating, 3 – 13
  in project based enterprises, 6 – 4
  representing jobs and positions, 3 – 2 to 3 – 7
  skill requirements of, 3 – 16
  work choices, 3 – 17

K
Key flexfields, 1 – 17
  Bank Details, B – 11
  Cost Allocation, 11 – 3
  creating database items, B – 4
  for country-specific information, B – 10 to B – 12
Grade Name, 4 – 2
Job Name, 3 – 5
People Group, 5 – 10
Personal Analysis, 27 – 10
Position Name, 3 – 5
protected, B – 10
setting up, B – 3
Soft Coded Legislation, B – 11
uses of, B – 2

L
Leadership competencies, creating, 18 – 2
Legislation Code, 2 – 15
Length of service bands
  for PTO accrual plans, 24 – 21
  setup of, 24 – 25 to 24 – 26
Letter generation, 26 – 2 to 26 – 6
Letters
  generating, batch processing, 26 – 5 to 26 – 8
  setting up, 26 – 3
Links
  defining, 8 – 10 to 8 – 13
  maintaining, 8 – 15
  reporting on, 8 – 13
  standard, 7 – 12, 8 – 6
  using, 7 – 10 to 7 – 13
LISTGEN, 33 – 15
Location, entering for an office, 13 – 7
Locations, 2 – 2 to 2 – 3
  assigning an employee to, 14 – 8
Lookups, 8 – 9, 31 – 2

M
Mail location information, entry of, 13 – 6
Mail merge, 26 – 2 to 26 – 6, 26 – 16
Mailstop, entry of, 13 – 6, 13 – 8
Manager–level assignments, 14 – 25
Managing change, 1 – 9
Marital Status information, entry of, 13 – 6
Mass Information Exchange (MIX), 9 – 7
Mass Move, 3 – 26
  deleting, 3 – 37
  describing, 3 – 28
  executing, 3 – 35
  making decisions for, 3 – 27
  managing your collection of, 3 – 37
  preparing for, 3 – 27 to 3 – 29
  prerequisites for, 3 – 27 to 3 – 29
  reexecuting, 3 – 36
  reviewing the results of, 3 – 35
  status of, 3 – 35
  summary of tasks, 3 – 28
Maternity leave, 27 – 7
Matrix management, hierarchies for, 2 – 24
Medical information, 13 – 7, 13 – 24, 27 – 10
Menu Structures Report, 30 – 19
Menus
  default menu paths, A – 1
  defining, 30 – 18 to 30 – 23
  for security, 33 – 2, 33 – 8
  query–only access, 30 – 21
Methods of measurement
  overview, Career Management, 16 – 12
  setting up Career Management, 17 – 3
Microsoft Word, 26 – 2 to 26 – 6
Military leave, 27 – 7
MIX, 9 – 7
Multiple element entries, 8 – 5, 8 – 7

N
Name, entry of additional name information
  for an employee, 13 – 7
Net Accrual Calculation, 24 – 26 to 24 – 27
Nonrecurring elements, 5 – 2, 7 – 5
  entering, 9 – 3

O
Offer assignment status, 15 – 15
Office location, entry of, 13 – 6
Office number, entry of, 13 – 6, 13 – 7
Oracle General Ledger, 11 – 4
Oracle Human Resources
  using with Oracle Payroll, 32 – 2 to 32 – 5
  using with spreadsheets, 32 – 5
ORACLE IDs, 33 – 11
Oracle Payroll, 32 – 2
ORG_TYPE, 2 – 6
Organization hierarchies, 2 – 23 to 2 – 30
  adding to, 2 – 20 to 2 – 22
  creating, 2 – 26 to 2 – 30
  for matrix management, 2 – 24
  in security profiles, 33 – 5
  versions of, 2 – 25
Organization Hierarchy Report, 2 – 29
Organizations, 2 – 6 to 2 – 7
  adding to hierarchies, 2 – 13, 2 – 20
additional information for, 2 – 12
assigning an employee to, 14 – 8
classifications for, 2 – 11
cost centers for, 2 – 7
defining, 2 – 10 to 2 – 13
deleting, 2 – 22
entering site addresses for, 2 – 2
external, 2 – 7
in project based enterprises, 6 – 3
levels of internal, 2 – 6
listing employees assigned to, 14 – 25
used with position control, 3 – 4

OTA
competencies, 16 – 14
SQL*Plus script, D – 8 to D – 11

Other information, entering for an employee,
13 – 7

Overrides for element entries, 9 – 5

P
Parent organizations, 2 – 20
Part time assignments, 12 – 3
Part time employment category, 14 – 6
Paternity leave, 27 – 7
Pay periods, 9 – 3
selecting, 5 – 6
Pay scales, 4 – 12
defining, 4 – 13
defining rates for, 4 – 14
Pay value, 7 – 8, 8 – 8
adjusting, 9 – 6
Payee organization, defining, 2 – 12
Payment methods
for a payroll, 5 – 8
for employee assignments, 14 – 19 to 14 – 21
for the enterprise, 5 – 3
Payroll code number, 14 – 7
Payroll management, 1 – 3
cycle of functions, 1 – 4
Payrolls
assigning employees to, 14 – 8
defining, 5 – 5 to 5 – 10
deleting, 5 – 9
in security profiles, 33 – 7

using in HRMS, 5 – 2
Pension groups, 5 – 10
People folders, 13 – 3
People Group key flexfield, B – 3
setting up, 5 – 10
People groups, assigning employees to, 14 – 9
Performance ratings, 25 – 5
Performance reviews, and salary proposals, 10
– 9 to 10 – 11
PERFORMANCE_RATING, 25 – 5
Period of service, 14 – 32
Person Details Report, 13 – 29
Person types, 27 – 2 to 27 – 4
Personal Analysis key flexfield, 27 – 10, B – 4
Personal information
deleting, 13 – 30
entering, 13 – 4
entering special information, 13 – 24
entering unstructured information, 23 – 4
inquiring and reporting on, 13 – 3, 13 – 29
office location, mailstop, 13 – 6
tracking roles and activities, 13 – 28
PERWPOUK, SQL*Plus script, D – 2 to D – 5
PERWPWUK, SQL*Plus script, D – 6 to D – 9
Physician’s name, entry of, 13 – 7
Pictures, 13 – 13
PLACEMENT_REASON, 4 – 17
Planning succession, 21 – 2
Position hierarchies, 3 – 3
adding a new position, 3 – 11
creating, 3 – 22 to 3 – 37
creating new versions, 3 – 23
in security profiles, 33 – 6
Position Hierarchy Report, 3 – 25
Position Name key flexfield, 3 – 5, B – 3
Positions
assigning an employee to, 14 – 9
contrasted with jobs, 3 – 2
defining, 3 – 10 to 3 – 13
entering valid grades, 3 – 15
evaluating, 3 – 13
in rule based enterprises, 6 – 6
listing employees assigned to, 14 – 27
representing jobs and positions, 3 – 2 to 3 – 7
salary budgets, 10 – 18, 12 – 6
skill requirements of, 3 – 16
source, 3 – 29
target, 3 – 31
viewing budget variance, 12 – 10
viewing occupancy, 3 – 20
work choices, 3 – 17
Prefix information, entry of, 13 – 5
Primary applicant assignment statuses, 15 – 16
Primary assignment statuses, for employees, 14 – 5 to 14 – 6, 27 – 5
Primary element classification, 8 – 4
Primary reporting hierarchy, 2 – 23
Probation period, 3 – 10, 3 – 11
entering on assignments, 14 – 9
Processes
  Create Descriptive Flexfield DB Items, B – 6, C – 23
  Create Key Flexfield DB Items, B – 4, C – 25
  Generate Secure User, 33 – 15
  Grant Permissions To Roles, 33 – 15
  PTO Carry Over, 24 – 21 to 24 – 22, 24 – 30
  Security List Maintenance, 33 – 15
  security of, 33 – 9
Processing type, 8 – 4
Proficiency levels, competencies, 17 – 3
Progression points
  defining, 4 – 13
  entering special ceiling for, 14 – 9
  relating to grades, 4 – 15
Project based enterprises, 6 – 2 to 6 – 6
Promotions, recording information about, 14 – 4 to 14 – 6, 14 – 11
PROPOSAL_REASON, 10 – 4
PTO (paid time off)
calculation of net accrued, 24 – 27
carry over process for, 24 – 30 to 24 – 34
manual or batch entry of time taken, 24 – 30
residual and carried over, 24 – 21 to 24 – 22
review of net time accrued, 24 – 32 to 24 – 34
sale or purchase of, 24 – 22, 24 – 30
PTO accrual plans
  elements for, 24 – 18 to 24 – 19
  enrollment in, 24 – 29
  length of service factors, 24 – 21 to 24 – 23
  maintenance of, 24 – 29
operation and structure of, 24 – 18 to 24 – 22
period of ineligibility under, 24 – 19
setup steps for, 24 – 23 to 24 – 28
start rule options for, 24 – 19 to 24 – 20
Public sector, implementation in, 6 – 6 to 6 – 13, 10 – 18, 12 – 6
Purge, 1 – 16

Q
Qualifications, 13 – 15
Qualifiers, for flexfield segments, 11 – 3
QUALIFYING_UNITS, 3 – 10
Query–only access to windows, 30 – 21
QuickCodes
  access levels, 31 – 2
  creating QuickCode values, 31 – 3
  defining QuickCode types, 31 – 5
  list of predefined types, 31 – 6 to 31 – 8
  removing QuickCode values, 31 – 4
QuickPaint reports, 29 – 9
  customizing, 29 – 14
  defining, 29 – 10 to 29 – 12
  running, 29 – 13 to 29 – 14

R
Rates
  for grades, 4 – 8
  for pay scales, 4 – 14
Rating scales, creating, 17 – 7
Re–hiring an employee, 13 – 8
REC_TYPE, 15 – 8
Recruitment
  entering applicants, 15 – 10
  identifying vacancies, 15 – 4
  recruitment cycle, 15 – 2 to 15 – 3
  running recruitment activities, 15 – 5
  tracking applicant progress, 15 – 15
Recurring elements, 7 – 5
  entering, 9 – 3
Reference information, for a rehire applicant, 13 – 7
Rehire information, 13 – 7
Relief position, to cover absence, 3 – 11
Relocation, employee preferences, 13 – 15
Reorganizing, positions and assignments, 3 – 26
Reporting lines, 2 – 24, 3 – 3, 3 – 22
Reporting users, 33 – 8
Reports
Absences, 24 – 17
Assignment Status, 14 – 29
Current and Projected Progression Point Values, 4 – 19
defining, 29 – 7
Employee Increment Results, 4 – 19
Employee Organization Movements, 14 – 30
Employee Payroll Movements, 14 – 30
Employee Summary, 14 – 30
Full Applicant Details, 15 – 10
Full Personal Details, 13 – 29
list of, 29 – 5 to 29 – 7
Menu Structure, 30 – 19
Organization Hierarchy, 2 – 29
Position Hierarchy, 3 – 25
QuickPaint, 29 – 10 to 29 – 18
Requisition Summary, 15 – 22
Salary Review, 10 – 17, 12 – 5
security of, 33 – 9
Skills Matching, 23 – 5
Staffing Budget Details, 12 – 13
Terminations, 14 – 16
Requirements, comparing with accomplishments, competence approach, 18 – 3
Requisition Summary Report, 15 – 22
Requisitions, 15 – 7
Responsibilities, 30 – 18, 33 – 2
defining, 33 – 11
Restricting access to records
by menu structures, 30 – 18, 33 – 8
by organization hierarchy, 33 – 5
by payroll, 33 – 7
by position hierarchy, 33 – 6
by Responsibilities, 33 – 2 to 33 – 4
by security profiles, 33 – 4
from other tools, 33 – 8
Resumes, 23 – 4
ten of status information on, 13 – 6
Reviews
of employee performance, 10 – 2 to 10 – 17,
of salaries, 14 – 10
ROLEGEN, 33 – 15
Rule based enterprises, 6 – 6 to 6 – 13
budgeting, 10 – 18, 12 – 6
S
Salary
relating to grades, 4 – 3
reporting on, 10 – 17, 12 – 5
ways to review, 10 – 3 to 10 – 5
Salary administration
for entry of salaries and wage rates, 10 – 2 to
10 – 17
setup of, 10 – 4 to 10 – 5
Salary bases, 10 – 4
Salary basis
assigning an employee to, 14 – 10
definition of, 10 – 6 to 10 – 7
for salary administration, 10 – 2
Salary budgets, 10 – 18 to 10 – 19, 12 – 6 to 12 – 13
Salary proposals, 10 – 2
approving, 10 – 12
correcting, 10 – 15
ten of, 10 – 9, 10 – 11 to 10 – 12
grade rates for validation of, 10 – 7
Scale rates, 4 – 14
School attendances, 13 – 15
SECGEN, 33 – 15
Secondary applicant assignment statuses, 15 – 16
Secondary assignment statuses, 27 – 6
adding reasons for, 27 – 6
Secondary statuses
defining, 27 – 7, 27 – 8
entering for employees or applicants, 14 – 21
Security, 33 – 2 to 33 – 9
  creating Oracle IDs, 33 – 11
  enabling currencies, 28 – 7
  list of user profile options, 28 – 5 to 28 – 8
  of reports and processes, 33 – 3, 33 – 9
  restrictions by HR:User Type, 32 – 4
  setting up, 33 – 10 to 33 – 12
  setting user profile options, 28 – 4
Security groups, 33 – 3, 33 – 9
Security List Maintenance process, 33 – 15
Security profiles, 33 – 2, 33 – 4 to 33 – 7
  defining, 33 – 13 to 33 – 15
Setting up
  appraisals, 16 – 12
  assessments, 16 – 12
  standard letters, 26 – 3
Setting up Career Management
  competencies and OTA, 19 – 2
  methods of measurement, 17 – 3
  suitability searching, 22 – 2
Skills information, 13 – 24, 23 – 2
Skills matching, 15 – 5, 23 – 2 to 23 – 3
Skills Matching Report, 23 – 5
Social security number, as employee number, 14 – 6
Soft coded legislation, B – 11
Source positions, identifying, 3 – 29
Special ceiling points, 14 – 9
Special information types
  enabling, 27 – 12
  entering, 13 – 24
  setting up, 23 – 2, 27 – 10 to 27 – 12
Spreadsheets, 10 – 19, 32 – 5
SQL*Plus script
  OTA – for confirmation letters, D – 8 to D – 11
  PERWPOUK, D – 2 to D – 5
  PERWPWUK, D – 6 to D – 9
SSP and SMP, 24 – 2
Staffing Budget Details Report, 12 – 13
Staffing budgets, 12 – 2 to 12 – 13, 15 – 4
Standard element links, 7 – 12, 8 – 6
Standard letters, 26 – 2
Standard work day, 14 – 9
Status, of assignments, 27 – 5
Statuses, for letter generation, 26 – 2
Statutory information, entering, 5 – 7
Structuring competencies, general method, 17 – 5
Structuring your competencies, 17 – 4
  individual method, 17 – 4
  which method to use, 17 – 6
Subsidiaries, as Business Groups, 2 – 4
Succession planning, 3 – 11, 16 – 15, 21 – 2, 21 – 6
Suffix information, entry of, 13 – 5
Suitability searching
  overview, 16 – 13
  setting up Career Management, 22 – 2
Supervisor, entering on assignments, 14 – 9
Suspended assignment status, 27 – 5
System administrator, role of in OHR, 28 – 2

T
Tables, user–defined, 31 – 9
  accessing values in, 31 – 9
  entering values into, 31 – 13
  setting up, 31 – 10 to 31 – 12
Target positions, identifying, 3 – 31 to 3 – 33
Task flows, 30 – 10 to 30 – 17
  adding to a menu, 30 – 22
  defining nodes, 30 – 14
Tax information, 2 – 18
Template
  PERWPOUK, D – 2 to D – 5
  PERWPWUK, D – 6 to D – 9
Temporary cover, 3 – 11
TERM_APL_REASON, 15 – 21
Terminate application assignment status, 15 – 16, 15 – 21
Terminate assignment status, 14 – 13, 27 – 5
Terminating applicants, 15 – 21
  cancelling a termination, 15 – 22
Terminating employees
  adding to reasons for, 14 – 14
  assignment statuses for, 14 – 15 to 14 – 17
cancelling a termination, 14 – 16
pay processing after, 14 – 15 to 14 – 17
procedure for, 14 – 14 to 14 – 15
processing pay after, 27 – 9
reporting on, 14 – 16 to 14 – 18
Termination, of employees, 14 – 14 to 14 – 15
Termination dates, 14 – 15
Termination rules, 8 – 5, 27 – 9
Terminations Report, 14 – 16
Third party payments
  defining a personal payment method, 14 – 20
  entering a payments recipient, 13 – 14
  payee organizations for, 2 – 12
Title information, entry of, 13 – 5
Training information, 13 – 24, 25 – 2 to 25 – 3
Transfers or relocations, recording information on, 14 – 4 to 14 – 6, 14 – 11
Turnover, reporting on, 14 – 30 to 14 – 31

U
Union membership, 5 – 10
Union pay scales, 4 – 12
University attendances, 13 – 15
User profile options, 32 – 4, 33 – 3, 33 – 11
User statuses
  defining, 27 – 7
  for applicant assignments, 15 – 15
  for employee assignments, 27 – 7
  renaming, 27 – 7
User tables, 31 – 9
Users, creating, 33 – 11

V
Vacancies
  creating, 15 – 7
  entering applications, 15 – 13
  reporting on, 15 – 22
  viewing, 15 – 9
VACANCY_STATUS, 15 – 7
Valid grades, 3 – 15
Validation, of element entries, 7 – 8, 8 – 3, 8 – 9
Views, list of, 29 – 3

W
Web access, 22 – 2
  career management, 16 – 4
Web interface, configurable, Career Management, 16 – 7
Windows
  Absence Attendance Type, 24 – 11
  Absence Detail, 24 – 13
  Accrual Bands, 24 – 25
  Accrual Plan, 24 – 23
  Accruals, 24 – 32 to 24 – 34
  Address, 13 – 10
  Alter Effective Date, 1 – 12
  Applicant Entry, 15 – 11
  Applicant Interview, 15 – 17
  Application, 15 – 12
  Appraisal Template, 20 – 30
  Assignment, 14 – 8
  Assignment Budget Values, 12 – 3
  Assignment Criteria, 29 – 16
  Assignment History, 14 – 32
  Assignment Set, 29 – 15
  Assignment Statuses, 27 – 7
  Assignments Folder, 14 – 22
  Batch Header, 9 – 8
  Batch Lines, 9 – 8
  Book Events, 15 – 18, 25 – 3
  Budget, 12 – 9
  Budgetary Calendar, 12 – 8
  Bulk Status Change, 15 – 16
  Business Group Information, 2 – 14
  Career Path Name, 21 – 5, 21 – 7, 21 – 8
  Columns, 31 – 11
  Competence Profile, 13 – 16
  Competence Requirements (Core or Generic), 18 – 5
  Competence Requirements (No Core or Generic), 18 – 8
  Competence Types, 17 – 17
  Competencies, 17 – 11
  Costing, 11 – 5
  DateTrack History Change Field Summary, 1 – 13
  default navigation paths, A – 16
Define Task Flow, 30 – 15
Define Task Flow Nodes, 30 – 14
Delete Person, 13 – 30
Element, 8 – 3, 10 – 5
Element and Distribution Set, 30 – 6
Element Entries, 9 – 4
Element Link, 8 – 10
Employee Review, 25 – 4
Entry Values, 9 – 5
Establishments, 19 – 5
Event Bookings, 15 – 18, 25 – 2
Find Competence, 17 – 13
Find Person, 13 – 3
Find Positions, 3 – 29
Form Customization, 30 – 8
Grade Rate, 4 – 9, 30 – 22
Grade Scale, 4 – 15
Grade Step Placement, 4 – 17
Grades, 4 – 4
Input Values, 8 – 8
Job, 3 – 8
Job Evaluation, 3 – 14
Job Requirements, 3 – 16
Letter, 26 – 11
Link Input Values, 8 – 12
List Assignments, 14 – 23
List Budget Variance by Organization, 12 – 12
List Employees by Absence Type, 24 – 16
List Employees by Element, 9 – 17
List Employees by Organization, 14 – 25
List Employees by Position, 14 – 27
List Employees by Position Hierarchy, 14 – 28
List People by Assignment, 14 – 24
List People by Special Information, 13 – 26
List Position Budget Variance, 12 – 11
Location, 2 – 3
Map Career Path, 21 – 8
Mass Move, 3 – 28
Mass Move – Assignments, 3 – 32
Mass Move – Positions, 3 – 31
Mass Move – Valid Grades, 3 – 34
Mass Update of Applicants, 15 – 19
Menu, 30 – 19
Net Calculation Rules, 24 – 26
Organization, 2 – 10
Organization Hierarchy, 2 – 26
Organizational Payment Method, 5 – 3
Parent Organization, 2 – 20
Pay Scale, 4 – 13
Payroll, 5 – 6
People, 13 – 5
People Folder, 13 – 3
Period Dates, 5 – 8
Period Types, 12 – 7
Person Types, 27 – 3
Personal Address Information, 13 – 10
Personal Payment Method, 14 – 19
Picture, 13 – 13
Position, 3 – 10
Position Evaluation, 3 – 14
Position Hierarchy, 3 – 22
Position Occupancy, 3 – 20
Position Requirements, 3 – 16
Qualification Types, 19 – 3
Qualifications, 13 – 21
QuickCode Types, 31 – 5
QuickCodes, 31 – 3
QuickPaint Inquiry, 29 – 13
QuickPaint Report, 29 – 10
Rating Scales, 17 – 9
Recruitment Activity, 15 – 8
Request Letter, 26 – 14
Requisition and Vacancy, 15 – 7
Rows, 31 – 11
Salary Administration, 10 – 9, 25 – 5
Salary Basis, 10 – 7
Salary Management Folder, 10 – 13
Scale Rate, 4 – 14, 30 – 22
Schools and Colleges Attended, 13 – 23
Secondary Statuses, 14 – 21
Security Profile, 33 – 13
Special Information, 13 – 24
Special Information Types, 27 – 12
Submit Requests, 29 – 5
Table Structure, 11 – 4, 31 – 10
Table Values, 31 – 13
Tax Details References, 2 – 18
Terminate, 14 – 14
Valid Grades, 3 – 15
Valid Payment Methods, 5 – 8
View Absence History, 24 – 15
View Element Entry History for Employee, 9 – 18
View Employee Grade Comparison, 4 – 10
View Requests, 29 – 5
View Vacancies, 15 – 9
Work Choices (Job or Position), 3 – 17
Work Choices (Person), 13 – 19
Work Day Information, 2 – 19

Word processors, 26 – 5
Work choices, 13 – 15
employee preferences, 13 – 19

jobs and positions, 3 – 17
Work day information, 2 – 19, 14 – 9
Work Details Report, 13 – 29
Reader’s Comment Form

Oracle Human Resources UK User’s Guide
A58347–01

Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this publication. Your input is an important part of the information we use for revision.

• Did you find any errors?
• Is the information clearly presented?
• Do you need more information? If so, where?
• Are the examples correct? Do you need more examples?
• What features did you like most about this manual? What did you like least about it?

If you find any errors or have any other suggestions for improvement, please indicate the topic, chapter, and page number below:

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

__________________________________________

Please send your comments to:
Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA 94065
Phone: (650) 506–7000     Fax: (650) 506–7200

If you would like a reply, please give your name, address, and telephone number below:

________________________________________________________________________

________________________________________________________________________

Thank you for helping us improve our documentation.